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It’s in the Documentation

Business Objects documentation continues to deliver timely and indepth 
coverage of product information. Not just facts about product features, but a 
world of knowledge in the way of tips, samples, and troubleshooting 
instructions.

For your convenience, Business Objects documentation comes in a variety of 
formats including Windows online help, HTML, Acrobat PDF, paper, and 
multimedia. What’s more, you can gain quick access to it at any time directly 
from the product you are working with.

Documentation has been carefully designed to meet your needs for speed and 
ease of navigation. All the information you need is there just a few mouse clicks 
away.

The next sections highlight the key features of our documentation.

A Documentation Service on the Web
From the Help menu of all our products, you can check out More Tips and 
Samples, the Business Objects documentation service on the Internet. From here, 
you can discover the latest updates, tips, samples, and troubleshooting.

You can also get there by pointing your browser to the following URL:

http://www.businessobjects.com/services/infocenter

From the Tips and Tricks page, registered customer support contacts can explore 
the electronic version of the Business Objects documentation set. It offers 
extensive information on all Business Objects products, updates, 
troubleshooting, tips, and much more. 

In addition, registered DEVELOPER SUITE customers can download new 
documentation and code samples.

http://www.businessobjects.com/services/infocenter 
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Multimedia
Business Objects multimedia comprises the BUSINESSOBJECTS Quick Tour, the 
INFOVIEW Quick Tour, and the BUSINESSMINER tutorial, all of which cover the 
essential features of these products.

The BusinessObjects Quick Tour
The BUSINESSOBJECTS Quick Tour is a multimedia presentation that takes you on 
a guided tour of the key features of BUSINESSOBJECTS. Its didactic approach makes 
it an ideal primer for first-time users of the product. 

You may wish to use it as an accompaniment to the guide Getting Started with 
BusinessObjects. 

An actual screen from the BusinessObjects Quick Tour
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The InfoView Quick Tour
The INFOVIEW Quick Tour is a multimedia presentation that highlights the key 
features of INFOVIEW. Intended primarily for new users, it offers an overview of 
all the features necessary for managing and distributing documents.

The INFOVIEW Quick Tour can be used as an accompaniment to the guide Getting 
Started with WebIntelligence.

An actual screen from the InfoView Quick Tour

The BusinessMiner Tutorial
This multimedia tutorial teaches novice users how to use the powerful desktop 
datamining software, BUSINESSMINER. Each lesson in this tutorial has a narrated, 
animated presentation which shows users how to answer a business question 
using BUSINESSMINER. Users can then try out the demonstrated tasks themselves 
by following the step-by-step exercises in the accompanying guide.
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Online Guides

User’s Guides
All user’s guides are available as Acrobat Portable Document Format (PDF) files. 
Designed for online reading, PDF files enable you to view, navigate through, or 
print any of their contents. The full list of Business Objects guides is provided in 
the Deployment Guide.

From a Business Objects product, you can open a guide from the commands of 
the Help menu.  

The Help menu of BusinessObjects provides commands for viewing documentation.

During installation, the BUSINESSOBJECTS installer program automatically copies 
these files to:

Business Objects\BusinessObjects 5.0\Online Guides\En

You can open a document from the Help menu provided that you have installed 
the Adobe Acrobat Reader, version 3.0 or higher on your machine. This Reader is 
available on the Business Objects CD-ROM. You can also download it for free 
from the Web site of Adobe Corporation.
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The Error Message Guide
The Error Message Guide is a compilation of the error messages that can appear 
with ordinary use of Business Objects products.

This guide provides you with detailed troubleshooting information so that you 
can determine the reasons for an error and take the appropriate steps to resolve 
it. It allows you to search for error messages by code. Each error message appears 
with its probable cause and the recommended course of action.

You can open this online guide from any of the Business Objects products by 
selecting the Error Messages Explained command from the Help menu. From 
IINFOVIEW, click Error Messages in the navigation bar. 

The Error Message Guide in PDF format.

Click an error message to go to its explanation
in the guide.

Click the 
List of Error Messages
bookmark to view
the error messages
by code
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Online Help
For Business Objects Windows desktop products, online help is available in the 
form of .hlp and .cnt files that comply with the standards of Microsoft Windows 
online help.

From INFOVIEW, online help is available for both INFOVIEW and 
WEBINTELLIGENCE. 

What to Do for More Information
If you cannot find the information you are looking for, then we encourage you to 
let us know as soon as you can. We welcome any requests, tips, suggestions, or 
comments you may have regarding the contents of this or other Business Objects 
documentation. You can contact us by e-mail at:

documentation@businessobjects.com

To find out information about Business Objects products and services, visit our 
Web site at:

http://www.businessobjects.com

http://www.businessobjects.com
mailto:documentation@businessobjects.com 
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About this Guide

This user’s guide is about BUSINESSOBJECTS 5.1 business intelligence software. It 
describes the different ways to access data to use in your reports, how to create 
and format these reports and how to analyze the data in them.

Audience
This guide is aimed at non-technical users who intend to use BUSINESSOBJECTS to 
build reports using personal or corporate business data.

These users should be familiar with the Microsoft Windows desktop 
environment and conventions.

Conventions Used in this Guide
The conventions used in this guide are described in the table below.

Convention How Used

SMALL CAPITALS The names of all products such as BUSINESSOBJECTS, 
WEBINTELLIGENCE, SUPERVISOR, DESIGNER.

This font The names of BUSINESSOBJECTS classes, objects and 
conditions.  
For example, Customer, Sales, Revenue, Service, etc.

This font Code, SQL syntax, computer programs .  
For example:  @Select(Country\Country Id)

(...) Placed at the end of a line of code, the symbol (...) 
indicates that the next line should be entered 
continuously with no carriage return.
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What is BusinessObjects?

BUSINESSOBJECTS is an integrated query, reporting and analysis solution for 
business professionals that allows you to access the data in your corporate 
databases directly from your desktop and present and analyze this information 
in a BUSINESSOBJECTS document.

BUSINESSOBJECTS makes it easy to access this data, because you work with it in 
business terms that are familiar to you, not technical database terms like SQL. 
You don’t need any knowledge of the database structure or technology.

Once you’ve used BUSINESSOBJECTS to access the data you need, you can present 
the information in reports as simple as tables or as sophisticated as dynamic 
documents with drillable charts.

You can then save those documents for your own personal use, send them to 
other users, or publish them to the corporate repository for potentially even 
broader circulation.

This section gives an overview of what BUSINESSOBJECTS does and how it works.

Part of a report with data displayed in a table and in a chart. 
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Where does the data come from?
BUSINESSOBJECTS makes it easy to access data from your corporate database 
because it has a business-intelligent, semantic layer that isolates you from the 
technical issues of the database. This semantic layer is called a universe. A 
universe maps to data in the database, using everyday terms that describe your 
business environment. This means you can select exactly the data that interests 
you using your own business terminology.

In your company or organization, universes are created by a universe designer, 
using BUSINESSOBJECTS DESIGNER. The designer then makes universes available 
to you and other users, so that you can access the data you want from the 
database through an intuitive, user-friendly interface

A BusinessObjects Universe.

Using this interface, you build a BUSINESSOBJECTS query using an editor called the 
Query Panel, by adding and organizing objects from a universe. Objects are 
elements that map to a set of data from a relational database in terms that pertain 
to your business situation. When you run the query, BUSINESSOBJECTS connects to 
the database and retrieves the data mapped to the objects you selected.

A query is a type of data provider. The data provider contains the data you have 
chosen to retrieve from the data source. Using this data set, you can build 
interactive reports.

Universes are made up of classes and objects.

Objects are elements that map to a set of data from 
a relational database using business terms. These 
objects allow you to retrieve data for your 
documents.

For example, the objects in the eFashion demo 
universe include Region, State, and Store name.

Classes are logical groupings of objects.

For example, the objects listed above belong to a 
class called Store.

Class

Objects
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BUSINESSOBJECTS lets you access data from a wide range of sources: from 
relational and multidimensional databases, from packaged applications, from 
personal data files, and, using Microsoft Visual Basic for Applications 
procedures, from virtually any source.

Presenting and analyzing data
Once you have the data you need, you can present it in a number of ways. You 
can present it in a simple table:

Or create sophisticated reports containing large amounts of data, organized and 
formatted to make it easy for people to go directly to the information that 
interests them:



 What is BusinessObjects?

  BusinessObjects User’s Guide   29

You can add images and embedded objects and format your documents to high 
presentation standards for viewing on screen or for printing.

On-report analysis allows you to switch your business perspective by dragging 
and dropping data, insert on-report calculations or drill into a report for detailed 
information:

Sharing the information
You can quickly and easily share the documents you have created with other 
users in your company, either by sending them directly to selected individuals or 
groups, or by publishing them as corporate documents. When you distribute 
documents in these different ways, you use the BUSINESSOBJECTS repository. The 
repository stores the documents you send so that other users can retrieve and 
view them. It also stores information about the documents it stores, such as name 
of sender, date and time, and also which users in the company have the right to 
retrieve and view a document.

You can retrieve documents that other users have sent, including 
WEBINTELLIGENCE and BUSINESSQUERY documents which you can open and view 
in BUSINESSOBJECTS. You can also use BROADCAST AGENT to send documents for 
scheduled processing.

Note: For information on sending, retrieving, printing, and publishing and 
scheduling documents, see the InfoView User’s Guide. You can open an electronic 
version of this guide directly from the BUSINESSOBJECTS Help menu.
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What about security?
The repository is set up and administered by the BUSINESSOBJECTS supervisor. All 
of the rights you have as a user are granted by your BUSINESSOBJECTS supervisor 
using BUSINESSOBJECTS SUPERVISOR. The supervisor defines:

• The parts of the BUSINESSOBJECTS interface you can access. Your supervisor 
can restrict the availability of BUSINESSOBJECTS functionality, such as access to 
certain menu commands.

• Your database connections

• The universes you can access for creating and editing queries

The rights accorded to each user define the user’s profile. This profile-based 
security system allows a single document to be distributed to many users -- with 
end users having access only to the information that they are authorized to see.

Keeping a document’s data up-to-date
Databases are regularly updated with new data. A document generated at a 
given point in time reflects the data as it existed at that time, but it may be 
inaccurate now. BUSINESSOBJECTS lets you update the data in a document while 
keeping the same presentation and formatting, either manually, or automatically 
at specified times. When you update a document, BUSINESSOBJECTS reconnects to 
the database, and retrieves the updated data. This is called refreshing a document.

eFashion Demo Materials and Samples

To help you get up and running with BUSINESSOBJECTS, a demonstration 
database, universe and sample reports are included in the BUSINESSOBJECTS 
eFashion demo kit. The Getting Started with BusinessObjects tutorial and the 
multimedia Quick Tour are both based on these materials, as are many of the 
examples in this user’s guide.

The eFashion demo database contains retail data from a clothing chain. It tracks 
211 products (663 product color variations), sold over 13 stores in the US, over 
three years.
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Upgrading from earlier versions of BusinessObjects

This section concerns those users who are upgrading from an earlier version of 
BUSINESSOBJECTS to BUSINESSOBJECTS 5.1.

Upgrading from BusinessObjects 5.0
Documents created in BUSINESSOBJECTS 5.0 are fully compatible with 
BUSINESSOBJECTS 5.1.

Upgrading from BusinessObjects 4.1
You can open documents created using BUSINESSOBJECTS 4.1 in BUSINESSOBJECTS 
5.1. However, 4.1 users cannot read documents created using BUSINESSOBJECTS 
5.1. You will also not be able to apply templates created using version 4.1 to 
reports created using version 5.x and vice versa.

Documents created in BUSINESSOBJECTS 4.1 are fully compatible with 
BUSINESSOBJECTS 5.1. However, BUSINESSOBJECTS 5.1 uses standard Microsoft 
fonts whereas BUSINESSOBJECTS 4.1 used fonts which are slightly different from 
standard Microsoft fonts. If you want documents created in BUSINESSOBJECTS 4.1 
to retain the same look when you open them in BUSINESSOBJECTS 5.1, see 
“Viewing a document created in BusinessObjects 4.1” on page 192 for the options 
you need to set to do this.

Upgrading from BusinessObjects 3.1
You cannot open documents created in BUSINESSOBJECTS 3.1 in BUSINESSOBJECTS 
5.1. If you want to open documents created in BUSINESSOBJECTS 3.1, you need to 
open and save them in BUSINESSOBJECTS 4.1 and then open them in 
BUSINESSOBJECTS 5.1.

What’s new in BusinessObjects 5.1?
Although not a major release over BUSINESSOBJECTS 5.0, BUSINESSOBJECTS 5.1 has 
some important new features.

Save as PDF
BUSINESSOBJECTS 5.1 allows you to save BUSINESSOBJECTS documents in Adobe 
Portable Document Format (PDF). All users need to view BUSINESSOBJECTS 
documents saved as PDF documents is the free Adobe Acrobat Reader. An 
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industry standard for viewing and printing, PDF documents allow users to view 
and navigate through the different reports in a BUSINESSOBJECTS document and 
obtain high quality printed copies.

Add hyperlinks to reports
New to 5.1, you can add hyperlinks such as mail addresses and web site 
addresses to your reports. BUSINESSOBJECTS now automatically recognizes 
keywords for several different protocols including http to connect to web sites, 
electronic mail addresses, FTP and more. These hyperlinks are maintained when 
you save the report in HTML or PDF format.

Zero Administration BusinessObjects
An important new extension to BUSINESSOBJECTS functionality, you can deploy 
BUSINESSOBJECTS 5.1 using either the traditional client/server deployment or 
using a new three-tier web deployment. This new web deployment is called a 
zero-administration deployment of BUSINESSOBJECTS.

In a zero-administration deployment of BUSINESSOBJECTS, only the 
BUSINESSOBJECTS client software is installed on the Windows PC; all middleware 
is stored and administered on the WEBINTELLIGENCE web server and the server-
side processing is handled by the WEBINTELLIGENCE system   This means zero-
administration on the client computer yet still gives the client all the powerful 
query, reporting and analysis features of BUSINESSOBJECTS.

A zero-administration deployment of BUSINESSOBJECTS allows you to:

• Install and automatically update the BUSINESSOBJECTS 5.1 client software from 
INFOVIEW via an Internet browser.

• Connect to the BUSINESSOBJECTS repository using a web connection and use 
middleware installed on the server.

• When connected to BUSINESSOBJECTS via a web connection, you can save 
documents either locally, or in personal storage space on the server.

BUSINESSOBJECTS 5.1 can be installed in two ways:

• from INFOVIEW via an Internet browser

If you install BUSINESSOBJECTS using the web installer you can retrieve data from 
queries built on BUSINESSOBJECTS universes, from personal data files stored 
locally on your PC, and, optionally, using VBA procedures.

• from the product CD

If you install BUSINESSOBJECTS from the CD, you can also install optional 
middleware required to retrieve data using additional data providers such as 
stored procedures or OLAP servers.
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In a zero-administration deployment of BUSINESSOBJECTS, BUSINESSOBJECTS 5.1 
can be started in two ways:

• from INFOVIEW

By setting BUSINESSOBJECTS as your document editor and viewer in the INFOVIEW 
options page, you can open BUSINESSOBJECTS directly from INFOVIEW either by 
clicking on a BUSINESSOBJECTS document in one of the document lists or by 
clicking the Create Document button on the navigation bar.

• from the Windows start menu

You have two ways of connecting to the BUSINESSOBJECTS repository. You can 
open BUSINESSOBJECTS from the Windows Start menu and connect to a repository 
via a web connection and use middleware installed on the web server. If you have 
installed BUSINESSOBJECTS and the appropriate middleware from the CD, you can 
also connect to a BUSINESSOBJECTS repository via a traditional client/server 
connection and retrieve data using stored procedures or OLAP servers (if this 
access has been set up in the company), connection types not available using a 
web connection.
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Overview

This chapter is about accessing data, i.e., how to get data from your database to 
the reports that you create with BUSINESSOBJECTS. It introduces the different data 
sources that are available, and how, using BUSINESSOBJECTS, you can access these 
to get the information you need, when you need it.

What data sources are available?
BUSINESSOBJECTS let you access data from a wide range of sources. You can access 
data from

• Relational databases (RDBMS), such as ORACLE, Microsoft SQL Server, 
Informix and IBM DB2.

• Multidimensional (OLAP) databases, such as Microsoft OLAP Services, 
Hyperion Essbase, and ORACLE Express.

• Text files and spreadsheets

• Packaged applications such as SAP

• Virtually any data source using Microsoft Visual Basic for Applications (VBA) 
procedures.

How do you access data sources?
BUSINESSOBJECTS lets you access your data through a graphical user interface. 
You need no technical knowledge of the underlying data structures to get the 
information you want. What you do need, however, is knowledge of your 
business.

To access a data source with BUSINESSOBJECTS, you build a data provider. The types 
of data providers supported in BUSINESSOBJECTS depends on whether you install 
BUSINESSOBJECTS from the installation CD or install BUSINESSOBJECTS via an 
Internet browser.
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The types of data provider that BUSINESSOBJECTS supports are described in the 
table below:

Data providers Description CD install Install via Internet 
browser

Queries on 
universes

A universe consists of classes 
and objects that represent the 
parts of a database that contain 
the data you need, in everyday 
language that is meaningful to 
you. In a query on a universe, 
you select the objects, such as 
Customer Name, Year, or 
Region.
This is by far the most common 
type of data provider in 
BUSINESSOBJECTS.

Yes Yes

Stored 
procedures

You can only use stored 
procedures if your supervisor or 
IS department has provided 
them, and if the RDBMS at your 
site supports them.
A stored procedure is a SQL 
(Structured Query Language) 
script, saved and executable on 
your database.

Yes No

Free-hand SQL You can use free-hand SQL if 
you are familiar with SQL, 
which is the language used to 
interact with relational 
databases. In free-hand SQL, 
you open or write a SQL script, 
which you then run against the 
database.

Yes No

Personal data 
files

You can retrieve data from 
Excel, dBASE and text files.

Yes Yes 
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Note: OLAP and SAP data providers are documented in dedicated guides that 
you receive when you purchase your OLAP or SAP Access Pack. The other types 
of data providers are documented in this guide.

VBA procedures Procedures written in Microsoft 
Visual Basic for Applications 
(VBA) enable you to retrieve 
data from almost any data 
source.

Yes Yes

OLAP servers You can view the contents of an 
Online Analytical Processing 
(OLAP) server, and select the 
data you want to display in your 
report.
OLAP servers are 
multidimensional databases 
that store summarized data, 
ready for business analysis.
To use OLAP servers in 
BUSINESSOBJECTS, you must 
install the BUSINESSOBJECTS 
OLAP ACCESS PACK for the 
multidimensional database at 
your site.
BUSINESSOBJECTS supports the 
following OLAP servers:
• Microsoft OLAP Services
• Hyperion Essbase
• IBM DB2 OLAP Server
• Informix MetaCube
• Oracle Express

Yes No

SAP BUSINESSOBJECTS interfaces with 
SAP applications, enabling you 
to use data from SAP BW and 
SAP BAPI.

Yes No

Data providers Description CD install Install via Internet 
browser
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Can all BusinessObjects users build data providers?
You can build data providers only if you have purchased the REPORTER module 
of BUSINESSOBJECTS.

What’s more, the BUSINESSOBJECTS supervisor can restrict access to certain types 
of data providers, or even certain objects within a universe, for example. So, you 
may be able to build just queries on universes but no other type of data provider, 
and then be able to use only certain objects.

The way the supervisor sets up access to data providers and other 
BUSINESSOBJECTS features depends entirely upon the query and reporting needs 
of your organization.

Note: By default, all BUSINESSOBJECTS users can refresh data providers, to get the 
latest information from their database.

Who sets up database connections?
In order to access and retrieve data from a database, you need a database 
connection. For example, if your company or organization stores its corporate 
data in an Informix database, someone somewhere has to make BUSINESSOBJECTS 
“talk” to this data source.

In 99% of cases, you, the BUSINESSOBJECTS end user, do not have to concern 
yourself with setting up database connections. Thus, BUSINESSOBJECTS lets 
business users get the information they need, when they need it, without any 
technical knowledge of what’s going on behind the scenes.

This does not mean that power BUSINESSOBJECTS users cannot define their own 
database connections. For example, in free-hand SQL, you can define a 
connection, write a SQL script, then run the script against the connection you 
created. 
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If you want to find out more about who sets up database connections for the 
different types of data providers that you can use, consult the following table.

Data providers Who sets up the database connection?

Queries on 
universes

The universe designer sets up the connection in the 
universe, so the connection is completely hidden from 
you when you build or edit queries.
Note: The supervisor may modify the existing 
connection or assign a new connection to the universe.

Stored procedures The supervisor creates the connection to access the 
stored procedure.

Free-hand SQL In free-hand SQL, you can create your own connection 
to the database. Once you have created the connection, 
you can make it available to other users.

Personal data files When you access data in a personal data file, you select 
the file and in doing so, you “connect” to it. This is not 
a technical task, it’s just a question of selecting the right 
file.

VBA procedures A VBA procedure runs a VBA macro which retrieves 
data for your BUSINESSOBJECTS report. The person who 
creates the macro defines the connection to the data 
source in the macro code.

OLAP servers & SAP The database administrator at your site sets up the 
servers so that you can access them from 
BUSINESSOBJECTS.
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Restrictive connections
If you are working with a universe that is set up with a restrictive connection, you 
need to supply the database username and password to run a query. This 
username/password is not the one that you use to log onto BUSINESSOBJECTS; it is 
the username/password of the underlying database (e.g. an Oracle or SQL Server 
database) that the universe accesses. This database normally remains hidden to 
you, but the universe designer can set up a restrictive connection to add an extra 
layer of security. Depending on the type of restrictive connection, you need to 
supply the database username and password in some or all of the following 
situations:

• When you first run a query (for more information on running a query, see 
“Building a query in the Query Panel and running the query” on page 65).

• When you refresh a query (for more information on refreshing a query, see 
“Refreshing BusinessObjects Documents” on page 209).

• When you parse a query to test its validity (for more information on parsing a 
query, see “Using SQL From BusinessObjects Queries” on page 116).

You see the following dialog box, in which you enter your username/password:

If you do not know your database username and password, see your 
BUSINESSOBJECTS administrator.

Can you combine data from different sources in one report?
Absolutely. With BUSINESSOBJECTS, you can build powerful reports with data 
from corporate databases which you can access using queries on universes, free-
hand SQL, etc., and data from your own spreadsheets, text files etc.

For more information, refer to Chapter 6 "Combining Data From Different 
Sources" on page 149.
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Workflows For Accessing Data

There are two basic workflows for building data providers to access your data in 
BUSINESSOBJECTS. You can build a data provider

• When you create a new document

- and -

• When you are working in an existing document. 

Also in an existing document, you can obtain a different set of results by editing 
a data provider.

The following sections explain these different workflows.

Building a data provider when you create a new document
Building a data provider when you create a new document is a typical way of 
using BUSINESSOBJECTS. You create the document in order to see your business 
data - and to do that, you have to build a data provider to access data from a data 
source.
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To help you build a data provider when you create a new document, 
BUSINESSOBJECTS launches the New Report Wizard when you start the 
application for the first time:

Tip: To run this wizard once you have launched BUSINESSOBJECTS, click the New 
Report Wizard button on the Standard toolbar.

New Report Wizard
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To build a new data provider using the wizard:

1. Select an option for the report layout, then click Begin.
The Specify Data Access dialog box appears:
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2. The next step depends on what you want to do:

If you chose to build a query on a universe in the previous step, the Select a 
Universe dialog box now appears:

3. Select the universe that you want to use, then click Finish.
The Query Panel appears. In the Query Panel, you can view all the classes and 
objects in the universe you selected, and use these to build your query. For 
more information, refer to “The Query Panel” on page 61.

Reminder: OLAP and SAP data providers are documented in dedicated guides 
that you receive when you purchase your OLAP or SAP Access Pack.

If you want to... Then...

Build a query on a universe 1. Click Universe, then click Next.

2. Go to the next step.

Use a stored procedure, free-
hand SQL, a personal data 
file or a VBA procedure

1. Click Others, then select an option 
from the list box.

2. Click Finish.
The dialog box that appears will 
allow you to build your data provider 
and retrieve the data for your report.
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Setting a default type of data provider for new documents
Do you always use the same type of data provider when you create new 
documents? If so, you can set an option so that the type of data provider you 
always use will be preselected in the New Report Wizard. In other words, you 
will not have to select the type of data provider you want every time you create 
a document. 

Tip: If you always use queries on universes, you can also select the default 
universe to use.

To set a default type of data provider:

1. Select the Options command on the Tools menu. 
In the Options dialog box that appears, click the New Document tab.

2. Click Invoke the New Report Wizard with the following settings:

3. In the Data Access group box, select the type of data provider you want to use.
• The Use a Default Universe option lets you select the universe you want.
• Use a Different Data Provider lets you select a data provider type from the 

drop-down list.

4. Click OK to close the dialog box.
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Building a query in an existing document
You don’t have to create a new document every time you want to see new data in 
BUSINESSOBJECTS. You can build data providers inside existing documents. This 
feature enables you not only to see more data that comes from the same source as 
the document’s initial query, but also to combine data from different sources in 
the same report. Here’s an example.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example How do the official figures compare with my personal targets?

Your company’s sales information is stored in your corporate database, which 
you access by running a query on a universe in BUSINESSOBJECTS. You already 
have a BUSINESSOBJECTS document containing this information.

You keep your quarterly targets in a Microsoft Excel spreadsheet, and want to 
compare the corporate figures with your personal data. To do this, you:

1. Open the document containing the corporate data.

2. Select the New Data Provider command on the Data menu.

3. In the Wizard that appears, click Access new data in a different way:
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4. In the next screen, click Personal data files:

5. Click Finish, and in the dialog box that appears, browse to the Excel file that 
contains your personal data:

6. Click Run.
BUSINESSOBJECTS makes the data from the spreadsheet available in your 
report. For information on how to insert it in the report, refer to “Creating 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Tables” on page 226.
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To build a data provider inside an existing document

1. Select the New Data Provider command on the Data menu.

2. Follow the wizard to select the type of data provider you want.

3. Build then run the data provider.
• BUSINESSOBJECTS retrieves the data, thereby making it available in the 

document.
• For information on inserting the new data, refer to “Creating Tables” on 

page 226.

Tip: If you want to see the new data as soon as BUSINESSOBJECTS has retrieved it, 
you should use the Table, Crosstab or Chart commands on the Insert menu. You 
then just have to follow the wizard to access the data you want.

For more information, refer to “Guided Table Insertion” on page 234.

Editing data providers
Editing a data provider means changing its definition in order to bring new or 
different data to the document you are working on. It’s often quicker and easier 
to edit a data provider than to build a new one.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example I need more data

You’re working in a document with sales figures by year, but you need some 
regional information to complete the picture. Rather than building a new query, 
and then having to manage multiple data providers in the same document, you 
can simply add result objects to the existing query. Here’s how to do it:

1. Select the Edit Data Provider command on the Data menu.

2. In the Query Panel, add the objects you want (e.g., Region, City) to the Result 
Objects box. You can do this by double-clicking each object’s icon in the 
Classes and Objects list.

3. Click Run.
BUSINESSOBJECTS returns the new data to the report, and, provided that your 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
data is displayed in a table, the new columns automatically appear.
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Other ideas for editing a data provider include:

• You want to restrict the volume of data returned by setting conditions or 
maximum number of rows.

• You want the data to be sorted in a given order at the query level.

To edit a data provider

1. Select the Edit Data Provider command on the Data menu.

2. The next step depends on whether or not the document contains more than 
one data provider:

3. Edit then run the data provider.
BUSINESSOBJECTS returns the new data set to your report.

Cancelling data providers
Cancelling a data provider means interrupting the data provider while it is 
fetching data to create or refresh a report. You may want to do this because you 
want to change the data provider or because you have a query that is taking too 
long.

1. To cancel a data provider, press the Esc key.
The Interrupted Execution dialog box appears on your screen. 

If the document contains... Then...

One data provider The editor (Query Panel, Access 
Personal Data dialog box, etc.) for 
the data provider appears.

More than one data provider The List of Data Providers dialog 
box appears.
Select the data provider you want 
to edit, then click OK.



 Workflows For Accessing Data

  BusinessObjects User’s Guide   53

2. Select which results you want to view in the report.

3. Click OK.

If Then

you want to view the results that 
will be created by the data 
provider you were running, 

select Continue the execution. 

you want to view the partial 
results created by the data 
provider when you interrupted 
the execution, 

select Stop the execution and keep the 
partial results.
When you have partial results in a 
report, the following notification 
appears in the status bar: 

you want to discard the results 
created by the data provider 
when you interrupted the 
execution, 

select Discard the results.

you want to view the results of 
the previous execution, 

select Keep the results of the previous 
execution.
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Overview

This chapter is about accessing data by using BUSINESSOBJECTS native technology: 
building queries on universes.

What exactly is a universe?
BUSINESSOBJECTS universes make it easy to access data, because they contain 
objects of data in business terms that are familiar to you. What’s more, you need 
no knowledge of the database structure, or of database technology, to be able to 
create powerful reports with data that is relevant to your work.

Universes provide the business-intelligent, semantic layer that isolates you from 
the technical issues of the database. A universe maps to data in the database, in 
everyday terms that describe your business situation.

Universes are made up of classes and objects. For example, the objects in a human 
resources universe would be Names, Addresses, Salaries, etc. Classes are logical 
groupings of objects. Each class has a meaningful name, such as Vacation (for 
objects pertaining to employees’ vacations). Each object maps to data in the 
database, and enables you to retrieve data for your reports.

Who is responsible for creating universes?
In your company or organization, universes are created by a universe designer, 
who works with a BUSINESSOBJECTS application called DESIGNER. The designer 
then makes universes available to you and other users at your site, so that you can 
access the data you want from the database.

A demo universe that maps to a demo database, as well as some sample reports, 
are delivered with BUSINESSOBJECTS. A full description of these is provided in 
“Demonstration materials” below.

So what are queries on universes?
Queries enable you to retrieve data from a database, via a universe. You build a 
query to bring data to a report, either when you create the report or when you 
want to view new data.

When you build a query, you select objects from a universe, then run the query. 
BUSINESSOBJECTS connects to the database, and retrieves the data mapped by the 
objects you selected.
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Demonstration materials
Two demonstration databases, Island Resorts Marketing and eFashion, and their 
accompanying universes and reports are included in the BUSINESSOBJECTS 
package. They are installed with BUSINESSOBJECTS, and used in the examples in 
this guide. Microsoft Access was used to create the databases.

Island Resorts Marketing
The universe, which accesses the data in the database, is called Island Resorts 
Marketing. It is designed for an imaginary tour operator that runs beach clubs in 
different resorts around the world. You use it to retrieve data on sales and 
reservations for resorts and customers, over time. The illustration on page 58 
shows the universe’s classes and objects as they appear in BUSINESSOBJECTS.

Because universes provide a business-intelligent semantic layer between you and 
the database, the names of the classes and objects in the demonstration universe 
are self-explanatory. For example, the Resort class contains objects that map to 
data on resorts:

• The Resort object retrieves the names of the company’s resorts.

• The Service object retrieves data for the types of services in each resort: 
accommodation, food and drinks, and recreation.

• The Service Line object retrieves data for the types of service in each resort, e.g., 
family suite (for accommodation), restaurant (for food and drinks), etc. 

For more information on classes and the different types of objects you find in 
BUSINESSOBJECTS, refer to “Classes and sub-classes” and “Dimension objects, 
measure objects and detail objects” on page 59.
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The demonstration universe, Island Resorts Marketing

Classes and sub-classes
The demonstration universe contains five classes: Resort, Customer, Sales, 
Reservations and Measures. The purpose of classes is to provide logical groupings 
of objects. For example, the Customer class contains objects that you map to data 
on customers in the database.

A folder represents a class.

Each icon within a class 
represents an object.
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The Customer class contains a sub-class, which is entitled Sponsor. A sub-class is 
to a class what a sub-folder is to a folder.

Dimension objects, measure objects and detail objects
When creating universes, universe designers define and qualify objects. The 
qualification of an object reveals how it can be used in analysis in reports.

An object can be qualified as a dimension, a detail, or a measure. Each type of 
object serves a different purpose:

Measure objects are semantically dynamic: the values they return depend on 
the objects they are used with. For example, if you include Resort and Revenue 
in a query, revenue per resort is calculated. If you include Customer and 
Revenue, revenue per customer is calculated, and so on.

eFashion
The eFashion demo database contains retail data from a clothing chain. It tracks 
211 products (663 product color variations), sold over 13 stores in the US, over 
three years. It contains approximately 90,000 rows of data.

• Dimension objects retrieve the data that will provide the basis for analysis 
in a report. Dimension objects typically retrieve character-type data 
(customer names, resort names, etc.), or dates (years, quarters, reservation 
dates, etc.)

Dimension object

• A detail object is always associated to one dimension object, on which it 
provides additional information. For example, Address is a detail object 
that is associated to Customer. Address provides additional information on 
customers, i.e., their addresses.

Detail object

• Measure objects retrieve numeric data that is the result of calculations on 
data in the database. In the demo universe, Revenue is the calculation of 
number of items sold multiplied by item price. Measure objects are usually 
located in the Measures class.

Measure object
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Building a Basic Query on a Universe

You can bring data to a report by building a query on a universe. You complete 
this task in the Query Panel, a graphical interface that enables you to build a 
query by dragging and dropping objects from the universe. The Query Panel is 
illustrated on page 61. 

There are three steps in building a basic query on a universe.

Displaying the Query Panel
How you display the Query Panel depends on whether you’re creating a new 
document or building a new query inside an existing document. You can use the 
following commands and toolbar buttons:

If you need more information, refer to “Workflows For Accessing Data” on 
page 44.

The Query Panel, illustrated on page 61, displays the contents of your 
BUSINESSOBJECTS universe, and lets you select the data you want with simple 
mouse clicks.

Step Description

Step 1 Display the Query Panel

Step 2 Build the query in the Query Panel and run the query

Step 3 Save the query definition

If you want Then

to create a new document, click the New Report Wizard button 
(Standard toolbar).

to edit a query or other type of 
data provider in the current 
document, 

from the Data menu, select Edit Data 
Provider.

to create a new query or other 
type of data provider in the 
current document, 

from the Data menu, select New Data 
Provider.

New Report Wizard
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The Query Panel 

a. Classes appear as folders.

b. Objects appear as cubes (for dimensions), spheres (for measures) or pyramids (for 
details). 

c. This button displays the universe’s predefined conditions.

d. This button, selected by default, displays the universe’s classes and objects.

e. Information on the selected class or object appears here.

f. This button enables you to set options before running the query, for example to specify 
a maximum number of rows.

g. The Result Objects box displays the objects that are included in the query.

h. The Conditions box displays conditions on the query.

i. Save and Close lets you save the query you have defined without running it. You can 
run it later on by using the Refresh command.

j. When you click View, the raw data retrieved by the query appears in the Data 
Manager. From the Data Manager, you can edit, accept or cancel the query.

k. When you click Run, the query connects to the database and the data appears in the 
report.

a

b 

d
c 

g

h

k

e

f

i

j
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Displaying the Query Panel
You’ve launched BUSINESSOBJECTS for the first time and the New Report Wizard 
appears. You use the wizard to display the Query Panel for the Island Resorts 
Marketing universe. Here are the steps you take:

1. In the New Report Wizard, click Begin.
The Specify Data Access dialog box appears, with the Universe option already 
selected.

2. Click Next.
The Select a Universe dialog box appears.

3. Click Island Resorts Marketing:
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4. Click Finish.
The Query Panel appears with the classes of the Island Resorts Marketing 
universe displayed:

Building a query in the Query Panel and running the query
Building and running a query includes the following steps:

Steps 2, 3, and 4 are not completely sequential. For example, you can include 
objects in a query, remove some of them, and then include other objects. 

Step Description

Step 1 Display all the objects that you can include in a query

Step 2 Include objects in a query

Step 3 Remove objects from a query

Step 4 Change the order of objects in a query

Step 5 Run the query
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Displaying the objects that you can include in a query
In the Query Panel, the Classes and Objects box presents the classes, sub-classes 
and objects of the universe that you are using. Objects represent the data that you 
can retrieve via the universe. Classes are logical groupings of objects. Classes can 
also contain sub-classes, as folders can contain sub-folders.

When the Query Panel appears, only the universe’s classes are visible. Click the 
+ plus to the left of a class icon to view the class’s objects and sub-classes.

Including objects in a query
When you include an object in the query, you instruct BUSINESSOBJECTS to 
retrieve the data for that object from the database. For example, to display 
revenue by resort in your report, you include the Revenue and Resort objects in 
the query.

You include an object in a query by placing it in the Result Objects box. There are 
three ways of doing this. You can:

• Click an icon in the Classes and Objects list, and drag it to the Result Objects 
box. 

• Double-click an object in the Classes and Objects list.

• Click a class folder and drag it to the Result Objects box. All the objects in the 
class appear in the Result Objects box.

Once you have placed objects in the Result Objects box, you have built a basic 
query.

Removing objects from a query
If you decide you want to remove an object from the query you are building, click 
its icon in the Result Objects box. You can now remove the object by:

• Dragging the icon to the Classes and Objects list.

• Pressing the Delete key.

• Clicking your right-mouse button, then selecting the Delete command on the 
pop-up menu that appears.

Repeat to remove other objects from the query.

Changing the order of the objects in a query
The order in which the objects appear in the Result Objects box determines the 
order in which the data will appear in the report. To move an object, click its icon. 
You can now:

• Drag the icon to the left or the right, then release the mouse button.
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Swap the icon with another object icon in the Result Objects box, by holding 
down the Shift key, dragging it until it is above the object you want to swap, then 
releasing your mouse button.

Running the query
Once you have built the query you want, you click Run to have the query retrieve 
the data from the database.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Building a query in the Query Panel and running the query

You have displayed the Query Panel for the Island Resorts Marketing universe 
and want to move objects from the Classes and Objects box to the Result Objects 
box to build your query.

1. Click the + sign next to the Resort class, the Sales class and the Measures class.
Doing this reveals the objects in each class.

2. Double-click the objects you want. For example, to find out yearly revenue in 
each resort, double-click Resort, Year and, in the Measures class, Revenue.
The Query Panel now looks like this:
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3. Click Run.
BUSINESSOBJECTS retrieves the data for Resort, Year and Revenue, and 
displays this in a new document:

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Note: If the universe designer has set the up the universe with a restrictive 
connection, BUSINESSOBJECTS prompts you to enter your database username and 
password before retrieving the data. For more information on restrictive 
connections, see “Restrictive connections” on page 43.

Saving the definition of a query
You can build a query without having to run it right away. This feature lets you:

• Save a query so that you can continue defining it at a later stage.

• Save a query that you have finished defining, but that you do not want to run 
right away, for example because you know network traffic is heavy.

1. Build a query by moving objects into the Result Objects and Conditions boxes 
in the Query Panel.

2. Click Save and Close.
The result objects from the query appear as column headings. You then 
refresh the query in order to view the data.
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Building a More Powerful Query

You build a simple query by adding objects to the Query Panel. The procedures 
described in the following sections enable you to build a more powerful query by 
controlling the data that your queries retrieve. You can:

• Define scope of analysis, which means that you retrieve data that you will 
later use for analysis in the report.

• Limit the query results to data that satisfies conditions.

• Sort data, for example alphabetically.

• Retrieve a specified number of rows of data.

• Eliminate duplicate rows of data from the query result.

Note: All the above tasks are easy to perform for non-technical end users. In 
Chapter 4 "Going Further with Queries on Universes" on page 77, you can find 
information on more powerful query building procedures that are designed for 
advanced users. For example, advanced users can create their own objects inside 
a universe.

Defining scope of analysis
Analysis means looking at data from different viewpoints and on different levels 
of detail. In reports, you can use scope of analysis to ensure that the data included 
in your report can be displayed at the appropriate level of detail for your analysis. 
Setting a scope of analysis allows you to work in drill mode, which enables you 
to display data in progressively greater detail.

“Scope of analysis” means a subset of data, returned by a query, that you will use 
for analysis in your report. The data for your scope of analysis does not appear in 
the report until you decide that you want to use it in analysis.

The scope of analysis you can define depends on hierarchies in the universe. A 
hierarchy, which the designer sets up when creating the universe, consists of 
dimension objects ranked from “less detailed” to “more detailed”. The objects 
that belong to hierarchies are the ones you can use to define scope of analysis.
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Note: If a universe contains no hierarchies, its classes are used as hierarchies by 
default. 

To define default scope of analysis
Once you include one object that belongs to a hierarchy in a query, you can define 
a default scope of analysis that includes other objects at other levels from the 
same hierarchy. Including more levels in your scope of analysis allows you to 
view lower levels of detail in your analysis. For example, the Resort object belongs 
to the Resort hierarchy. Once you include Resort in a query, you can 
automatically include Service Line and Service objects in your scope of analysis, 
as these objects also belong to the Resort hierarchy. 

To view the hierarchies in the universe you are working with, click the Scope 
of Analysis button on the Query Panel toolbar. The Scope of Analysis dialog 
box appears:Scope of Analysis

A check appears 
next to the objects 
that are included in 
the scope of 
analysis.

Click the + sign to 
the left of the 
hierarchy’s folder to 
view the objects it 
contains.

HIerarchies are represented by folders.
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To use this feature, first insert an object from a hierarchy in the Result Objects box. 
Then, click the arrow on the Scope of Analysis list box on the Query Panel toolbar:

This list enables you to include one, two or three objects from the hierarchy in 
your scope of analysis. For example, if you insert Resort in the Result Objects box, 
then click One Level Down, your scope of analysis contains the object below 
Resort (i.e., Service Line) in the Resort hierarchy. Click the option that corresponds 
to the number of objects you want to include in your scope of analysis. This 
option is now active in the Scope of Analysis list box.

When you run the query, the report displays the data for the objects that you 
included in the Result Objects box of the Query Panel. The data for the objects in 
your scope of analysis is not displayed, but it is available for use in analysis.

To define scope of analysis manually
Instead of using the default method described in the previous section, you can 
manually select the dimension objects you want. To do this: 

3. Click OK to return to the Query Panel.
In the Scope of Analysis list box on the Query Panel toolbar, “Custom Level” 
is shown, which indicates that you manually defined your scope of analysis.

Tip: You can select all the objects in a hierarchy by clicking the hierarchy’s check 
box in the Scope of Analysis dialog box.

1. Click the Scope of Analysis button in the Query Panel toolbar.
The Scope of Analysis dialog box appears.

2. Click inside the checkbox of each object you want to include in your scope 
of analysis.

Scope of Analysis
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Applying conditions
A condition is a way of limiting the data that a query returns. Here’s a simple 
example.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Limiting query results by using a condition

The Resort object retrieves five values: Australian Reef, Bahamas Beach, French 
Riviera, Hawaiian Club and Royal Caribbean.

You can apply a condition on the Resort object to stipulate that you want to 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
retrieve the data for only Bahamas Beach and Royal Caribbean of the resorts.

In BUSINESSOBJECTS, you can set three types of conditions on a query:

Conditions Description

Predefined 
conditions

When universe designers build universes, they can 
create predefined conditions for you to use. For 
example, the Island Resort Marketing universe contains 
predefined conditions such as Year 98, which lets you 
obtain reservations for 1998 only.

You can apply one or more predefined conditions when 
you build a query. However, you can neither delete 
predefined conditions from a universe, nor can you edit 
their definition.

Simple conditions Enable you to limit data returned by a result object. For 
example, you can find out about certain customers by 
applying a simple condition on the Customer object, 
then selecting the customer names that appear in a 
dialog box.

Complex 
conditions

Enable you to limit the query results by any object in the 
universe. 

For more information on complex conditions, refer to 
“Applying Complex Conditions on Queries” on 
page 93.
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To apply a predefined condition

2. Double-click the predefined condition you want to apply.
The condition appears in the Conditions box.
When you run the query, only the data corresponding to the predefined 
condition appears in the report.

Tip: For information on using two or more conditions in the same query, refer to 
“Applying Groups of Conditions” on page 107.

To remove a predefined condition
Click the condition’s icon in the Conditions box, then press the Delete key.

1. Click the Predefined Conditions radio button, which is located below the 
Classes and Objects box in the Query Panel.
The Predefined Conditions box replaces the Classes and Objects box.
The predefined conditions in the Island Resorts Marketing universe are 
illustrated here:

Predefined
Conditions
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To apply your own simple condition
Before you can apply a simple condition on an object, you must include the object 
in the query. Then:

1. Click the object’s icon in the Result Objects box.

2. Click the Simple Condition button on the toolbar.
The list of values for the object is retrieved from the database, and appears in 
the List of Values dialog box:

3. Hold down the Ctrl key on your keyboard, click the values you want the 
object to retrieve, then click OK.
The condition appears in the Conditions box.
When you run the query, only the data corresponding to the value(s) you 
selected will appear in the report.

To select different values for a simple condition
Once you have applied a simple condition on an object in a query, you can 
modify it by selecting different values for the object to return. To do this:

1. In the Conditions box of the Query Panel, click the value(s) that appear(s) on 
the right-hand side of the condition. 
The Classes and Objects box becomes the Operands box.

2. Double-click the Show list of values operand. 
The object's list of values appears in the List of Values dialog box.

Simple Condition
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3. If you want to select more values for the condition, hold down the Ctrl key 
and then, in the List of Values dialog box, click each value that you want the 
object to retrieve.

4. Click any selected values that you do not want the object to retrieve, and click 
OK.

To delete a simple condition
Click the condition in the Conditions box, then press the Delete key.

Applying sorts
Sorts control the order in which data appears: ascending or descending. For 
example, you can apply a sort on a measure object so that its data appears in 
ascending order, i.e., from lowest to highest values.

The following table summarizes the order in which data appears:

To apply a sort on an object

To remove a sort
There are two ways of doing this:

• Click the sort icon and press the Delete key.

• Drag the sort icon from the object in the Result Objects box, to the Classes and 
Objects list, where you release your mouse button.

In both cases, the sort icon disappears from the object in the Result Objects box.

To invert a sort
Double-click the sort icon below the object. The arrow in the sort icon appears the 
other way up, to indicate that you have inverted the sort.

Text Numbers Dates

Ascending order A-Z lowest to 
highest

past to present

Descending order Z-A highest to 
lowest

present to past

1. Click an object in the Result Objects box.

2. Click the Sort button on the toolbar. 
A sort icon appears below the object icon in the Result Objects box.

Sort
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Sorts and free-hand SQL
If you apply a sort on a query and then use the SQL statement generated by the 
query to create a new report, the SQL statement will ignore the sort. You need to 
either adjust the order of the columns in the SQL statement to create the report 
you want or modify the order of the columns in the report itself. 

To define sort priority and apply transparent sorts
When you apply more than one sort on a query, you may want to define sort 
priority. Also, you can apply transparent sorts, i.e., on objects that are not result 
objects, provided that the database at your site supports this feature.

To define sort priority or apply transparent sorts, click the Manage Sorts button 
on the Query Panel toolbar. The Sorts dialog box appears.

To find out more about these tasks, click the Help button in the Sorts dialog box.

Setting options and running a query
Before running a query, you can set options that enable you to:

• Specify the number of rows of data that you want the query to return. The 
Default Value option corresponds to the maximum number of rows that the 
universe designer specified for queries on the current universe, in the 
DESIGNER module.

• Eliminate duplicate rows of data. This feature is useful if you think that the 
query will return many rows containing the same data.

• Retrieve no data when you run the query. In this case, the query’s SQL is 
generated, but no connection to the database is made. The names of the objects 
included in the query appear as column headings in the report.

This option is useful if you want to save the query you have built, but refresh 
it at an off-peak time.

Manage Sorts
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To set options, then run a query:

1. Click Options in the Query Panel.
The Query Options dialog box appears.

2. Click No Duplicate Rows if you want to eliminate duplicate rows of data from 
the query result.

3. To obtain a partial result, you can:
• Click 10 rows or 20 rows.
• Enter a number of rows in the Other field. You can use the arrows to raise 

or lower the value.

4. Click Do Not Retrieve Data if you do not want the query to connect to the 
database when you run it. 
When you refresh the query, this option will be automatically switched off, 
meaning that the query will connect to the database and the data will appear 
in the report.

5. Click OK to return to the Query Panel. 
Once you are satisfied with the query you have built, click Run. 
The query connects to the database, and retrieves the data you specified. The 
report that appears displays the data for the objects that you placed in the 
Result Objects box in the Query Panel.
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Running a Query on a Different Universe

BUSINESSOBJECTS allows you to run a query on one universe and then run the 
same query on a different universe. By doing this, you can test your query on a 
pilot universe before applying it to your real data. The following procedure 
describes how to run a query on a different universe after having run it on an 
initial universe.

1. Open the report containing the query.

2. From the Data menu, choose View Data.
The Data Manager dialog box opens.

3. Choose the query you want to use in the Data Providers list, then click the 
Definition tab.

4. Click the button to the right of the current universe name.

5. In the dialog box that appears, select the universe you want to use, then click 
OK. 

6. Click the Results tab, then Refresh.

7. Click OK to close the Data Manager.
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Overview

This chapter describes how to benefit from the most powerful query features in 
BUSINESSOBJECTS. You learn how to

• Create your own objects

• Customize lists of values

• Apply complex conditions

• Work with multiple conditions

• Combine the results of multiple queries into one data set

• View, edit and reuse the SQL generated by BUSINESSOBJECTS queries.
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Creating User Objects

A universe consists primarily of classes and objects, created by the universe 
designer. If the objects in a universe do not meet your needs, you can customize 
the universe by creating your own objects, which are called user objects.

User objects appear in the User Objects class in the universe. You include them in 
queries in the same way that you include regular objects. Moreover, you do not 
need to define a connection to a database to define a user object.

Why create a user object?
Based on one or more existing objects, user objects enable you to:

• Make calculations at the database level.

• Apply functions to text, for example to capitalize data.

• Group data.

Here’s an example of a user object.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Obtaining total ordered revenue by creating a user object

To obtain the revenue generated by an order, you create the Total user object with 
the following formula:

=Quantity Ordered*Product Price

where Quantity Ordered and Product Price are objects in your universe. When 
you include the Total user object in a query, the calculation is made at the 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
database level and the calculated results appear in your report.

What does a user object consist of?
A user object has a name, a type (character, date or numeric), a qualification 
(dimension, measure or detail) and a formula. The formula contains a 
combination of functions, objects, user objects, operators, and text.

User objects are end-user personal objects that are not shared with other end-
users. User objects are defined for each universe and stored on a local file inside 
the “\Universe” folder. For example, when creating a user object on top of a 
specific universe, say BEACH.UNIV, this user object will then be stored locally 
on a file called the BEACH.UDO (inside the Universe folder).
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What are the restrictions on user objects?
You can work only with the user objects that you create yourself, and you cannot 
move user objects from the User Objects class. Also, user objects are available 
only in the universe in which they were created. 

User objects are not shared. Reports that include user objects can only be viewed 
by other end-users. This is because user objects are stored locally in a specific user 
object definition file. Other end-users, who do not have the same user object 
definition file are not able to access the user object definitions. If an end-user tries 
to refresh or edit a query that contains another user’s user objects, the user objects 
are automatically removed from the query and report.

Despite these restrictions, the universe designer can turn user objects into regular 
objects, which can be made available in other universes, and for other users.

Note: Scheduling reports containing user objects is not a supported feature. User 
objects are removed when the report is refreshed. For more information refer to 
the InfoView User’s Guide. 

How can an end-user share user objects with other users?
If an end-user wants to share user objects with other users, they should ask the 
universe designer to include these user objects in the related universe in order to 
make them available to all BUSINESSOBJECTS end-users. The universe designer 
includes the file UNIVERSE_NAME.UDO in the universes where the user objects 
are to be used.

Creating, editing and deleting user objects
BUSINESSOBJECTS lets you create user objects in two different ways. 

If you want to Then

create user objects that you can 
use only in the universe that 
contains the current query, 

click the User Objects button on the Query 
Panel toolbar. 
You cannot delete user objects this way.

create, edit, or delete user 
objects in any of the universes 
available to you,

use the Universes command on the Tools 
menu in the main application window.

User Objects
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The following sections describe how to create, edit and delete user objects using 
the Universes command.

To create a user object in any universe available to you

1. Select the Universes command on the Tools menu.
The Universes dialog box appears.

2. Select the universe in which you want to create the user object, then click User 
Objects.
The User Objects dialog box appears.

3. Click Add.
The User Object dialog box appears:

4. In the Definition tab, type the name of the user object in the Name field.

5. In the Type list, select the type of the user object (Character, Number or Date).

6. In the Description field, type a help text on the object.
The help text appears when you select the user object in the Query Panel.

7. In the Qualification box, click a radio button to qualify the user object as a 
dimension, a measure or a detail.

8. Click the Formula tab to write the formula for the user object.
For information on how to write the formula, refer to “To write the formula of 
a user object” on page 83.
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9. Click OK.
The user object you have created appears in the User Objects dialog box. The 
next time you build or edit a query on the universe, the user object you have 
created will appear in the User Objects class.

Reminder: You can create a user object by clicking the User Objects button on the 
Query Panel toolbar. However, using this method you can create user objects 
only in the universe you selected for the query you are working on.

To write the formula of a user object

1. Display the User Object dialog box by following steps 1 to 3 under “To create 
a user object in any universe available to you” on page 82.

2. Click the Formula tab, then check Get Assistance on Functions:

3. Double-click the objects, functions and operators you want to use in the user 
object's formula.
• When you double-click an object or an operator, it appears in the Formula 

box. The functions and operators you can select depend on the database at 
your site.

• When you double-click a function, the Function[FunctionName] dialog 
box appears.

User Objects
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4. In the Function[FunctionName] dialog box, type an argument in each field.
• If the function's arguments include objects, user objects, functions or 

operators, you can double-click these in order to insert them in the 
function's formula.

• The arguments appear in the Formula box.

5. If necessary, type text, numbers or dates in the formula.
You must type quotes (") before and after text and numbers, but type a single 
quote (') before and after dates.

6. Click OK, then click Test to check the syntax of the formula.

To edit a user object
Editing a user object enables you to change the object’s name, qualification, and 
definition (formula). To edit a user object:

1. Click the Universes command on the Tools menu.
The Universes dialog box appears.

2. Select the universe that contains the user object that you want to edit, then 
click User Objects.
The User Object dialog box appears.

3. Select the user object you want to edit, then click Edit.

4. In the Definition tab of the User Objects editor, change the name, the type 
and/or the help text of the user object.

5. In the Qualification box, click a radio button to change the user object's 
qualification.

6. Click the Formula tab if you want to edit the user object's formula.

7. Click OK.

To delete a user object

1. Click the Universes command on the Tools menu.

2. In the Universes dialog box, select the universe that contains the user object 
you want to delete, then click User Objects.

3. In the User Objects dialog box, select the user object you want to delete, then 
click Delete.



 Creating User Objects

  BusinessObjects User’s Guide   85

Creating a time hierarchy for a user object
When one of your user objects is a date-type dimension, you can create a time 
hierarchy for the object. 

1. In the User Object dialog box, make certain that the object is a date-type 
dimension.

2. Click Automatic Time Hierarchy.
The Automatic Time Hierarchy dialog box appears.

3. In the Automatic Time Hierarchy dialog box, click Year, Quarter, and/or 
Month.
When you click Year, Quarter, and/or Month, you create a new user object 
that will appear below the initial user object in the hierarchy. 

4. If you want, enter a name and help text for each new user object in the Name 
box and Description box, respectively, then click OK.



 Chapter 4 Going Further with Queries on Universes

86   BusinessObjects User’s Guide

Customizing Lists of Values

A list of values presents the values returned by an object. BUSINESSOBJECTS lets 
you use lists of values in order to select the value(s) you need when defining 
conditions on objects in a query, or when running a query that contains a prompt. 

How are lists of values created?
In DESIGNER, the universe designer decides whether or not to associate a list of 
values to an object. Once associated to an object, the list of values can be viewed 
or edited in DESIGNER, or in BUSINESSOBJECTS.

The first time you view a list of values for an object, BUSINESSOBJECTS runs a query 
and retrieves the object's values from the database. In other words, a list of values 
is by default equivalent to a query containing one object.

How can you customize lists of values in BusinessObjects?
BUSINESSOBJECTS lets you customize lists of values in the following ways:

• By editing the list’s corresponding query.

For example, you can limit the data returned by the list of values by applying 
a condition.

• By assigning data from personal data files to lists of values. 

This feature is especially useful if you always use the same values, e.g., city 
names, when applying conditions. You can view only the values you need 
without having to connect to your remote database. For more information, 
refer to “Assigning personal data to a list of values” on page 88.

Tip: You can also define lists of values in free-hand SQL scripts. For more 
information refer to “Creating a prompt with a list of values for a free-hand SQL 
script” on page 133.

A word about .LOV files
When you use or view a list of values on an object for the first time, 
BUSINESSOBJECTS creates a .lov file which contains the query definition and the 
values it returns. By default, .lov files are located in sub-folders inside the 
UserDocs folder.
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Editing lists of values
In DESIGNER, the universe designer decides whether or not a list of values can be 
edited in BUSINESSOBJECTS. Therefore, you can only edit a list of values if the 
designer has granted you the right to do so.

Because a list of values is first and foremost a query, you edit the list of values by 
editing its corresponding query in the Query Panel. You can edit the query by:

• Applying conditions to restrict the values returned.

• Applying sorts to make the values appear in a specific order.

• Building a combined query.

• Including additional objects in the query. 

Here’s an example of how you can benefit from this feature.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Showing family names and first names in a list of customers

The Customer object has a list of values that you want to use in a query condition. 
The goal is to let users select the customers they’re interested in when they run 
the query.

However, some of your customers have the same family name. To let users see 
exactly which customers they’re selecting, you edit the Customer list of values by 
adding the First Name object. The list of values now returns both family and first 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
names; these will appear when users are prompted to select values from the list.

To edit a list of values:

1. Select the Universes command on the Tools menu.
The Universes dialog box appears.
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2. Click the universe that contains the list of values you want to edit, then click 
Lists of Values.
The List of Values dialog box appears:

3. Open a class by clicking its + sign, click the object whose list of values you 
want to edit, then click Edit.
The Query Panel appears.

4. Edit the query, then click Run.
BUSINESSOBJECTS populates the list of values according to the new definition 
of the query.

5. To view the changes in the list of values, click Display, then click OK.

6. Click OK to close the dialog box.
You can now use the edited list of values in a query condition.

Assigning personal data to a list of values
If you always use one of a small number of values when applying conditions, you 
can limit your choices by assigning personal data to an object's list of values. 
Assigning personal data to the list of values decreases the time required for the 
query because it is quicker to retrieve values from a list than it is to query the 
database. 
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The following example describes how a list of values can return a limited set of 
values from a text file, rather than a complete set of values from the corporate 
database.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Assigning personal data from a text file to a list of values

The database you access contains data on all major cities in the USA. As a regional 
sales manager, you only ever need to view the results for three cities: New York 
City, Albany and Buffalo.

To save time and to focus on the data you need, you create a text file containing 
the names of the three cities. Next, you assign the text file to the City object's list 
of values. 

The next time you want to select a value when applying a condition on the City 
object, you only view the three city names, rather than the names of all the cities 
in the database. Also, no connection to the database is made when you view the 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
list of values, so you save time and cut down on network traffic.

What kinds of data can you use?
The personal data you assign to a list of values must be stored in a file that you 
can access from your computer. The file types you can use are:

• Text

• Microsoft Excel (including version 97)

• dBASE.

What kinds of delimiters can you use to separate the data?
The data in the file must be separated by any of the following:

• Tabulation

• Space

• Character

To assign personal data to a list of values

1. Select the Universes command on the Tools menu.
The Universes dialog box appears.

2. Click the universe that contains the list of values you want to edit, then click 
Lists of Values.
The List of Values dialog box appears.



 Chapter 4 Going Further with Queries on Universes

90   BusinessObjects User’s Guide

3. Click the + sign to the left of the class containing the object you want, then 
click the object.

4. If Personal Data is not already active, click this option now. 
The following message box appears:

5. Click OK.
The message box closes and the Access Personal Data dialog box appears:

6. Click Browse to locate the file that contains the list of values you want to use, 
select the appropriate delimiter, then click Run.
• The Access Personal Data dialog box closes.
• The list of values now points to the file you selected, not to the database.

7. To view the new list of values, click Display, then click OK.

8. Click OK to close the List of Values dialog box.
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Viewing, refreshing and purging lists of values
BUSINESSOBJECTS lets you view, refresh and purge lists of values at any time. To 
do so:

1. Select the Universes command on the Tools menu.
The Universes dialog box appears.

2. Select the universe that contains the list of values you want, then click Lists of 
Values.
The Lists of Values dialog box appears.

3. Open a class by clicking its + sign, then select the object whose list of values 
you want to view, refresh or purge.

4. Click the button you want:

Button Action

Display BUSINESSOBJECTS displays the values in the List of 
Values of Object Name dialog box.
To view the list in table or hierarchy format, click 
Tabular View or Hierarchical View respectively. These 
options are useful if the list of values contains more 
than one object, i.e., it combines two or more 
columns of values:

• In Tabular View, the columns appear next to each 
other.

• In Hierarchical View, the values from the first 
column appear as a folder. The folder contains 
the values of the second column. If there is a third 
column, the second column appears as a folder 
that contains these, and so on.

Refresh BUSINESSOBJECTS runs the query for the list of values, 
and a refreshed list appears.

Purge BUSINESSOBJECTS empties the .lov file corresponding 
to the list of values.
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5. Click OK to close the dialog box.

Tip: You can populate a purged list of values by clicking Refresh.



 Applying Complex Conditions on Queries

  BusinessObjects User’s Guide   93

Applying Complex Conditions on Queries

You can limit the data that queries return by applying conditions. You apply 
complex conditions by combining an object with an operator (e.g., greater than), 
and an operand (e.g., values that you type, or another object). 

In addition to complex conditions, you can use predefined conditions and simple 
conditions. Here are some guidelines for choosing among the three types of 
conditions:

To illustrate how you can benefit from complex conditions, here’s an example.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Which customers made reservations for 1997 and 1998?

You want to market new products to customers who made reservations for 1997 
and 1998. All you need is that list of names - and you obtain it by applying a 
complex condition on Reservation Year, without using Reservation Year as a 
result object in the query. Here’s how to do it:

1. Insert the Customer object in a query on the Island Resorts Marketing 
universe.

2. Drag the Reservation Year object to the Conditions box.
The Classes and Objects list turns into the Operators list.

3. Double-click the Greater than operator.
The Operators list turns into the Operands list.

If you want Then use

to use conditions defined by the 
universe designer using DESIGNER 
that you can apply to a query, but 
that you cannot edit or delete from a 
universe,

predefined conditions.

to use conditions that you apply by 
selecting values from an object list 
of values and that let you limit the 
data returned only by result objects,

simple conditions.

to use conditions that let you choose 
the exact operator and operand on 
any object in the universe, 

complex conditions.
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4. Double-click the Show list of values operand.
The List of Values of Reservation Year dialog box appears.

5. Click FY96 (you only want 97 and 98), then click OK.
The Query Panel now looks like this:

6. Click Run.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
The list of customers appears in the report.
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Applying a complex condition on a query
Applying a complex condition requires three steps. First, you select the object you 
want, then the operator (e.g., greater than), then the operand (e.g., values that you 
type, or another object). The following procedure explains how to do it, and gives 
information to help you choose the operator and operand you need:

1. In the Query Panel, drag the object you want to use from the Classes and 
Objects list to the Conditions box.
The Classes and Objects list turns into the Operators list:

The following table helps you to select the operator you need:

To obtain data that... For example... Double-click...

Is equal to one given value A particular Year Equal to

Is different from one given 
value

Countries not including 
France

Different from

Is greater than a given 
value

Revenue over $100,000 Greater than

Is greater than or equal to 
a given value

Customers who are 60 or 
over

Greater than or 
equal to
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Is lower than a given 
value

Revenue under $100,000 Less than

Is lower than or equal to a 
given value

Customers who are 60 or 
under

Less than or equal 
to

Falls between two given 
values

Weeks between 25 and 36 Between

Falls outside two given 
values

All the weeks of the year 
excluding weeks 25 to 36

Not between

Is the same as any of a list 
of values

Revenues from only two 
resorts

In list

Is different from given 
values

Non-European customers Not in list

Contains empty rows Customers who have not 
paid (i.e., without invoice 
dates) 

Is null

Does not contain empty 
rows

Customers who have paid 
(i.e., their invoice dates 
are in the database)

Is not null

All contains the same 
letter or letters

Customers whose names 
begin with the letters S

Matches pattern

Does not contain a given 
letter or pattern of letters

Customers whose names 
do not begin with S

Different from 
pattern

Satisfies two conditions 
on one object

Customers who settled an 
invoice in June and in July

Both

Excludes a given value Customers who stayed at 
resorts other than French 
Riviera

Except

To obtain data that... For example... Double-click...
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2. Double-click the operator you want to use.
The Operators list turns into the Operands list:

The operands in the list depend on the operator you selected.

3. Double-click the operand you want.
The following table helps you select the operand you need and tells you what 
to do next:

If you want to compare the 
condition object with...

Double-click... Then...

Values that you type Type a new 
constant

Type the values with a 
separator (comma, semi-
colon, etc.) between each one. 
The separator to use is 
defined in the Windows 
Control Panel (Regional 
Settings).

Values that you select 
from the object’s list of 
values

Show list of 
values

1. Hold down the Ctrl key.

2. Click the value(s) you 
want, then click OK.
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Tips for applying complex conditions
This section provides some tips on getting the most out of BUSINESSOBJECTS 
complex conditions.

Using wildcard characters
Conditions with the Match pattern and Different from pattern operators are great 
for finding lists of similar values, such as customer names beginning with S.

Values that you will select 
when you run the query

Type a new 
prompt

1. Type your question.

2. Press the Enter key.

- or -

Show list of 
prompts

Select a prompt from the 
dialog box that appears.

Another object (which can 
be a user object)

Select an object Double-click the object in the 
Classes and Objects box.

Any value returned by 
another query

Create a 
subquery (ANY)

Build a query in the new 
query tab that appears. 
For more information, refer 
to “Applying a condition 
with a subquery” on 
page 103.

All values returned by 
another query

Create a 
subquery (ALL)

The result of a calculation 
(sum, minimum, 
maximum, average or 
count)

Calculation Follow the screens of the 
wizard that appears. 
For more information, refer 
to “Applying a condition 
with a calculation” on 
page 100.

If you want to compare the 
condition object with...

Double-click... Then...
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Wildcards are special characters that can denote any single character, or any 
number of characters. BUSINESSOBJECTS supports the standard wildcard 
characters, which are:

Using In list
The In list operator lets you select multiple values for a document. These multiple 
values can be a condition on a query that you want to build or can be the basis for 
an interactive document in which other users are prompted to select values from 
the list you created to view data limited to their needs. 

You type your list of values in the text field of the Enter or Select Values dialog 
box or if you click Values in this dialog box you can select them from a list. When 
you type in your values, separate each value with the setting defined in your 
Windows Regional Options.  

Note: A semicolon is used when it's associated with a prompt.

The maximum number of values allowed in a list depends on restrictions in the 
target DBMS or on the length of the SQL statement generated by BusinessObjects. 
(BusinessObjects can generate SQL of up to 65,536 characters.)

Using Different from, Not in list and Except
Different from, Not in list and Except are all operators that exclude certain data 
from your query results. For example, you could use this condition

to obtain a list of customers who have not stayed at Bahamas Beach.

However, when you use Different from or Not in list, you might still get the values 
you don’t want. The condition illustrated above would not exclude customers 
who had stayed at Bahamas Beach if these customers had also stayed at other 
resorts. However, if you used Except, the query would exclude all Bahamas Beach 
customers, whether they had stayed at other resorts or not.

Note also that:

Wildcard Description

% Replaces several characters, or in the response to a prompt. 
For example, N% returns all values beginning with an N 
(New York, Nevada, etc.)

_ Replaces a single character in a constant. For example, 
GR_VE returns Grave, Grove, Greve, etc.
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• You can only specify one value with Different from, but multiple values with 
Not in list.

• You can only specify one value with Except. However, you can build 
combined queries using MINUS to exclude, for example, Bahamas Beach 
customers and 1996 customers.

For more information, refer to “Building Combined Queries” on page 111.

Editing complex conditions
You can edit a complex condition by changing its object, operator and/or 
operand. Here’s how to do it:

1. In the Conditions box of the Query Panel, click the part of the condition that 
you want to change.

2. Depending on the element you clicked, select a different element in either the 
Classes and Objects list, or the Operators list, or the Operands list.

Note: If you use a different operator, you may also have to use a different 
operand.

Deleting complex conditions

1. Right-click the condition’s icon in the Conditions box.

2. Select the Delete command on the pop-up menu:

Applying a condition with a calculation
BUSINESSOBJECTS lets you limit query results with calculations in complex 
conditions. This type of condition is useful in answering questions such as 
“Which products generated above average revenue?” at the query level.

You apply a condition with a calculation by using the Calculation operand. 
BUSINESSOBJECTS then displays a wizard which guides you through the steps 
required to make the calculation. 
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To apply a condition with a calculation
Use the following procedure to apply a condition with a calculation. There’s an 
example on page 102.

1. In the Query Panel, move an object to the Conditions box.
The Classes and Objects box becomes the Operators box.

2. Double-click Equal to.
The Operators box becomes the Operands box.

3. Double-click Calculation.
The Complex Calculation wizard appears. The first screen asks you to select a 
calculation object. 

4. Open the folder containing the object, click on the object, then click Begin. 
The next screen asks you to select a function to apply on the object.

5. Select the function from the list, then click Next. 
The next screen asks you to define the level of calculation.

6. Select a level of calculation.

The next screen asks you to choose between making an independent 
calculation and comparing the result of the calculation with the values of one 
or more objects.

If Then

you want to obtain a single result 
row,

click Globally, then click Next.

you want to obtain several result 
rows,

click By one or more objects, select 
the objects from the list, then 
click Next.
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7. Select how you want to synchronize your calculation.

The next screen asks you to set the number of values to compare.

8. Select whether you want to compare the object with at least one value or with 
all values.

The Query Panel reappears with the query defined with a condition on a 
calculation.

9. Click Run.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example When did each customer last pay for a product?

You want to find out the date of each customer’s last invoice so that you can 
contact those customers who have not been buying your products. To obtain this 
data, you need to apply a complex condition with a calculation. The calculation 
compares the invoice dates for each customer, then returns only the last date. 
Here’s how to do it:

1. Insert the Customer and Invoice Date objects in a query on the Island Resorts 
Marketing universe.

2. Drag the Invoice Date object to the Conditions box.

3. Double-click the Equal to operator.

If Then

you want to make a calculation 
independently of your objects, 

click Independently of your objects, 
then click Next.

you want to make a calculation for 
each value of one or more of your 
objects, which allows you to limit 
the calculation to particular objects, 

click For each value of one or more 
objects, select the objects from the 
list, then click Next.

If Then

you want to compare the object with 
at least one value, which allows you 
to limit the values compared with 
the object,

click At least one value, then click 
Finish.

you want to compare the object with 
all values,

click All values, then click Finish.
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4. Double-click the Calculation operand.
The Complex Condition Wizard appears:

5. Open the Sales class, click the Invoice Date object, then click Begin.

6. Click Maximum (you want the last invoice date), then click Next.

7. In the next dialog box, click Globally, then click Next.

8. In the next dialog box, click For the value of one or more objects, then Customer.
This option forces the calculation to return the last invoice date per customer.

9. Click Next, click Next again, then, in the Query Panel, click Run.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
One invoice date per customer appears in the report.

Applying a condition with a subquery
A subquery is a query within a query. It returns a single column of data which is 
compared with the data retrieved by the main query. You use subqueries for 
situations such as finding a single individual in a list of individuals who meet the 
conditions of the query. For example, of all customers who made reservations, 
what is the name and address of the customer who made the first reservation? 
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Complex conditions on queries consist of three elements: an object, an operator 
and an operand. Conditions that include the Create a subquery (ALL) operand, or 
the Create a subquery (ANY) operand, generate a subquery. The operator (e.g., 
greater than, less than etc.) you include in the condition determines whether the 
data returned by the subquery is, for example, excluded from the main query 
result.

The operands that generate a subquery are described here:

To apply a condition with a subquery
Here’s how to apply a condition with a subquery. An example follows on page 
102.

1. In the Query Panel, drag an object from the Classes and Objects box and drop 
it in the Conditions box.

2. Double-click the operator you want to use.
• Some operators (e.g., Both, Between, Match pattern) cannot be used with 

subqueries.
• For information on which operator to choose, refer to the table on page 95.

3. Double-click the Create a subquery (ALL) operand or the Create a subquery 
(ANY) operand.
A tab is created for the subquery (Subquery 1.1).

4. In the Subquery 1.1 tab, insert an object in the Result Objects box.
Note that you can only include one result object in the subquery.

5. If necessary, apply a condition on the subquery.

6. Click Run.

This 
operand...

Compares... And answers questions such as...

Create a 
subquery 
(ALL)

All the values returned by 
the subquery with the values 
returned by the main query

Which customers have not 
bought my latest product?

Create a 
subquery 
(ANY)

Any values returned by the 
subquery with the values 
returned by the main query

Which products generated 
above average revenue?
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Note: The subquery's tab always appears to the right of the main query. A 
number appears in the tab, (Subquery n.n). The number is automatically 
incremented to show you the relationship between a query and its subquery or 
subqueries.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Which customer made the earliest reservation?

You want to offer a bottle of champagne to the customer who made the earliest 
reservation. To obtain the name and address of this customer:

1. Insert the Customer object and the Address object in a query on the Island 
Resorts Marketing universe.

2. Drag the Reservation Date object to the Conditions box.

3. Double-click the Less than or equal to operator.

4. Double-click the Create a subquery (ALL) operand.
The Subquery 1.1 tab now appears in the Query Panel.

5. In the Subquery 1.1 tab, insert the Reservation Date object in the Result Objects 
box.
The Query Panel now looks like this:
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6. Click Run.
The name and address of the customer who made the earliest reservation 
appears in the report:

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Deleting a subquery
A subquery is generated by a condition containing the Create a subquery (ALL) 
operand or the Create a subquery (ANY) operand. Therefore, you delete a subquery 
by deleting the condition in the main query.

To delete the condition:

1. Right-click the condition’s icon in the Conditions box.

2. Select the Delete command on the popup menu that appears:
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Applying Groups of Conditions

You use conditions to limit the data retrieved by queries. A group of conditions 
consists of two or more conditions (predefined, simple or complex) applied on 
the same query.

You use groups of conditions when a single condition does not enable you to 
obtain the data that you need.

Organizing groups of conditions
A group of conditions consists of two or more conditions applied on the same 
query. In the Conditions box in the Query Panel, conditions are linked by an 
operator (AND or OR).

In a group that contains only two conditions, you double-click the operator to 
change it from AND to OR, or vice versa. When you double-click the operator in 
a group that contains at least three conditions, you create an indentation in the 
group, as illustrated here:

In groups that contain three or more conditions, you can also:

• Create indentations without replacing the operator, by dragging the operator 
horizontally. 

• Move conditions within the group.

• Delete a condition from a group.

The following table explains how to organize groups of conditions in different 
ways:

To... Do this...

Change a group's operator from AND 
to OR and vice versa

• Double-click the AND or OR 
operator.

Indent or outdent conditions within a 
group of conditions

1. Click the AND or OR operator 
with your right-mouse button.

2. On the pop-up menu that appears, 
click Shift right or Shift left.
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AND and OR
In the Conditions box in the Query Panel, multiple conditions are automatically 
linked by an operator:

• AND specifies a result that is true for both conditions.

For example, the following group of predefined conditions on a query 
containing the Customer object specifies customers who stayed at Bahamas 
Beach in 1995:

• OR specifies a result that is true for either the first or the second condition.

For example, the following group of predefined conditions on a query 
containing the Customer object specifies any customers from 1995 and any 
customers who stayed at Bahamas Beach:

You can replace AND with OR, and vice versa, by double-clicking it. When you 
apply three or more conditions on a query, double-clicking the operator creates 
an indentation in the group of conditions.

Tip: Avoid groups of conditions such as Year Equal to 1994 AND Year Equal to 1995. 
This example would return no data, because Year cannot be equal to two different 
values in SQL. To obtain, for example, the list of customers from both 1994 and 
1995, you would have to build a combined query using the INTERSECT operator. 
For information on combined queries and how to build them, refer to “Building 
Combined Queries” on page 111.

Move a condition from one group to 
another

1. Click the condition and hold 
down your mouse button.

2. Drag the condition to another 
group of conditions, then release 
your mouse button.

To... Do this...
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To apply groups of conditions

1. In the Query Panel, apply a condition (predefined, simple or complex).

2. Apply a second condition.
The conditions are automatically linked by the AND operator.

3. Apply more conditions if necessary.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Which customers bought a given product in a given timeframe?

You need the list of customers who stayed at the Bahamas Beach resort in 1994 or 
1995. This requires two conditions: Resort=Bahamas Beach and Year Inlist 
1994,1995. Here’s how to do it:

1. Include the Customer object in a query on the Island Resorts Marketing 
universe.

2. Click the Predefined Conditions radio button below the Classes and Objects 
box.
The list of predefined conditions in the universe appears.

3. Click the + sign to the left of the Resort class, and double-click Bahamas resort.

4. Click the + sign to the left of the Sales class, then double-click Year 1994.

5. Double-click Year 1995. 
The conditions are linked by an AND operator.

6. Double-click the AND that links Year 94 with Year 95. 
AND changes to OR, and the group of conditions is indented, as illustrated 
here:

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
7. Click Run.

Predefined
Conditions
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Deleting groups of conditions

1. Click the operator (AND or OR) that links the group of conditions that you 
want to delete.

2. Click your right-mouse button.

3. On the pop-up menu that appears, click Delete.
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Building Combined Queries

BUSINESSOBJECTS lets you combine the data returned by up to eight queries as one 
set of results. These combined queries enable you to:

• Obtain a single column of data from multiple objects.

• Obtain data common to two sets of results, such as customers from a given 
region and a given age group.

• Exclude the results of one query from the results of another.

Note: Building combined queries allows you to combine or exclude data from the 
query result by using operators to combine the results of multiple queries. You 
can contrast this with using the In list and Not in list operators when you apply 
a complex condition on a query. The In list and Not in list operators include or 
exclude data from a query result based on a list of values that you enter. 

Building a combined query
Here’s how to build a combined query:

1. In the Query Panel, build a query.

2. Click the Combine Queries button on the Query Panel toolbar.
• The existing query appears in the Query 1 tab.

Combine Queries
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• A second tab, Query 2, also appears and is now active:
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3. If you want to use a different operator, click the Query 2 tab with your right-
mouse button, then click the operator you want on the pop-up menu that 
appears:

 The following table describes which operator to use for the result you want.

Use... To...

UNION Combine the data from two objects in a single column in the 
report.
UNION is especially useful for working with incompatible 
objects. For example, you need to find out the dates on which 
your customers made reservations or paid their invoices. This 
query requires two incompatible objects: Invoice Date and 
Reservation Date. If you include these objects in a regular 
query, BUSINESSOBJECTS returns two blocks of data. By 
building a combined query with UNION, with Invoice Date in 
one tab and Reservation Date in the other, the data appears in 
one column in the report.
UNION is the default operator.
The symbol for the UNION operator is shown here:

INTERSECT Obtain data common to two sets of results, such as customers 
from a given region and a given age group.
The example, “Which customers bought a given product in a 
given timeframe?” on page 109, illustrates the use of 
INTERSECT.
The symbol for the INTERSECT operator is shown here:
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4. Build the rest of the query in the Query 2 tab.

5. If necessary, repeat the above steps to include more queries.
You can include up to eight queries in a combined query.

6. Click Run.
The data from the combined query appears in the report.

Tip: You can delete one of the queries you have combined by clicking its tab with 
your right-mouse button, then by clicking the Delete command on the pop-up 
menu that appears.

Restrictions on combined queries
It’s worth knowing that:

• Queries that you combine must contain the same number of objects in order 
to return the same number of columns of data.

• When you build a combined query to return data from more than one object 
in one column, i.e., using the UNION operator, you must use objects of the 
same type (character, date or number).

• You can include up to eight queries in a combined query.

MINUS Exclude the results of one query from the main query result. 
For example, you can use MINUS to find out which customers 
bought product A but not product B. You cannot obtain this 
data with a condition such as Product different from B, because 
the condition would include customers who bought A and B.
The symbol for the MINUS operator is shown here:

Use... To...
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To illustrate how you can benefit from combined queries, the following example 
explains how to obtain data common to two sets of results.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Which customers bought products in both 1994 and 1995?

Finding customers who match two criteria is a common business goal. You 
cannot obtain the list of paying customers from two years by

• Applying a complex condition with the In list operator; in this case, you would 
obtain customers from either 1994 or 1995, or possibly both.

• Two conditions (Year equal to 1994 and Year equal to 1995) because in SQL, 
Equal to can only be used for one value.

The trick is to build a combined query which returns the intersection of customers 
from 1994 and 1995. Here’s how to do it:

1. Include the Customer object in a query on the Island Resorts Marketing universe.

2. Drag the Year object to the Conditions box.

3. Double-click Equal to, then Type a new constant, then type 1994.

4. Press Enter, then click the Combine Queries button on the Query Panel 
toolbar.
• The existing query appears in the Query 1 tab.
• A second tab, Query 2, also appears and is now active.
• Customer is already a result object in Query 2.

5. In the Query 2 tab, drag the Year object to the Conditions box.

6. Double-click Equal to, then Type a new constant, then type 1995.

7. Press Enter, then click the Query 2 tab with your right-mouse button.
The operators you can use to combine the queries appear on a pop-up menu:

8. Click Intersect.
The INTERSECT symbol appears on the Query 2 tab as shown here:

9. Click Run.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
A list of customers who bought products in both years appears in the report.

Combine Queries
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Using SQL From BusinessObjects Queries

When you build a query in the Query Panel, BUSINESSOBJECTS writes the query’s 
corresponding Structured Query Language (SQL) script. If you know SQL and 
want to find out how BUSINESSOBJECTS resolves a query, you can view the SQL 
script.

You can also reuse the SQL that BUSINESSOBJECTS generates by saving it to a file. 
And because BUSINESSOBJECTS also lets you edit your queries’ SQL scripts, you 
can build complex queries in the Query Panel, change the SQL to suit your needs, 
then save the script. You can then run the saved script using another application. 
BUSINESSOBJECTS does the hard work for you!

To view, edit or save a query's SQL script:

Note: BUSINESSOBJECTS may have created a complex SQL script to resolve the 
query, for example if the query contains incompatible objects or certain types of 
conditions. Such SQL scripts can be split into several SELECT statements, which 
BUSINESSOBJECTS indicates as folders in the left pane of the SQL Viewer dialog 
box.

2. To edit the script, click inside it and type the changes you want.

3. Click Regenerate to go back to the SQL of the original query.

View SQL

1. Click the View SQL button on the Query Panel toolbar.
The query's SQL script appears in the SQL Viewer dialog box:

Regenerate
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4. Check Do Not Generate SQL before running if you want to keep the changes you 
have made.
• This option automatically parses the script when you click OK and ensures 

that the query SQL is not regenerated as long as the objects in the result set 
or conditions remain unmodified.

• If you do not click this option, any SQL changes you have made will be lost 
when you click OK.

5. Click Parse to check the validity of the script.

Note: If the universe designer has set the up the universe with a restrictive 
connection, BUSINESSOBJECTS prompts you to enter your database username and 
password before parsing the script. For more information on restrictive 
connections, see “Restrictive connections” on page 43.

6. Click Save to save the edited script to a file.

7. Click OK to return to the Query Panel.Save

Parse
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Overview

This chapter explains how to bring data to your BUSINESSOBJECTS reports by using 
stored procedures, free-hand SQL, personal data files and Visual Basic for 
Applications (VBA) procedures.

Note: Using BUSINESSOBJECTS, you can also access data in OLAP databases and 
SAP applications. Information on how to work with these is not covered in this 
guide. OLAP and SAP data providers are documented in dedicated guides that 
you receive when you purchase your OLAP or SAP Access Pack.

Setting up hierarchies for drill mode
Drill mode enables you to analyze data on different levels of detail. You perform 
analysis by navigating up, down and across hierarchies of data in a report. You 
drill down on the data to examine the details of more consolidated data. You drill 
up on data to examine totals for the underlying data. Your ability to drill on data 
requires that the data be organized into hierarchies. 

You can have BUSINESSOBJECTS automatically build hierarchies from the 
dimensions returned by stored procedures, free-hand SQL, personal data files 
and VBA procedures.

Note: You can only work in drill mode if you have installed the EXPLORER option 
with BUSINESSOBJECTS.

When you use queries on universes to retrieve data for your reports, you can 
build hierarchies with the Scope of Analysis feature. 

You can also build hierarchies when you use stored procedures, free-hand SQL, 
personal data files and VBA procedures. Each of these data providers lets you use 
the Build Hierarchies and Start in Drill Mode option. You learn how to use this 
option in the following sections.

Some points worth knowing about the hierarchies BUSINESSOBJECTS builds from 
stored procedures, free-hand SQL, personal data files and VBA procedures:

• You can edit the hierarchies and build new ones inside the report. You can 
even change the qualification of the data returned, for example to change a 
detail object into a dimension so that you can include it in your hierarchy.
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• BUSINESSOBJECTS can automatically create hierarchies if the dimensions 
returned have a logical structure (Year, Quarter, Month, for example). 

• The name given to a hierarchy is also the name of the first dimension it 
contains.
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Using Stored Procedures

This section introduces stored procedures, and explains how to use them to bring 
data to your BUSINESSOBJECTS reports.

What are stored procedures?
Stored procedures are sets of SQL statements that are saved as executable files in 
a database. The database administrator is often the person who creates stored 
procedures at your site, but all database users who know SQL and who have 
access to the database can create stored procedures. Once created, stored 
procedures are made available to end users.

How can you use stored procedures in BusinessObjects?
In BUSINESSOBJECTS, stored procedures are data providers that retrieve data for 
reports, in the same way that a queries on universes do. In the New Report 
Wizard, you select the stored procedure you want to use. You can then enter 
parameters to specify the data that you want the stored procedure to retrieve. 
You can keep these parameters for the next time the stored procedure is run.

Tip: You can create and edit stored procedures in free-hand SQL in 
BUSINESSOBJECTS.

Restrictions on stored procedures
• The BUSINESSOBJECTS supervisor grants access to the database or account 

where stored procedures are located.

• BUSINESSOBJECTS supports stored procedures for certain databases only. 
Consult the Database Guide for the RDBMS you work with, to find out if it 
supports stored procedures.

• Stored procedures may contain the COMPUTE, PRINT, OUTPUT and 
STATUS statements. These statements will not be executed in 
BUSINESSOBJECTS.
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Using a stored procedure to bring data to a report
Here’s how to use a stored procedure to bring data to a report:

1. Click the New Report Wizard button on the Standard toolbar.
The New Report Wizard appears.

2. Select an option for the report layout, then click Next.
The Specify Data Access dialog box appears.

3. Click Others, then click Stored procedures:

New Report Wizard
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4. Click Next, then select a connection:

5. Click Next, then select a stored procedure:
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6. Click Finish.
The Stored Procedure Editor appears:

7. Click the first parameter in the Parameters column, then type a value in the 
Value box.

8. Select an option in the Next Execution list box:
• Use this value means that the value you entered will be used the next time 

you run this stored procedure.
• Prompt me for a value means that you will be prompted to enter a different 

value the next time that you run this stored procedure. A dialog box will 
appear, where you enter the different value.

9. Check Build Hierarchies and Start in Drill Mode if you want to perform drill 
down analysis as soon as the data appears in the report.

10. Click Run.
The data from the stored procedure appears in the report.



 Using Stored Procedures

  BusinessObjects User’s Guide   127

Changing a stored procedure's parameters
To work with different data in a report you created by using a stored procedure, 
all you have to do is change the stored procedure’s parameters, then run the 
stored procedure. Here’s how to do it:

1. Open the report containing data from the stored procedure.

2. Select the Edit Data Provider command on the Data menu.
• If the List of Data Providers dialog box appears, click the stored procedure 

you want to edit, then click OK.
• The Stored Procedure Editor appears:

3. Click the first parameter in the Parameters column.

4. In the Value box, type the new value for this parameter.

5. In the Next Execution list box, select Use this value or Prompt me for a value.
• Use this value means that the value you entered will be used the next time 

you run this stored procedure.
• Prompt me for a value means that you will be prompted to enter a different 

value the next time that you run this stored procedure. A dialog box will 
appear, where you enter the different value.

6. Click Run.
The different data set appears in the report.
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Using Free-Hand SQL

Free-hand SQL is a type of data provider that enables you to work with SQL 
scripts in BUSINESSOBJECTS. You can open and run existing SQL scripts; users who 
know SQL can write their own scripts.

With free-hand SQL, you can use the different types of SQL orders supported by 
the database at your site: pre-defined queries, stored procedures, PL/SQL and 
Transact SQL. 

You can also use free-hand SQL to make changes to the database, if the 
BUSINESSOBJECTS supervisor has granted you the right to do so.

Creating a report using free-hand SQL
When you create a report using free-hand SQL, you can:

• Write a new script or open an existing one, including SQL generated by 
BUSINESSOBJECTS queries in the Query Panel.

• In the SQL script, you can define lists of values and prompts.

• Create a new connection to the database or use an existing one.

• View raw data before it appears in the report, which lets you check that you’re 
getting the result you want.

• Parse the script for SQL errors, and save any changes you make to a file.

To create a report using free-hand SQL:

1. Click the New Report Wizard button on the Standard toolbar.
The New Report Wizard appears.

2. Select an option for the report layout, then click Next.
The Specify Data Access dialog box appears.

New Report Wizard
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3. Under Others, click Free-hand SQL, then click Finish:

The Free-hand SQL editor appears:

4. The next step depends on what you want to do:

If you want to... First... Then...

Write a new SQL script Type the script. Go to the next step.
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5. Click the Parse button to check the script for SQL errors.

Note: COMPUTE statements in free-hand SQL scripts will not be executed.

ORDER BY statements in free-hand SQL scripts are not executed. In order to 
apply a sort on a query, you need to order the columns in the SQL statement. You 
can also arrange the column order in reports.

6. To make a connection to the database:
• Select a connection in the Connection list box, or
• Click the Create a new connection button. 

For the steps to follow, refer to “Creating or editing a connection for free-
hand SQL” on page 131 below.

7. Check Build Hierarchies and Start in Drill Mode if you want to perform drill 
down analysis as soon as the data appears in the report.

8. Click Run.
The data from the SQL script appears in the report.

Editing a free-hand SQL script
To get different results from a free-hand SQL script that you’ve already run, all 
you have to do is edit the script then rerun it. Here’s how to do it:

1. Open a report containing data from a free-hand SQL script, then select the Edit 
Data Provider command on the Data menu.
• If the List of Data Providers dialog box appears, click the script you want 

to edit, then click OK.
• The SQL script appears in the Free-Hand SQL editor.

Open an existing script In the Free-Hand SQL 
editor, click Open:

Use the dialog box that 
appears to locate the 
SQL script file.

If you want to... First... Then...

Parse

Create a new
connection
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2. Make the necessary changes to the script. As you work, you can:
• Click Parse to check the script for SQL errors.
• Click View to see the raw data the script retrieves.
• Click Save to keep the changes you make.

3. Click Run.
BUSINESSOBJECTS retrieves the new data and displays it in the report.

Tip: You can also get different data by running an existing free-hand SQL script 
on a different database connection. To do this, select a different connection box in 
the Free-Hand SQL editor. Refer to “Creating or editing a connection for free-
hand SQL” below for more information.

Creating or editing a connection for free-hand SQL
To get data by using free-hand SQL, you need to define a connection to your 
database in BUSINESSOBJECTS. This is not the case when you run queries on 
universes, as the connection required is delivered with the universe.

Working in the Free-Hand SQL editor
You create and edit connections for free-hand SQL in the free-hand SQL editor. 
You work in the editor in the following ways:

• When you create a new report using the New Report Wizard

• When you insert a new table, crosstab or chart in an existing report by running 
a free-hand SQL script (Table/Crosstab/Chart commands, Insert menu), or

• When you edit a free-hand SQL script by selecting the Edit Data Provider 
command on the Data menu.

Once inside the Free-Hand SQL editor, you’re ready to create or edit a 
connection. 

To create a connection

1. In the Free-Hand SQL editor, click the Create a new connection button.
The Add a Connection dialog box appears.

Parse

Save

Create a new
connection
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2. Click the network layer for the connection, then click OK:

The dialog box that appears depends on the network layer you selected.

3. Type a name in the Name box, and select the RDBMS to use in the Database 
Engine list box.

4. Enter the connection parameters in the Login Parameters box.
These parameters are specific to the database you are going to connect to. 
Database-specific information is provided in the online help, which you can 
access by clicking the Help button in the dialog box.

5. In the Type list box, select Personal or Shared.
• Personal means only you can use the connection.
• Shared means that you can share the connection with other users.

6. Click the Advanced tab to enter further parameters for the connection.

7. Click Test to check that the connection is correctly defined, then click OK.

To edit an existing connection

1. In the Free-Hand SQL editor, select the connection in the Connection list box, 
then click the Edit connection button.
The dialog box that appears lets you change the parameters for the 
connection. The dialog box title depends on the driver and the database you’re 
using.

2. Make the necessary changes, for example change the data source, or select 
different options in the Advanced tab.

Edit connection 
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3. Click Test, then click OK.
You can now:
• Click Run to run a script against the connection.
• Click View to get the raw data the new connection retrieves for the current 

script, which can be useful if you’ve changed data source.
• Click Cancel to save the connection for later use.

Customizing free-hand SQL scripts
Free-hand SQL lets you run new or existing SQL scripts to retrieve data for your 
reports. You can customize scripts so that they prompt users to filter the data 
retrieved by selecting values from lists of values.

Creating a prompt with a list of values for a free-hand SQL script
A prompt is a question that incites users to select values when they run queries. 
In this way, users filter the query to get the data that’s pertinent to them.

On top of that, a prompt can call a list of values which enables users to select 
values rather than typing them in a text field. The list of values shows users 
exactly what values they can work with, and prevents them from typing data 
incorrectly.

In free-hand SQL, you can add a prompt and a list of values to a SQL script. This 
section provides:

• The syntax required for creating a prompt with a list of values.

• A step-by-step procedure.

• An example.

Syntax for prompts and lists of values in free-hand SQL
The SQL that creates the prompt and the list of values must appear in the WHERE 
clause. The syntax is as follows:

@prompt('prompt','data type',{'value','value', etc.},mono/
multi,free/constrained)
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The following table describes each argument. Below the table you will find a 
sample script containing a prompt that calls a list of values.

Argument Description Default

@prompt The function that enables you to create the 
prompt for the free-hand SQL script.
This function can take up to five arguments. The 
only mandatory argument is 'prompt'. If this is 
the only argument, the syntax is as follows:
@prompt('Which year?',,,,)

In this case, BUSINESSOBJECTS uses default values 
for the other arguments.

The above syntax can be replaced by
@variable('Which year?')

N/A

prompt Text that appears when you run the SQL script. 
The prompt appears in a dialog box and incites 
the user to enter pertinent values such as years or 
customer names. 
This argument takes a character string inside 
single quotes ('), for example
‘Which customer?’

None

data type Refers to the type of data that the list of values 
returns (character, number or date). This 
argument takes a character: 
• A for character type,
• N for numbers and 
• D for dates.

This argument is optional.

A

value, value 
etc.

Indicates the list of values that will be called 
when you run the script. This argument takes up 
to a maximum of 256 character strings inside 
single quotes ('), for example
‘Chicago’,’New York’,’San Francisco’

This argument is optional. If you do not use it, no 
list of values is available and you will have to 
enter values manually when you run the scripts. 

None
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Here’s an example of a free-hand SQL script which prompts users to select a 
value from a list.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Prompting users to select a year when they run a free-hand SQL script

The following free-hand SQL script prompts the user to select one year (1996, 
1997 or 1998) from the list of values. How?

• The mono argument restricts the selection to one value.

• The constrained argument forces users to select the value from the list.

Note: This script will work with a Microsoft Access database.

mono/multi Specifies whether or not users have the right to 
select more than one value from the list of values. 
This argument takes one of the following 
parameters:
• mono, which does not allow multiple 

selection.
• multi, which allows multiple selection.

mono

free/ 
constrained

Specifies whether or not users have the right to 
enter values manually. This argument takes one 
of the following parameters:
• free, which lets users enter values manually. 
• constrained, which forces users to select 

values from the list of values.

free

Argument Description Default
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Here’s the script:
SELECT

Customer.last_name,

Service.Service,

Reservations.res_date

FROM

Customer,

Service,

Reservations,

Reservation_Line

WHERE

( Customer.cust_id=Reservations.cust_id  )

AND  ( Reservation_Line.res_id=Reservations.res_id  ) 

AND  ( Reservation_Line.service_id=Service.service_id  )

AND  (Format(Reservations.res_date,'YYYY') = @prompt('Which 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Year?','A',{'1996','1997','1998'},mono,constrained))

To create a prompt with a list of values in a free-hand SQL script

1. Display the SQL script in the Free-Hand SQL editor, either by creating a new 
report or by selecting the Edit Data Provider command on the Data menu in a 
report that was created using free-hand SQL.

2. In the WHERE clause, after the table.column statement for which you want to 
create a prompt with a list of values, type the prompt. Refer to “Syntax for 
prompts and lists of values in free-hand SQL” on page 133 if necessary.

3. Click Run.
The prompt appears in a dialog box.

4. Type or select the value(s) you need, then click OK.
The data appears in the report.
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Using Personal Data Files

Personal data files are a type of data provider that enables access to data in 
Microsoft Excel spreadsheets, dBASE files, and text files.

What are the benefits of using personal data files?
The main benefits of using personal data files are as follows:

• You can display corporate data next to personal data in the same report.

For example, you can compare your company's budget (corporate data) with 
your own running costs (personal data). You can obtain such a report by 
building a query to retrieve the corporate data, then by inserting a new table 
that displays data from a personal data file. 

• If you have no connection to a remote database or if there is no RDBMS at your 
site, you can use personal data files as your only data source. 

• You can use BUSINESSOBJECTS reporting and analysis features to work on data 
that comes from other applications.

Creating a report using a personal data file
Creating a report from a personal data file is a two-stage procedure:

• First, you specify the personal data file that you want to use for the report. 
This is described under “Selecting the personal data file for the report”, below.

• Second, you set options that depend on the type of file you selected in the first 
stage. For example, the options to set for a spreadsheet are different from 
those for a text file. This is described under “Setting options for a personal 
data file” on page 140.

Selecting the personal data file for the report
Here’s how to use the New Report Wizard to get to the personal data file 
containing the data you need:

1. Click the New Report Wizard button on the Standard toolbar.
The New Report Wizard appears.

2. Select an option for the report layout, then click Next.
The Specify Data Access dialog box appears.

New Report Wizard
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3. Under Others, click Personal data file, then click Finish:

The Access Personal Data dialog box appears:
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4. Click Browse to locate the file that contains the data you want.
• The Open a File to Access Personal Data dialog box appears.
• When you have located the file and closed the dialog box, the path to the 

file appears in the Name field of the Access Personal Data dialog box.
• The Format field displays the format of the file you selected.
• The options in the dialog box are now specific to the file type you’re 

working with.
• If you’ve selected a dBASE file, no further options are available so just click 

Run.

Note: BUSINESSOBJECTS supports Microsoft Excel 97 files. When using this type of 
file, you must make sure that the Format field displays Microsoft Excel 97 Files 
(*.xls):

If you’re using a Microsoft Excel 95 workbook, select Microsoft Excel Files (*.xls) in 
the Format field.

5. Set the options you want (refer to “Setting options for a personal data file” on 
page 140 for more information).

6. Check Build Hierarchies and Start in Drill Mode if you want to perform drill 
down analysis as soon as the data appears in the report.

7. Click Run.
The data from the personal data file appears in the report.
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Setting options for a personal data file
In the Access Personal Data dialog box, BUSINESSOBJECTS displays options that 
are relevant to the format of the file you have selected. Other options are available 
irrespective of the file format. The table below describes each option in detail.

File format Options available Description

All Files (*.*) First Row Contains 
Column Names

The first row of data in the file 
appears as column headings 
in the BUSINESSOBJECTS report.

This option is not available for 
dBASE files.

Build Hierarchies and 
Start in Drill Mode

Creates hierarchies that you 
will use in the report to 
analyze data in drill mode. 
BUSINESSOBJECTS can create 
hierarchies automatically 
only if the dimensions you use 
in the personal data file have a 
logical structure (Year, 
Quarter, Month for example). 
When the report appears, drill 
mode is active, and you can 
immediately begin analyzing 
data.

Text Files (.asc; .prn; 
.txt; .csv)

Delimiter

• Tabulation
• Space
• Character

Lets you indicate the way the 
data is delimited in the text 
file. The default settings per 
file type are as follows:

• | (.asc)
• space (.prn)
• tabulation (.txt)
• semi-colon (.csv)
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Microsoft Excel (.xls) 

Microsoft Excel 97 
(.xls)

Sheet Name Lists the worksheets from the 
file you selected, and lets you 
select the worksheet 
containing the data you want.

Field Selection Lets you specify fields of data 
in the worksheet.

• All Fields Retrieves all the data from the 
worksheet.

• Range Definition Retrieves the data from the 
range of cells you indicate 
(e.g., A1:Z20 for Microsoft 
Excel.)

• Range Name Retrieves the data from a 
range defined in the 
worksheet.

dBASE No dBASE-specific options are available

File format Options available Description
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Using Visual Basic for Applications Procedures

A VBA data provider is a powerful and flexible tool accessing external data. Very 
often you will want to access automation servers through VBA to retrieve their 
proprietary data. VBA allows you to retrieve data from various sources: ADO, 
DAO, RDO, Application Object Models, EDK, low-level APIs, etc.

To create a VBA data provider, you write a VBA procedure which takes the 
interface DpVBAInterface as a parameter. You can write this procedure from 
within the VBA environment of BUSINESSOBJECTS. DpVBAInterface is the 
interface to the VBA data provider Automation object which is described in detail 
in the BusinessObjects SDK Reference Guide.

The procedure for writing a VBA data provider is:

1. Create a connection to the data source.

2. Create a data cube.

3. Set the data cube dimensions.

4. Populate the cube with data from the data source.

Once the data cube is populated, you can generate a report based on this data in 
BUSINESSOBJECTS.

Creating a report using a VBA data provider
To create a report using a VBA data provider:

1. Click the New Report Wizard button on the Standard toolbar.
The New Report Wizard appears.

New Report Wizard
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2. Select an option for the report layout, then click Next.
The Specify Data Access dialog box appears.

3. Under Others, click Visual Basic procedures, then click Finish.
The Access Data From VBA dialog box appears:

Selected 
subroutine

Available 
subroutines

Subroutines
available in:

Edit 
subroutine
Create new 
subroutine
Delete selected 
subroutine
Add a description 
for the selected 
subroutine

Debug 
selected 
subroutine

Run selected 
subroutine
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4. Type the name of the new VBA subroutine you wish to write and click Create. 
The Visual Basic Editor opens on the skeleton of the subroutine. The 
subroutine is always created in ThisDocument.

5. Compile the project and select Close and Return to BUSINESSOBJECTS from the 
File menu.

6. Select the subroutine in the Access Data from VBA dialog box, and click Run.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Accessing Email data using VBA

In this example we will create a BUSINESSOBJECTS report containing details of the 
last ten messages to arrive in a Microsoft Outlook Inbox.

You will need to have Microsoft Outlook 97 or a later version installed.

Referencing the Microsoft Outlook object library

To access Microsoft Outlook with VBA, you need to reference the Microsoft 
Outlook Object Library. To do this:

1. In the BUSINESSOBJECTS Visual Basic Editor, from the Tools menu, select 
References… 

2. Select Microsoft Outlook Object Library, and click OK.

This enables you to use the Microsoft Outlook programming tools in your VBA 
data provider.

Declarations

The subroutine that you create in the Access Data from VBA dialog box has a 
single argument, dpInterface. This is an interface to the VBA data provider. 
(For details of DpVBAInterface see BusinessObjects SDK Reference Guide.)

A comment is automatically added showing you where to insert your code.
Sub Outlook(dpInterface As DpVBAInterface)

' TODO: Add VBA Data Provider code here.

' For information, refer to DpVBAInterface online help.

End Sub

The following variables are then declared:
Dim olkApp As Outlook.Application

Dim nspNameSpace As NameSpace

Dim objInboxFolder As Object

Dim objMail As Object
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Accessing the Inbox

The class olkApp is initialized as follows:
Set olkApp = CreateObject("Outlook.Application")

Then nspNameSpace is set to point to the Messaging API:
Set nspNameSpace = olkApp.GetNamespace("MAPI")

The variable, objInboxFolder, is set to point to the Outlook Inbox:
Set objInboxFolder = nspNameSpace.GetDefaultFolder _

        (olFolderInbox)

Creating the data cube

The following code instantiates the cube object.
dpInterface.UserString(1) = "User String for Outlook Data _ 

Provider"

Dim oCube As DpVBACube

Set oCube = dpInterface.DpVBACubes.Item(1)

The number of columns in the data cube is set to 7, and oCol is declared as a 
column.

Dim oColumns As DpVBAColumns

Set oColumns = oCube.DpVBAColumns

oColumns.SetNbColumns (7)

Dim oCol As DpVBAColumn

Dim i As Integer

We now set about constructing each column.
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Creating the columns

First, the variable oCol is set to point to a new column. It is assigned a name, a 
type, and a qualification.

' 1st column

Set oCol = oColumns.Item(1)

oCol.Name = "From"

oCol.Type = boCharacterObject

oCol.Qualification = boDimension

Next, the first ten SenderNames of the Inbox are assigned to corresponding Items 
in oCol.

For i = 1 To 10 'objInboxFolder.Items.Count

Set objMail = objInboxFolder.Items.Item(i)

oCol.Item(i) = objMail.SenderName

Next i

This is repeated for each column:
' 2nd column

Set oCol = oColumns.Item(2)

oCol.Name = "To"

oCol.Type = boCharacterObject

oCol.Qualification = boDimension

For i = 1 To 10 'objInboxFolder.Items.Count

Set objMail = objInboxFolder.Items.Item(i)

oCol.Item(i) = objMail.To

Next i

' 3rd column

Set oCol = oColumns.Item(3)

oCol.Name = "Cc"

oCol.Type = boCharacterObject

oCol.Qualification = boDimension

For i = 1 To 10 'objInboxFolder.Items.Count

Set objMail = objInboxFolder.Items.Item(i)

oCol.Item(i) = objMail.CC

Next i



 Using Visual Basic for Applications Procedures

  BusinessObjects User’s Guide   147

' 4th column

Set oCol = oColumns.Item(4)

oCol.Name = "Subject"

oCol.Type = boCharacterObject

oCol.Qualification = boDimension

For i = 1 To 10 'objInboxFolder.Items.Count

Set objMail = objInboxFolder.Items.Item(i)

oCol.Item(i) = objMail.Subject

Next i

' 5th column

Set oCol = oColumns.Item(5)

oCol.Name = "Size"

oCol.Type = boNumericObject

oCol.Qualification = boMeasure

For i = 1 To 10 'objInboxFolder.Items.Count

Set objMail = objInboxFolder.Items.Item(i)

oCol.Item(i) = objMail.Size

Next i

' 6th column

Set oCol = oColumns.Item(6)

oCol.Name = "Created"

oCol.Type = boDateObject

oCol.Qualification = boDimension

For i = 1 To 10 'objInboxFolder.Items.Count

Set objMail = objInboxFolder.Items.Item(i)

oCol.Item(i) = objMail.CreationTime

Next i

' 7th column

Set oCol = oColumns.Item(7)

oCol.Name = "Received"

oCol.Type = boDateObject

oCol.Qualification = boDimension
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For i = 1 To 10 'objInboxFolder.Items.Count

Set objMail = objInboxFolder.Items.Item(i)

oCol.Item(i) = objMail.ReceivedTime

Next i

Finally, we perform a check to ensure all the data is present and correct. If it is 
not, the procedure is cancelled and an error message is returned:

dpInterface.CheckDataIntegrity (boCheckAll)

You should now compile this code and select Close and Return to 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
BUSINESSOBJECTS from the File menu, to create your report.
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Overview

The data you need may not all come from the same source. For example, you may 
have business objectives in a corporate database and personal data that you store 
in a spreadsheet. BUSINESSOBJECTS enables you to combine data from different 
sources in the same report.

This chapter explains

• The different data sources you can use

• How to include data from different sources in the same report

• When BUSINESSOBJECTS automatically links data from different sources, and 
when you have to make the link yourself. 
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Which Data Sources Are Available?

BUSINESSOBJECTS lets you access data from a wide range of sources. You can 
access data from

• Relational databases (RDBMS), such as ORACLE, Microsoft SQL Server, and 
Informix.

• Multidimensional (OLAP) servers such as Microsoft OLAP Services, 
ORACLE Express, and IBM DB2.

• Text files and spreadsheets.

• Packaged applications such as SAP.

• Virtually any data source using Microsoft Visual Basic for Applications (VBA) 
procedures.

Including Data from Different Sources in the Same 
Report

You access data sources in BUSINESSOBJECTS by building data providers for the 
data sources. To include data from different sources in the same report, you 
display data from different data providers. For example, if you want to display 
data from a SYBASE database and a Microsoft Excel file in the same report, you 
could retrieve the data from the SYBASE database by building a query or by 
using a stored procedure and retrieve the data from Excel by accessing a personal 
data file. BUSINESSOBJECTS supports the following types of data providers:

• Queries on universes

• Stored procedures

• Free-hand SQL

• Personal data files

• VBA procedures

• OLAP servers

• SAP 
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Which data providers can you combine in one report?
You can combine data from any BUSINESSOBJECTS-supported data provider with 
data from any other BUSINESSOBJECTS-supported data provider in a single report. 
For example, in a report that displays data from a query on a universe, you can 
build a new query on a different universe. You can also use a different type of 
data provider: a stored procedure, a free-hand SQL script, a personal data file, or 
an OLAP server. 

Using separate data providers for separate blocks in one report
You can display data from separate data providers in one block or separate blocks 
in a BUSINESSOBJECTS report. To display data from separate data providers in one 
block, you first create a separate block with the separate data provider and then 
combine data from the blocks. To create a separate block in a report using a 
separate data provider, follow this procedure.

1. Open a report.

2. Click the Table command (or the Crosstab command or the Chart command) 
on the Insert menu.
Your choice depends on the type of block you want to insert.

3. With your mouse, draw a rectangle where you want the new block to appear.
When you release the mouse button, a wizard appears. Which wizard (New 
Table, New Crosstab, or New Chart) appears depends on the command you 
clicked on the Insert menu.
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4. To use a separate data provider, click Access new data in a different way, then 
click Next. The New Table wizard with Access new data in a different way 
selected is shown in the following figure.

The Specify Data Access screen appears. The Specify Data Access screen is 
shown in the following figure.

5. Click the type of data provider you want to use, then click Finish. The editor 
for the data provider appears. 
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6. Define and run the data provider. 
BUSINESSOBJECTS can automatically link data providers. BUSINESSOBJECTS 
prompts you to link the new data provider with the existing data provider if:
• No common dimension exists between them. BUSINESSOBJECTS will 

automatically link two data providers without prompting you if both have 
a dimension with the same name, belonging to the same universe. 
BUSINESSOBJECTS will prompt you to link data providers if they both have 
a dimension named “Year,” but one data provider comes from a universe 
and the other comes from an Excel spreadsheet.

• And, the new block is in a section.
The new data appears in the new block.

Further information
For further information on linking data providers, refer to the section Linking 
Data Providers on page 158.

Displaying data from separate data providers in the same block
Once you have created a separate block in a report from a separate data provider 
and you manually or BUSINESSOBJECTS automatically has linked the data 
providers, you can display data from the separate data providers in one block. 
You can do any of the following:

If Then

you want to display data in an 
existing table or crosstab,

use the Pivot tab in the Table Format 
dialog box.

you want to display data in an 
existing chart,

use the Pivot tab in the Chart Format 
dialog box.

you want to display data in any type 
of existing block,

use the Slice and Dice Panel.
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Which variables from linked data providers can you display?
Compatibility rules determine which variables from separate data providers can 
be combined in the same block. When you cannot include a variable in a block, it 
appears dimmed and italicized as shown in the following figure.

You can use the common dimension from either data provider. Most often, you 
can use measures from both data providers in the same block.

Displaying data in an existing table or crosstab

1. Click inside the table or crosstab that you want to modify with data from 
another data provider.

2. Click the Table command or the Crosstab command on the Format menu.
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3. In the Table Format dialog box, click the Pivot tab, then click Variables.

4. In the Used Variables box, click the folder that represents where you want to 
display the data: Columns, Rows, Body.

5. In the Available Variables box, click the variable you want to add, then click 
Add.

6. Click OK.

Displaying data in an existing chart

1. Click inside the chart that you want to modify with data from another data 
provider.

2. Click the Chart command on the Format menu.

3. In the Chart Format dialog box, click the Pivot tab.

4. In the Used Variables box, click the folder that represents the axis where you 
want to display the data: Columns, Rows, Body.

5. In the Available Variables box, click the variable you want to add, then click 
Add.
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6. Click OK.
In 2-D charts, all the variables are located in the X-Axis and Y-Axis folders. In 
3-D matrix charts, the variables are located in all three folders: X-Axis, Y-Axis, 
and Z-Axis.

Adding data in slice and dice mode

1. With a report open, display the Slice and Dice Panel.
Variables for all the blocks in the report are displayed in the Available 
Variables box.

2. Drag the icon of the variable you want to add to the report from the Available 
Variables box and drop it either in the Section box or in the Block Structure 
box.

3. Repeat the previous step for other variables you want to add.

4. Click Apply.

Slice and Dice
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Linking Data Providers

Linking data providers enables data from different sources to be computed in the 
same table, crosstab, or chart in a report. 

What situations require you to link data providers?
BUSINESSOBJECTS automatically links data providers with a common dimension. 
Two dimensions in separate data providers are common when they belong to the 
same universe and have the same name. BUSINESSOBJECTS prompts you to link 
data providers if there is no common dimension between the data providers.

Tip: If you simply want to add columns of data to a report, use the Edit Data 
Provider command on the Data menu instead of building a new query. This 
method lets you add result objects to the initial query; BUSINESSOBJECTS 
automatically inserts the new columns of data in the report or creates a new 
report.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example BUSINESSOBJECTS prompts you to link data providers

Here’s an example scenario where BUSINESSOBJECTS prompts you to link data 
providers:

• You create a new document by running a query on a universe.

• You format the report as a master/detail, using for example the Year 
dimension.

• You want to compare yearly revenue with your sales targets, so you insert a 
new table in the Year section.

• Rather than inserting data from the document, or using the universe you ran 
the first query on, you pull in data from the spreadsheet that contains your 
personal targets.

• Even though the spreadsheet contains the Year column, BUSINESSOBJECTS 
prompts you to link the personal data file with the query already in the report, 
because you’re inserting the new data in a section that’s generated by the 
query data.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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Which dimension should act as the link?
It is necessary that the dimension you use to link data providers be the same type 
(numeric or alphanumeric) in both data providers. If not, two rows of data will 
appear for the linked object when you create a table that uses the object. 
Additionally you should use only dimensions that return the same type of values. 
It doesn’t make sense to create a link between dimensions with totally different 
lists of values (Year and Region, for example).

To link data providers when you’re inserting a new block

1. Select the Table, Crosstab or Chart command on the Insert menu.

2. In the Wizard that appears, select Access new data in a different way, then click 
Begin.
The Specify Data Access dialog box appears.

3. Select the type of data provider you want to run, then click Finish.

4. Build and run the data provider.
BUSINESSOBJECTS displays a dialog box which prompts you to link the new 
data provider with the data in the report.
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5. To make the link:
• Select the linking dimension from the new data provider by clicking an 

icon in the Dimensions box.
• Select the report’s section master by clicking an icon in the Master(s) in the 

Report box.
• Click Link:

The dimension you clicked in the Dimensions box appears below the 
dimension in the Master(s) in the Report box:
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6. Click OK.
The new data appears in the report. Measures are automatically calculated.

Note: If the Links Between Data Provider and Report dialog box appears, and you 
click OK or Cancel without creating a link, you will obtain a Cartesian product.

Linking existing data providers
The procedure above describes how to link data providers when you’re bringing 
new data to a report section. But what if you find yourself in the following 
situation?

• Your report contains two tables - one from a universe, the other from a 
personal data file.

• There’s no link between the tables because when you inserted the second 
table, you simply placed it alongside the existing table without having 
previously linked their data providers.

• You now want to create the master/detail format, which is possible because 
the tables share a dimension with the same name and same type.

The procedure for linking existing data providers is as follows:

1. Open the document containing the data providers you want to link.

2. Select the View Data command on the Data menu.
The Data Manager appears.
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3. In the Data Providers box, click the dimension you are going to use as the link 
between the data providers.
In the illustration below, the Resort dimension has been selected:

4. Click the Definition tab, then click the Link To button:

The Define Link Between Dimensions dialog box appears. It lists the 
dimensions you can use to link the two data providers.
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5. Click the dimension you want to use as the link.
The symbol next to the dimension name now changes to indicate that the 
dimension is the link between two data providers:

This symbol will also now appear when you click the dimension in the Data 
Manager.

6. Click OK to close the dialog box, then click OK in the Data Manager.
You can now use the linking dimension to apply a master/detail format in the 
report.

Deleting the link between data providers
To delete the link between data providers, you delete the link of the common 
dimension that links the data providers. You would delete the link between data 
providers to use all the variables in a single data provider to build an 
independent query. The procedure for deleting the link of the common 
dimension is as follows:

1. Select the View Data command on the Data menu.
The Data Manager appears.

2. In the Data Providers box, click the dimension that acts as the link.
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3. Click the Definition tab, then click Unlink:

4. Click OK to close the Data Manager.
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Overview

In what ways can you manage queries and other data providers in 
BUSINESSOBJECTS documents? This chapter answers that question by describing 
how to:

• Rename data providers

• Get statistics such as the date and time a data provider was last refreshed, and 
how many rows of data were returned

• Empty data providers of their data (called purging), and deleting data 
providers you no longer need.

Reminder: Data provider is the BUSINESSOBJECTS generic term for all types of 
queries: queries on universes, stored procedures, free-hand SQL, personal data 
files and VBA procedures.
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Renaming Data Providers

BUSINESSOBJECTS assigns a name to all data providers. Here are some examples:

Why rename data providers?
Renaming data providers is by no means required in BUSINESSOBJECTS. You can 
work with the software without ever thinking about these names!

However, data provider names appear in several places in BUSINESSOBJECTS, e.g., 
in the Report Manager:

Here are a few cases where you might want to rename data providers.

Data provider name Description

Query 1 on EVALKIT The first query built on the EVALKIT 
universe in the current document.

PS1 on Stock Stored procedure run on a database 
account called Stock.

SQL 1 with Sales A free-hand SQL script run on a 
database connection named Sales.

PD1 in C:\My 
Documents\Forecast.xls

Personal data coming from a 
spreadsheet stored in My Documents.

VBA 1 with ThisDocumentApp The first VBA data provider built in 
the current document, where 
ThisDocumentApp is the name of the 
VBA macro itself.

Data provider name
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Documents with data from different sources
In documents containing two or more data providers, the names of variables may 
also contain the name of the data provider that they belong to. For example, 
Resort (Query 2 on EVALKIT) is the Resort dimension from the second query 
built on the EVALKIT universe.

This additional information only appears if the data providers in the document 
contain variables with the same name. In such cases, to help you distinguish 
between variables with the same name, which in fact come from different data 
sources, BUSINESSOBJECTS automatically inserts the full variable name, e.g., 
Resort (Query 2 on EVALKIT) in column headings in the report.

Selecting the data provider you want to edit
Editing a data provider in a document with multiple data providers also causes 
each data provider’s name to appear. When you select the Edit Data Provider 
command on the Data menu, you are prompted to select one data provider in the 
following dialog box:

Giving data providers more meaningful names can help you know right away 
which one you want.

To rename data providers
You rename data providers in the Data Manager. Here’s how to do it:

1. Open the document containing the query you want to rename.

2. Select the View Data command on the Data menu.
The Data Manager appears.
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3. Click the icon of the data provider you want to rename, then click the 
Definition tab:

4. Type the new name in the Name box, then click OK.
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Getting Statistics on Data Providers

BUSINESSOBJECTS allows you to find out useful information on data providers, 
such as when a query was last refreshed, how many rows of data a personal data 
file returned, and how long it took to refresh a free-hand SQL script. To get these 
statistics:

1. Open the document containing the data provider.

2. Select the View Data command on the Data menu.
The Data Manager appears.

3. Click the icon of the query you want to find out about, then click the Definition 
tab.
The information appears in the bottom right corner of the dialog box:
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Purging and Deleting Data Providers

What’s the difference between purging and deleting a data provider? Purging 
means emptying a data provider of its results, whereas deleting means getting rid 
of the data provider for good - an action which cannot be undone.

So, why purge or delete a data provider? Purging reduces the size of a document, 
so is useful when you want to send the document to other users, or save it on a 
diskette, for example. You should only delete a data provider, however, if you are 
certain that you and other users no longer need it.

To purge or delete a data provider:

1. Open the document containing the data provider.

2. Select the View Data command on the Data menu.
The Data Manager appears.

3. Click the icon of the query you want to purge or delete:

4. Click Purge or Delete.
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5. Click Yes in the confirmation box that appears, then click OK to close the Data 
Manager.

Tip: You can populate a purged data provider by selecting the Refresh Data 
command on the Data menu. Note that this command refreshes all the data 
providers in the active document.
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Using Data Providers Efficiently

If you have multiple reports on separate report tabs and these reports draw their 
data from the same source, you do not need to create a separate data provider for 
each report. Instead you create a “base” data provider that contains the data used 
by all the reports. This approach is better because BUSINESSOBJECTS performs one 
data retrieval for each data provider; it is more efficient to retrieve data once and 
share it among reports than to retrieve the same data several times.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Create reports showing revenue by country and resort, and revenue by country

In this example the Revenue and Country objects are common to both reports. 
Instead of creating a data provider for each report you create a data provider 
containing the Revenue, Country, and Resort objects and use these objects in both 
reports. To do this:

1. Create a report showing revenue by country and resort by dragging the 
Country, Resort and Revenue objects into the report. (See “Building a Basic 
Query on a Universe” on page 60 for an explanation of how to build a report 
on a universe.)

2. Add an additional report tab by selecting Insert > Report.

3. Drag the Country and Revenue objects to the new report tab to create the 
revenue by country report.

When you run this report, BUSINESSOBJECTS retrieves the data once and shares it 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
between the two reports rather than retrieving the data twice.

Note: You can use the Query Panel to modify a data provider by selecting Data > 
Edit Data Provider. Do this rather than create a new data provider if you wish to 
add a new report to a new tab and the new report uses the same or similar data 
to your existing report(s).
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Overview

Exporting data from BUSINESSOBJECTS enables you to use it in other applications. 
All you have to do is save the result of a data provider in a format that is 
recognized by the application you want to use.

What external formats are available?
You can export data from BUSINESSOBJECTS to the following formats:

• Text.

You can open the text file in many different applications, and on platforms 
other than Windows (Macintosh, OS/2 or UNIX, for example).

• Spreadsheet format (Microsoft Excel).

When you view the exported data in the spreadsheet application, each value 
appears in a separate cell. 

• RDBMS format (including .dbf format for dBASE).

When you export data from BUSINESSOBJECTS to RDBMS format, you create a 
relational table in the database. The table contains the columns of data 
returned by the data provider.
This feature enables you to extract a subset of data from a very large table, 
then export the result to your RDBMS. Once exported, the data can be 
retrieved by running a data provider in BUSINESSOBJECTS. The universe 
designer can build a new universe, or edit an existing universe, to map to the 
data in the new table. Alternatively, you can access the data directly by using 
free-hand SQL.

Copying and pasting from BusinessObjects to another application
You can copy objects such as tables and charts in BUSINESSOBJECTS, or copy the 
whole report contents, and then paste them into a Microsoft Office application, 
for example, such as Excel or Word.

To copy and paste an object:

1. Hold down the Alt key and click the table you want to copy.

2. Press Ctrl C.

3. Move to the target application.

4. Press Ctrl V.



 Overview

  BusinessObjects User’s Guide   177

Copying and pasting a whole report
You can also copy a whole report and then paste the report data either as images, 
for presentation purposes, for example; or as text so that you can work on the data 
further in the target application. The table below summarizes how you can copy 
and paste different types of report components:

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Copying and pasting from BUSINESSOBJECTS to Microsoft Excel

The following example shows how to copy data from BUSINESSOBJECTS to 
Microsoft Excel:

1. From the Edit menu, choose Copy All.
BUSINESSOBJECTS copies the contents of the currently active report to the 
clipboard.

2. Open the Microsoft Excel workbook where you want to paste your data.

3. From the Edit menu, choose Paste Special.

4. Choose how you want to paste the data.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
The clipboard contents are pasted into the Excel workbook.

If you copy a report with.... You can...

Tables, crosstabs and cells Paste the data in them as an image or as text

Charts and images Paste them as images

Choose... To....

Text Copy the clipboard contents as data that you can then 
work on in Excel.

Picture Copy the clipboard contents as a Picture image. For 
example, a BUSINESSOBJECTS table is copied as an image 
and you will not be able to work on the data. This is the 
recommended format for pasting images.

Bitmap Copy the clipboard contents as a Bitmap image. If you 
choose to paste a Bitmap image, bear in mind that this 
format can take up a lot of memory and disk space.
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Exporting Data From BusinessObjects

This section explains how to export data from BUSINESSOBJECTS to the format you 
need. Here’s how to do it:

1. Open the report containing the data you want to export.

2. Click the View Data command on the Data menu.
The Data Manager appears.

3. In Data Providers box, click the icon of the data provider containing the data 
you want to export:
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4. Click Export.
The Export to External Format dialog box appears:

5. Select the way you want to export the data.
The following table describes the options available and the actions required:

Option Description Actions

Export to Local File 
Format

Exports the data to a 
text, spreadsheet or 
dBASE file.

1. Select the file type in the 
Format list box.

2. Click Browse to specify the 
file name and location.

3. If you are exporting the 
data to a text file, you can:

• Change the delimiter by 
typing a different 
character in the Delimiter 
box

• Check DOS Format.

4. Click OK.

Export to RDBMS Exports the data to a 
relational database.

1. Select the connection, or 
click the Connection 
button to create a new one.

2. Click OK.
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Tip: Check Delete Spaces to get rid of blanks in the data you are exporting.

You can now use the data from BUSINESSOBJECTS in the applications that support 
the external format you selected.

Note: When you export to a local file, integers in the report appear as decimals in 
the file, e.g. 1 appears as 1.00.

Date settings and the year 2000
We strongly advise you to set a four-digit year style on the Date tab of the 
Windows Regional Settings Properties dialog box. This ensures that you will not 
lose century information if you are exporting data from BUSINESSOBJECTS to text 
files.

TXT file display 
When you exported data to TXT files in versions prior to BUSINESSOBJECTS 4.1, 
character strings were surrounded by double quotes in addition to being set off 
by your selected delimiter. In BUSINESSOBJECTS 4.1 and later versions, there are no 
double quotes surrounding the character strings. For example, in versions prior 
to BUSINESSOBJECTS 4.1, you might have seen “jean” y “55” where y is the 
character delimiter. In BUSINESSOBJECTS 4.1 and later versions, this becomes jean 
y 55.

Copy to DDE Copies the data to 
the clipboard, 
enabling you to 
paste the data into 
another application 
such as Microsoft 
Excel.

• Click OK.

Option Description Actions
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Overview

This chapter covers the basics you need to know to work with BUSINESSOBJECTS.

Starting BusinessObjects

The way you start BUSINESSOBJECTS depends on how it has been set up in your 
company. You may be able to start BUSINESSOBJECTS from INFOVIEW via an 
Internet browser as well as from the Windows Start menu. Your system 
administrator will give you all the necessary information on how you should 
start your BUSINESSOBJECTS. Using BUSINESSOBJECTS via INFOVIEW is fully 
documented in the InfoView User’s Guide. Starting BUSINESSOBJECTS from the 
Windows start menu is explained below.

Starting BusinessObjects from the Windows Start menu
The way you log on to BUSINESSOBJECTS depends on the way BUSINESSOBJECTS 
has been set up in your company. When you start BUSINESSOBJECTS, you may 
have to enter a user name and password, and you may have to choose a security 
domain.

If this is the case, the user name, password, and security domain are assigned by 
your BUSINESSOBJECTS supervisor or system administrator. 

To start BUSINESSOBJECTS:

1. Click the BUSINESSOBJECTS program icon in the BUSINESSOBJECTS group in the 
Programs menu.
The User Identification dialog box appears:

2. Enter your user name and password, and choose your security domain, if 
applicable, and click OK.
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3. The User Identification box closes and the BUSINESSOBJECTS window opens

Note: In some configurations, the User Identification dialog box does not appear 
when you start BUSINESSOBJECTS.

Choosing a security domain
Depending on the way BUSINESSOBJECTS is set up in your company, you may 
have a choice of security domains. There are two types of security domain 
connection and the features available to you in BUSINESSOBJECTS may change 
according to the type of security domain you connect to. Certain menu items may 
become unavailable or you may not have access to all types of data provider or 
to the same list of universes.

The type of security domain connection is identified by an icon:

• A connection to a repository via a BUSINESSOBJECTS web connection is 
identified by a globe icon.

• A connection to a repository via a BUSINESSOBJECTS client/server connection 
is identified by a computer icon.

Using offline mode
Depending on how BUSINESSOBJECTS has been set up, you may have the option of 
starting BUSINESSOBJECTS in offline mode. Using BUSINESSOBJECTS in offline mode 
means that you are not connected to a repository which in turn means that, 
whatever your connection type, you will not be able to retrieve and send 
documents using BROADCAST AGENT. However, what you can do once you have 
opened BUSINESSOBJECTS in offline mode depends on the type of connection you 
chose to use in offline mode.

client/server connection
web connection
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Client/Server connection
If you are using a BUSINESSOBJECTS client/server connection offline and not 
connected to a repository, you can still work with documents and universes 
stored locally on your computer and even create and refresh documents if you 
have a connection to the database, and the database connection and security 
information is stored on your computer.

Web connection
If you are using a web connection offline, you will not be able to retrieve 
documents from, and send documents to, Personal Document folders on the web 
server, and will not be able to create queries or refresh documents because all the 
database and connection information is stored on the web server.

In offline mode, you can continue to work on documents stored locally; you can 
work on the formatting of your reports or analyze data in existing reports, for 
example, and work with the data contained in the document to build new reports.

If BUSINESSOBJECTS cannot establish the connection you requested with the web 
server, it may give you the option of starting BUSINESSOBJECTS in offline mode if 
your user rights allow you to work offline.

No remote connection
You may also choose to start BUSINESSOBJECTS in offline mode because you know 
you have no remote connection at all - for example, on a plane - and want to 
continue to work on documents you have stored locally.

Note: The right to use BUSINESSOBJECTS offline is given to you by your 
BUSINESSOBJECTS supervisor or system administrator. Depending on how 
BUSINESSOBJECTS has been set up in your company, you may not even have the 
option of logging on to BUSINESSOBJECTS in offline mode.
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BusinessObjects Workspace

The BUSINESSOBJECTS workspace is illustrated below. BUSINESSOBJECTS has three 
main parts:

• the menus and toolbars

• the Report Manager window

• the report window

The name of the report is 
displayed on the report tab.

Status Bar 

Toolbars
The document name is 
shown in the title bar

Report 
Manager 
window

Report 
window

Menu bar

Horizontal 
scroll bar

Vertical 
scroll bar
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Menus and toolbars
The menus contain all the commands for the tasks you need to carry out in 
BUSINESSOBJECTS. Many of these commands also have buttons on one of the 
BUSINESSOBJECTS toolbars.

You can hide and display the toolbars as needed:

1. From the View menu, choose Toolbars.
The list of toolbars is displayed as shown below:

2. Check the ones you want to display and uncheck the ones you want to hide.

3. Click Close to close the toolbar window.

Tip: You can also display and hide toolbars by right-clicking on any toolbar. To 
display or hide a toolbar, click its name on the popup menu.

Docked 
toolbars

Floating 
toolbars

Standard 
toolbar
Report 
toolbar
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Status bar
The status bar, at the bottom, of the BUSINESSOBJECTS window, displays status 
and help messages.

The help messages give a brief description of menu commands as you highlight 
them with your mouse cursor display instructions when you are carrying out 
certain actions to remind you of the options you have available.

The status messages give information such as the time the data in the report was 
last updated and information on what BUSINESSOBJECTS is currently doing, 
connecting to the database, for example, or loading a document.

Right-click menus
Commonly used options are available through context-sensitive menus. Right-
click on the area that you want to work on to pop up a menu. The options in the 
menu only apply to the area you clicked on. This is a very quick and convenient 
way of accessing options.

Keyboard shortcuts
Keyboard shortcuts are available for most menu and dialog box options. 
Keyboard shortcuts are given next to commands in the menus and sometimes in 
the tooltips. You also use keyboard combinations to carry out certain tasks. 
Watch the status bar for reminders on these shortcuts.

When you right-click on a free-standing 
cell, only the options applicable to that 
type of cell are displayed in the menu.
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Organizing your workspace

This section describes the options you can set to customize how your 
BUSINESSOBJECTS workspace looks.

Setting the display size
You can magnify a part of the display to see it close up, or reduce the display to 
see more in the report window.

To change the size of the display:

• Click the arrow next to the zoom control box on the Standard toolbar and 
choose a value from the list.

You can also type a value directly into the zoom control box.

You can set values between 10% and 400%.

Setting Windows display properties
We advise you to avoid working with the large fonts that you can set in the 
Windows Display properties. If you use this setting, certain menu and dialog box 
labels may be truncated. We also recommend that, on the Appearance tab of the 
Display properties, you set the Scheme to Windows Standard.

Choosing a view to work in
You can view your reports on screen in different ways.

Structure
Structure view displays only the names of the variables, or the formulas you have 
in your report and not the associated data.

To switch Structure view on and off:

• From the View menu, choose Structure.

A crosstab shown in 
Structure view
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Page Layout
In Page Layout view, you can see how elements will be positioned on the printed 
page. You can also see the headers, footers and margins of your report. Some 
settings, such as page break settings, and the correct result of certain page 
functions can only be seen in Page Layout view.

The view switched on when you last closed the current document will also be 
switched on when you next open the document.

To switch Page Layout on and off:

• From the View menu, choose Page Layout.

Viewing a document created in BusinessObjects 4.1
BUSINESSOBJECTS 5.1 uses standard Microsoft fonts. BUSINESSOBJECTS 4.1 used 
fonts which are slightly different from standard Microsoft fonts.

If you’re using documents created in BUSINESSOBJECTS 4.1, you can display and 
print data in the fonts used in BUSINESSOBJECTS 4.1 so that your documents retain 
the same look.

To do this:

1. From the Tools menu, choose Options.
The Options dialog box is displayed.

2. Click the General tab.

3. Check the option Print as BusinessObjects 4.1.

Note: When you check or uncheck this option, you may need to minimize and 
then maximize the BUSINESSOBJECTS document window to see the change in the 
display.
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Regional settings
BUSINESSOBJECTS supports international settings. This means that the regional 
settings in the Windows Control Panel affect how BUSINESSOBJECTS displays and 
sorts numbers, currency, times and months in reports. Make sure these settings 
are correctly set.

To do this:

1. From the Start menu, choose Settings and then Control Panel.

2. Double-click on Regional Settings to open the Regional Settings dialog box.

In the illustration above, the regional settings have been set to United States 
English. This means BUSINESSOBJECTS will use US conventions for numbers, dates 
and times and will use the dollar sign as the default currency sign.

Date settings and the year 2000
We strongly advise you to set a four-digit year style on the Date tab of the 
Regional Settings Properties dialog box. This ensures that you will not lose 
century information if you are exporting data from BUSINESSOBJECTS to text files.

The date has a four-
digit format which 
ensures that century 
information will not be 
lost
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Report Manager

The Report Manager is a key part of the BUSINESSOBJECTS workspace from which 
you can manage many different aspects of your work. 

To display the Report Manager
You can show or hide the Report Manager window by using the button on the 
Standard toolbar.

• Click the Report Manager button on the Standard toolbar to display or hide 
the Report Manager window.

The Report Manager has two tabs. Each tab is used to manage a different aspect 
of your work in BUSINESSOBJECTS.

• The Data tab allows you to manage the variables and formulas contained in a 
BUSINESSOBJECTS document.

• The Map tab allows you to navigate through reports and to work on the 
structure and organization of reports and report components.

Tip: When the Report Manager window opens, it is docked on the left-hand side 
of your report window. You can undock the Report Manager window and drag 
it to any other convenient location on your screen. Hold down the Ctrl key while 
moving the Report Manager window to prevent it from docking

Report Manager



 Report Manager

  BusinessObjects User’s Guide   195

Managing the data in a document
The Report Manager Data tab contains a list of all the variables and formulas in 
the document. You can view the data list in two different ways:

• In alphabetical order: in this view, the data in the document is listed in 
alphabetical order with the variables in the Variables folder and the formulas 
in the Formulas folder.

• By data provider: in this view the variables are grouped into the data 
providers from which they were returned.

You can drag variables from this list and drop them into the report window to 
construct tables and other components in your report.

If you right-click on a variable in the list, a menu is displayed which allows you 
to:

•  edit the data provider to bring in other data

• create a new data provider

• view the data

• open the Variables dialog box to create a new variable

• edit local variables

View in alphabetical order

View by data provider
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Navigating through reports
The Report Manager Map tab allows you to manage the structure of your 
document. It has two views.

In navigation view, a list of all the reports in your document is displayed. For the 
report currently displayed on your screen, section names are also displayed.

If you click on an item in the list in the Report Manager, the corresponding report 
or section is displayed in the report window.

If you right-click on a report in the list, a menu is displayed which allows you to:

• rename, duplicate or delete the selected report

• apply a template or standard styles to the selected report

• insert a new report

Navigation view

sections

reports
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Structuring and formatting reports
In structure view, the Map tab displays a list of all the reports in the document 
and a list of all the components in the selected report.

Each report component (header, section, cell, table, chart etc.) is represented by 
an icon and a name. The names of components hidden in the report are displayed 
in italics. 

When you click on an icon in the Report Manager window, the corresponding 
section or component is displayed in the main report window.

If you right-click on an icon, a menu is displayed. If you right-click on a table icon, 
for example, you can:

• format the table

• turn the table to a chart

• format any breaks, sorts or filters applied to the selected table

• apply the standard report style

• copy, cut or delete the table

Structure view

reports

report components
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Managing Reports

This section describes how to manage reports inside a BUSINESSOBJECTS 
document.

Inserting a blank report
Creating a blank report enables you to design special features before you display 
any data in it. For example, you can work on the report’s title or apply a page 
background first, then build a query or other data provider to display data in the 
report.

To create a blank report inside an existing document
• Select the Report command from the Insert menu. 

A new, blank report appears inside the document

To insert a blank report by default
You can set BUSINESSOBJECTS to always create a blank report inside a new 
document when you select the New command from the File menu or click the 
New button on the toolbar. To do this:

1. Select the Options command from the Tools menu.
The Options dialog box opens.

2. Click the New Document tab. 

3. Click Systematically Create Blank Document.  
The next time you click the New button or select the New command from the 
File menu, a blank report inside a new document appears.

Copying a report
To make a copy of an existing report inside the document:

1. Right-click on the tab of the report you want to copy.

2. Choose Duplicate Report from the pop-up menu that appears.
A copy of the active report appears in a new tab inside the document. The 
name that appears in the tab is <<Report Namen +(1)>>. For example, if the 
report you copied is named Sales, the new report is named Sales (1). 
Note that the Duplicate Report command is also available on the Edit menu.

New
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Displaying, renaming and deleting reports
One document can contain many reports. Each report has a tab, which appears at 
the bottom of the document window:

To switch from one report to another
•  Click the tab of the report you want to display.

To rename a report

1. Right-click the report tab. 

2. Choose Rename Report from the menu. 

3. In the dialog box that appears, type the name you want to give the report, then 
click OK. 
The name you typed appears in the report’s tab. Note that the Rename Report 
command is also available on the Format menu.

To delete a report
You can delete a report from a document if the document contains more than one 
report. You cannot delete the last report in a document.

1. Right-click the report tab.

2. Choose Delete Report from the menu.
A dialog box appears asking you to confirm or cancel that you want to delete 
the report.

To delete more than one report

1. Holding down the Shift key, click the tab of each report you want to delete.

2. Click your right-mouse button.

3. Choose Delete Report from the menu.

Note that the Delete Report command is also available on the Edit menu.

Note: You cannot undo the deletion of a report.
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Managing reports using Report Manager
You can also manage reports directly from the Report Manager Map tab. See 
page 196 for information on how to do this.

Undoing actions
If you make a mistake or want to undo something you have just done because 
you are not pleased with the result, you can use the Undo button on the Standard 
toolbar.

• The Undo button lets you undo up to ten successive actions.

• The Redo button lets you redo up to ten previously undone actions.

To undo actions, you can also use the keyboard shortcut Ctrl + Z.

Undo/Redo
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Opening Documents

BUSINESSOBJECTS 5.1 is fully compatible with:

• All documents created in BUSINESSOBJECTS 5.0 and 4.x

• BUSINESSQUERY documents

• WEBINTELLIGENCE documents

This section describes how to open these documents.

Restrictions on WebIntelligence and BusinessQuery documents
WEBINTELLIGENCE and BUSINESSQUERY documents that you open in 
BUSINESSOBJECTS appear with the standard BUSINESSOBJECTS document template. 
Formatting applied in WEBINTELLIGENCE and BUSINESSQUERY is lost.

Opening a document
If the document is stored locally on your computer:

1. Click the Open button on the Standard toolbar.
The Open dialog box appears.

2. Choose the type of document you want to open from the Files of type list.

3. Locate the document you want to open and click OK.

Tip: BUSINESSOBJECTS keeps track of the last documents opened. These files are 
named at the end of the File menu. Just choose the file you want to open from the 
list.

Opening several documents at once
Opening several documents at once is useful if you have complex documents that 
take a long time to open. You can select all the documents you want to use and 
then get on with another task while you are waiting for them all to open.

To do this:

1. Click the Open button on the Standard toolbar.
The Open dialog box appears.

2. Choose the type of document you want to open from the Files of type list.

Open

Open
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3. Select the documents you want to open using the Shift key to select adjacent 
documents and the Ctrl key to select non adjacent documents.

4. Click OK.

Using Personal Document folders

The Personal Documents folder is reserved storage space on the web server 
where you can save documents for your personal use. Only you can use this 
folder. You will only have access to Personal Documents if you connect to 
BUSINESSOBJECTS via a web connection.

To help you organize and find your documents more easily, you can use 
categories. The categories you use here are personal categories and you are the 
only person who can create, delete and modify them.

You can view the documents saved in Personal Documents list either from 
BUSINESSOBJECTS or from INFOVIEW.

Note: For information on viewing personal document lists in INFOVIEW, see the 
InfoView User’s Guide.

Retrieving a personal document
If you are connected to a BUSINESSOBJECTS web connection, you can retrieve 
documents you have saved in your personal documents folder on the web server.
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To retrieve a document saved in your personal documents folder:

1. From the File menu, choose Retrieve From/Personal Documents.
The Retrieve Personal Document dialog box opens. 

2. Select the file you want to open from the list and click Open.
You can only retrieve one file at a time.
A copy of the document is downloaded to your computer and opened.

Note: When you open a BUSINESSOBJECTS document from Personal Documents, 
BUSINESSOBJECTS copies the document locally. If you work on this document, save 
it in Personal Documents and then retrieve the same document during a different 
work session, BUSINESSOBJECTS displays the following message to tell you that 
you already have a document with the same name on your computer:

If you know that you saved the latest copy of this document in Personal 
Documents, you can quite safely overwrite the local copy.

Using categories to find personal documents
Documents can be assigned to filtering mechanisms called categories. Categories 
help you sort and find documents in your personal documents list by filtering the 
list to display only documents belonging to the selected category.

Retrieve form 
Personal Documents
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To filter the document list by category:

1. Click the arrow to the right of the All Categories button.
The Categories box opens. If you haven’t created any categories, this list has 
one entry only, <No Category>.

2. Select one or more categories from the list.
Use the Shift and Control keys to make multiple selections. If you select <No 
Category>, BUSINESSOBJECTS filters the personal document list to display 
those documents to which no category has been assigned.

3. Click OK.
The list is filtered to display only the documents assigned to the selected 
category or categories.
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Saving a document in your Personal Documents folder
You can send a document to your personal documents folder if you are connected 
to a WEBINTELLIGENCE server.

To save a document in your personal documents folder:

1. From the File menu, choose Send to/Personal Documents.
The Send Personal Document dialog box opens:

2. Type a name for the document in the “File name” box.

3. In the Save as type list box, choose the format. Choices are:
• BusinessObjects Document (*.rep),
• Portable Document Format (*.pdf),
• Rich Text Format (*.rtf),
• Text Files (*.txt),
• BusinessObjects Templates (*.ret),
• BusinessQuery Files (*.bqy).
• BusinessObjects Add-ins (*.rea)

4. Assign a category to the document if you wish.

5. Click Save.
The document is saved in your personal documents folder on the web server.

Deleting documents from your Personal Documents folder
If you want to delete documents from Personal Documents, you have to use the 
personal document list in INFOVIEW. For information on viewing the personal 
document list in INFOVIEW and deleting documents from it, see the InfoView 
User’s Guide.

Send to Personal 
Documents
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Assigning categories to a document
You assign categories to a document when you save it. When you are saving a 
document to which you’ve already assigned categories, BUSINESSOBJECTS 
displays <Keep existing categories> in the Categories box and saves the 
document with these categories unless you make any changes. To assign a 
category:

1. Click the arrow to the right of the Categories box.
The Categories box opens.

2. Check the categories you want to assign to the document, uncheck any you 
wish to remove and click OK.
The selected categories are displayed in the Categories box.

3. Click Save to save the document with the assigned categories.

Creating a new personal category
You manage the categories assigned to your personal documents. You can create, 
delete and rename categories according to your personal needs. To create a new 
category:

1. Click the arrow to the right of the Categories box.
The Categories box opens.
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2. Click the Add Category button.

3. Type in a name for the category in the newly created box.

Renaming a personal category
Select the category you want to rename.

1. Click the Rename button.

2. Type in the modifications.

Deleting a personal category

1. Select the category you want to delete.

2. Click the Delete button.

Changing default file locations
When you choose Open, the Open dialog box opens by default in the UserDocs 
folder in the BUSINESSOBJECTS. You can change this setting.

a b c d e f

a Displays only the selected 
category

b Check all categories

c Uncheck all categories

d Add new category

e Delete the selected category

f Rename the selected category

Add Category

Rename Category

Delete Category
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To do this:

1. From the Tools menu, choose Options.
The Options dialog box opens.

2. Click the File Locations tab.

3. Click on the file type in the list and click the Change button.
The Browse for Folder dialog box opens.

4. Locate and open the folder you want to set as the default and click OK.
The new folder and path is displayed in the list.
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Refreshing BusinessObjects Documents

A document generated at a given point in time reflects the data as it existed at that 
time, but it may be inaccurate now. In BUSINESSOBJECTS, you can update the data 
in a document while keeping the same presentation and formatting. When you 
update a document, BUSINESSOBJECTS reconnects to the database or file, and 
retrieves the updated data. This is called refreshing a document.

Refreshing a document ensures that the data is kept up-to-date with changes in 
the database or personal data file. 

You can update the data displayed in a BUSINESSOBJECTS document if you have a 
connection to the data source.

Note that if your document contains data retrieved using a web connection as 
well as data retrieved using a client/server connection you will not be able to 
refresh both data providers at the same time. You will have to connect to the web 
connection to refresh one set of data and then connect to the client/server 
connection to refresh the other set of data.

Different ways of refreshing documents 
BUSINESSOBJECTS allows you to refresh documents in the following ways:

• Manually

• Automatically at specific times or intervals

• By sending the document to Broadcast Agent, the BUSINESSOBJECTS product 
that manages the scheduled processing of documents.

• Every time you open a document.

Before refreshing a document 
When you refresh a document, you refresh the data provider(s) contained in the 
document. The data provider is the data source; this can be a database query or a 
personal data file, for example. The user who created a document can specify 
whether or not the document's data provider(s) can be refreshed. Before trying to 
refresh a data provider, check that the Refreshable option is has been set.
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To do this:

1. From the Data menu, choose View Data.
The Data Manager dialog box opens.

2. Click the Definition tab.

3. In Data Providers box, select the data provider you want to check on and make 
sure the Refreshable option is checked.
If this option is not checked, you cannot refresh the selected data provider. 
Only the creator of the document or the BUSINESSOBJECTS supervisor can 
change this setting.

Before refreshing data providers, you should also check that:

• The most up-to-date data is the data you want.

• Refreshing the data provider will not block the server (database).

• Refreshing the data provider will not block your computer.

Some databases support asynchronous mode, which enables you to refresh a data 
provider without blocking your computer. If the database at your site does not 
support asynchronous mode, you can avoid blocking your computer by 
specifying off-peak times for refreshing data providers.

Your IS department, the universe designer and/or the supervisor should be able 
to advise you on these points.

Make sure this 
option is 
checked.
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Manually refreshing a document
To update the data in a document:

• Click the Refresh button on the toolbar.

BUSINESSOBJECTS refreshes all the data providers in your document.

Note: If the universe designer has set the up the universe with a restrictive 
connection, BUSINESSOBJECTS prompts you to enter your database username and 
password before refreshing the data providers. For more information on 
restrictive connections, see “Restrictive connections” on page 43.

Refreshing a document with more than one data provider
If your document contains more than one data provider, you can choose which 
data provider you want to refresh. To do this:

1. From the Data menu, choose View Data.
The Data Manager dialog box opens.

2. Click the Results tab.

3. Select the data provider you want to refresh in the Data Providers list.

4. Click the Refresh button.

Refresh
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Refreshing a document with a prompt
A prompt is a dialog box that asks you to choose which data you want to retrieve 
and display in your report. this allows you to focus your analysis on a particular 
year or particular product line, for example. If a report has been set up with a 
prompt, BUSINESSOBJECTS shows this dialog box when you click the Refresh 
button. The way a prompt dialog looks depends on how the person who created 
the report set it up.

In the example below, the custom prompt dialog box asks you to choose a 
product line before refreshing the report.

Automatically refreshing a document
There are a number of options you can set to refresh your documents on a regular 
basis or at a set time.

Automatically refresh data providers on opening a document
You can set BUSINESSOBJECTS to automatically refresh all data providers in a 
document each time you open it. To do this:

1. Make sure the document is open.

2. From the Tools menu, choose Options.
The Options dialog box opens up.

3. Click the Save tab.

4. Check Refresh Document When Opening, then click OK.
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Refresh a data provider once at a set time
If you know the database is to be updated at a certain time on a given date, you 
can specify that your data provider(s) be automatically refreshed at this point in 
time. To do this:

1. From the Data menu, choose View Data.
The Data Manager dialog box opens.

2. Click the Definition tab.

3. In Data Providers box, select the data provider you want to work on.

4. Check Automatic Refresh then Once.

5. Select an option from the list box:
• "On date, at time".

Use this option to refresh the data provider at a given time on a given day.
• "On date, from time".

Use this option to refresh the data provider after a given time on a set day.

6. Select a date and a time from the respective list boxes, then click OK.

Regularly refresh a data provider
If you know the database is updated every day at a certain time, for example, 
midnight, you can specify that your data provider(s) be automatically refreshed 
at 1a.m. every day. To do this:

1. Follow Step 1 to Step 3 in the procedure “Refresh a data provider once at a set 

Set automatic 
refresh options 
here

Select the data 
provider from 
this list
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time” on page 213.

2. Check Automatic Refresh, then Every.

3. Set the intervals at which you want to refresh the data provider by entering a 
value in the box, and selecting Hour(s) or Minute(s) from the list box. 

4. Select the start date and time in the From Date and Time boxes, then click OK.
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Saving Documents

BUSINESSOBJECTS reports are saved inside BUSINESSOBJECTS documents. 
BUSINESSOBJECTS also allows you to save your document in different formats so 
that you can use the data in other applications or share the data with other users. 
This section describes how to do this. Depending on how BUSINESSOBJECTS is set 
up in your company, you may have the choice of saving documents locally or in 
a personal documents folder reserved for you on a server.

Saving a document

1. Click the Save button on the Standard toolbar, or select the Save command on 
the File menu. 
The Save As dialog box appears. By default, the UserDocs folder is active and 
the file name is Documentn.

2. If you wish, type a different name in the File Name box.

3. Click Save.
The Save As dialog box closes. The name you gave the document now appears 
in the title bar of the application window. The default file extension for 
BUSINESSOBJECTS documents is .rep.

Changing a document’s name and/or folder
To save a BUSINESSOBJECTS with a different name or in a different location:

1. From the File menu, choose Save As. 
The Save As dialog box appears.

2. Type a new name in the “File name” box.

3. Navigate to the folder in which you want to save the document, then click 
Save.

Saving a document for all users
If you want to make a document accessible to another user working without a 
repository, then check the Save for all users option in the Save as dialog box (Save 
As command, File menu).

If you do not do this, users working without a repository will get an error 
message saying “You are not authorized to use this document” when they try to 
open your document. This is important to bear in mind if you are sending 
documents to other users via email, for example.

Save
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Saving a document in text or rich text format
When you save a BUSINESSOBJECTS document in text (.txt) or rich text format (.rtf), 
only the currently selected report is saved. Graphics are not saved in rich text 
format and text documents. To save a document in text or .rtf format:

1. From the File menu, chooses Save As. 
The Save As dialog box appears.

2. In the Save as type list box, click:
• “Text file (*.txt)”, or
• “Rich text format (*.rtf)”.

3. Click Save. 
BUSINESSOBJECTS makes a copy of the document and saves it in the specified 
format. The original document remains on your screen.

Saving a document in HTML format
You can save a BUSINESSOBJECTS document in HTML format. To do this:

1. From the File menu, choose Save As HTML.
The Save As dialog box opens.

2. Choose the location where you want to save the file and click Save.

3. The HTML options dialog box opens where you can specify how you want 
your HTML document to be saved. For a full description of the options 
available on this dialog box and for advice on preparing HTML documents in 
general, see the InfoView User’s Guide.
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Saving a document in PDF format
BUSINESSOBJECTS 5.1 allows you to save BUSINESSOBJECTS documents in Adobe 
Portable Document Format (PDF). Once you install the free Adobe Acrobat 
Reader, you can view and print PDF documents. When you open a 
BUSINESSOBJECTS document saved in PDF format, you can view and navigate 
through different reports and obtain high quality printed copies. You cannot edit 
or analyze the data. To save a BUSINESSOBJECTS document in PDF format:

1. From the File menu, choose Save As. 
The Save As dialog box appears.

2. In the Save as type list box, choose Portable Document Format (*.pdf) and specify 
where you want to save the PDF file.

3. Click Save. 
BUSINESSOBJECTS makes a copy of the document and saves it in PDF format. 
The original document remains on your screen. The illustrations below show 
the same document in its original BUSINESSOBJECTS format and after saving in 
PDF format.

Original 
BusinessObjects 
document
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Note how the navigation outline is retained in the PDF document, making it easy 
to navigate quickly through reports and report sections.

Note: The fonts used to generate the PDF document are found in the following 
folder in your local hard drive:

Program Files\Business Objects\BusinessObjects 5.0\Language 

If the fonts used in your BusinessObjects documents do not have an equivalent 
Adobe Font Metrics (AFM) font in this directory, a substitute font is used.

Saving a document as a BusinessQuery file
BUSINESSQUERY for Excel users build queries on universes in Microsoft Excel. By 
saving a document as a BUSINESSQUERY file, you can transfer data obtained in 
BUSINESSOBJECTS to BUSINESSQUERY. You can then work with the query using the 
functionality of both BUSINESSQUERY and Microsoft Excel.

Click here to 
view a report.

Click here to go 
to a section in a 
report.
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Saving a document as a BUSINESSQUERY file is only possible if all the following 
conditions are satisfied:

• The current document contains only one data provider.

• The data provider is a query on a universe.

• The query returns only one microcube.

To save a document as a BUSINESSQUERY file:

1. From the File menu, chooses Save As.

2. Navigate to the folder in which you want to save the document.
Note that the default folder for BUSINESSQUERY files is 
C:\BusinessObjects\UserBQY\UniverseName, where UniverseName 
corresponds to the universe on which the query was built.

3. Select BusinessQuery files (*.bqy) in the Save as type list box.

4. If you wish, type a different name in the File name box, then click OK. 
Otherwise, simply click OK.

5. For information on working with the query in BUSINESSQUERY, refer to the 
BusinessQuery User’s Guide.

Note: If you have opened a BUSINESSQUERY document in BUSINESSOBJECTS, you 
can save it as a BUSINESSQUERY document or as a BUSINESSOBJECTS document. 
Whether you save the document in BUSINESSQUERY or BUSINESSOBJECTS format, 
you will be able to continue to work with it in both applications.

Saving WebIntelligence documents
If you have opened a WEBINTELLIGENCE document in BUSINESSOBJECTS, you 
cannot save it as a WEBINTELLIGENCE document. You can only save it as a 
BUSINESSOBJECTS document, i.e., a .rep file.

Once you have saved the document, you can send, publish and schedule the 
document, but only as a BUSINESSOBJECTS document, not as a WEBINTELLIGENCE 
document. If you want to send, publish and schedule the document as a 
WEBINTELLIGENCE document, you must use INFOVIEW in your Web browser. See 
the InfoView User’s Guide for more information.
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Overview

BUSINESSOBJECTS has three basic ways of displaying the data in a report. You can 
display data in tables, in charts or in free-standing cells.

This chapter deals with the different types of tables, including crosstabs, that you 
can use in BUSINESSOBJECTS. It describes how to create tables and how to organize 
the way your data is displayed in them. This chapter also describes how to insert 
and display data in free-standing cells. Chapter 17 "Creating Charts" on page 405 
of this guide describes how to display your data in charts. 

Formatting tables and cells, that is working with colors, font and number styles 
is covered in Chapter 22 "Formatting Tables, Cells and Sections" on page 525.

See also Chapter 13 "Breaking Up Tables and Displaying Calculations" on page 
285 which describes breaking up the data in tables to display calculations.
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What Types of Tables?

BUSINESSOBJECTS has three types of table. It has two basic table types that display 
data in a list and crosstabs, which are a special kind of table that allows you to 
summarize data. These different types of table are described below.

Tables
BUSINESSOBJECTS tables display data in either rows or in columns and have a 
header and a footer. Header and footer rows and columns are special rows and 
columns. The header displays information about the row or column e.g. a label or 
the name of the variable whose values are displayed. The footer displays 
calculations on the values displayed in the columns or rows.

You can display the variable labels along the top row of the table so that you read 
the data down the columns as shown below:

Or, you can have the variable labels displayed down the left edge of the table so 
that you read the data across the rows as shown below. This table format is 
typically used in financial reports such as balance sheets.

The names of the variables are 
displayed at the top of the table

The values are listed underneath 
the column headings

Calculation totals are displayed 
in the table footer

The names of 
the variables 
are displayed 
down the left 
edge of the 
table

The values are listed along the 
rows after the row headings

Calculation totals 
are displayed in 
the table footer
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Crosstab tables
A crosstab is a particular kind of table where data is displayed in columns and in 
rows. Corresponding data appears at the intersection of the columns and rows;   
this part of the crosstab is called the body. The body typically displays numerical 
data.

A crosstab can display both row totals and column totals as well as a grand total.

You need at least three variables to display data in a crosstab including one 
measure. The measure is placed in the body of the crosstab.

The crosstab illustrated below displays sales revenue per year for the top three 
selling product lines.

The Year variable is displayed 
in the top row.

This is the Down Edge of the 
crosstab.

The Line 
variable is 
displayed in 
the left 
column.

This is the 
Across Edge of 
the crosstab.

The Sales Revenue variable 
is displayed in the body

Row and column totals 
are displayed in the two 
footers with a grand total 
shown in the bottom right-
hand cell

The same crosstab in Structure 
View shows how the variables 
are placed in the crosstab
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Creating Tables
This section only deals with inserting tables that contain data that already exists 
in the report i.e. using the variables that are displayed in the list in the Report 
Manager. There are several ways of inserting a new table in a report. You can:

• Select and drag variables from the Report Manager list and drop them in a 
blank space in the report. The data is displayed in a table. You can then add 
other columns as required, rotate the table, move it, turn it into a crosstab and 
rename the data labels.

• Use the Insert Table/Crosstab wizards.

• Copy an existing table and then replace the variables and delete or add 
columns and rows as required.

If you want to bring new data into your report, see Chapter 2 "Introduction to 
Accessing Data with BusinessObjects" on page 37.

Inserting a table from Report Manager
Inserting a table by dragging the variables you want to use from the Report 
Manager and dropping them into your report is the quick and convenient 
method. Here’s how to do it:

1. Make sure the Report Manager window is open. If it isn’t, click the Report 
Manager button on the Standard toolbar

2. Click on the Data tab of the Report Manager.
A list of all the data you can use in your report is displayed.

3. Select the variables you want to use in your table in the Report Manager.
Use the Ctrl key to select more than one variable.

Report Manager

Create table cursor
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4. Holding down your mouse button, drag the variables out of the Report 
Manager and onto the report.
The cursor changes to the Create Table cursor and the status bar displays the 
message Drop to create a table.

5. Release your mouse button to drop the variables and create a table to display 
the data.

Rotating tables
You can change the orientation of your table to list data in rows instead of 
columns or the other way round. To do this:

1. Select the table.

2. Click the Rotate Table button on the Report toolbar.
The table is rotated as shown below. 

Re-organizing data in tables
Once you have inserted your table you can re-organize the columns and rows in 
it, add more data to it and delete rows and columns to get the layout that best 
represents your data. You can do all this using your mouse. There’s no need to go 
through dialog boxes or menus.

Swapping two columns or two rows
To swap two columns or two rows:

1. Click in one of the rows or columns.
Make sure you click in a cell other than the header cell.

Status bar

Rotate Table

From this...... ....to this
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2. Click on the same row or column again and, holding down your mouse, drag 
your cursor over the second column or row.
The cursor changes to the swap cursor and the status bar reads Drop to swap 
contents.

3. Release your mouse button.
The two columns or rows have changed position in the table.

Moving columns and rows
To move a column or row to a different position in the table.

1. Click on the row or column.
Make sure you click in a cell other than the header cell.

2. Click on the same row or column again and, holding down your mouse, drag 
your cursor to where you want to place the row or column.
The cursor changes to the move cursor and the status bar reads Drop to move 
contents.

3. Release your mouse button.
The row or column is moved to the new position.

Swap cursor

From this...... To this......

Move cursor

From this......

To this......
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Copying columns and rows
To copy a column or row:

1. Click on the row or column.
Make sure you click in a cell other than the header cell.

2. Click on the same row or column again and, holding down your mouse 
button, drag your cursor to where you want to place the row or column.

3. Hold down the Ctrl key.
The cursor changes to the copy cursor and the status bar reads Drop to copy 
contents.

4. Still holding down the Ctrl key, release your mouse button.
The row or column is copied to the new position

Keeping source formatting 
When you swap, move or copy rows and columns you may want to keep any 
particular formatting you have used on a column or row. In the example below, 
you have formatted the values in the Year column in Red in a larger font size than 
the other columns. To keep this formatting on the Year column when you move 
it to a different position in the table:

• Hold down the Alt key as you drop the column or row into its new position.

Copy cursor

From this...... To this......

 
Swap columns only and 
formatting stays on middle 
column

Hold down Alt key and 
formatting is copied to the 
new position
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Adding more data to a table
You can add more data to your table by dragging variables from the Report 
Manager and inserting new columns or rows in your table.

To insert a row or column in a table:

1. In the Report Manager, click on the variable you want to add to your table.

2. Holding down your left mouse button, drag the cursor to the edge of the 
column or row where you want to add a new one. 

3. When the edge of the column or row is highlighted with a gray hatched border 
and the status bar displays the message Drop to insert, release the mouse 
button.
A new column or row is added to the table to display the new data.

Tip: You can add more than one variable at a time. Use the Ctrl or Shift keys to 
select more than one variable from the list in the Report Manager.

Replacing data in a table
You can replace the data in a column or a row by dragging a different variable 
from the Report Manager window and dropping it onto the table.

1. In the Report Manager, click on the variable you want to add to your table.

2. Holding down your left mouse button, drag the cursor over the column or 
row of data you want to replace. 

Insert highlighting

Replace 
highlighting



 Creating Tables

  BusinessObjects User’s Guide   231

3. When the column or row is highlighted with a gray hatched border and the 
status bar displays the message Drop to replace contents, release the mouse 
button.
The data in the column or row is replaced with the new data.

Removing data from a table
You can remove a row or column of data from a table by dragging it back into the 
Report Manager window. To do this:

1. Click on the row or column.
Make sure you click in a cell other than the header cell.

2. Click on the same row or column again and, holding down your mouse 
button, drag the cursor into the Report Manager window.

3. Release the mouse button.
The column or row of data is removed from the table.

From this......

To this......
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Inserting a crosstab
You can create a crosstab by dragging variables from the Report Manager into the 
report to create a table and then re-organizing the table into a crosstab. 
Remember that you need at least two dimensions/details and one measure to 
create a crosstab. To turn a table into a crosstab:

1. Select a column and drag it to the upper right corner of the table.
You can also drag a variable from the Report Manager window to the upper 
right corner of the table.

2. When the cursor becomes the Turn to Crosstab cursor and the status bar 
displays the message Drop to turn to crosstab, release the mouse button.
The table becomes a crosstab.

Re-organizing crosstabs
You can re-organize a crosstab by swapping or replacing the variables in the 
headers or by replacing the variable displayed in the body. The example below 
shows how to swap two headers:

1. Click in the Year header. Click again in the same header.

2. Holding down your mouse button, drag the cursor over the Resort header.
The Resort header is highlighted, the cursor changes to the swap cursor and 
the status bar reads Drop to swap.

Turn to Crosstab 
cursor
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3. Release the mouse button.
The headers are displayed in the new positions.

Turning a crosstab to a table
You can rearrange the columns and rows in a crosstab into a table. To do this:

1. Click inside the header row of the crosstab.

2. Click again in the same row and, holding down the mouse button, drag the 
cursor towards the left border of the crosstab.

3. When a horizontal line appears above the cursor, release the mouse button.

Tips on dragging and dropping data
• Make sure you have correctly selected the data you want to move.

• Watch how the cursor changes shape as it moves over different parts of the 
table and how the highlighting on the table changes. This shows you what will 
happen when you release your mouse button.

• Watch the status bar messages for instructions on what keyboard shortcuts 
you can use and for what will happen when you release your mouse button.

• If you are not happy with the result, use the Undo button on the Standard 
toolbar or Ctr+Z to undo the action you’ve just carried out. You can undo up 
to ten actions.

Turn to Table cursor

Undo button
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Guided Table Insertion

You can also insert tables and crosstabs using the Insert wizards. These wizards 
guide you through the steps you need to carry out to insert a new table or crosstab 
in your report.

The following procedure describes how to insert a table or crosstab in a report, 
using existing data from the document. If you want to insert a table or crosstab 
using new data see Chapter 2 "Introduction to Accessing Data with 
BusinessObjects" on page 37 of this user’s guide.

1. Click inside a blank space in the report.

2. Click the Insert Table or the Insert Crosstab button on the Report toolbar.
The cursor changes to the insert cursor.

3. Click once in the report where you want the top left-hand corner of the table 
or crosstab to be positioned.
The Insert wizard opens.

4. Click the first option, Use existing data from the document, then click Begin.
Next, choose the data that you want to use:

a b  

a. Insert table button

b. Insert crosstab button

c. Insert table cursor

d. Insert crosstab cursor
c d 
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5. Hold down the Ctrl key and click the variables you want to display in the new 
table/crosstab.

6. In the next screen, the variables you selected are organized in three folders. 
The variable in the Column folder will be displayed in the header down the 
left edge of the crosstab, the variable in the Rows folder will be displayed in 
the header in the top row of the crosstab and the variable in the Body folder 
will be displayed in the body of the crosstab:

7. You can re-organize the variables in the folders by dragging them from one 
folder to another. When you have organized the variables as required, click 
Finish.
The crosstab appears in the report.

If you are inserting a.... Click....

Table Finish.
The table appears in the report.

Crosstab Next, then go to Step 6
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Editing Tables

This section describes how you can edit existing tables and crosstabs.

Selecting tables, rows and cells
When you work on a table, you can select the whole table, which means all the 
cells, rows and columns and header cells, or, you can select just part of the table, 
one row, one column, one cell or several cells together. The next section describes 
how to select the different parts of a table.

To select a table

1. If part of the table is selected, click a blank space outside it. 

2. Hold down your Alt key and click once inside the table. 
A hatched gray border appears around the table:

Hatched gray border that appears 
when the table is selected.
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To select two or more tables

1. Click a blank space in the report.

2. Drag the mouse until you have covered part of each block you want to select.

3. Release the mouse button.
A hatched gray border appears around each.

To select columns and rows
To select one column or one row:

1. Place the cursor at the top of the column or at the left-hand side of the row

2. When the cursor changes to a black arrow, pointing downwards for a column 
or to the right for a row, click once. 
The column or row is highlighted as shown below:

The column or row is 
highlighted, to show 
that it is selected.
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You can also select a column or a row simply by clicking inside it. This method 
does not select the column or row header, which is the cell that contains the name 
of the variable.

To select adjacent columns or adjacent rows

1. Select one column or row. 

2. Holding down the Shift key, click the adjacent column(s) or row(s).

To select columns or rows that are not adjacent

1. Select the first column or row. 

2. Holding down the Ctrl key, then click the other column(s) or row(s) you want 
to select.

Note: You can select one or more columns at a time, or one or more rows at a time, 
but you cannot select a combination of columns and rows.

To select a cell in a table
• To select a cell, click inside it. 

The cell background is blackened, to indicate that it has been selected:

• To select more than one cell, hold down your Ctrl key, then click inside each 
one.

Only the body cells 
are selected.

Header cell is not 
selected.
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Inserting empty columns and rows
You can add columns and rows to existing tables or crosstabs.

1. Select a column, row or cell. 

2. Click one of the insert buttons on the Structure toolbar:

Naming or renaming a column or row
A new column or row does not have a title when you add it to your table. To 
name a column or row header:

1. Double-click inside the header cell. 

2. Type a name.

3. Press the Enter key.

a. Inserts a row above the selection.

b. Inserts a row below the selection.

c. Inserts a column to the left of the selection.

d. Inserts a column to the right of the selection.

e. Inserts a cell above the selection

f. Inserts a cell below the selection.

g. Inserts a cell to the left of the selection

h. Inserts a cell to the right of the selection

f a b c d e g h 
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Resizing columns and rows

1. Move the mouse cursor over the right edge of the column (or bottom edge of 
a row) you want to resize.

2. When the cursor changes to the Resize cursor, hold down the left mouse 
button and drag the edge to increase or decrease the column (or row) to the 
required width (or row height).

Tip: If you double-click on the resize cursor, the column or row is automatically 
sized to width or height of the contents.

Copying, pasting and deleting
You can copy, paste and delete report components using menu commands, 
toolbar buttons and keyboard shortcuts.

Copying tables and crosstabs

1. Select the table.

2. Click the Copy button on the standard toolbar.

3. Click in the location where you want to display the copy of the table.

4. Click the Paste button on the Standard toolbar.

Tip: You can also copy a table or crosstab by selecting it, dragging it to a new 
position and holding down the Ctrl key as you release the mouse button. The 
table or crosstab is copied to the new location.

Resize cursor
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Deleting columns and rows

1. Select the column or row.

2. Click the Delete button on the Standard toolbar.

Deleting tables

1. Select the table.

2. Click the Delete button on the Standard toolbar.

Copying and pasting from BusinessObjects to other applications
You can copy objects such as tables and charts in BUSINESSOBJECTS, or copy the 
whole report contents, and then paste them into a Microsoft Office application, 
for example, such as Excel or Word. For details on how to do this, see “Copying 
and pasting from BusinessObjects to another application” on page 176.

Delete button
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Free-standing Cells

BUSINESSOBJECTS reports have two types of cell: cells that make up tables and free-
standing cells. A free-standing cell is a single cell that is not attached to any other 
report component and can be moved and formatted individually. Free-standing 
cells have many uses in BUSINESSOBJECTS reports. They are containers for text, 
calculations or graphics and are used among other things for report titles, for 
adding comments and for displaying page numbers.

Inserting a free-standing cell

1. Click inside a blank space in the report to make sure no other report 
component is selected.

2. Click the Insert Cell button on the Report toolbar.
The cursor changes to the Insert Cell cursor.

3. Click where you want your cell to appear and, holding down your mouse 
button, draw a cell.

When you release the mouse button, a cell appears in the area you have 
drawn. When a new cell is inserted it has a flashing cursor inside it so that you 
can immediately type in text.

Tip: You can also insert a free-standing cell by copying and pasting an existing cell 
from the report. To do this, select the cell, hold down the mouse button, hold 
down the Ctrl key and drag the mouse. When you release the mouse button, a 
copy of the cell appears.

Insert Cell button

Insert Cell cursor
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Dragging a cell out of a table
You can drag a cell out of a table to display the data contained in it in a free-
standing cell. To do this:

1. Select the cell.

2. Click in the cell again and, holding down the mouse button, drag the cell out 
of the table and drop it in a blank space in the report

If you drag a cell containing a dimension or detail object out of a table you create 
a master/detail report as shown below:

If you drag a measure out of a table you can display a grand total or a section total 
depending on where you place the cell. In the example below the table total is 
displayed at the top of the table.

You can use a grid to automatically align the selection as you drag it. To do so, 

• From the Format menu choose Snap to Grid.

•  To view the grid, from the View menu choose Grid



Chapter 10 Displaying Data in Tables

244   BusinessObjects User’s Guide

Editing cells and cell content
You can work on free-standing cells in the following ways.

Typing text in a cell
Double-click on the cell. If the cell is empty, it has a black border around it and a 
flashing cursor. If the cell already contains text, the text is also highlighted. Type 
in your text and press Enter.

Tip: If you get these symbols displayed in a cell ####, this happens because the cell 
contents are larger than the cell. Resize the cell to fix the problem.

Moving a cell
To move a cell to a different position, click on it once to select it and then click on 
it again and drag it to a new position.

Resizing a cell
Hold your cursor over the edge of the cell. When the cursor changes to the resize 
cursor, click and drag the cell border to resize it.

Tip: If you double-click on the resize cursor, the cell is automatically sized to 
content width. You can also autosize the cell height by holding your cursor over 
the top or bottom border and double-clicking on the resize cursor.

Resize cursor
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Overview

This chapter describes how to structure your data into a master/detail report.

What are master/detail reports?
Master/detail reports enable you to split large blocks of data into sections. This 
type of presentation allows you to avoid repeating values and also to display 
subtotals. 

In the example below the table displays data for Resort, Quarter and Revenue. 
The Quarter column has repeated values. If you set Quarter as a master value, 
each distinct value of quarter creates a section. You now have four sections, one 
for each quarter. Each section has a master cell, and a table showing resort and 
revenue.

Structuring a master/detail report

a

b

a. For each value of the master, Quarter, a 
section is created. One master value 
appears in a cell inside each section. In 
this section, the master value is “Q1”.

b. The detail can be a table, crosstab or 
chart. It displays data that relates to the 
master. In this report, the detail is a table 
that shows revenue per resort.

c. You can clearly see the sections in a 
master/detail report by activating the 
Section Delimiters command on the 
View menu.

c
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Structuring a Master/Detail Report

You set up a master/detail report by setting a variable as a master cell. This 
section describes the different ways to do this. You can:

• use a variable in a table or crosstab to create a master cell

• add a variable from the Report Manager to create a master cell

From a table or crosstab
If the data you want to set as the master is already displayed in a table or crosstab, 
you can drag it out of the table or crosstab and create a section. To do this:

1. Click inside the column or row contains the data you want to use as master.

2. Click inside the data again, hold down the mouse button, and drag the data 
away from the table or crosstab.
The cursor changes to the Set as Master cursor.

3. Release the mouse button in a blank above the table or crosstab.
The column or row of data you clicked is removed from the table or crosstab. 
For each of its values, a section is created. Each section contains:
• A master cell which displays one value, and
• A table or crosstab.

Tip: You can also right-click on the row or column of data you want to set as 
master and choose Set As Master from the menu.

Set as Master 
cursor
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From the Report Manager
If your report contains a chart or the variable you want to set as master is not 
currently in the table or crosstab, you can add a master cell from the Report 
Manager window. To do this:

1.  If Report Manager is not open, choose Report Manager from the View menu.

2. In the Report Manager Data tab, click the variable you want to use as a master.

3. Drag the variable from the Report Manager window into the Report window.
The pointer changes to the insert cell cursor and the status bar displays Drop 
to create section.

4. Drop the variable in the report above the block.
A section is created for each value of the variable.
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Building a master/master/detail report
A master/master/detail report has sections within sections. You create this type 
of report in the same way you create a master/detail report by dragging a value 
out of a table or crosstab or from the Report Manager and creating a second 
section.

You can create up to nine sections in a report by adding master cells above or 
below the current master cells.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Making a report with a year and a quarter section

In this example, you have a report with a Quarter section. You want to add a year 
section so each financial year section displays the data for the four quarters in that 
year. To do this:

•  Drag the Year variable from Report Manager and drop in the report to create 
a new master cell.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

a

b

a. Drag the Year variable from the 
Report Manager window and drop in 
the area above the Q1 master cell to 
create a new section and new 
master cell.

b. If you want the new section under 
the Quarter section, drop the new 
variable under the Q1 cell.
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Re-organizing a Master/Detail Report 

You can re-organize the section levels in a master/detail report or change the 
master to get a different view of your data.

Replace a master with a new variable
• Drag a new variable from the table or crosstab or from the Report Manager 

window and drop it into the master cell.

Change the order in a master/master/detail

1. Click on one of the master cells.

2. Drag the cell and drop it on the other cell.
The contents are swapped and the section levels are changed.

Sorting, ranking and filters
You can sort, filter and rank data in master/detail reports. You can sort, filter and 
rank the values in the master cells and/or the data in the tables and crosstabs in 
the sections. For more information on sorting, ranking and filtering data, see 
Chapter 12 "Organizing Data in Reports" on page 255.

From this...... ....to this
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Managing Sections in Master/Detail reports

When you create a section, it covers the entire width of the report. Whatever you 
add or change in one section is added or changed in all the other sections created 
by the same master.

Displaying section delimiters
Section delimiters are graphical markings that show you where sections begin 
and end. Each section is named. Showing these delimiters helps you organize and 
structure your sections.

To display the section delimiters:

1. From the View menu, choose Section Delimiters.
A check mark is displayed next to the command to show that it is turned on.

2. Click once on the report window.
The section delimiters are displayed.

Scaling charts in master/detail reports
If you have a master/detail report which contains charts, you can use different 
scaling for the charts in the different sections. See “Scaling charts in Master/
Detail reports” on page 439 for information on how to do this.

Formatting sections in master/detail reports
You can format the sections in a report by applying shading to the background. 
If you have set up a report with several sections, you can apply a different type 
of shading to each section in the report. This can allow you to easily distinguish 
between the different sections. For information on formatting sections, see 
“Formatting Sections” on page 526.

Hiding sections in master/detail reports
You can hide sections in master/detail reports so that only the sections you are 
interested in are displayed. For information on how to do this, see “Hiding and 
Displaying Report Components” on page 569.
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Undoing a Master/Detail Report

You can undo a master/detail report in the following ways:

• By placing the master in the table or crosstab.

• By removing the master from the report. 

• By removing the data from the master cell but leaving the cell in the report.

Placing the master in a table or a crosstab
You can remove a master cell by adding it to a table or crosstab in the section. The 
cell is inserted as an extra column or row of data.

1. Click the master cell.

2. Click the master cell again and, holding down the mouse button, drag the cell 
to the edge of the column or row where you want to insert it.

3. When the edge of the column or row is highlighted with a gray hatched border 
and the status bar displays the message Drop to copy contents, release the 
mouse button.

The following message box is displayed:
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• Choose Yes to remove the data, the master cell and the section from the 
report. A new column or row is added to display the data and the section 
is deleted from the report as shown below:

• Choose No to remove the data and the master cell but to leave the section 
in the report. A new column or row is added to display the data and the 
section remains in the report as shown below:

Deleting the master

1. Select the master cell.

2. From the Edit menu, choose Delete.
The message box described on page 252 is displayed.

Tip: You can also remove a master cell by dragging it into the Report Manager 
window.
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Clearing the master cell

1. Click the master cell.

2. Select the Clear command from the Edit menu.  
The data from the master cell disappears, but the master cell remains.
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Overview

A BUSINESSOBJECTS report can contain a great deal of data. This chapter presents 
the various ways in which you can organize and present report data to bring 
certain key information to the instant attention of your readers. 

• You can limit the amount of information displayed in a report to focus on a 
selection only by using filters.

• You can order the information by using ranking or sorting.

• You can highlight interesting data with special formatting by using alerters.
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Limiting the Data Displayed

You may not want to display all the data returned by a data provider in a report. 
You may want to focus on a selection of it only, which is difficult to do if there is 
a lot of data on the screen. A filter enables you to hide the data you do not want 
to view behind the scenes and display only the data you need. 

There are two types of filter. A global filter affects the whole report. A block-
specific filter only filters data for the specified chart, table or crosstab.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Filter data to show sales revenue for two regions only

In this example you want to show the sales revenue results for two regions only. 
To do this, you insert a filter on the Region column and choose to display East and 
Midwest only.

Notice how the filter also affects calculations. The sum is different in the two 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
tables. 

You can filter the data for Region by 
selecting two of its values: East and Midwest.

Only the data for 
these values is 
now displayed.
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Inserting a filter
You can insert a filter on data in tables, crosstabs or charts.

To insert a filter

1. Click the row, column or chart element you want to filter.

2. Click the Insert Filter button on the Report toolbar, or select the Filter 
command on the Insert menu.
The Apply a Filter On dialog box appears. It displays the values you can select 
for the filter:

3. Hold down the Ctrl key and click the values you want to include in the report, 
then click OK.
The dialog box closes, and the report includes only the values you selected. 
The Insert Filter button on the toolbar is dimmed.

Tip: To remove the filter, click inside the filtered data, then click the Insert Filter 
button.

Insert Filter

The title of this dialog box depends on the data 
you select in the report. Here, data for Region was 
clicked, so the title is “Apply a Filter on Region”.
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Managing filters
You can manage filters in the Filters dialog box in the following ways:

• Select different values for existing filters.

• Add new filters.

• Insert filters on variables that are not displayed in the report.

• Specify whether a filter be applied on the whole report or on a specific block.

• Remove filters.

The following sections describe these tasks.

Selecting different values for existing filters
Once you have defined a filter by specifying the values you want to display, you 
can edit it by selecting different values. For example, instead of displaying data 
for the East and Midwest regions, you can select different values and display data 
for the West and South.

To select different values for an existing filter:

1. Click inside the block or master cell where the filtered data appears.

2. Select the Filters command from the Format menu.
The Filters dialog box appears. 

Filters placed in this folder 
affect the whole report.
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3. In the Filters On list, click the variable whose filter you want to edit.
In the Values box, the values that are currently displayed in the report are 
highlighted (East and Midwest, in the illustration above.)

4. To select different values, you can:
• Click values that are already selected. The highlighting disappears, which 

shows that the values will not appear in the report.
• Select previously unselected values. Before you do this, check Show All 

Values to display all the values for the variable.
• Click Select All Values. Doing this enables you to keep the filter, yet view all 

the data for the selected variable.

5. When you are done, click OK or Apply.

Adding filters
The Filters dialog box enables you to add filters to the report. To add a filter:

1. Click inside the report, then from the Format menu, choose Filters.
The Filters dialog box is displayed.

2. Double-click a folder in the Filters On box:
• Filters in the Global folder affect the whole report.
• Filters in the BlockName folder are block-specific.

3. Click Add.
The Variable(s) to Filter dialog box is displayed. It lists all the variables in the 
document which are not currently filtered, whether or not they are displayed 
in the current report:
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4. Click the variable you want to filter, then click OK.
You return to the Filters dialog box. The variable(s) you clicked in the 
Variable(s) to Filter dialog box appear(s) in the Filters on box.

5. In the Values box, hold down the Ctrl key and click the values to display.

6. If you selected more than one variable to filter in the Variable(s) to Filter 
dialog box, repeat step 5, then click OK or Apply.

Tip: You can drag-and-drop a filter between folders. This enables you to change 
the way a filter is applied. For example, if you drag a filter from a Block Name 
folder to the Global folder, then click Apply or OK, you apply the filter on the 
whole report rather than on one block.

Removing a filter
When you remove a filter, all the data for the variable on which you applied the 
filter is displayed in the report. For example, if you applied a filter that displays 
revenue only for the East and Midwest regions, then you remove that filter, the 
data for all regions is displayed.

To remove a filter:

1. Click in the data on which you applied the filter.

2. Click the Insert Filter button on the Report toolbar.

Note: You can also choose the Filters command from the Format menu, highlight 
the filtered variable in the Filters On box, then click Remove.

Displaying filter names in a special field
To keep track of the global filters you have applied to the whole report, you can 
automatically insert the names of the filtered values you have placed in the global 
filters folder as a comment or title to your report.

To do this:

1. From the Insert menu, choose Special Field/Global Filters.
The cursor changes to the insert cell cursor.

2. Draw a box in the area of the report where you want insert the names of the 
filtered values.

3. When you release the mouse button the names are inserted.

Insert Filter
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Tip: You can also insert the data in an existing cell. To do this:

• Select the cell and then from the Insert menu, choose Special Field/Global 
Filters.

The names of the filtered values are displayed in the selected cell.

Creating more complex filters
Simple filters enable you to view only the data you need in a report. When you 
apply a simple filter, all you do is select values for a variable in the report. 

Complex filters enable you to display values that satisfy conditions. You define a 
complex filter by writing a formula.

For more information on using the Formula Editor to write formulas, see Chapter 
14 "Formulas, Local Variables & Functions" on page 313.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Only display stores with weekly revenue over $200 000

You publish a weekly report on sales revenue per store but only want to show the 
results of your better performing outlets.

To do this, you define a complex filter that displays only those stores whose 
revenue is equal to or over $200,000. To do this, you write a formula that states 
that revenue must be greater than or equal to $20,000. The syntax is as follows:

 =(<Revenue>>=20000)

Each week, when you refresh your report with the new sales data, only those 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
stores with a revenue over $200,000 will be listed in the table.

Inserting a complex filter

1. Click inside the section or block that displays the data you want to filter.

2. Click the Filters command on the Format menu.

3. In the Filters dialog box that appears, click a folder in the Filters On box:
• To apply the filter on the whole report, click Global.
• To apply the filter on a specific block, click the folder with that block's 

name.

4. Click Add. 
The Variable(s) to Filter dialog box appears. 



Chapter 12 Organizing Data in Reports

264   BusinessObjects User’s Guide

5. Click the variable you want to filter, then click OK. 

6. Click Define.
The Formula Editor opens.

7. Type the formula in the Formula box, or double-click the function(s), 
variable(s) or operator(s) you need.

8. Click OK to return to the Filters dialog box. 

9. If you wish, deselect values for the variable in the Values box. 
The filter will only be applied on the remaining selected values.

10. Click Apply or OK.
A complex filter is identified by an asterisk next to the filter symbol.

 Editing a complex filter

1. Click inside the block which contains the filtered data.

2. Click the Filters command on the Format menu.

3. In the Filters On box, click the filter you want to edit, then click Define.

4. Edit the filter's formula in the Formula box, then click OK.

5. If you wish, deselect values for the variable in the Values box. The filter will 
only be applied on the remaining selected values. 

6. Click Apply or OK.

Note: If there is a syntax error in the formula you enter, an error message appears. 
Click OK to return to the formula. BUSINESSOBJECTS automatically selects the 
incorrect part of the syntax. Correct the error and click OK. You cannot use the 
formula if it contains an error.

Ignoring filters
You can force BUSINESSOBJECTS to ignore any filters you have inserted on a report 
so that when you make a calculation, the calculation is made on all the data, not 
just the filtered values. To do this, you use the NoFilter function. The syntax is:

=NoFilter(formula)

Complex Filter
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The example below shows how this works.

A filter is inserted on the City column so that only the data for New York and 
Washington is displayed.

In the first table, the sum displayed has only calculated the data for the filtered 
values, New York and Washington. The formula to calculate this sum is:

=Sum(<SalesRevenue>)

In the second table, the Nofilter function has been used and the sum displayed 
has calculated the data for all the values of City. The formula to calculate this sum 
is:

=NoFilter (Sum(<SalesRevenue>))

Notice the difference in the two sums.
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Ordering Data

You can change the order in which data appears in rows and columns by 
applying a sort on the data. For example, you can sort a column of city names to 
have the cities appear in alphabetical order. You can apply a sort on text, dates or 
numbers. 

Sorting data
There are three types of sorts which you can apply using the Sorts toolbar. To 
display the Sorts toolbar:

• Click the Sorts button on the Report toolbar

There are three types of sorts on the Sorts toolbar:

Note: The default order of appearance of all types of data is ascending.

Text Numbers Dates

Ascending order A-Z lowest to 
highest

past to present

Descending order Z-A highest to 
lowest

present to past

Custom sort You can use a custom sort to order days and months in 
chronological order.
You can customize sorts by placing values in the order 
you want.

a b 

a. Ascending sort

b. Descending order

c. Custom sortc 
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Applying a sort on report data

1. Click the cell, column, row or chart element containing the data you want to 
sort. 

2. Click the toolbar button for the sort you want to apply. 
The data appears in order, and the button you clicked remains pushed, to 
show that the data has been sorted.

Inverting a sort 

1. Click the data you have already sorted

2. Click one of the sort buttons on the toolbar.  
For example, if you want to invert an ascending sort, click the Descending Sort 
button.

Removing a sort
The Sort buttons work as toggle buttons turning sorts on and off, so to remove a 
sort:

1. Click the data you have already sorted.

2. Click the button you used to apply the sort.
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Applying a custom sort

1. Click the cell, column, row or chart element where the data you want to sort 
is displayed. 

2. Click the Custom Sort button on the toolbar. 
The Custom Sort dialog box opens.

3. Either
• Choose an option from the Sort Option list box: 

Default Sorts the values in the order they were in when 
the Custom Sort dialog box appeared. This 
option cancels the order you have specified but 
does not close the dialog box.

Alphanumeric Displays values in alphabetical or numerical 
order.

Month Displays the months of the year in chronological, 
not alphabetical, order. Only applicable for a 
variable that returns the months of the year.

Day Displays the days of the week in chronological, 
not alphabetical, order. Only applicable for a 
variable that returns the days of the week.
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or
•  drag and drop the values in the list into the desired order
• use the Move Up and Move Down buttons to place the values in the 

desired order

4. Click OK to close the Custom Sort dialog box.

Note: You cannot use custom sorts and alerters. For example, if you set up an 
alerter to highlight months greater than May, BUSINESSOBJECTS will use the 
alphabetical sort order instead of the chronological sort order.

The following example shows a table that has two custom sorts.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example How can I get months to sort correctly?

In this table the months have been sorted to display in chronological order and 
the product lines have been manually sorted.

By default, BUSINESSOBJECTS sorts months in alphabetical order. To sort months 
correctly in chronological order:

1. Click in the column or row that displays the months.

2. Click the Custom Sort button on the Sorts toolbar.
The Custom Sort dialog box opens.

3. Choose Month from the Sort Option list box and click OK.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Your months are sorted correctly.

Reminder: Months and days are sorted according to the Regional Settings made 
in the Windows Control Panel. See “Regional settings” on page 193 for more 
information on checking these settings.
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Managing multiple sorts
You can apply more than one sort on report data and specify the order in which 
you want to apply the sorts. The following example shows how this can be useful.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Sort customers by nationality and then by name in alphabetical order

In this table data is sorted first by applying an ascending sort to the country 
column so that the countries are displayed in alphabetical order and then by 
applying a secondary ascending sort to the customer column so that German 
customers are sorted by alphabetical order, then Japanese customers in 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
alphabetical order and so on.
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Define sort priority in a report
You can change the order in which sorts are applied.

1. Click inside the block or master cell containing sorted data.

2. Click the Sorts command on the Format menu.
The Sorts dialog box appears:

If your report contains a table or a 2-D chart, the dialog box contains one tab 
only. If your report contains a crosstab or a matrix chart, the dialog box has 
both tabs, Across Edge and Down Edge. The Down Edge tab displays the sorts 
applied to columns. The Across Edge tab displays the sorts applied to rows or 
on the Z-axis of the chart.

3. Click the tab you want to work in, then click the sort that you want to 
prioritize.

4. Click Move Up to give the sort higher priority, or Move Down to give it lower 
priority.
The sort icon moves up or down one place in the list of sorts.

5. Click OK or Apply.
The sort priority you defined is applied to the report.

Primary sort
The table is sorted by the 
Country of origin column 
first

Secondary sort
The table is then sorted by 
the Customer column
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Adding sorts from the sorts dialog box
You can add, remove and re-organize sorts in the Sorts dialog box.

1. Click inside a block or a master cell, then click the Sorts command on the 
Format menu.

2. Click the tab you want to work in.

3. Click Add.

4. Choose the variable to sort and click OK.
The new sort appears in the Current Sorts box.

5. Set the sort options you want to apply and click OK.

To remove a sort
• Click the Sort in the Current sorts list and click Remove.
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Using Ranking to View the Top and Bottom Values

You may only want to show the extreme ranges of the data. For example, you 
may want to determine your top ten customers.

Ranking enables you to look at the largest numbers and the smallest numbers in 
a report. Like filtering, it hides the data you do not want to display. The hidden 
data is not deleted from the report - you can view it again whenever you like by 
removing the ranking.

Ranking also sorts the data in descending order. Thus, the largest value of the 
ranking is always at the top of the ranked column and the smallest value at the 
bottom.

You can rank data contained in tables, crosstabs or master cells in master/detail 
reports.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Display only top three-selling product lines

In the example below, the table shows sales revenue for the product lines in the 
efashion retail chain. The table on the left shows revenue for all product lines. In 
the table on the right, the product lines column shows only the top three-selling 
lines.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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Applying a ranking on report data

To apply a ranking:

1. Click to select the data you want to rank. For example, if you want to rank the 
data for customers, click the column where this data appears.

2. Click the Apply Ranking button on the Report toolbar, or select the Ranking 
command on the Format menu.

3. The Select Top/Bottom Variable Name dialog box appears. It displays the 
options you can select for the ranking:
The options you can select are:
• Top 

Click this check box and type or select from the list for the largest n values. 
When you click the check box, a default value of 3 is selected.

• Bottom 
Click this check box and type or select from the list for the smallest n 
values. When you click the check box, a default value of 3 is selected.

• Based On 
Click to select the measure on which your ranking is to be based. This list 
includes all measures that you can select from the report. You must select 
a measure before the ranking can be applied.

Apply Ranking

The title of this dialog box depends on the 
data you select in the report. Here, data for 
Month was clicked, so the title is “Select Top/
Bottom Lines”.
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• In percentage of total number of values 
Click this check box if you want to interpret the numbers for Top and 
Bottom as percentages. When this option is selected a percent sign (%) 
appears at the Top and Bottom values. These numbers are truncated if 
necessary to fall in the percentage range of 1 to 100.

• Display Subtotals 
Click this check box to display the following calculations:

• Display Percentages 
Click this check box to display calculations as percentages in a new cell.

4. Click the ranking values you want to display in your report, then click OK (or 
Apply).
The report displays only ranked data for the values you selected. The Apply 
Ranking button on the toolbar is dimmed.

Ranking in master/detail reports
In master/detail reports, subtotals and percentages can only be shown for cells 
selected for ranking that are in the table. Master cells that have ranking applied 
will not display subtotals and percentages.

In master/detail reports, data is ranked for each section.

Ranking and breaks
In a table or crosstab in which breaks have been inserted, data is ranked 
separately for each break level.

Note: If you have created a local variable using values from different data 
providers, you will not be able to rank data based on this variable. The variable 
will not be displayed in the list in the Ranking dialog box.

Sum Shows the sum of all the rows displayed in the 
table after ranking has been set

Sum Other Shows the sum of all the rows which are not 
displayed in the table after ranking has been set

Sum All Shows the sum of all the rows in the table, those 
displayed and those hidden
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Show sales revenue for top three months and compare with overall revenue

This report displays the top three revenue-making months. It shows the 
combined revenue for September, January and March (Sum) and the total 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
revenue for the other nine months of the year (Sum Other).

Tip: To remove the ranking, click inside the ranked data, then click the Apply 
Ranking button.

Altering values for an existing ranking
Once you have defined a ranking by specifying the ranking values you want to 
display, you can edit it by selecting different ranking values. For example, if you 
have applied a ranking that enables you to view the top and bottom 3 ranking of 
revenue for customers, you can edit the ranking to show the top 10 instead.

To select different values for an existing ranking:

1. Click inside the data where the ranking was applied.

2. Select the Ranking command on the Format menu.
The Select Top/Bottom Variable Name dialog box appears, with the current 
ranking options selected.

3. Alter the ranking settings as desired, then click OK (or Apply). When you exit 
from the Dialog box, the values with the new ranking criteria are displayed.

Removing a ranking
When you remove a ranking, all the data on which you applied the ranking that 
may have been suppressed by the ranking criteria re-appears in the report. For 
example, if you applied a ranking that displays the top 10 customers by revenue, 
then you remove that ranking, the data for all customers is displayed.
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To remove a ranking, first click inside the data on which you applied the ranking. 
Then, you can:

• Click the dimmed Apply Ranking button on the Report toolbar.

• Select the Ranking command from the Format menu. Remove Top and 
Bottom check marks. Then click OK or Apply.

Managing ranking with filters and sorts
To rank data in a report, you must remove any sorts or filters currently applied 
to that data. If any sorts or filters exist when you try to apply a ranking, an 
Overwrite? message is displayed. Click Yes to remove the existing sort or filter 
and continue to apply ranking. Clicking No closes the ranking dialog and returns 
with no change.

Apply Ranking
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Hiding Columns and Rows of Data

You can hide columns or rows of data so that the data is not displayed in your 
table but still remains in the report.

1. Right-click inside the table or crosstab.

2. Choose Format Table or Format Crosstab from the menu.

3. Click the Pivot tab in the dialog box that appears.

The Pivot tab for tables and crosstabs

Hiding Data
• In the Used Variables box, click the variable you want to hide, then click Hide. 

• To hide more than one variable at the same time, hold down the Ctrl key, click 
the variables, then click Hide.

Hidden variables are grayed in the Used Variables box.

Showing Data
• To display a previously hidden variable, click it in the Used Variables list, then 

click Show.

Hidden variables are 
displayed in gray in the 
Used Variables list.
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Highlighting Data

You can highlight data in a BUSINESSOBJECTS report using Alerters. Alerters use 
special formatting to make data that fits certain conditions stand out from the rest 
of the data. This helps draw attention to trends and exceptions in report data.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Which sales representatives generate revenue over $500 000?

You want to identify excellent salespeople who generate revenue over $500 000, 
and poor salespeople who generate revenue below $50 000. 

You define a condition for your good salespeople: "Revenue > 500000" and define 
a format that will be applied for values that fit this condition: "Top salesperson" 
red.

You then define a condition for your not-so-good salespeople: "Revenue < 50000". 
and define a format that will be applied for values that fit this condition: "Work 
harder!" in green.

You insert an extra column after revenue and name it performance. You then 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
apply the alerter to the performance column.

Note: You cannot use alerters on charts.

Creating an alerter
There are 4 steps involved in creating an alerter:

1. Select the data you want to use.

2. Name and describe the Alerter.

3. Define the range of values.

4. Define how the Alerter will be displayed in the cell.

Once you have created an Alerter you can apply it, hide it or display it.
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Step 1: Select the data

1. In a report, click a cell, row or column of data. 

2. Click the Alerters command on the Format menu.

3. In the Alerters dialog box that appears, click Add.

Step 2: Name and describe the alerter

1. In the Name box in the Definition tab, type a name for the alerter. 

2. In the Description box, type a help text on the alerter to remind you and others 
what the Alerter is set to highlight.

3. Click the Conditions tab.
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Step 3: Set the conditions 

1. Choose a variable from the Variable to Compare listbox.

2. Choose an operator from the Operator 1 listbox.

• Type a value (number, character or date), or

• Click the down arrow button to the right of the Value 1 box, then click the 
Variables command, or the List of Values command. Select a variable or a 
value.

3. If operator 1 requires the use of a second operator, click the operator to use in 
the Operator 2 box.

4. Click inside the Value 2 box and repeat step 2.

Step 4: Set the formatting
Specify different formats for each range, using fonts, colors and borders, for 
example. Or you can enter a text or select a variable that will mask the data that 
satisfies the conditions you set.

1. Click the arrow next to the Cell Content box.
A popup menu appears.

2. To have the alerter display text, click Text.

3. Type the text, then click OK. 

4. To have the alerter display a variable or a formula, click Variables.

5. To format the cell contents, click Format.
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6. In the Cell Format box, format the text, then click OK.

7. Click OK to return to the Edit Alerters dialog box.

Switching alerters off and on
Once you have created alerters, you can apply or deactivate them whenever you 
like. For example, you can create an alerter, apply it to a report, print the report, 
then deactivate the alerter. In this case, the alerter appears on the printed report, 
but no longer appears on your screen. 

Turn an alerter on

1. Click the cell, column or row where you want to display the alerter.

2. Click the Alerters command on the Format menu.

3. Click the check box next to the alerter that you want to activate. 

4. Click Apply or OK.

Turn an alerter off

1. Click the cell, column or row where the alerter is displayed.

2. Click the Alerters command on the Format menu.

3. Click the check box next to the alerter that you want to deactivate. 
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4. Click Apply or OK.

Display or hide all alerters in the current report
You can also display or hide all alerters that you have applied to the current 
report.

1. Click the Options command on the Tools menu. 

2. Click the Display tab. 

3. In the Report Options box, click Alerters. 
If this option is already checked and you want to hide the alerters in your 
report, click it again to remove the check.

4. Click OK to apply the option and to close the dialog box.

Working on existing alerters
Once you have created an alerter, you can use it as the basis for other new alerters. 
You copy the existing alerter, then modify its conditions and their corresponding 
formats.

Copy an alerter

1. Click the Alerters command on the Format menu.

2. Click the alerter you want to copy. 

3. Click Copy.
The Edit Alerters dialog box appears. 
In the Definition tab, the name of the initial alerter appears in the Name box 
followed by no2. If you renamed your first alerter so it no longer has the 
variable name, the name given to the copy is the variable name with nothing 
added.

4. Type a new name and description for the new alerter.

5. In the Conditions tab, define the first range of values for the alerter.

6. Define the way the result appears in the cell.

7. Repeat Step 5 and Step 6 to define a second range of values if you wish, then 
click Apply or OK. 
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 Edit an alerter

1. Click the Alerters command on the Format menu.

2. Click the alerter you want to edit. 

3. Click Edit.

4. Change the definition of the alerter. 

5. Click Apply or OK.

 Delete an alerter

1. Click the Alerters command on the Format menu.

2. Click the alerter you want to delete.

3. Click Remove.
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Overview

This chapter explains how to break up the data in tables and crosstabs and how 
to make and display simple calculations in tables and crosstabs. The final section 
of this chapter describes all you need to know about converting currencies to and 
from euros in BUSINESSOBJECTS

The following chapters give further information on using calculations in 
BUSINESSOBJECTS:

• Chapter 14 "Formulas, Local Variables & Functions" on page 313 explains how 
you can use the power of the BUSINESSOBJECTS formula editor to write your 
own calculations.

• Chapter 15 "Calculation Contexts and Extended Syntax" on page 341 explains 
the more sophisticated aspects of writing formulas and gives some 
background about how the BUSINESSOBJECTS calculation engine works.

• Chapter 16 "Calculation Troubleshooting" on page 373 explains the error 
messages and other problems you may encounter when inserting formulas 
and calculations in your reports and explains how to fix these problems.

• For information on using calculations in charts, see “Displaying a Calculation 
on Data in Charts” on page 456.
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Breaks
This section explains how to break up data in tables and crosstabs and describes 
the different options available to format and manage these breaks.

What is a break?
A break does what its name implies. It breaks up the data in a table or crosstab by 
grouping the data according to a selected value. This allows you to display all the 
data for each value of a dimension variable together, and more importantly, it 
allows you to display subtotals. The example below demonstrates how breaking 
up a table works.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example How can I show revenue subtotals for each resort in a table?

The table on the left displays the revenue per quarter per resort with the total 
revenue displayed at the bottom of the table. 

The table on the right displays the same data but, by breaking up the data by 
resort, you can now show a subtotal for the revenue generated by each resort for 
the four quarters of the financial year. A mini table is created for each of the three 
values of resort. This separation, however, is only visual. The three mini tables 
still belong to one block.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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Inserting and removing breaks
You can insert and remove breaks with a simple mouse click. The Insert Break 
button on the Report toolbar is a toggle button that inserts and removes breaks 
on data.

To insert a break:

1. Click inside the column or row of data where you want to insert a break.

2. Click the Insert Break button on the Report toolbar.
The data in the table is broken up and the Insert Break button is dimmed.

To remove a break:

1. Click inside the data where the break has been inserted.
The Insert Break button on the Report toolbar is dimmed to show that there is 
a break on the selected data.

2. Click the Insert Break button.
The Break is removed from the table or crosstab.

Note: You cannot insert breaks on data in charts. 

Formatting breaks
When you first insert a break on data, certain formatting and display options are 
applied by default. You can edit these settings and set other options in the Breaks 
dialog box.

To display the Breaks dialog box:

1. Right-click on the column or row where the break has been inserted.

2. Choose Format Breaks from the menu. 
The Breaks dialog box is illustrated and described on page 290.

Note: If no break has been inserted on a table or crosstab, all the options in this 
dialog box are unavailable.

Insert Break
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Breaks dialog box

Showing headers and footers
When you insert a break, a mini table is created for each value of the variable. You 
can choose whether or not you want to display a header and/or footer in each 
mini table. 

a. The breaks applied on columns appear in the Down tab. The breaks inserted on rows 
appear in the Across tab. For a crosstab, both tabs are displayed. For a table, only the 
appropriate Down or Across tab is displayed.

b. List of breaks currently inserted.

c. Allows you to insert a new break.

d. Remove a break by selecting it, then clicking Remove.

e. You can set break attributes for the selected break in the Break Definition box.

f. By default, a break is inserted on all values of the selected variable. Clicking Values allows 
you to select only the values you want to include in the break. To activate the Values 
button, first check the Value-Based Break check box.

g. You can control the way a break is managed over page breaks in the Break and Pages 
box. These attributes are described on page 297.

h. Clicking Edit allows you to apply the selected break on a different variable, or on more 
than one variable. If the report contains at least two breaks on different levels, you 
change the break level.

e

a

c

d

g

h

f

b
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To do this:

• To display a break header or footer, check the box next to Break Header or Break 
Footer in the Breaks dialog box.

• To hide a break header or footer, uncheck the box next to Break Header or Break 
Footer in the Breaks dialog box.

The illustration below shows two examples of using break headers and footers 
with a sum calculation on the Revenue column :

Break header

Break footer 
displays the 
sub-total for 
each section 

This table displays a break footer only, a table 
header and footer, and a sum calculation.

This table displays a break header and footer, 
a table footer, and a sum calculation.

Table footer 
displays the total 
for the table
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Folding breaks
You can also choose to display only the break headers and footers in a table as 
shown in the illustration below. The other rows in the table are hidden.

To do this:

• Check the Fold option in the Breaks dialog box.
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Merging cells
When you have inserted a break on a row or column, you have several columns 
or rows displaying the same value. If you wish, you can display this value only 
once. To do this:

• Check Remove Duplicates on the Breaks dialog box.

You can also merge these cells into one and display the name only once. The 
name is centered over the columns or rows of data that it describes. To do this:

• Check Center Value Across Break on the Breaks dialog box.

The examples below show how these options are applied:

You can also use the Center Across Break button on the Formatting toolbar. This 
button removes duplicate values, merges the cells and centers the value over the 
rows or columns it describes.

Here, the Remove Duplicates option is turned 
on so the resort name is displayed only once. Here, the Remove Duplicates and Center Value Across 

Break options are turned on. The resort name is dis-
played once and centered over the rows it describes.

Center Across 
Break
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Tip: If the Resort column footer cell is empty when you center the resort value 
across the break, all rows, including the footer row are merged as shown in the 
table on the left below. If you do not want an empty footer cell to be merged:

1. Type a character in the empty resort footer cell.

2. Right-click on the footer cell and choose Format Cell from the menu.
The Format Cell dialog box opens.

3. Click the Font tab.

4. Set the font color to the same color as the cell background, in this example to 
white, and click OK.

5. Check the Center Values Across Break option in the Breaks dialog box.
The empty cells for each value of resort are merged and the footer cells are 
untouched, as shown in the table on the right below.

Type a 
character 
in this cell 
and set the 
font color 
to white.
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Making a value-based break
You can choose to only apply a break on certain values in your table. In the 
illustration below, instead of inserting a break on the whole resort column, the 
break is inserted on the resort French Riviera only. This breaks up the table to 
show a revenue subtotal for French resorts as illustrated below:

To do this, begin with a table with the Format Table, Show Header and Show 
Footer options turned on:

1. Insert a break on the Resort column.

2. Right-click on the Resort column and choose Format Breaks from the menu.
The Breaks dialog box opens.

3. Check the Value-Based Break check box.
When this box is checked, the Values button becomes available.

4. Click the Values button.
The list of values box opens, displaying a list of all the values of the Resort 
dimension.

5. Select French Riviera from the list and click OK.

6. Click OK again to close the Breaks dialog box.

7. Right click the Revenue column and select Calculations > Sum.
The calculation result sums the French Riviera section and the entire table.

The break footer 
displays the subtotal 
on the value-based 
break

This table footer 
displays the total for 
the entire table -- not  
the remaining sections.

Here, the Break Footer, Remove Duplicates, and 
Value-Based Break options are turned on. The Show 
Table Header and Footer options display the table 
header and the table sum.
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Organizing multiple breaks
You can insert up to nine breaks on a table or crosstab.

When you have more than one break in a table or crosstab, the breaks are 
assigned levels. BUSINESSOBJECTS assigns level 1 to the first break you insert, level 
2 to the second and so on. You can rearrange these levels in the Breaks dialog box. 
You can also set different options for the different breaks.

In the illustration below, there are two breaks on the data. One on the Resort 
dimension and one on the Quarter dimension. As you can see, the data is broken 
up first by resort with information for all four quarters displayed for French 
Riviera, then for Bahamas Beach and so on. The data in each resort section is then 
broken up by quarter. You can change this organization at any time and add and 
remove breaks in the Breaks dialog box.

To reorganize the order in which breaks are applied:

1. Right-click on a column or row that contains a break and choose Format 
Breaks from the menu.
The Breaks dialog box opens.

2. Click on the break name in the list and click the Edit button.

3. Set the order you want the break to be applied and click OK.

List of breaks 
inserted in the 
selected table 
and the order 
in which they 
are applied.

Sets the order the break is 
applied.
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Managing breaks over multiple pages
When a table spans more than one page, there are certain options you can set to 
make sure that tables are not split incoherently and so that certain elements such 
as column and row headers are repeated on the new page.You can set the 
following options in the Break and Pages section of the Breaks dialog box.

To open the Breaks dialog box:

• Right-click on a row or column that contains a break and choose Format 
Breaks from the menu.

Check this option..... To.....

Avoid Page Break Where possible, keep each break section of the 
table or crosstab on the same page.

Start a New Page Display each part of the table or crosstab created 
by a break on a separate page.

Repeat the Header on 
the New Page

Repeat the header on each new page if a table or 
crosstab extends over more than one page.

Repeat Break Value on 
New Page

Repeat the current break value on the new page.
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Calculations

BUSINESSOBJECTS has standard calculation functions that enable you to make 
quick calculations on the data in reports. These calculations are available directly 
from a menu. The most commonly used calculations are also available on the 
Report toolbar. This section describes how to make calculations using the menu 
and toolbar functions. 

You can also make calculations by writing your own formulas. This is described 
in Chapter 14 "Formulas, Local Variables & Functions" on page 313. 

Making simple calculations

1. Select the row or column on which you want to make the calculation.

2. From the Data Menu, choose Calculations and then the type of calculation:

Choose... To...

Sum Calculate the sum of the selected data.

Count Count all rows for a Measure object.
Count distinct values for a Dimension or Detail object.

Count All Count the number of rows in the body including all 
duplicate and empty rows

Average Calculate the average of the selected data.

Maximum Display the maximum value of the selected data.

Minimum Display the minimum value of the selected data.

Percentage Display the selected data as a percentage.

Variance Calculate the difference between two selected values.
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The result of the calculation is inserted in a new cell in the table or crosstab.

Note: Note: Variance syntax containing the Where operator will work in all cases 
except when you have two cascading Wheres (a variance using a Where operator 
that contains a formula that also uses a Where operator) or in certain contexts, e.g. 
the variance of the variable "<Revenue>" in Report.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example What’s the difference between Count and Count All?

In the example below, if you insert a Count on the Resort column, the result of the 
calculation is 3 because there are three different resorts, Bahamas Beach, 
Hawaiian Club and French Riviera. The Count function counts values of a 
dimension object that are the same only one time. This is called a distinct count. 

If you insert Count All on the same column, the result is 12 because there are 
twelve rows of data in the resort column. The Count All function counts all rows 
including empty and duplicate rows.

If you look at the Revenue column, Count and Count All return 12. For a measure 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
object, the Count function counts all rows.

Variance 
percentage 

Calculate the difference between two selected values and 
display the difference as a percentage.

Choose... To...
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Using the Calculation toolbar
You can also use the buttons on the Report toolbar for certain calculations.

Removing calculations from a table or a crosstab
To delete calculations from a table or crosstab:

1. Select the row or column where the calculation is displayed.

2. From the Data Menu, choose Calculations and then the calculation that has 
been applied from the submenu.
You can see which calculations have been applied to a row or column of data. 
On the Data menu, the icon next to the calculation is dimmed or has a check 
mark next to it to show it has been used. Buttons on the toolbar are dimmed 
to show they have been used on the selected data.

Note: The calculation commands available on the menu and toolbar depend on 
the data you have selected in the table or crosstab.

Making calculations on dimension and detail objects
You can use the following calculations on dimension and detail objects:

• Count

• Minimum

• Maximum

a. Sum

b. Percentage

c. Count

d. Variance

e. Variance percentage

a b c d e

Dimension object

Detail object
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Calculation examples
The following section contains several examples of making calculations using the 
Calculations menu.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Displaying total revenue and subtotals

You want to calculate and display the total revenue in a table. To do this:

1. Click in the Revenue column.

2. Click the Sum button on the Calculations toolbar.
• The revenue sum is displayed in the footer at the end of the table.
• The sum button on the Calculations toolbar is dimmed.

You now decide you want to insert a break on this table to display subtotals for 
each resort. 

3. Click inside the Resort column and click the Insert Break button.
The data is broken up and an empty row is inserted at the end of each resort 
section.

4. Click in the Revenue column.

5. Click the Sum button once to remove the existing calculation.

Sum

Sum button 
dimmed

Insert Break
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6. Click the Sum button again to carry out a new calculation.
A subtotal is displayed for each resort and a total sum at the end of the table:

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Displaying average, maximum and minimum revenue

The following table has four different calculations for revenue. Notice that the 
Average revenue, the Maximum and Minimum revenues and the Sum are all 
displayed in separate rows in the order they were applied. Each figure is 
identified by the name of the calculation. A new column has been inserted to 
show the percentage for each row.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

A subtotal is displayed 
for revenue per resort

A total is displayed for 
revenue for all resorts
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Calculating the difference in revenue between two quarters

In this example you have a crosstab that displays revenue per resort per quarter 
and total revenue per quarter. You want to show in the table the difference in 
revenue between two quarters. To do this:

1. Select Q2 with the mouse, then, holding down the Ctrl key, select Q1.

2. Click the Variance Percentage button on the calculations toolbar.
The difference in revenue between Q1 and Q2 for each resort and for the total 
revenue of all resorts is displayed in a new cell as a percentage. The new row 
is labeled Q2-Q1.

3. Now select Q4 with the mouse.

4. Holding down the Control key, select Q3.
The difference in revenue between Q4 and Q3 for each resort and for the total 
revenue of all resorts is displayed in a new cell as a percentage. The new row 
is labeled Q4-Q3.

Note: You can also use the Shift key to select columns and rows. If you use the 
Shift key, BUSINESSOBJECTS does not take into account the order in which you 
selected the columns and rows and always selects cells from top to bottom and 
from left to right. If you carry out the calculation above using the Shift key, 
BUSINESSOBJECTS will calculate Q1-Q2.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Q2 is selected first. Then Q1.

Variance Percentage

The result of Q2-Q1 
is displayed in a 
new row.



Chapter 13 Breaking Up Tables and Displaying Calculations

304   BusinessObjects User’s Guide

Reusing a calculation elsewhere in a report
You can drag a calculation from a table or a crosstab and place it in a different 
position in a report. BUSINESSOBJECTS keeps the formula with the cell. To do this:

1. Click inside the cell containing the calculation.

2. Click inside the cell again and, holding down your mouse button, drag the cell 
to the desired position.

3. Release the mouse button.

Note: When you move a cell containing a calculation to a different part of the 
report, the calculation result depends on where exactly the cell is positioned as 
this can change the context in which the calculation is made. For more 
information on this point see “What are calculation contexts?” on page 345.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Displaying total revenue as a table title

In this report you dragged the cell containing the sum of the total revenue for all 
resorts out of the table and placed it at the top of the table. You inserted a cell next 
to the figure and typed in the text “Total revenue”. You then deleted the rows for 
Sum total and Maximum total at the very bottom of the table.
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Converting To And From Euros

The following section describes how BUSINESSOBJECTS uses built-in functions to 
help you quickly and accurately convert a currency to or from euros.

What is the euro?
The euro is the official currency unit of the European countries that belong to the 
EMU (European Monetary Union).

For each of these countries, a six-digit conversion rate between the euro and the 
national currency has been fixed and EMU regulations stipulate how the 
conversion must be carried out.

BUSINESSOBJECTS euro conversion functions adhere to these stipulations.

Displaying the euro symbol
The euro is designated by an official symbol. To display this currency symbol in 
BUSINESSOBJECTS, you need to have a Windows operating system that can display 
it or you need to install a euro font upgrade to your Windows operating system.

If your operating system cannot display the euro symbol, you can use the official 
ISO three-letter code, EUR, instead.

How does the conversion work?
For each currency, there is a fixed conversion rate of six significant digits. The 
number of digits after the decimal point depends on the number of digits before 
the decimal point.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Converting to euros: six-digit conversion rates

The conversion rate for Dutch guilders (NLG) is 2.20371, with 1 digit before the 
decimal and five after.

The conversion rate for Belgian francs (BEF) is 40.3399, with 2 digits before the 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
decimal point and four after.

To convert to euros from an EMU-compliant currency, you divide the local 
currency amount using the six-digit conversion rate for that currency and then 
round the result to display the appropriate number of decimal digits.

euro currency 
symbol
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To convert from euros to an EMU-compliant currency, you multiply the amount 
in euros by the six-digit conversion rate for the target currency and then round 
the result to display the appropriate number of decimal digits.

Conversion Errors
When you convert an EMU-compliant currency to or from euros, you use the 
fixed six-digit conversion rate and then round the result to the appropriate 
number of decimal digits. Rounded numbers are less accurate than the original 
numbers and the round error on a given amount may be fairly negligible or quite 
substantial. BUSINESSOBJECTS allows you to display round errors after you have 
converted amounts to and from euros to assess the importance of the difference.

Displaying currency formats in BUSINESSOBJECTS

BUSINESSOBJECTS uses the default currency defined for your operating system 
defined in the Windows Regional Settings in the Windows Control Panel.

You can display custom currencies in your BUSINESSOBJECTS reports in addition 
to the default currency provided by your operating system. For example, if your 
default currency is $, all the amounts in your report will be in US dollars. If you 
also want to display a column with revenue in euros, you can add your own 
currency format in BUSINESSOBJECTS. See “Creating your own number and date 
formats” on page 547 for details.

Converting to euros
You can convert an amount from one of the eleven EMU currencies into euros 
using one easy mouse click.

To do this:

1. Select the column, row or cell that contains the data you want to convert.

2. From the Data menu, choose Euro, then Convert To Euro.
• If BUSINESSOBJECTS recognizes the currency, it carries out the conversion 

and displays the result.
• If BUSINESSOBJECTS does not recognize the currency, it displays the Select 

Currency dialog box.

3. Choose the currency from the list box and click OK.
The data is converted. If the source data was formatted as currency, the 
converted data is formatted with the euro currency formatting defined in the 
Conversion Rates table.
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How does BusinessObjects recognize the currency of the selected 
data?
BUSINESSOBJECTS recognizes the currency of selected data if:

• it is formatted as currency using the standard Windows currency symbol

• and the selected currency is in the Conversion Rates list

For example, 47 DM will be recognized by BUSINESSOBJECTS as German marks.

If the data is not formatted as a currency BUSINESSOBJECTS recognizes, the Select 
Currency dialog box is displayed.

If the currency you want to convert to euros is not in the list, you can add it as 
described below.

Converting from euros
You can convert a figure from euros into one of the eleven EMU currencies using 
one easy mouse click.

To do this:

1. Select the column, row or cell that contains the data you want to convert.

2. From the Data menu, choose Euro, then Convert From Euro.
The Select Currency dialog box opens.

3. Choose the currency you want to convert the euros to and click OK.
The data is converted. If the data in euros was formatted as currency, the 
converted data is formatted with the currency formatting defined in the 
Conversion Rates table.

Displaying rounding errors
A rounding error occurs because when an amount is converted to or from euros, 
the result is rounded to show only the appropriate number of decimal digits. The 
rounding error returns the difference between the rounded number and the 
number before rounding.
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To display round errors:

1. Select the column, row or cell that contains the converted data.

2. From the Data menu, choose Display Rounding Errors.
The rounding errors are displayed in a new column, row or cell which is 
inserted after the selected column, row or cell.

Note: The Display Rounding Errors command is only available if the selected cell 
contains a number that has been converted to or from euros.

Conversion rates
BUSINESSOBJECTS stores the conversion rates and other information for the EMU 
currencies and uses this information to carry out conversions to and from euros. 
You can edit this information and add other currencies to this list.

Viewing conversion rates

1. From the Data menu, choose Euro, then Display Conversion Rates.
The Conversion Rates dialog box opens. 

This dialog box shows the following information about each currency:

Currency Shows the official ISO (International Standards 
Organization) label for the currency.

Rate Shows the official 6-digit conversion rate between the 
currency and the euro.
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Editing information about a currency

1. From the Data menu, choose Euro, then Display Conversion Rates.

2. The Conversion Rates dialog box opens.

3. Select the currency you want to edit from the list.

4. Click the Edit button.
The Edit Conversion Rate dialog box opens.

This dialog box displays the information that BUSINESSOBJECTS currently uses 
for the selected currency.

5. Make any necessary changes by typing in the new information over the old 
information in the text boxes.

6. Click OK when you have finished.
The Edit Conversion Rate dialog box closes.
The new information concerning the selected currency is now displayed in the 
list in the Conversion Rates dialog box.

7. Click OK to close the Conversion Rates dialog box.

Decimal Shows the number of decimal digits used by each 
currency.

Format Shows the symbol or abbreviation used to designate 
the currency.

Label Shows the name of the currency in the local language.
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Adding a new currency

1. From the Data menu, choose Euro, then Display Conversion Rates.
The Conversion Rates dialog box opens.

2. Click the Add button.
The Add Conversion Rate dialog box opens.

3. Enter the required information in each text box
You must enter information in each text box.

4. Click OK.
The Add Conversion Rate dialog box closes.
The new currency is now displayed in the list in the Conversion Rates dialog 
box.

5. Click OK to close the Conversion Rates dialog box.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Add US dollars to the euro conversion list

You want to add US dollars to the list of currencies since you regularly use dollar 
to euro conversion in your business. You have today's dollar/euro exchange rate. 
Since the price of the dollar against the euro fluctuates daily, you will have to 
update dollar currency information regularly.

To add US dollars to the currency list:

1. From the Data menu, choose Euro, then Display Conversion Rates.
The Conversion Rates dialog box opens.

2. Click the Add button.
The Add Conversion Rate dialog box opens.

3. Enter the information in the Add Conversion Rate dialog box:
• Enter USD in the Currency box.
• Enter 0.9 in the Rate box
• Enter 2 in the Decimal box.
• Enter $ in the Format box.
• Enter US Dollars in the Label box.
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4. Click OK.

US dollars now appears in your list and will be recognized by BUSINESSOBJECTS 
so that you can convert between US dollars and euros using the Convert to Euro 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
and Convert from Euro menu commands.

Fixed and fluctuating currency rates
The conversion rates between the euro and EMU-compliant currencies are fixed. 
When converting euros to any other currency you must use the daily rate set by 
financial institutions.

Triangulation
If you want to convert from one EMU-compliant currency to another EMU-
compliant currency, you cannot simply use cross rates. You have to use a 
procedure called triangulation. To triangulate, you convert the first currency into 
euros using a six-digit conversion rate and then convert the euros into the second 
currency using another six-digit conversion rate.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Triangulation: Converting between EMU-compliant currencies

In the following example, you want to convert an amount in German marks into 
Belgian francs. To do this, you first have to convert the German marks into euros 
using the six-digit conversion rate for German marks. You then round the euros 
to no less than three decimal digits. Finally you convert the euros into Belgian 
francs using the six-digit conversion rate for Belgian francs. You can carry out this 
conversion by writing a BUSINESSOBJECTS formula.

The following BUSINESSOBJECTS formula converts 100 DEM to 2063 BEF.
EuroConvertFrom(EuroConvertTo(100, "DEM", 3), "BEF", 0)

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .



Chapter 13 Breaking Up Tables and Displaying Calculations

312   BusinessObjects User’s Guide



  BusinessObjects User’s Guide   313

  Chapter 14 Formulas, Local Variables 
& Functions

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

In this chapter 

 ❑ Overview 315

 ❑ Formulas 316
 Why use formulas? 316
 Creating formulas 317
 Displaying the Formula Bar 317
 Displaying the Formula Editor 318
 Using the Formula Editor 318
 Guidelines on the syntax to use in formulas 320

 ❑ Local Variables 321
 Why use local variables? 321
 How can I recognize a local variable? 321
 Creating a local variable 322
 Transforming a formula into a local variable 323

 ❑ Creating Local Variables by Grouping Values 325
 Grouping values 325
 Adding grouped values to a drill hierarchy 329



Chapter 14 Formulas, Local Variables & Functions

314   BusinessObjects User’s Guide

 ❑ Managing Formulas and Local Variables 330
 Inserting local variables and formulas in a report 330
 Editing formulas 330
 Editing local variables 330
 Deleting formulas and local variables 331

 ❑ Functions 332
 Using Functions 332
 Using the Function Help 334

 ❑ More Examples of Using Formulas 335

 ❑ 



 Overview

  BusinessObjects User’s Guide   315

Overview

This chapter gives you an introduction to using BUSINESSOBJECTS formulas, local 
variables and functions. It explains how to set up your own formulas and 
variables in BUSINESSOBJECTS reports using BUSINESSOBJECTS syntax, how to use 
BUSINESSOBJECTS functions, and also includes several examples of business 
calculations.

Chapter 15 "Calculation Contexts and Extended Syntax" on page 341 describes 
how to build more powerful calculations by using extended syntax to define 
calculation contexts. This chapter also has a calculations “Quick Reference” on 
page 369 that recaps some of the key BUSINESSOBJECTS terms.

Chapter 16 "Calculation Troubleshooting" on page 373 gives solutions to 
computation errors that may occur in BUSINESSOBJECTS when you are writing or 
using formulas.
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Formulas

When you run a query, BUSINESSOBJECTS carries out certain calculations on the 
data at the query level and returns the results as variables. You can also make 
calculations on report data using the built-in calculations available on the 
calculations menu or toolbar. This section explains how you can set up your own 
personalized calculations on data in your reports by writing BUSINESSOBJECTS 
formulas.

Why use formulas?
A BUSINESSOBJECTS formula is made up of functions, variables, and operators and 
always begins with an “equal to” sign. The examples below show two very 
simple formulas:

=Sum<Sales Revenue>

=<Margin>/<Sales revenue>*100%

Formulas are used to carry out calculations locally in the report and also allow 
you to set conditions on filters and data display, for example.

Making local calculations
You may want to carry out personal calculations in your reports or compare 
database figures to figures from a spreadsheet for example. Writing a formula 
allows you to do this.

In addition, there are certain types of calculation that some SQL servers cannot 
carry out. For example, standard SQL does not allow you to use decision logic 
such as the IF statement.

Setting conditions
You can also use formulas in BUSINESSOBJECTS to set conditions. For example, you 
can set up a condition to hide sections in a report if the sales revenue falls below 
a certain level.

You can also set up conditional filters. For example, you only want to display 
outlets in a report that have generated weekly revenue above a certain sum. By 
setting a filter with a condition, when you refresh the report with the new weekly 
data, only those outlets that satisfy the condition will be displayed in the report.

You can also use conditions in BROADCAST AGENT when you are setting up 
reports for scheduled processing to specify under what conditions your 
documents should be processed.



 Formulas

  BusinessObjects User’s Guide   317

Creating formulas
Let's look now at how you create formulas in BUSINESSOBJECTS. There are three 
ways of creating formulas. You can:

• type your formula directly into a cell

• type your formula in the Formula Bar

• use the Formula Editor

Displaying the Formula Bar
Once you are familiar with BUSINESSOBJECTS syntax you can type simple formulas 
directly into a cell or into the Formula Bar. Using the Formula Bar allows you to 
see more clearly what you are doing as the whole formula is displayed more 
easily than in a cell. If the Formula Bar is not displayed:

• From the View menu, choose Formula Bar.

The Formula Bar has five buttons and a text box where the formula is displayed. 
If you click inside any cell in a report, the contents are displayed in this text box. 
Depending on the type of cell you clicked in, this could be text, the name of a 
variable or a formula.

a b c d e

a. Opens the Variable Editor

b. Defines the formula displayed in the Formula Bar as a variable

c. Clears the Formula Bar text box of any non-validated changes you 
make in the Formula Bar 

d. Validates the formula displayed in the text box

e. Opens the Formula Editor
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Displaying the Formula Editor
If you are not familiar with BUSINESSOBJECTS syntax or are writing more complex 
formulas, the best method is to use the Formula Editor.

1. Click inside the cell where you want the formula to appear.

2. Then
• If the Formula Bar is open, click the Formula Editor button on the Formula 

Bar.
• Or, from the Data menu, choose Edit Formula.
The Formula Editor opens.

Using the Formula Editor
The Formula Editor allows you to make up your formula by choosing Variables, 
Functions and Operators directly from the lists.

The Formula Editor has four main parts:

Formulas box

Displays the formula. You use this box to write or edit formulas.

Click here for explanations 
on the functions in the 
Function list.
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Variables box

Displays a list of all the variables in the document, these can be local variables or 
variables returned by the data provider; you can include these variables in your 
formula.

Functions

Displays a list of all BUSINESSOBJECTS functions.

Operators

Operators define the relationship between elements in a formula. Operators 
include mathematical operators such as addition (+) and division (/), relational 
operators such as greater than (>) and between, logical operators such as If Then 
Else and context operators such as ForAll, ForEach and In. The list of operators in 
this window is updated as you add elements to the formula so that only the 
operators that are compatible with the current syntax are displayed.

To understand how the Formula Editor works, let's look at an example.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Calculating a running total

In the table below you want to display a running total for the monthly sales 
revenue.

To do this:

1. Insert a new column after the Sales Revenue column and name it Running 
total.

2. Click inside the Running total column.
This is where you are going to insert the formula.

From this...... To this......
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3. From the Data menu, choose Edit Formula.
The Formula Editor opens.

4. Double-click the equal sign (=) sign in the Operators list.
The equal (=) sign is displayed in the Formulas box.

5. In the Functions box, open the All functions & aggregates folder.

6. Scroll down until the function RunningSum is displayed in the Functions box.

7. Double-click RuningSum.
RunningSum is displayed in the Formulas box. Notice that the cursor is inside 
the brackets. This is where the variable will be inserted.

8. In the Variables box, double-click Sales revenue.
Sales revenue is added to the formula. Notice the angle brackets which are 
automatically added to a variable by the Formula Editor.

9. Click OK.
The Formula Editor closes and the calculation is displayed in the RunningSum 
column.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
The formula is stored in the Formulas folder of the Report Manager Data tab.

Guidelines on the syntax to use in formulas
Whichever method you use to write formulas, always bear these guidelines in 
mind:

• A formula must begin with an "equal to" sign. If you remove this sign, the 
formula is considered as a constant or as text.

• Variables included in formulas must be surrounded by a "lower than" sign (<) 
and a "greater than" sign (>), e.g., <Revenue>. 

• Text included in formulas must be surrounded by double-quotes (")

Syntax errors
If there is a syntax error in a formula you have written, an error message is 
displayed and the part of the formula that contains the error is highlighted.
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Local Variables

A local variable is a formula that is given a name. Local variables appear in the 
list of variables in the Report Manager Data tab and you can use them to build 
tables, charts etc. in the same way as you use variables returned by a data 
provider.

The difference is that local variables are attached to the document in which they 
are created and calculations are carried out at the report level. This means that 
local variables are only available in the document in which they were created.

Why use local variables?
As we said earlier, a variable is a formula with a name. However, variables have 
a certain number of advantages over formulas because they allow you to do 
things that you cannot do just using formulas:

• You cannot apply alerters, filters, sorts and breaks on columns or rows 
containing formulas, but you can on those containing variables.

• You can include variables qualified as dimensions in drill hierarchies.

Local variables are also useful from a practical point of view:

• You can re-use local variables in the same document more easily than 
formulas because they are named.

• Some formulas are very complex. If you create variables, you can re-use them 
in formulas and avoid having very long and complex formulas which can lead 
to making syntax errors. In addition, you don't have to re-write the formula 
over and over again. What’s more, complex formulas are easier to decipher if 
they contain variables.

How can I recognize a local variable?
If you want to know whether a variable has been returned by a data provider or 
created locally in a report:

• Right-click on the variable in the list in the Data tab of the Report Manager.

In the menu that opens:
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• If the menu command Edit Variable is available, the variable is a local variable 
and you can modify the attributes.

• If the menu command Edit Variable is not available (grayed out) the variable 
was returned by the data provider and cannot be edited.

Creating a local variable
You can create local variables using the variable editor, by turning an existing 
formula into a variable, and by grouping values from an existing variable to 
create a new one.

Using the Variable Editor
You can create a local variable from scratch using the Variable Editor. To do this:

1. Right-click on the Data tab of the Report Manager and choose New Variable 
from the menu.
In the Variables dialog box opens.

2. Click the Formula tab.

3. Type the formula in the Formula box, or double-click the function(s), 
variable(s) or operator(s) you need.
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4. Click the Definition tab and type a name in the Name box.

5. In the Qualification box, choose whether you want the local variable to be 
defined as a Dimension, Measure or Detail object.

6. Click OK.
The new variable is displayed in the list of variables in the Report Manager 
data tab. 

Transforming a formula into a local variable
You can also transform an existing formula into a local variable. As we said 
earlier, variables are useful because you can apply alerters, filters, and sorts to 
variables but not to formulas. After setting up a formula in a report, you may 
decide that you’d like to highlight the top values. To do this, you can easily 
transform the formula you have created into a variable.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Highlighting above average margin

You have set up a formula to calculate average margin and now decide you want 
to highlight all those stores that have made above average margin. In 
BUSINESSOBJECTS you can highlight data in this way using alerters but you cannot 
apply an alerter on a column or row of data that contains a formula. However, 
you can use an alerter on a variable. By turning your formula into a variable you 
can highlight your above-average stores.
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To transform a formula into a variable:

1. Select the column of data that contains the formula.

2. Choose Define As Variable from the Data menu.

3. Type in a name for the variable in the Define the Variable dialog box.

4. Set how you want the formula to be defined. 

5. Click OK.
The variable is now displayed in the variables folder in the Report Manager 
Data tab and you can set up an alerter using the variable.

For further information on calculation contexts, see Chapter 15 "Calculation 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Contexts and Extended Syntax" on page 341.

Choose.... If you want to.....

Evaluate the formula in 
its context

Restrict the definition of this variable to its 
context in the current block. If you insert this 
variable in another block in the report, the result 
of that calculation will always be based on the 
original context

Keep the formula 
generic

Allows you to define the variable so that it 
calculates the data dynamically, based on the 
context of the block where the variable is 
inserted



 Creating Local Variables by Grouping Values

  BusinessObjects User’s Guide   325

Creating Local Variables by Grouping Values

You can also create new variables by grouping the values of existing variables 
which enables you to create dynamic groups for analysis purposes. Grouping 
values prior to analyzing your data in drill mode can also be useful, for example, 
if you have a variable which has a lot of values. It allows you to create an 
intermediary level of detail in your analysis.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Group quarters to display revenue per semester

You have a report showing the sales revenue per quarter but you would like to 
display revenue per semester. Since you have the data for Quarter, you can do 
this quite easily. The Quarter variable returns four values - Q1, Q2, Q3, Q4. By 
grouping Q1 and Q2 into one value (H1), and Q3 and Q4 into a second value (H2) 
you can create a new variable, Semester, and then calculate revenue by semester. 
You can then add Semester to a drill hierarchy and use it in your analysis in drill 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
mode. Here’s how to do it.

Grouping values
Your table displays sales revenue per quarter. You are going to create a new 
variable called Semester.

1. Select Q1 in the table.

2. Holding down the Ctrl key, select Q2.

3. Click the Group Values button on the Report toolbar.
The Rename grouped values box opens.

4. Type in the new name, H1, in the Rename Group box and click OK.

Group Values
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Q1 and Q2 are grouped together and the new name, H1, is displayed in the 
table.

A new variable is created and displayed in the list in the Report Manager. The 
table column header is updated with the name of the new variable, Quarter+ 
In Table 1.

5. Repeat Step 1 to Step 4 to group the values for Q3 and Q4 and name the new 
value H2.
Your table now looks like this.

Since the name of the new variable is not very meaningful, you can rename it.
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To rename the variable

1. Right-click on the Quarter+ In Table 1 variable in the Report Manager 
window.

2. Choose Edit Variable from the menu.
The Edit box opens.

3. Type in a new name, Semester, in the Name of the Variable text box and click 
OK.
The new name, Semester, is displayed in the Variables list and in the table. 
Your table now displays sales revenue per semester.
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Editing grouped values
At any time, you can edit variables created by grouping values from another 
variable. You can rename the variable or the values, re-arrange the values in the 
groups or create a new group of values.

1. Right-click on the variable in the Report Manager window.

2. Choose Edit Variable from the menu.
The Edit box opens.

3. Make the required changes and click OK.

Deleting grouped values
You can delete a variable created by grouping values from another variable.

1. From the Data menu, choose Variables.

2. In the Variables box, select the variable you want to delete.

3. Click Remove and then OK.

Ungrouping grouped values
You can ungroup a variable created by grouping values from another variable.

1. Select the grouped value in the table.

2. Click the Group Values button on the toolbar.

You can drag and drop 
values from one group 
folder to another.

You can rename the 
values here. Click on 
the name and type in 
the new one.

You can rename the 
variable here.
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Adding grouped values to a drill hierarchy
You can add a local variable that has been qualified as a dimension to a drill 
hierarchy and then use it in your analysis in drill mode. You can now add 
Semester to the Time period hierarchy and then drill down from Year to Semester 
and then to Quarter.

To add Semester to the drill hierarchy:

1. From the Analysis menu, choose Hierachies.
The Hierarchy Editor opens up.

2. Add Semester to the Time period hierarchy between Year and Quarter.

Note: For more information on setting up and using drill mode, see Chapter 
20 "Analyzing Data in Drill Mode" on page 463.
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Managing Formulas and Local Variables

This section describes how to insert, edit and delete the local variables and 
formulas you have created.

Inserting local variables and formulas in a report
You can drag the variable or formula from the Data tab of the Report Manager 
window and drop it where you want it to appear on the report.

Editing formulas
You can edit a formula directly in the cell or in the Formula Bar or you can use 
the Formula Editor.

1. Click the cell that displays the result of the formula you want to edit.

2. Then:
• Type your changes into the cell and press Enter to validate them
• Click inside the Formula Bar, and edit the formula and click the Validate 

Formula button to validate the formula.
• From the Data menu, choose Edit Formula; make your changes in the 

Formula Editor and click OK to validate them.
The result of the formula is displayed in the cell.

Editing local variables
You can edit a local variable directly from the Report Manager. To do this:

1. Right-click the variable in the Data tab of the Report Manager window.

2. Choose Edit Variable from the menu.
The Variable Editor opens.

3. You can:
• Type in a new name in the Name box.
• Change the qualification of the variable.
• Edit the formula on the Formula tab.

4. Click OK to validate your changes.
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Deleting formulas and local variables
To delete a formula or local variable from a report:

1. From the Data menu, choose Variables.
The Variables dialog box is displayed:

2. Open the Variables or the Formulas folder.

3. Select the variable or formula to delete.

4. Click Remove and then click Close.

Note:  You can only delete local variables, not variables returned by a data 
provider.

The Edit and Remove buttons 
are not available if you 
choose a variable returned by 
the data provider.
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Functions

BUSINESSOBJECTS contains many built-in functions which greatly extend it’s 
capabilities. Functions are pre-defined formulas. A function consists of the 
function name followed by a pair of parentheses. The parentheses can contain 
arguments and arguments supply functions with values on which to operate. 
Arguments can be objects, constants or other functions.

Some commonly used functions are available directly from the BUSINESSOBJECTS 
menus and toolbars. When you choose one of these functions, the necessary 
arguments are added automatically. 

The entire set of functions is organized in nine folders in the Functions window 
of the Formula Editor:

Using Functions
When you select a function in the list in the Functions window, a description of 
the syntax the function requires is displayed at the bottom of the Formula Editor 
window.

The folder... Lists.....

All All available functions in alphabetical order.

Aggregates Functions that return aggregate totals (e.g. the 
sum or average of a column of data)

Numeric Functions Functions that operate on numerical arguments. 

Character Functions Functions that operate on character objects and 
text strings.

Date Functions Functions that operate on dates.

Logical Functions Functions that return true or false.

Document Functions Functions that return information about a 
document.

Data Provider Functions Functions that return information about a data 
provider.

Miscellaneous Functions Functions that cannot be categorized into one of 
the seven category folders.
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When you add a function to the Formula window, any necessary commas are 
added. The following example shows you how to use a BUSINESSOBJECTS function 
to rank data according to revenue generated.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example How can I rank cities according to sales revenue?

In this example, you want to rank the cities in your table according to sales 
revenue generated this quarter.

Here’s how to do it:

1. Add a new column to the table and name it Revenue rank.
Click in the Revenue rank column.

2. From the Data menu, choose Edit Formula.
The Formula Editor opens.

3. Open the All functions and aggregates folder and scroll down to the Rank 
function.

From this...... To this......
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4. Double-click on Rank.

The Rank function is added to the Formula window.
To use the Rank function, you need to add a dimension variable, a comma and 
then a measure variable inside the parentheses. The function then ranks the 
dimension according to the measure.

5. In the Variables list, double-click City and then Sales revenue.
The completed syntax is displayed in the formulas window.

=Rank(<City> ,<Sales revenue>)

6. Click OK.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
The cities are ranked from 1 to 10 according to sales revenue.

Tip: To quickly find a function in the Functions list, open the All functions & 
aggregates folder and then type the first letter of the function you want to find. 
BUSINESSOBJECTS highlights the first function beginning with that letter.

Using the Function Help
Before working with a function for the first time, use the Function Help to find 
out what the function does. To do this:

• Select the function in the Functions list and click the Function Help button.

The help page gives a description of the function, its syntax, and an example.

The parentheses and 
required commas are 
added automatically.

The syntax for the 
selected function is 
shown here.

Click here to get more 
information on what 
the function does.
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More Examples of Using Formulas

There are examples of using functions and writing formulas throughout this 
chapter and throughout this user’s guide. This section has several additional 
examples on using the BUSINESSOBJECTS formula editor and BUSINESSOBJECTS 
functions to set up personal calculations.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Calculating a 3-week rolling average

Using a rolling average smooths out the fluctuations of a measure variable that 
fluctuates over time, stock prices, for example, which change daily. A rolling 
average is obtained by calculating the average of the current value and the 
specified number of previous values. In BUSINESSOBJECTS, you use the Previous() 
function to set up a rolling average.

This example shows you how to create the variable to calculate a three-week 
rolling average for sales revenue.

1. Right-click on any variable in the Report Manager Data tab and choose New 
Variable from the menu.
The Variable Editor opens.

2. Click the Definition tab.

3. In the Name box, type 3 weeks rolling.

4. In the Qualification section, choose Measure.

5. Click the Formula tab.

6. In the Formulas box, type the formula:
=(<Sales revenue>+Previous(<Sales 
revenue>)+Previous(Previous(<Sales revenue>)))/3.

This formula adds the sales revenue for the current week to the sales revenue 
for the two previous weeks and then divides the total by three to obtain an 
average for those three weeks. To create this formula, we use the 
BUSINESSOBJECTS Previous() function. 

7. Click OK.

The new variable is added to the list in the Report Manager Data tab and you can 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
use it in the tables and charts in your report.
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Combining data in a single cell
You frequently need to combine different pieces of data returned by data 
providers in a single cell of a report. For example, first and last names are 
typically stored as separate pieces of data in the database but you often need to 
display a person’s whole name in a single cell of a report.

There are two ways of combining pieces of data or combining text and data in a 
single cell in BUSINESSOBJECTS. You can either use the Concatenation() function or 
the & operator.

The examples below describe how to use both methods to combine character-
type data, and how to combine numbers and dates with text or with other pieces 
of data.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Combining first and last names in a single cell

The BUSINESSOBJECTS Concatenation() function allows you to combine two 
character strings. The character string may be a piece of text or a character-type 
variable. The syntax for this function is:

Concatenation(character string, character string)

To display a person’s first and last name in a single cell, the following syntax:
=Concatenation(<First Name>,<Last Name>)

will give the following result: JohnGardner

You would typically wish to have a space between the first and last name. To do 
this, you need to use the following syntax:

=Concatenation(<First Name> ,(Concatenation(" " ,<Last Name>)))

A second way to achieve the same result is to use the & operator. If you are 
combining several character strings and want to add spaces, using the & operator 
is a simpler solution than using the Concatenation() function. The syntax to 
achieve the same result as shown above using the & operator is:

=<First Name>&" "&<Last Name>

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Notice that the space we typed is surrounded by quote marks.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Combining text and data in a single cell

You can use the same syntax as in the example above to add a comment to data 
in a table cell or a master cell. The table below shows the sales figures for the top 
three lines for the first quarter, but quarter is not displayed in the table. By editing 
the master cell contents, you can add a more explanatory title for each section in 
the report as shown below:

To obtain the result illustrated above, the formula:
=”Sales for Q1 in “&<City>

will give you the following result:

Sales for Q1 in Austin

Notice that text is surrounded by quote marks and that we typed a space at the 
end of the text and before the final quote marks to add a space between the text 
and the name of the city.

If you want to place a filter on the City section after combining text and data in 
the master cell, you’ll notice that the Insert Filter button on the Standard toolbar 
is unavailable. To insert a filter:

1. Select the master cell.

2. From the Format menu, select Filters.
The Filters dialog box opens.

3. Click Add.
The Variables to filter dialog box is displayed.

4. Select City and click OK to return to the Filters dialog box.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
In the Values box, select the cities you want to filter and click OK.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Combining text and numbers in a single cell

The Concatenation() function and & operator only allow you to combine 
character-type data. If you want to combine text or character-type data with 
numbers you must first convert the number into a character string. Otherwise, 
BUSINESSOBJECTS displays the error message 'Incompatible data type'. You can 
convert a number to a character string using the FormatNumber() function.

To obtain the result illustrated above, the formula:
="Revenue for week: "&FormatNumber(<Week> ,"0")

will give you the following result:

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Revenue for week: 1

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Combining text and dates in a single cell

In the same way, if you want to combine text with dates using the & operator or 
the Concatenation() function, you must first convert the date into a character 
string. Otherwise, BUSINESSOBJECTS displays the error message 'Incompatible 
data type'. You can convert a date into a character string using the FormatDate() 
function.

To obtain the result illustrated above, the formula:
="Invoice date: "&FormatDate(<Date>, "dd/mm/yyyy")

will give you the following result

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Invoice date: 01/01/1993
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Comparing yearly margin growth using the Where function

A common requirement in business is to compare data from different dates or 
periods so you can evaluate how key indicators such as revenue and margin have 
progressed. The BUSINESSOBJECTS Where function allows you to identify data 
with the values of another variable so that you can compare related data.

In the example below, you want to compare yearly margin. Your 
BUSINESSOBJECTS document contains the variables for year, margin and city. 
Using this data, you can write a BUSINESSOBJECTS formula to assign margin to a 
specific year and then calculate margin growth from one year to the next.

Here’s the procedure:

1. Right-click on any variable in the list of variables in the Report Manager Data 
tab and choose New Variable from the menu.
The Variable Editor opens.

2. Click the Definition tab.

3. In the Name box, type 1999 margin.

4. In the Qualification section, choose Measure.

5. Click the Formula tab.

6. In the Formulas box, type the formula:
=<Margin> Where (<Year>="1999")

This formula calculates the margin for the year 1999 only. Note that we use the 
BUSINESSOBJECTS Where operator in the formula to specify the year.

7. Click OK.
The new variable is added to the list in the Report Manager Data tab.
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8. Repeat the procedure above to create one variable called 2000 margin and one 
called 2001 margin using the following syntax:

=<Margin> Where (<Year>="2000")

=<Margin> Where (<Year>="2001")

The new variables are added to the list in the Report Manager Data tab. 

We could have simply created a formula to calculate the margin for each year. 
The advantage of creating a variable is that we can then re-use it more easily in 
other formulas. For example, you can now easily calculate the percent increase in 
margin between the 1999 and 2000 using the variables you have just created and 
display the increase in a new column in the table:

=(<2000 margin>-<1999 margin>)/<Margin>

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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Overview

This chapter is designed to help you use the powerful calculation capabilities 
delivered with BUSINESSOBJECTS.

Who should read this chapter
This chapter especially concerns those users whose business requires that they 
perform advanced calculations. The information here is also useful for any user 
who has experienced computation errors in their BUSINESSOBJECTS reports.

What’s in this chapter
The chapter provides information on how BUSINESSOBJECTS performs 
calculations in reports. It describes the concepts behind the BUSINESSOBJECTS 
calculation engine. Most specifically, its aim is to explain the extended syntax that 
enables you to manipulate complex aggregations in reports.

You can find calculation troubleshooting information on error messages such as 
#COMPUTATION in Chapter 16 "Calculation Troubleshooting" on page 373.
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Introduction to Contexts and Extended Syntax

This section introduces you to the key concepts of calculations in 
BUSINESSOBJECTS.

Semantically dynamic calculations
In BUSINESSOBJECTS, you create a report by building a query that retrieves data 
from a database. Typically, your query contains:

• Dimensions, which retrieve character-type data (customer names, product 
names, etc.), or dates (years, quarters, reservation dates, etc.).

• Measures, which retrieve numeric data that is the result of calculations. For 
example, in the BUSINESSOBJECTS demo universe, Revenue is the calculation of 
number of items sold multiplied by item price.

When you run the query, BUSINESSOBJECTS brings to the report the data 
corresponding to the dimensions and measures you selected. 

In the report, measures are calculated dynamically, based on the dimensions with 
which they appear. Here’s an example.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Revenue per region per year, and revenue per region

The report illustrated below contains two tables: revenue per region per year, and 
revenue per region.

BUSINESSOBJECTS dynamically calculates the measure, Revenue, according to the 
dimensions in the table. So, when the user removes the Year column, revenue per 
region is returned:

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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What are calculation contexts?
By default, BUSINESSOBJECTS determines the result of a measure based on the 
dimension or dimensions in the part of the report in which the measure is 
inserted. These sets of dimensions are called calculation contexts.

Calculation contexts are dynamic in BUSINESSOBJECTS. Here’s an example.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Calculating total revenue for two years

In the report illustrated below, the table displays revenue per city per year, with 
a sum on Revenue that calculates total revenue per year.

You can copy and paste, or drag and drop, the cell displaying total revenue per 
year from the table footer to the free-standing cell at the top. BUSINESSOBJECTS 
dynamically calculates total revenue for both years in the report:

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
The result is different because the calculation contexts are different.

In the next section, you learn more about how calculation contexts work.
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Understanding input and output contexts
BUSINESSOBJECTS defines an input context and an output context to determine the 
result of an aggregate calculation. Remember that a context is made up of one or 
more dimensions. The following table defines which dimensions in a report make 
up which context: 

(BUSINESSOBJECTS also supports reset contexts, which are used in cumulative 
aggregations such as running totals. To find out about reset contexts, refer to 
“What about reset contexts?” on page 355).

This section explains how BUSINESSOBJECTS defines input and output contexts in 
different parts of a report. This information is important if you

• Want to understand the different results BUSINESSOBJECTS returns from the 
same formula in different parts of a report.

• Cannot obtain the results you need from the default calculation behavior.

• Need to fix errors such as #COMPUTATION.

The... Consists of one or more dimensions that...

Input context Go into the calculation

Output context Determine the result of the calculation
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How BusinessObjects defines input and output contexts
To understand how BUSINESSOBJECTS defines input and output contexts, you 
must first understand the terms body and local context. The following table 
provides a definition of these terms, and shows how they map to input and 
output contexts in a report:

Below you will find an illustrated example that helps you to understand the 
dimensions in the body and the local context - and thus the default input and 
output contexts - in different parts of a report.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example A report containing aggregations in different contexts

The report illustrated on page 348 displays revenue per city per quarter in 1995. 
The user has placed calculations in different parts of the report:

• Total revenue at the top of the report

• Revenue in the Year section

• Revenue in the table, and

• Average revenue in the break footer.

The table below the illustration explains the default input and output contexts 
BUSINESSOBJECTS uses to obtain the result of each calculation.

The... Consists of one or more 
dimensions that...

And by default is the same 
as the...

Body Are present in the part of 
the report (e.g., a block) 
where the calculation is 
inserted

Input context.

Local context Govern the part of the 
report where the 
calculation is inserted 
(e.g., a master variable in a 
section). 

Output context.
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 The calculation contexts in a report

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

The calculation 
returns...

Because the body (input 
context) is...

And the local (output) 
context is...

a. Total revenue 
for the report

All dimensions - 
including any that are not 
displayed in the report

The same as the body.

b. Total revenue 
for 1995

Year, the section master, 
(the calculation is placed 
at the section level)

The same as the body.

c. Revenue per 
city per quarter 
per year

Year, Quarter, City, i.e., 
the dimensions in the 
section and table

The same as the body.

d. Average 
revenue per city 
per quarter per 
year

Year, Quarter, City, i.e., 
the dimensions in the 
section and table

Quarter (the calculation 
is placed in the footer of 
the break on Quarter.)

a. Total revenue for 
the report

b. Total revenue for 
1995

c. Revenue per city 
per quarter per 
year

d. Average revenue 
per city per 
quarter per year
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Using your understanding of input and output contexts
Once you understand input and output contexts, you are ready to benefit from 
extended syntax.

The extended syntax of an aggregate formula contains not only the basic formula, 
but also the dimensions that make up the aggregation’s calculation contexts. 
Here’s an example.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example The extended syntax of an aggregate formula

The report shown here calculates running total resort revenue per country:

The user obtained the running totals by applying the RunningSum function on 
the Revenue column. The basic formula for the calculation is

=RunningSum(<Revenue>)

The extended syntax of the formula, in which the explicit input and output 
contexts are shown, is

=RunningSum(<Revenue> In Body) In <Country>

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
where Body is the input context, and Country, the output context.

You can use your knowledge of extended syntax to:

• Understand the results BUSINESSOBJECTS returns by default (see below), and

• Change the default input and output contexts of a formula to get the results 
you need. For information on how to do this, refer to “Using Extended Syntax 
for Advanced Calculations” on page 351.
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Viewing the extended syntax of a formula
BUSINESSOBJECTS provides two simple ways of viewing a formula’s extended 
syntax, to find out the dimensions in the input and/or output context of an 
aggregate calculation. You can view extended syntax by

• Using the Formula Bar, or

• Using the Define As Variable command on the Data menu.

Using the Formula Bar

1. If the Formula Bar is not displayed, select the Formula Bar command on the 
View menu.

2. Click the cell containing the calculation.

3. Rest the cursor over the Formula Bar.
The extended syntax of the formula appears in a tooltip.

Using the Define As Variable command

1. Click the cell containing the calculation.

2. Select the Define As Variable command on the Data menu.
The Define As Variable dialog box appears.

3. Click Evaluate the formula in its context.
The extended syntax of the formula appears in the dialog box:

4. Click Cancel to close the dialog box.
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Using Extended Syntax for Advanced Calculations

When you insert a simple aggregation in a report, for example to calculate 
average revenue, BUSINESSOBJECTS writes a simple formula, in this case

=Average(<Revenue>)

By default, BUSINESSOBJECTS evaluates the formula in its default context, as 
explained in the previous section, “Understanding input and output contexts” on 
page 346.

So how do you get more specific results? What if you need average revenue per 
city in a table containing region and city? By default, BUSINESSOBJECTS returns 
results based on region and city, i.e., both dimensions from the local context. What 
if you need a result based on a dimension that is available in the document but 
which you do not want to display in the report?

BUSINESSOBJECTS provides extended syntax so that you can specify the 
dimensions to use in your calculations. Here’s an example.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Calculating the number of cities per region

In a table containing the dimensions City and Region, if you insert a count, 
BUSINESSOBJECTS counts the cities one by one, using the following formula:

=Count(<City>)

By default, BUSINESSOBJECTS makes the calculation based on the dimensions in 
the table (Region, City). There’s only one city per city, so 1 is returned every time.

Extended syntax enables you to specify that you want BUSINESSOBJECTS to count 
the cities per region. To obtain this result, you must extend the formula:

=Count(<City>) In <Region>

Now you get the result you were looking for:

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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Defining calculation contexts with extended syntax
Using extended syntax, you specify the dimensions you need for your 
calculation. In the example above, we specified the dimension Region in order to 
return the number of cities per region. When you use extended syntax to specify 
dimensions in this way, you define calculation contexts other than the default 
contexts assigned by BUSINESSOBJECTS.

BUSINESSOBJECTS lets you define your own input and output contexts. A quick 
reminder of the difference between them:

Thus, in the example on page 351 (number of cities per region), we defined an 
output context, Region. Here’s an example of a calculation with an input context 
defined by the user.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Calculating the minimum revenue per city for each region

You display Region, City and Revenue in a table. When you remove City from 
the table, BUSINESSOBJECTS automatically calculates revenue per region, because 
Region is now the only dimension in the body.

The only way to display minimum revenue per city for each region is to define an 
input context, because the local context does not contain the City dimension. 
BUSINESSOBJECTS allows you to do this, because even though you have removed 
City from the report display, it is still available in the document.

The formula and the result are as follows:
=Min(<Revenue> In (<Region>,<City>))

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

The... Consists of one or more dimensions that

Input context Go into the calculation.

Output context Determine the result of the calculation.



 Using Extended Syntax for Advanced Calculations

  BusinessObjects User’s Guide   353

How to define input and output contexts
Let’s start with the basics. When you insert an aggregation such as Sum, 
BUSINESSOBJECTS writes a simple formula, for example

=Sum(<Revenue>)

To define contexts, you have to edit formulas, so the first thing to do is to display 
the Formula Bar. To do this, select the Formula Bar command on the View menu. 
Now, when you click a cell in a report, its formula appears in the Formula Bar:

Syntax for input and output contexts
To define contexts, you add arguments to a formula. The syntax for input and 
output contexts is as follows:

Let’s dissect a formula to understand this more clearly.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example A formula containing input and output contexts

The following formula returns the minimum revenue per city per region:
=Min(<Revenue> In (<Region>,<City>)) In <Region>

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
The input context consists of Region and City, while the output context is Region.

=AggregateFunction(<measure> In <input context>) In <output 
context>
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To add an input and output context to a formula
This procedure shows you step-by-step how to add an input and/or output 
context to a simple calculation you have already inserted. The procedure is based 
on the example on page 352, “Calculating the minimum revenue per city for each 
region”.

1. If the Formula Bar is not displayed, select the Formula Bar command on the 
View menu.

2. Click inside the cell containing the calculation you want to change, in this case 
a column containing the Revenue measure.
The formula appears in the Formula Bar, for example

=Min(<Revenue>)

3. If you’re adding input context, click to the left of the closing parenthesis. For 
an output context, click to the right of the closing parenthesis.

4. Type a space, type In, then type another space.

5. Type the name of the dimension you want to specify as the context.

6. Type < > on either side of the dimension, for example
<City>

7. If you need to add dimensions to the context, separate each one with a comma, 
and place the list of dimension in parentheses, like this:

(<Region>,<City>,<Year>)

8. Press Enter to validate the formula.

Tip: You can also use the Formula Editor to add contexts to a formula. The 
advantage is that you can double-click variables to add them to the formula, 
instead of having to type them. 
To display the Formula Editor, click the Formula Editor button on the left of the 
Formula Bar.

Formula Editor
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What about reset contexts?
You use a reset context in a cumulative aggregation, such as running total revenue 
per quarter. The reset context consists of one or more dimensions which reset the 
value of the calculation to zero each time a dimension value changes. This is best 
explained with an example.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Calculating running total revenue per country

You want to calculate running total revenue per country per year, and naturally 
you want the calculation to be reset for each country. In other words, when the 
value of Country changes, you want the calculation to begin at 0.

To obtain this result, you display Country, Year and Revenue in a table, and 
apply a break on Country. You then add the cumulative aggregation

=RunningSum(<Revenue>;<Country>)

in which Country is specified as the reset context. Here’s what you get:

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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How to define reset contexts
You define a reset context by specifying one or more dimensions in the 
cumulative formula. The syntax is

=RunningAggregateFunction(<measure>;<dimension>)

giving, for example
=Sum(<Revenue>;<Year>;<Region>)

To define a reset context:

1. If the Formula Bar is not displayed, select the Formula Bar command on the 
View menu.

2. Click inside the cell containing the calculation you want to change.
The formula appears in the Formula Bar.

3. Type a parenthesis before the function name.

4. Type a semi-colon (;) after the measure.

5. Type the name of the dimension you want to use as the reset context, e.g.,
<Year>

6. Add other dimensions if necessary; separate each with a comma and place the 
list in parentheses.
A reset context with more than one dimension looks like this:

;<Year>,<Region>

7. Type a closing parenthesis at the end of the formula, then press Enter.
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Using reset contexts in crosstabs
A crosstab displays data in rows and columns, as opposed to a table which 
displays data in columns only. Measures are typically placed in the body of a 
crosstab, i.e., at the intersection of rows and columns. The crosstab illustrated 
here shows revenue per region in 1994 and 1995:

Now, to calculate running total revenue, you insert a break on Year, then change 
Revenue to 

=RunningSum(<Revenue>)

Here’s the result:

Notice that the running totals are calculated for both Year and Region. In other 
words, the figures are added from left to right, and from top to bottom.

To reset the running sum for either Year or Region, you add a reset context to the 
formula. The formula to reset the running sum to 0 for each year is

=RunningSum(<Revenue>;<Year>)

and the result is as shown:

Note: Users of previous versions of BUSINESSOBJECTS may have used the 
keywords Col and Row to define reset contexts in crosstabs. These keywords are 
no longer necessary. You can use them, but they have no added value. For 
example

=RunningSum(<Revenue>; Col <Year>)

and
=RunningSum(<Revenue>; <Year>)

return the same result.
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Syntax for combining reset, input and output contexts
When input and output contexts are specified, the syntax for reset contexts is as 
follows:

=RunningAggregateFunction(<measure> In <input context>;<reset 
context>) In <output context>
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Modifying contexts with the operators ForEach and ForAll
When you define a context, you specify the dimension(s) it must contain. The 
syntax requires that you use the In operator to introduce the context:

=Min(<Revenue> In (<Region>,<City>) In <Region>

In is the default operator for defining a context. However, you can modify the 
context you’re defining by replacing In by ForEach or ForAll. The following table 
provides a definition of ForEach and ForAll:

The following example illustrates how ForEach and ForAll work.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Using ForEach and ForAll

A table containing Region, City and Revenue returns the revenue per city per 
region.

The Year dimension is also available in the document. You want to display 
maximum revenue per city per year, but you don’t want to add Year to the table. 
No problem, you add Year to the local context by using ForEach:

=Max(<Revenue> ForEach <Year>)

Finally, you want to display maximum revenue per region, but want City to 
remain in the table. In other words, you have to remove City from the local context 
without physically removing the City column. You achieve this by using ForAll.

Operator Definition

ForEach Adds dimensions to the input or output context.

ForAll Removes dimensions to the input or output context.
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Here’s the formula and the result:
=Max(<Revenue>) ForAll <City>

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Getting the same result: ForAll <City> vs. In <Region>
In the previous example, we calculated maximum revenue per region by using 
ForAll to remove City from the local context. You could obtain the same result by 
making Region the output context.

Here’s how this works. The local context is City and Region. Unless you specify 
otherwise, BUSINESSOBJECTS returns maximum revenue per city per region. You 
want maximum revenue per region. To calculate this, you must “tell” the formula 
to “ignore” City, either by

• Removing City from the local context, or

• Defining an output context, Region.

So, these two formulas,
=Max(<Revenue>) ForAll <City>

=Max(<Revenue>) In <Region>

where the local context is Region and City, obtain the same result.

Now try ForEach <City> vs. In (<Region>,<City>)
In the example entitled “Calculating the minimum revenue per city for each 
region” on page 352, we used

=Min(<Revenue> In (<Region>,<City>))

to calculate minimum revenue per city in a table containing only Region and 
Revenue. The default result is input context is Region, but we added City to it.

You could obtain the same result by adding City with the ForEach operator, the 
formula being

=Min(<Revenue> ForEach <City>)
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Using the Rank function and extended syntax
The Rank function allows you to rank the values of a dimension based on a 
measure. The syntax is:

=Rank(dimension ,measure)

The first table below shows revenue per quarter per country. Quarters are ranked 
according to revenue by inserting the following formula in the Rank column:

=Rank(<Quarter> ,<Revenue>)

But what if you put a break or a section on country? The result is that the quarters 
are ranked for each country separately, as shown in the second table.

This is because, by default, BUSINESSOBJECTS includes country in the calculation 
context. Since there are two values for Country, BUSINESSOBJECTS makes a 
calculation for each value.

You can modify the calculation context by using the ForAll context operator. This 
tells BUSINESSOBJECTS to ignore the break (or section) on Country. The syntax is:

=Rank(<Quarter> ,<Revenue>) ForAll <Country>

The result is:
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BUSINESSOBJECTS now calculates the rank according to revenue generated per 
quarter and for all values of the Country dimension. 

What if you now want to rank all eight quarters in the block according to revenue 
generated?

To do this, you have to remove the Country break from the rank calculation 
context, but keep it in the revenue calculation context. The best way to achieve 
this is to create a new variable to calculate the revenue and then include this in 
the formula inserted in the Rank column.

Here’s how to do it:

1. Create a new measure variable using the following syntax:
=<Revenue> ForEach <Country>

This variable calculates the revenue for each country.

2. Name the variable Revenue ForEach Country.

3. Insert the following formula in the rank column:
=Rank(<Quarter> ,<Revenue ForEach Country>) ForAll <Country>

The result is:
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Using the Rank function in crosstabs
In the following example, you have a crosstab that displays revenue per quarter 
per resort. You have inserted a column to display rank after each Resort column 
and inserted the following syntax:

=Rank(<Quarter> ,<Revenue>)

The result is:

The problem is that the rank is the same for all quarters in all resorts. 

What you want to do is rank the quarters for each resort in the crosstab. To do 
this, you have to specify that you want to calculate rank for each resort in the 
output context. The syntax is:

=Rank(<Quarter> ,<Revenue>) ForEach <Resort>

And the result is:
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Defining contexts with keywords
Calculation contexts consist of one or more dimensions. In the examples so far, 
we’ve defined contexts by writing the names of dimensions inside the formula.

BUSINESSOBJECTS provides keywords that enable you to define contexts without 
listing the specific dimensions you need. A keyword corresponds to the 
dimension or dimensions in a specific part of the report. Keywords can define all 
types of context in extended syntax- input, output or reset.

Keywords offer you the following advantages:

This section provides:

• Definitions of the keywords you can use

• An example of how to use a keyword in a formula

• A step-by-step procedure for writing formulas with keywords

• Information on how BUSINESSOBJECTS assigns keywords to formulas, and

• An explanation of how report filters behave when you use keywords.

Advantage Description

Simplified formula 
definition

It’s often quicker to add one keyword to a formula 
than to write a list of dimensions.

Reduced risk of 
syntax errors

The syntax for keywords is simple: you just add the 
keyword to the formula. Thus, you avoid missing 
parentheses, misspelled dimensions, etc.

Guaranteed 
dynamic results 

If you add or remove dimensions from the report, 
perform drag-and-drop or slice-and-dice, you don’t 
have to rewrite formulas containing keywords. 
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Keywords: definitions and example
The four keywords you can use in formulas are Report, Block, Body and 
CurrentPage. Each keyword corresponds to the dimension or dimensions in a 
specific part of the report. The definitions in the following table indicate

• In which part of a report you can use each keyword, and

• The dimensions the keywords correspond to.

To illustrate how keywords can be used, here’s an example.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Calculating a grand total by using the Report keyword

You want to display the grand total revenue across all dimensions in a report. 
This calculation does not require extended syntax if the formula is placed in a cell 
at the very top of the report, because in this case the default output context 
contains all the dimensions in the report. But you want to display the information 
elsewhere, for example inside a table footer. 

To obtain this result, you could define an output context by listing all the 
dimensions in the report. A much simpler solution is to use the Report keyword 
in the following formula:

=Sum(<Revenue>) In Report

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Wherever you display this formula in the report, you obtain the grand total.

Tip: A formula in which the Report keyword is used to define the output context 
always returns a single value.

Keyword Can be used in 
formulas...

And corresponds to...

Body Inside a block The dimensions in the block.

Outside a block The dimensions in the current 
section.

Block Inside a block The dimensions in the current 
section.

Report Anywhere in the 
report

All the dimensions in the document.

CurrentPage Inside the current page The dimensions in the current page.
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How to define a context using a keyword
Here’s the step-by-step procedure for using a keyword to define a context:

1. If the Formula Bar is not displayed, select the Formula Bar command on the 
View menu.

2. Click the cell in which you want to place the formula, then write the basic 
formula, e.g., 

=Sum(<Revenue>)

in the Formula Bar.

3. If you’re adding input context, click to the left of the closing parenthesis. For 
an output context, click to the right of the closing parenthesis.

4. Type a space, type In, then type another space.

5. Type the keyword (Block, Body, Report, or CurrentPage), then press Enter.
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How BusinessObjects uses keywords
You use keywords in extended syntax when you need to define contexts in 
aggregate formulas. BUSINESSOBJECTS defines contexts in all aggregate formulas, 
however simple, and often uses keywords to do so. Here’s an example to 
illustrate this behavior.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example The formula BusinessObjects writes for a simple calculation 

You create a master/detail report that shows revenue per resort per year. You 
insert a sum on Revenue. This is a simple calculation requiring no extended 
syntax. 

BUSINESSOBJECTS, however, writes a full formula in which input and output 
contexts are specified. The formula is

=Sum(<Revenue> In Body) In (<Year>)

where Body corresponds to Resort (the dimension in the table containing the 
calculation, i.e., the local context), and Year is the output context.

You can view the full formula by clicking the cell containing the sum, then resting 
the mouse pointer over the Formula Bar. The formula appears in a tooltip.

You can also view the full formula by using the Define As Variable command on 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
the Data menu.

Benefits

In simple aggregations such as the one in the example above, you rarely need to 
understand the extended syntax BUSINESSOBJECTS uses. But what if you don’t 
understand the numbers BUSINESSOBJECTS displays in a report? What if you’re 
having a hard time fixing an error such as #COMPUTATION?

In these cases, you can use the extended syntax BUSINESSOBJECTS provides to

• Understand the computation behind the report display, then

• Edit your formula to get the result you want. The formula displayed in the 
tooltip is a base for you to work from.
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Filters and keywords
Question: if your report contains filters, are these taken into account when you 
apply aggregate calculations using keywords?

Answer: yes. The results you obtain will always be filtered. You can, however, 
force BUSINESSOBJECTS to ignore filters.

How to force BusinessObjects to ignore filters

Let’s say you have a master/detail report and a filter on the master variable. You 
want to calculate a grand total using the Report keyword. Problem: you don’t 
want to compute the filter but you don’t want to delete it either.

Solution: use the NoFilter function! The syntax is
=NoFilter(formula)

an example being
=NoFilter(Sum(<Revenue>) In Report)

Tip: Why not try comparing filtered and non-filtered information? Insert a cell 
with the regular formula, then use NoFilter to get the real grand total.
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Quick Reference

This guide contains a lot of theory and terminology, which is not always easy to 
remember. This section provides at-a-glance information to jog your memory 
when you just can’t remember the difference between, for example, ForEach and 
ForAll...

The information below is organized by category:

• Basic terms such as document, microcube, aggregation, etc.

• Calculation contexts (local, body, input, output and reset)

• Context operators (In, ForEach, ForAll)

• Keywords (Report, Block, Body, CurrentPage).

Frequently used terms
A selection of useful terms often used in this context.

Term Definition

Aggregation A calculation that returns totals, percentages, etc. in which any 
of the following functions are used:

Average, Count, Max, Min, StdDev, StdDevP, Sum, Var, VarP.

Cumulative 
aggregation

A calculation that returns running totals, percentages, etc. in 
which any of the following functions are used:

RunningAverage, RunningCount, RunningMax, 
RunningMin, RunningSum. 

Dimension Qualification of an object, variable or formula that returns text 
(names, IDs, etc.) or dates.

In a report, dimensions make up calculation contexts.

Document A BUSINESSOBJECTS file (extension .rep).

Extended 
syntax

The syntax of a formula for an aggregation, in which the input 
and output contexts for the aggregation are displayed.

You can use extended syntax to define your own input and 
output contexts 

You have to use extended syntax to define reset contexts.
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Formula The definition of the content of a cell. Can contain functions, 
operators, variables and text.

Measure Qualification of an object, variable or formula that returns 
numeric data, such as revenue.

The result of a measure is by default determined by the 
dimensions in the context in which the measure is placed in a 
report.

Microcube Set of data returned by a query.

Because documents can contain data from different sources in 
BUSINESSOBJECTS, any given document can contain multiple 
microcubes.

Report Pages in a document where data is displayed. A document can 
contain many reports; each report has a tab at the bottom of 
the application window.

A report can display only a subset of data from the document. 
You can use any dimension - displayed or not - as input or 
output for a calculation.

Variable A named formula.

BUSINESSOBJECTS always stores query results as variables.

Term Definition
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Calculation contexts
A calculation context consists of one or more dimensions that determine the input 
and output of aggregate calculations.Important: In BusinessObjects 5.1.x, the SQL 

Important: In BusinessObjects 5.1.x, the SQL for contexts is generated differently 
to previous versions. Therefore, if you run a query that was built in a previous 
version to 5.0.x, you receive #SYNTAX, #COMPUTATION and #ERROR 
messages in the upgrading report.

Context Definition

Local Dimension or dimensions that govern the part of the report 
where the calculation is inserted (e.g., a master variable in a 
section). 

Body Dimension or dimensions that are present in the part of the 
report (e.g., a block) where the calculation is inserted.

Input One or more dimensions that go into an aggregate calculation. 
By default, the input context for a calculation is the defined by 
the dimension(s) in the body.

You can define your own input context using extended 
syntax.

Output One or more dimensions that determine the result of an 
aggregate calculation. By default, the output context is 
defined by the dimension(s) in the local context.

You can define your own output context using extended 
syntax. 

Reset One or more dimensions that reset a cumulative aggregation 
such as running total to 0 when the value of the dimension(s) 
changes.

You specify reset contexts using extended syntax.
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Context operators
In the formula for an aggregation using extended syntax, an operator introduces 
the input and/or output context.

Keywords
In extended syntax, a keyword stands for the dimension(s) in a specific part of a 
report. The keyword enables you to define contexts in aggregate formulas by 
using one word rather than listing the dimensions in the context.

Operator Definition

In The default operator. Includes the specified dimension(s) in 
the context.

ForEach Modifies a context by including the specified dimension(s).

ForAll Modifies a context by excluding the specified dimension(s).

Keyword Definition

Block Corresponds to the dimensions in the current section.

Can only be used in a formula placed inside a block.

Body When the formula is 
placed...

Corresponds to...

Outside a block The dimensions in the current 
section.

Inside a block The dimensions in the block.

Report Anywhere in the report All the dimensions in the 
document.

CurrentPage Inside the current page The dimensions in the current 
page.
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Overview

This chapter describes and offers solutions for computation errors that may occur 
in BUSINESSOBJECTS. A computation error always starts with # and appears the 
cells where your business data should be.

The bulk of the information in this chapter focuses on the most common errors, 
i.e., #COMPUTATION and #MULTIVALUE. For the full list of errors covered 
here, please refer to the table of contents or the index.

Tip: If you need help with #COMPUTATION and #MULTIVALUE errors in your 
reports, you are strongly advised to first read Chapter 15 "Calculation Contexts 
and Extended Syntax" on page 341.
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#COMPUTATION

This section provides descriptions, examples and solutions for the following 
errors in BUSINESSOBJECTS:

• #COMPUTATION in cumulative aggregations such as running average 
revenue per city

• #COMPUTATION in non-aggregate formulas, for example using IF THEN 
ELSE statements.
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#COMPUTATION in cumulative aggregations
The expression “cumulative aggregations” refers to any aggregation containing 
a running aggregate function such as RunningMax or RunningAverage. In 
reports, cumulative aggregations let you answer questions such as “What’s the 
running percentage of revenue per city for each year?”.

Note: The information presented here requires that you understand 
BUSINESSOBJECTS extended syntax, which is described in “Using Extended Syntax 
for Advanced Calculations” on page 351.

Description of #COMPUTATION in a cumulative aggregation
#COMPUTATION can occur in cumulative formulas where a reset context is 
defined. A reset context consists of a dimension, and resets a running calculation 
to zero when the value of the dimension changes. To read up on reset contexts, 
refer to “What about reset contexts?” on page 355.

#COMPUTATION occurs in cumulative aggregations for the following reason:

The reset context is not included in the output context.

Here’s an example.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example #COMPUTATION resulting from a running sum with a reset context

You’ve displayed running totals per country per year, and reset the calculation 
per country. The formula is as follows:

=RunningSum(<Revenue>;<Country>)

You now set a break on Year, because you want to display the running total for 
each year. You copy the formula from the running total column and paste it in the 
break footer. #COMPUTATION appears:

Why? Because the reset context in the formula you pasted is Country, but you 
placed the formula in the footer of the break on Year. Thus, the reset context 
(Country) is not in the output context (Year).

To fix this error, you need to display the Formula Bar and change the reset context 
from Country to Year. The winning formula is:

=RunningSum(<Revenue>;<Year>)

Alternatively, you could set the break on Country, but you would obtain a 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
different result.
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Solution for #COMPUTATION in a cumulative aggregation
To avoid #COMPUTATION in a cumulative aggregation, the reset context must 
be included in the output context. In other words, the dimension or dimensions 
after the semi-colon (;) in the formula must also be listed after the operator (In, 
ForEach or ForAll) on the right of the formula.

Reminder: If no output context is defined in the formula, the calculation is made 
using the local context. To brush up on this concept, refer to “Understanding 
input and output contexts” on page 346.

To fix your formula:

1. Display the Formula Bar (Formula Bar command, View menu), then click the 
cell containing the formula.

2. Check that the dimension in the reset context is also specified in the output 
context. The following table will help you determine this:

3. Edit the formula in the Formula Bar, then press Enter.

When the reset context is Region and... Then...

Only the output context is defined, e.g.,
=RunningSum(<Revenue>;<Region>) In 
(<Region>,<City>))

Region must also be specified 
in the output context.

Only the input context is defined, e.g.,
=RunningSum(<Revenue> In 
(<Region>,<City>);<Region>)

Region must be present in the 
local context.

Neither the input nor output contexts are 
defined, e.g., 
=RunningSum(<Revenue>;<Region>)

Region must be present in the 
local context.

Both the input and the output contexts 
are defined, e.g., 
=RunningSum(<Revenue> In 
(<Region>,<City>);<Region>) In 
(<City>;<Region>)

Region must also be specified 
in the output context.
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#COMPUTATION in non-aggregate formulas
#COMPUTATION can occur in formulas that do not contain aggregate or 
running aggregate functions.

Description of #COMPUTATION in a non-aggregate formula
In non-aggregate formulas, #COMPUTATION occurs because the output context 
is not included in the input context. Here’s an example.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example #COMPUTATION caused by a conditional formula in a break footer

You can use an IF THEN formula to set a condition for displaying data in a report. 
The following formula

= If (<Year>="FY95") Then <Revenue>

displays the measure, Revenue, only when 1995 is also displayed.

In the report illustrated here, the formula is inserted in a break footer, and this 
causes #COMPUTATION:

Why? The input context required to display revenue for 1995 is Year, whereas the 
output context of the break footer is Resort. To fix this error, you add Year to the 
output context using the ForEach operator:

=(If (<Year>="FY95") Then <Revenue>) ForEach <Year>

Finally, you add Max (or Min) to return the single value you need:
=Max((If (<Year>="FY95") Then <Revenue>) ForEach <Year>)

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
BUSINESSOBJECTS now displays Revenue for 1995 in the break footer.
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Solution for #COMPUTATION in a non-aggregate formula
You must:

1. Edit the formula so that the output context is included in the input context, as 
described in the example above.

2. Add Max or Min to the beginning of the formula, followed by an opening 
parenthesis.

3. Add a closing parenthesis at the end of the formula, then press Enter.
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#MULTIVALUE

This section provides descriptions, examples and solutions for #MULTIVALUE 
in BUSINESSOBJECTS:

• #MULTIVALUE in aggregations such as maximum revenue per year

• #MULTIVALUE in break headers and footers

• #MULTIVALUE in a cell at the section level.

#MULTIVALUE in aggregations
The expression “aggregations” refers to any calculation containing an aggregate 
function such as Sum, Count, Min, Max etc. In reports, aggregations let you 
answer questions such as “What is the minimum revenue per city for each 
region?”.

This section provides a description of why #MULTIVALUE occurs in 
aggregations, with an example, and offers a solution.

Note: The information presented here requires that you understand 
BUSINESSOBJECTS extended syntax, which is described in “Using Extended Syntax 
for Advanced Calculations” on page 351.
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Description of #MULTIVALUE in an aggregation
#MULTIVALUE occurs in aggregations because

The output context is not included in the local context.

Here’s an example.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example #MULTIVALUE in an aggregation

Check out the following table:

The desired result in the right-hand column is revenue for a dimension that is not 
present in the table, e.g., Year. The formula

=<Revenue> In <Year>

returns #MULTIVALUE because Year is specified as the output context but it is 
not present in the local context, i.e., the table.

Note: The formula in this example does not begin with an aggregate function 
(Min, Max, etc.). If you omit the function in this way, BUSINESSOBJECTS calculates 
a sum by default. However, if the user had specified Sum or another aggregate 
function in the formula above, e.g.,

=Sum(<Revenue>) In <Year>

BUSINESSOBJECTS would have returned #COMPUTATION.

If the Year dimension is available in the document, you can, using extended 
syntax, calculate revenue per year without displaying Year in the table. To do 
this, you must define a formula with an input and an output context, like this:

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
=Sum(<Revenue> In (<Region>,<City>,<Year>) In <Year>)
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Solution for #MULTIVALUE in an aggregation
To avoid #MULTIVALUE in an aggregation, the output context must be included 
in the local context. In other words, the dimension(s) specified on the right of the 
formula after In or ForEach must be present. To fix your formula:

1. Display the Formula Bar (Formula Bar command, View menu), then click the 
cell containing the formula.

2. Check the following questions:
• Does the output context contain dimensions that are not in the block or 

section in which the formula is inserted? For example, if the following 
formula appears in a block that does not contain Year, you’ll get a 
#MULTIVALUE:

=Min(<Revenue>)In(<Year>)

• Does the output context contain more dimensions than the local context?
• For example

=Min(<Revenue>) In(<Region>,<City>)

• returns #MULTIVALUE in a table containing only one of these 
dimensions.

3. Edit the formula in the Formula Bar, then press Enter.
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#MULTIVALUE in break headers and footers
#MULTIVALUE can occur when you insert a variable in a break header or footer 
in a table or crosstab.

Description of #MULTIVALUE in a break header or footer
A break splits up the values of a variable and thus enables you to make 
calculations.

A break footer is a cell at the bottom of each value of the break. Users typically 
display text or calculations such as running totals in break footers.

#MULTIVALUE occurs in a break header or footer:

Here’s an example.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example #MULTIVALUE in a break footer

The table below shows the running total revenue for two customers. When you 
insert Age in the break footer, BUSINESSOBJECTS returns #MULTIVALUE:

This error occurs because variables with a 1:1 relationship, i.e., Customer and 
Age, are inserted at the same break level. By default, a break is based on one 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
variable only.

If You... Then You... And...

Set a break on a 
variable

Insert a second 
variable in the break 
footer

These two variables 
have a 1:1 relationship, 
as is the case with 
Customer and Age.
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Solution for #MULTIVALUE in a break header or footer
You fix this problem by including the variable from the header or footer in the 
break definition. Here’s how to do it:

1. Click inside the table or crosstab containing the break, then select the Breaks 
command on the Format menu.
The Breaks dialog box appears.

2. Click the icon of the break concerned, then click Edit.
A dialog box listing all the variables in the report appears.

3. Click the check box next to the variable you want to display in the break footer 
(Age in the example on page 385), then click OK.

4. Click OK in the Breaks dialog box.
BUSINESSOBJECTS displays the variable in the break footer. Here’s proof!
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#MULTIVALUE in a cell at the section level

Description
A report section displays data in a master cell and in a block or blocks. If you use 
two variables at the section level, #MULTIVALUE can occur. Here’s an example.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example #MULTIVALUE in a section containing Name and Address

You want to display customer names and addresses in a section, and the 
customers’ and revenue details in a table. You build a table containing Customer, 
Address, Invoice Date and Revenue, then drag Customer out of the block to 
create a section.

The next step is to drag Address out of the block, and drop it next to Customer. 
Here’s what you get:

Why? Because by default, there is only one master variable per section. When you 
place a second variable at the section level, BUSINESSOBJECTS thinks “ah, multiple 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
values occur here” so returns #MULTIVALUE.
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Solution #1 for #MULTIVALUE at the section level
The way round this problem is to turn the variable that returns the error into a 
measure. Here’s how to do it:

1. Click the cell containing the #MULTIVALUE error.

2. Select the Variables command on the Data menu.
The Variables dialog box appears:

3. In the dialog box, click the variable that returns the error.
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4. The next step depends on the type of variable you just clicked:

5. In the Variables dialog box, click Replace.
You replace the erroneous variable with the one you have just either created 
or modified. The data appears instead of the error.

Solution #2 for #MULTIVALUE at the section level
You can also fix #MULTIVALUE at the section level by applying the Min or Max 
function, which forces BUSINESSOBJECTS to display only one value. This solution 
works great for master variables with a 1:1 relationship, such as Customer and 

The Edit button is grayed. The Edit button is available.

It means that the variable you need 
to turn into a measure comes from 
a query on a universe.
You cannot edit variables that come 
from queries on universes, so you 
have to create a new variable 
instead. 

No problem, you can turn the 
variable into a measure. 

• Click Add. 
The Variable Editor appears.

• In the Definition tab, type a 
name for the new variable.

• In the Qualification box, click 
Measure.

• Click the Formula tab.
• In the Variables box, double-

click the name of the variable 
that returned the error. For 
example if you’re creating a 
new variable to replace 
Address, double-click Address 
in the Variables box.

• Click OK.

• Click Edit. 
The Variable Editor appears.

• In the Qualification box, click 
Measure, then click OK.
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Address (unless your customers have more than one address). If the variable 
returning #MULTIVALUE contains more than two values, you will only be able 
to display the first and last of these by applying Min or Max.

1. Click the master cell displaying #MULTIVALUE.

2. In the Formula Bar, type Min or Max after =, then add parentheses, like this:
=Min(<Address>)

3. Press Enter.

#######

Description
Simply means that the cell is not wide enough to display the data it contains in 
full. 

Solution
Double-click the cell’s right border. BUSINESSOBJECTS widens the cell to autofit the 
data.

#ALERTER

Description
This error occurs when an alerter contains a missing variable. For example, if the 
definition of the alerter contains the Revenue variable, #ALERTER appears if 
Revenue does not exist in the report.

The definition of the alerter itself may also be the cause of this error. For example, 
if you try to compare a measure with a dimension (Revenue greater than 
Country), #ALERTER is returned.

Solution
You can:

• Obtain the missing data by adding the corresponding object to the query (Edit 
Data Provider command, Data menu)

• Edit the alerter so that its definition contains only available data (Alerters 
command, Format menu)
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• Deactivate the alerter (Alerters command, Format menu, then uncheck the 
alerter in the dialog box).

• Check that the definition of the alerter does not contain a comparison such as 
that of a measure with a dimension.

Tip: To use the Alerters command on the Format menu, first click any cell 
containing data.

#DICT.ERROR

Description
In BUSINESSOBJECTS, you can format a report by applying a template. You do this 
by choosing Report, and then Apply Template from the Format menu. The Apply 
Template dialog box appears.

A template contains a set of variables, also referred to as the variable dictionary. 
The report you wish to format also contains a variable dictionary. When you 
apply a template, unless you click the Options button in the Apply Template 
dialog box, in order to specify the correspondence between the two variable 
dictionaries, BUSINESSOBJECTS automatically replaces the variables in the 
template with the variables in the report. In some cases, BUSINESSOBJECTS cannot 
match the variable dictionaries and returns #DICT.ERROR.

Solution
There is a simple way to fix this problem:

1. Click the cell containing #DICT.ERROR, then select the Variables command 
on the Data menu.
The Variables dialog box appears.

2. Click the variable or formula that you want to display in the selected cell.

3. Click Replace.
The Variables dialog box closes, and the variable or formula appears in the 
report.
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How to avoid #DICT.ERROR from the start
If the template you select has many more variables than the report you are 
working on, you may well end up with #DICT.ERROR. To avoid the problem:

1. From the Format menu, choose Report, then Apply Template.
The Apply Template dialog box appears.

2. Click the template you want to apply, then click Options.
The Template Options dialog box appears.

3. Uncheck Replace Variables Automatically, then click Define.
The Replace Variables dialog box appears.

4. In the Report Variables box, click a variable, then click a corresponding 
variable in the Template Variables box, making sure that the two variables are 
of the same type (dimension, measure or detail).

5. Click Replace, then repeat the previous step until you have replaced all 
variables from the template with variables from the report.

6. Click OK in the Replace Templates dialog box.
You return to the Template Options dialog box.

7. Ensure that Delete Undefined Template Variables is checked, then click OK.

8. Click OK in the Apply Template dialog box.
BUSINESSOBJECTS applies the template to the report.

#DIV/0

Description
Occurs when a formula performs a division by 0. For example, the formula

=<Revenue>/<Quantity Sold>

returns 20 if Revenue is 100 and Quantity Sold is 5. But if Quantity Sold is 0, then 
the result is #DIV/0.
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Solution
Using an IF THEN ELSE statement, you can set up a value or text, e.g., “No Sale”, 
which will appear when a division by zero occurs. To do this:

1. Switch on the Formula Bar command on the View menu.

2. Click inside the cell where #DIV/0 appears.

3. Write the following formula in the Formula Bar:
=If IsError (<VariableName>) Then “No Sale” Else (<VariableName>)

4. Press the Enter key.

Tip: You can use an IF THEN ELSE statement such as the one in the above 
procedure to return default values for errors other than #DIV/0.

#ERROR

Description
This error occurs when the definition of a formula or a variable within a formula 
is incorrect. For example, the formula that returns percentages based on a 
measure, such as

=<Nb Customers>/Sum(<Nb Customers>)

returns #ERROR if the measure, in this case Nb Customers, itself contains an 
error.

Solution
You need to break down the formula into its component parts in order to find 
which part contains the error. Here’s how:

1. Insert a new cell in the report (Cell command, Insert menu).

2. Select the cell containing the error, then select Copy on the Edit menu.

3. Select the new cell, then select Paste on the Edit menu.
The formula containing the error appears in the new cell.

4. Click the new cell, then in the Formula Bar, select one part of the formula.
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5. Copy and paste the selection into the cell where the error first occurred, then 
press Enter.

6. Repeat this step until you find the part of the formula that contains the error.

7. Fix the error, then paste the whole corrected formula back into the cell where 
the error first occurred.



 #IERR

  BusinessObjects User’s Guide   395

#IERR

Occurs in complex “formulas within formulas”. The three common causes are:

• Formulas combining measures and dimensions, where a dimension is missing 
from the calculation context

• Aggregations containing multiple formulas

• Formulas with complex WHERE clauses.

Tip: When you make calculations by combining formulas, #IERR may occur 
because the formulas within the formulas contain errors. If none of the solutions 
in this section get rid of #IERR, try breaking down the formula into its component 
parts, and test each one. This procedure is described under “#ERROR” on page 
393.

#IERR in a formula combining measures and dimensions

Description
BUSINESSOBJECTS supports aggregate formulas that contain both dimensions and 
measures. For example, the following formula displays revenue for customers 
called Prince:

=If(<Customer>=”Prince”) Then <Revenue>

BUSINESSOBJECTS qualifies any formula containing a measure (e.g., Revenue) as a 
measure. This qualification requires that all dimensions are present in the 
calculation context - the local context if none is specified. #IERR may occur when 
a dimension required to compute the formula is missing from the context.

Tip: For information on calculation contexts, refer to Chapter 15 "Calculation 
Contexts and Extended Syntax" on page 341.

Solution
You add the missing dimension to the context using the ForEach operator, and 
apply the Sum function. So, if 

=If(<Customer>=”Prince”) Then <Revenue>

returns #IERR, the formula you need is as follows:
=Sum((If(<Customer>=”Prince”) Then <Revenue>) ForEach 
<Customer>)
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#IERR in an aggregation containing a complex formula

Description
An aggregation such as Min, Max etc., used on a formula that already contains a 
formula, may produce #IERR.

Solution
The trick is to turn the formula within the formula into a variable, then rewrite 
the whole formula using the new variable. 

Remember that a variable is a formula with a name. So, once you have made your 
variable, to include it in your formula, all you have to do is write its name, rather 
than a complex formula within a formula. Here’s an example.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Solving #IERR by turning part of a formula into a variable

You want to know the week your top ten customers placed their first order. In a 
table containing the list of customers, you add a column and insert the following 
formula:

=Min(Week(<Order Date>))

If #IERR occurs, the first thing to do, using the Variables command on the Data 
menu, is to create a variable called WeekOrderDate from the formula

=Week(<Order Date>)

Then, rewrite the original formula using the new variable, as follows:
=Min(<WeekOrderDate>)

Please note that the original formula may work. The purpose of this example is 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
to show how to fix #IERR should it occur in similar formulas.
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#IERR in a formula using WHERE

Description
The WHERE operator lets you specify values of a dimension to include in a 
calculation. For example

=(<Revenue>*2) WHERE (<Customer>=”Prince”)

shows revenue at 200% for customers named Prince. #IERR can occur in WHERE 
clauses that contain complex formulas.

Solution
The trick is to turn conditions specified after WHERE into variables. Then, you 
can rewrite the whole formula, using the variables instead of the original 
formulas in the WHERE clause.

This is the same solution as for #IERR in an aggregation containing a complex 
formula. Refer to “Solving #IERR by turning part of a formula into a variable” on 
page 396 for more information.
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#OVERFLOW

Description
The calculation returns a number that is too big for BUSINESSOBJECTS to compute. 
The maximum is 17e +/- 308, or 15 digits.

Solution
Check the maximum value of the function used in the formula. For example, the 
maximum value for the Fact function is 709.

The BUSINESSOBJECTS online help on functions includes maximum values where 
appropriate.

#SYNTAX

Description
#SYNTAX occurs when a variable used in a formula no longer exists in the 
document. For example, the formula

=<Product Price> * <Quantity Sold>

returns #SYNTAX if the user deletes either object from the query.

The missing variable can correspond to

• An object returned by a query, or

• A local variable that you have defined in the report.

Solution
The way you fix this problem depends on the data available in the report:

If the variable you need is... Then...

Available as an object in the 
universe you are using

Edit the query (Edit Data Provider command, 
Data menu), add the object you need, then 
click Run.

A local variable that you have 
defined in the report

Create it in the Formula Editor (Variables 
command, Data menu, Add button).
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#UNKNOWN

Description
Occurs when the object corresponding to a variable displayed in the report has 
been removed from the query.

In BUSINESSOBJECTS, when you remove an object from a query, the corresponding 
variable is automatically removed from the report - sometimes. More specifically:

Note: If the missing variable is used in a formula, BUSINESSOBJECTS returns 
#SYNTAX.

Solution
You have to add the missing object to the query. Here’s how to do it:

1. Select the Edit Data Provider command on the Data menu. If the List of Data 
Providers dialog box appears, click the query you want to edit, then click OK.
The Query Panel appears.

2. Double-click the missing object in the Classes and Objects box.
The object appears in the Result Objects box.

3. Click Run.
BUSINESSOBJECTS replaces #UNKNOWN with the variable corresponding to 
the object you added.

Tip: If you do not want to add the missing data to your report, simply clear the cell 
containing the error. Select the cell, then press the Del key on your keyboard. To 
delete the cell, select the Delete command on the Edit menu.

If the variable is displayed in... Then BUSINESSOBJECTS...

• A table or simple crosstab
• A master cell

Removes it from the report.

• A free-standing cell
• A break header or footer

Returns #UNKNOWN.
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Tips and Tricks

This section provides tips for writing formulas and avoiding #COMPUTATION, 
#MULTIVALUE and other errors.

Tip Here’s how to do it:

1. All formulas must begin with =
If you forget =, BUSINESSOBJECTS 
displays the formula as text!

Type = before your formula!

2. The extended syntax of a formula 
shows you the contexts 
BUSINESSOBJECTS applies by default. 
There are two easy ways to see the 
extended syntax of a formula.

1. Click the cell containing the 
formula.

2. Rest your cursor over the 
Formula Bar. 
The extended formula appears 
in a tooltip.

- or -

1. Click the cell containing the 
formula.

2. Select the Define as Variable 
command on the Data menu.

3. Click Evaluate the formula in its 
context. 
The extended formula appears 
in the dialog box.

3. If you remove a dimension from a 
table, a calculation that needs that 
dimension can return an error. To 
avoid this, you can hide the 
dimension: it won’t appear in the 
report, but it will be included in the 
calculation.

1. Click the table containing the 
dimension you want to hide.

2. Click the Table command on 
the Format menu.

3. In the Pivot tab, click the 
dimension.

4. Click Hide, then click OK.

4. The best way to fix #MULTIVALUE 
is to include the variable returning 
the error in the current break.

Use the Breaks command on the 
Format menu. For more 
information, refer to “Solution for 
#MULTIVALUE in a break header 
or footer” on page 386
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5. If you get #MULTIVALUE when 
you insert a variable in a column 
header of a table, try fixing it by 
applying a sort.

1. Click the cell containing 
#MULTIVALUE.

2. Select the Sort command on the 
Insert menu.

6. When you create or edit a formula in 
the Formula Bar or the Formula 
Editor, you press enter to validate 
the formula. If there’s a syntax error, 
BUSINESSOBJECTS tell you so and 
highlights the anomaly in the 
formula itself. This helps you fix the 
specific problem.

• If a variable name is 
highlighted in full, add 
parentheses and check the 
spelling.

• If one end of a variable name is 
highlighted, add a parenthesis.

7. You can edit formulas directly in the 
report, without using the Formula 
Bar or the Formula Editor.

1. Double-click the cell 
containing the formula you 
want to edit.

2. Edit the formula in the cell, 
then press Enter when you’re 
done.

8. You can display the Formula Editor 
from the Formula Bar.

• Click this button:

9. You can view and edit all the 
formulas displayed in a report by 
switching to Structure view.

• Select the Structure command 
on the View menu.

10. BUSINESSOBJECTS lists all the 
formulas you create in a document 
in the Data tab of the Report 
Manager.

To open Report Manager, choose 
Report Manager from the View 
menu. Click the Data tab and 
expand the Formulas folder.

11. BUSINESSOBJECTS also lists formulas 
in the Variables dialog box. In this 
dialog box, you can view, edit or 
insert any formula you have created. 

1. Select the Variables command 
on the Data menu.

2. Double-click the Formulas 
folder.

3. To edit a formula, select it then 
click Edit.

4. To insert a formula, select it 
then click Insert or Replace.

Tip Here’s how to do it:
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Overview

Charts are the graphic equivalent of tables and crosstabs. BUSINESSOBJECTS has a 
very powerful and easy-to-use charting feature which enables you to produce 
sophisticated and visually appealing charts to display a simple summary of your 
data or to represent complex relationships in it.

• The first chapter of this part describes how to display data in charts in 
BUSINESSOBJECTS reports and how to organize the way the data is displayed 
on the chart.

• The second chapter describes the different elements (legends, titles, gridlines) 
you can add to your charts and how you can format them to obtain 
professional looking charts.
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Chart Types

BUSINESSOBJECTS has five basic chart types, some with a 2-D and some with a 3-D 
view.

2-D and 3-D Column

2-D and 3-D Line
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2-D and 3-D Area

2-D and 3-D Pie

XY Scatter chart
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Creating a Chart

There are several ways of creating a chart to display your data. You can:

• Use the Insert Chart wizard.

• Turn an existing table or crosstab into a chart.

• Copy & paste an existing table or crosstab and then turn it into chart.

To create a chart you need to use at least one measure object and one dimension 
or detail object.

Using the Insert Chart wizard
You can use the Insert Chart Wizard to insert a chart in a report using existing 
data from the document. To do this:

1. Click the Insert Chart button on the Report toolbar, or from the Insert menu, 
choose Chart.
The cursor changes to the insert chart icon.

2. Click in a blank part of the report and holding down the left mouse button. 
draw a box around the area where you want to display the chart.

Tip: The size of the box you draw determines the size of the area in which the chart 
will be displayed.

When you release your mouse button, the New Chart wizard appears.

3. Click the first option, Use existing data from the document, then click Begin.

4. Hold down the Ctrl key and select the variables you want to display in the 
chart. Click Next.

5. Choose the type of chart you want to display from the list and then choose a 
chart style. Click Finish.
The chart is displayed in the report.

Note: If you check Generate a Default Chart, BUSINESSOBJECTS automatically 
creates the default chart best suited to the number of variables you have selected 
in the list. If you check this option, the Chart Autoformat screen is not shown. Just 
click Finish to generate the chart.

Insert Chart
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Turning a table or crosstab into a chart
If the data you want to display in your chart is already displayed in a table or 
crosstab in your report you can change it automatically into a chart. To do this:

1. Select the chart.

2. Click the down arrow next to Chart Types button on the Report toolbar.

3. Choose the chart type from the menu.

- or -

1. Right-click on the table or crosstab.

2. Choose Turn to Chart from the popup menu
For each type of chart, there are several predefined styles. Each style provides 
a variation on the basic chart type as illustrated below.

3. Choose the type of chart you want to display from the list and then choose a 
chart style.

4. Click Apply to test the settings or OK to close the Chart Autoformat dialog box 
and save the settings.

Chart Types toolbar

Choose the 
type of chart 
from this list.

Choose from one of 
the pre-defined styles 
for the selected chart 
type.

When you click on a 
chart style, a short 
description of what the 
style consists of is 
displayed.



 Creating a Chart

  BusinessObjects User’s Guide   411

Tip: If you want to display the data from a table in a chart and keep the table:

• Copy the table or crosstab and paste it in a new location and then turn it to 
a chart.

Turning a chart into a table or crosstab
You can also turn data displayed in a chart into a table or crosstab.

1. Right-click on the chart.

2. Choose Turn to Table or Turn to Crosstab from the popup menu.
Turn to Table is displayed for a 2-D chart and Turn to Crosstab for a 3-D chart.

The data from the chart is displayed in a table or crosstab.

Using the best chart type for your data
When you turn a table or crosstab to a chart, BUSINESSOBJECTS will propose a 
default chart type based on the type of block -- table or crosstab -- and the number 
of variables in the block. This may not necessarily be the best chart type for your 
business data and you may need to experiment with other chart types to find the 
best presentation for your data.
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Switching between chart types
If you decide that you want to display your data as a pie chart rather than a 
column chart you can easily switch from one type of chart to another.

There are two ways to change chart type. The first method allows you to change 
from one chart to another. The second method additionally allows you to apply 
a predefined chart style to the chosen chart type.

To change chart type only

1. Select the chart.

2. Click the down arrow next to Chart Types button on the Report toolbar.

3. Choose the new chart type from the menu.
The data in the chart is displayed using the new chart type.

To change chart type and style

1. Right-click on the chart and choose Chart Autoformat from the popup menu.
The Chart AutoFormat dialog box appears:

2. Choose a chart type from the list and then a style for that chart type.

3. Click OK.
The new chart type is displayed in the report.

If you check this box, the 
default formatting for 
the selected chart style is 
applied to your chart 
and any custom 
formatting you have 
applied is lost.
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Organizing Chart Data

In all types of chart except pie charts, data is plotted on axes. Charts have two or 
three axes. Measure objects are always plotted on the Y-axis and dimension or 
detail objects are plotted on the X-axis or the Z-axis. 

You can re-organize how the data is displayed in charts by using the Pivot tab on 
the Format Chart dialog box. You can move data from one axis to another, re-
distribute data among the axes, add or remove data, temporarily hide data from 
your chart and, if you have more than one variable on an axis, you can change the 
order in which the variable is displayed on the axis.

Matrix charts
When you turn a table to a chart, the data is distributed over two axes.Matrix 
charts have at least one variable on each of the three axes of a chart. When you 
turn a crosstab to a chart, the data is automatically distributed over three axes. 
The example below shows how you get a different look to a column chart by re-
distributing the data over three axes.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Re-organizing data on chart axes in 2-D charts

The charts on the next page both represent revenue per quarter for three resorts. 
In both charts, Revenue, the measure variable is placed on the Y-axis.

In the first chart, the other two variables, Resort and Quarter, are both placed on 
the X-axis. This gives a column chart where all the columns have the same color 
since they all show Revenue.

Y-axis
measures

X-axis
dimensions or
details

Z-axis
dimensions
or details
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In the second chart, the variables have been re-arranged and Resort has been 
placed on the Z-axis. The columns are now grouped by quarters and Resort is 
represented by a different color column. This type of chart is called a matrix chart.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Showing multiple lines on a line chart

The two charts below both display data for one measure, Revenue, and two 
dimensions, Resort and Financial Year. In the first illustration below the two 
dimensions were both placed by default on the X-axis. By moving Resort to the 
Z-axis, as shown in the second illustration, you can show multiple lines on the 
same chart and see the revenue plotted for each resort.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Re-organizing data on chart axes in 3-D charts

In the illustration below, the first chart shows the Quarter variable plotted on the 
Z-axis and the Service Line variable on the X-axis. In the second chart these two 
variables have been swapped by dragging Quarter into the X-axis folder on the 
Pivot tab of the Chart Format dialog and dragging Service Line into the Z-axis 
folder. Quarter is now plotted on the X-axis and Service Line on the Z-axis.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Reorganizing chart data
To reorganize the data in a chart:

1. Right-click on the chart.

2. Choose Format Chart from the popup menu.
The Chart Format dialog box appears.
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3. Click the Pivot tab.

The Pivot tab shows a representation of the data in the chart:

• The Available Variables box lists the variables you can display in the chart. 

• The Used Variables box contains three folders. These folders show the 
variables that are already displayed on the X-axis, the Y-axis and the Z-axis.

4. Make the required changes and click Apply or OK.

Moving Data

To move data from one axis to another:

• Drag the variable from the its current axis folder and drop it in the new one.

To change the order in which data appears on chart axes:

1. In the Used Variables box, select the variable you want to move.

2. Click Move Up or Move Down.

In 2-D charts, the variables 
are shown in the X-axis 
and Y-axis folders.
Numeric data is always 
shown in the Y-axis folder.
In matrix charts, there is at 
least one variable in each 
of the three folders.
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Removing or hiding data
You can hide a variable so that the data is temporarily not displayed on the chart. 
You can also remove the variable permanently from the chart.

1. In the Used Variables box, select the variable you want to remove or hide.
To remove or hide more than one variable at the same time, hold down the 
Ctrl key and select the variables.

2. Click the Remove button or the Hide button.
Hidden variables are grayed in the Used Variables box. Removed variables 
are no longer displayed.

• To display a previously hidden variable, click it in the Used Variables list, then 
click Show.

• To add a variable from the Available Variables list, click it, then click Add.

The variable appears in the folder you selected.

Note: You can also re-organize chart data using slice-and-dice mode. See Chapter 
21 "Using Slice and Dice Mode" on page 499.



Chapter 17 Creating Charts

418   BusinessObjects User’s Guide



  BusinessObjects User’s Guide   419

  Chapter 18 Formatting Charts
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

In this chapter 

 ❑ Overview 420
 What makes up a chart? 420
 Selecting chart elements 421

 ❑ General Formatting 422
 Choosing elements to display 422
 Formatting the chart block 422
 Resizing the chart block 424
 Formatting the plot area 426

 ❑ Formatting the Data Series 428

 ❑ Chart Specific Formatting 429
 Column charts 429
 Area charts 430
 3-D charts 431

 ❑ Formatting Chart Axes and Axis Labels 434
 Axis labels 434
 Axis scale 437
 Scaling charts in Master/Detail reports 438



Chapter 18 Formatting Charts

420   BusinessObjects User’s Guide

 ❑ Helping Users to Read your Chart 440
 Chart title 440
 Chart Legend 441
 Data labels 443
 Gridlines 445

 ❑ Using Different Chart Types on one Chart 447
 Using groups on charts 447
 Using a secondary Y-axis 449

 ❑ Deleting Charts 454

 ❑ Displaying a Calculation on Data in Charts 455

 ❑ 



 Overview

  BusinessObjects User’s Guide   421

Overview

The elements that make up a chart can be formatted in different ways. Some 
elements are common to all types of chart and some appear in certain types of 
chart only.

What makes up a chart?
The illustration below shows the elements of a chart and what you can do to 
format them.

a. Change the color, border and shade of the plot area.

b. Apply text, number and date formats to the Y-axis labels.

c. Change the scale and style of the Y-axis, where numeric data is plotted.

d. Change the style of the X-axis.

e. Apply text and date formats to the X-axis labels.

f. Display and format a title.

g. Change the color, border and shade of the chart block.

h. Display and format a legend key.

i. Change the color, border and shade of the data series.

j. Display/hide tick marks on the X-axis; change their style and color.

a

c

i

b

d

e

j

f

g

h



Chapter 18 Formatting Charts

422   BusinessObjects User’s Guide

Selecting chart elements
You set the formatting attributes for chart elements on the Format dialog box. 
There are different ways in which you can open this dialog box. You can:

• Right-click on the chart element and choose Format [chart element] from the 
popup menu. 
This command is dynamic: it refers to the chart element that you selected. For 
example, if you right-click on the chart axis, the menu command is Format 
Axis Label.

• Double-click the chart element that you want to format. 

• Select a chart element, such as the slice of a pie chart, then choose the [chart 
element] command on the Format menu.

A dialog box is displayed. The dialog box, like the menu command, is dynamic: 
its name and tabs depend on the chart element that you first selected.
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General Formatting

This section describes general formatting options.

Choosing elements to display
You can display and hide axes, walls, a legend or a title on your chart.

To do this:

1. Right-click on the chart and choose Format Chart from the menu.
The Chart Format dialog box opens.

2. Click the General tab.

3. Set the required options as described below:

4. Click OK to save the settings and close the dialog box.

Formatting the chart block
The chart block is the term used to describe all the elements that make up a chart 
and the area in which they are contained. It includes the plot area, the title, the 
legend and the data series labels. You can resize the chart block and apply a 
border and shading to it.

Type in a name for 
the chart

Set the elements you want 
to display on the chart.

Some elements are only 
available for certain types 
of chart.

Places the selected 
chart on a new 
page.

Repeats the 
selected chart on 
every page of the 
report

Where possible, starts a 
new page for charts 
that would otherwise 
be split by a page 
break.
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To do this:

1. Right-click on the chart and choose Format Chart from the menu.
The Chart Format dialog box opens.

2. Click the Border tab to set and format a border.
Set the required options as illustrated below:

3. Click OK to save the settings and close the dialog box.

Select the line style.

Click to open the color 
palette.

Clear the style 
from all borders.

Apply the style to 
outer borders.

Select the 
borders you 
want to format.

Chart block border

Chart block 
shading
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4. Click the Shading tab to set and format the color you want to apply to the chart 
block.
Set the required options as illustrated below:

Resizing the chart block
Once you see your chart actually displayed you may need to resize it. You can 
resize charts using your mouse.

1. Hold down the Alt key and click inside the chart.
A border with handles appears around the chart.

2. Rest the mouse pointer over a handle. When the pointer changes to a double-
headed arrow, click the handle and hold down your mouse button.

Click here to select a 
color you want to the 
foreground.

Click here to select the 
color you want to apply 
to the background.

Choose the pattern 
or shade from the 
list.

If you choose Clear, 
you apply the 
Background color 
only.

If you choose Solid, 
you apply the 
Foreground color 
only.

The other settings 
mix the two colors.

Click None if you do 
not want to apply 
shading. This makes 
the background 
transparent.

This box displays a 
preview of the shading 
that will be applied to 
the section.

A handle appears on each border 
and corner of a selected chart.
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3. Drag the handle until the chart’s height or width reaches the required size.
Note that if you drag a handle on a corner of the chart, you can adjust the 
height and width simultaneously.

4. Release the mouse button, then repeat the previous steps, if necessary, to 
make further adjustments.

Keeping the plot area proportionate to chart size
When you enlarge the size of the chart block, the plot area of the chart is not 
automatically enlarged.

When you reduce the size of the chart block, however, BUSINESSOBJECTS reduces 
the chart’s plot area proportionately.

To keep the plot area proportionate to the chart’s size when you enlarge the chart 
block:

1. Enlarge the chart.

2. Right-click on the chart and choose Format Chart from the popup menu.
The Chart Format dialog box appears.

3. Click the General tab.

4. On the General tab check Adjust Plot Area to Chart Size and click OK.
BUSINESSOBJECTS resizes the plot area in proportion to the size of the chart.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Adjusting the plot area to the chart size - before and after

In the first illustration the chart has been enlarged. In the second illustration the 
option Adjust Plot Area to Chart Size has been checked and the graph is enlarged 
to fit inside the enlarged area.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Formatting the plot area
The plot area is the area where the data series and the axes are displayed as 
illustrated:

The plot area is contained within the chart block. You can apply color and shade 
and put a border around it.
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To format the plot area

1. Right-click inside the plot area without clicking any other chart element. 

2. Choose Format Plot Area from the pop-up menu.
The Plot Area Format dialog box appears. It contains the Pattern tab only:

3. Select the formats that you want to apply and click Apply or OK. 

Deselect Fill if you do not want to 
apply shading or color.

Click here to select a 
color to apply to the 
shade.

Select the pattern or 
shade you want. Note 
that Clear applies the 
Background color, 
whereas Solid applies 
the Foreground color. 
The other settings show 
both colors and the 
pattern or shade you 
select.

Deselect Border if you 
do not want to apply 
borders.

Select the border 
style to apply.

Select the border 
color to apply.
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Formatting the Data Series

Data series map the data in a chart. In a pie chart, a data series is a slice of the pie. 
In a line chart, it is a line, in a column chart, a column, and so on.

To format the data series

1. Right-click on the data series.

2. Choose Data Series from the pop-up menu.
The Data Series Format dialog box opens. 

3. Make the required changes and click Apply or OK.

 

Data Series Format dialog box for 2-D Line and XY Scatter charts

For... You can format....

Column, Area, Pie, 3-D 
Line

Border, color, shading

2-D Line, XY Scatter Line style, marker style

Deselect Line if you 
want to display no 
lines, but only 
markers.

Select the line color 
to apply.

Select the line style 
to apply.

Deselect Marker if you 
want to display no 
markers, but only lines.

Select the marker style 
to apply.
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Chart Specific Formatting

The following section describes formatting that you can only use on certain types 
of chart.

Column charts
You can enhance the appearance of your column charts by setting how the 
columns are placed on the chart.

To change these settings:

1. Right-click on the chart and choose Format Chart from the menu.
The Chart Format dialog box is displayed.

2. Click the Series tab.

3. In the Groups and Data series section, select the group you want to format.

4. In the Group Type section, click the column chart icon.

• Type a value between 0 and 500 in the Gap Width box.

or

• Type a value in the Overlap box.

5. Check the Show Negative Values checkbox if you want to display negative 
values on your column chart.

6. Click Apply to see how the changes look on the chart.

7. When you are satisfied with the result, click OK to close the dialog box and 
make the changes. 

• You can define the amount of space you want to 
have between each set of columns.

• You can overlap columns in the same set.

• You can choose to show or hide any negative values 
you have in your data.
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Area charts
There are certain elements that you can add to line and area charts to highlight 
certain aspects of your data. 

To add these options:

1. Right-click on the chart and choose Format Chart from the menu.

2. Click the Series tab in the dialog box that appears.

3. In the Groups and Data series box, click the line or area chart icon.

4. Check the options you want to display on your chart:

• High-Low Lines, Drop Lines and/or Up-Down Bars for line charts.

• Drop Lines for area charts.

5. Click Apply to see how the changes look on the chart.

6. When you are happy with the result, click OK to close the dialog box and 
make the changes.

Drop lines Lines extending from a point in the chart down to the X-
axis.

Up-down 
bars

Bars that extend from the highest value of one data 
series to the lowest value of another data series. You can 
only display up-down bars in charts that display data 
for two measures.

High low lines Lines going from the highest to the lowest value for 
numeric data. You can only display high-low lines and 
up-down bars in charts that display data for two 
measures
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3-D charts
The illustration below shows the elements specific to a 3-D chart and what you 
can do to format them:

Formatting chart walls
In some 3-D charts, you can display and format three walls: the back wall, side 
wall and floor.

To display walls:

See “Choosing elements to display” on page 423.

To format walls:

1. Right-click on the wall you want to format.

2. Choose Format Wall from the pop-up menu. 

The Wall Format dialog box appears. It contains the Pattern tab only. For 
information on how to apply formats using this dialog box, refer to page 428.

a. Change the color, border and shade of the side wall.

b. Change the color, border and shade of the back wall.

c. Adjust the 3-D view

d. Display the Z-axis, and format its axis labels.

e. Change the color, border and shade of the floor.

b

d

e

a

c
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Formatting the 3-D view
A chart's 3-D view consists of its elevation, rotation and ratio. With some chart 
types, you can also adjust the chart's depth and thickness. When you create a 3-D 
chart you may need to experiment with these settings to get the best possible 
view. To set these options:

1. Right-click on the chart and choose Format Chart from the menu.

2. Click the Series tab.

3. Click the 3-D view button.

4. Make the settings described below and click OK or Apply.

Defining the 3-D view of a chart

1. In the Elevation box, set a value either by clicking Up or Down, or by typing 
a value between -90 and 90.
Elevation is measured in degrees. 

2. In the Rotation box, set a value either by clicking Up or Down, or by typing a 
value between 0 and 360. 
Rotation is measured in degrees. The value you set rotates the chart 
horizontally.

3. In the Height % of Base box, type a value between 5 and 500. The value 
corresponds to the ratio between the height and width of the chart. For 
example, 200% means that the chart will be twice as high as it is wide (from 
left to right). 

4. If you want the chart to cover the plot area, click AutoScale.
The AutoScale option is not available for pie charts.

Note: For pie charts, the angle you set in the Rotation box is the angle at which the 
first slice of the pie begins (an angle between 0 and 360, clockwise from the top). 

Defining the depth and thickness of a 3-D chart.

1. In the Chart Depth box, type a value between 20 and 2000.
The value you type determines the depth of the chart floor. The higher the 
value, the deeper the floor.
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2. In the Gap Width box, type a value between 0 and 500.
This value determines the distance in depth between the data series displayed 
in the chart. 

Note: You cannot use this feature in pie charts.
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Formatting Chart Axes and Axis Labels

The horizontal and vertical axes of a chart are called the X-axis and the Y-axis 
respectively.

Matrix charts contain a third axis, the Z-axis.

You can work on chart axes and axis labels in the following ways:

• Format the text, numbers or dates of the axis labels.

• Change the orientation of the axis labels (horizontally, vertically, etc.).

• Apply different axis styles and colors.

• Display tick marks, and change their style.

• Change the scale of the Y-axis.

Axis labels

1. Right-click on the axis you want to work on.
The illustration below shows a chart with the Y-axis selected.

X-axis

Y-axis

Axis labels

Tick mark
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2. Choose Format Axis Label from the pop-up menu.

The Axis Format dialog box opens.

• If you selected the Y-axis, the dialog box contains five tabs, as shown below. 

• If you selected the X-axis or the Z-axis, the dialog box does not contain the 
Scale tab, as this tab is used to change the scale of the Y-axis only.

• Use the Number tab to edit number and date formats on the axis labels.
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• Use the Alignment tab to change the orientation of the axis labels:

• Use the Font tab to apply different text formats to the axis labels.

• Use the Pattern tab to display and edit tick marks. You can also change the 
axes’ line style and color:

• Use the Scale tab to change the scale of the Y-axis. See below.

Select an orientation, 
then click Apply. 

This is the default 
orientation. 

Position the tick marks 
by clicking a button. 

Deselect Tick Mark if 
you want to display no 
tick marks.

Deselect Line if you 
want to hide the axis 
lines.

Select the line style to 
apply to the chart 
axes.

Click here to select a 
color to apply.
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Axis scale
The scale of a chart determines the minimum and maximum values on the chart's 
Y-axis, where numeric data such as Revenue is plotted. The scale also includes 
the intervals between the values on the axis. You can change the scale to broaden 
or narrow the range of values displayed.

To define the scale of a chart

1. Click the axis label of the Y-axis. 
This can be the primary or the secondary axis.

2. Click the Axis Labels command on the Format menu.

3. Click the Scale tab in the dialog box that appears.

4. In the Value (Y) Axis Scale box, click the following options:

5. In the Scale box, click Decimal for a scale in decimal numbers, or Logarithmic 
for a scale to the power of 10, based on the range of data plotted in the chart.

6. Click Apply or OK.

Logarithmic scale
Negative or null values are not displayed in logarithmic charts. The value of the 
Major Unit option must be to the power of 10. If you enter a value to a different 
power, it will be rounded up to the nearest power of 10.

A logarithmic scale enables you to display very low values, or values that cover 
a broad range.

If you enter decimal values for the chart's scale and then click Logarithmic, 
remember to edit the values accordingly.

Minimum, to display the lowest value as the minimum value 
on the Y-axis. To specify a different value, type the 
minimum value in the box.

Maximum, to display the highest value as the maximum 
value on the Y-axis. To specify a different value, type the 
maximum value in the box.

Major Unit, to set an automatic interval between the values 
on the Y-axis. To specify the interval you want, type a value 
in the box.
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Scaling charts in Master/Detail reports
In a Master/Detail report a chart is displayed for each value of the master in a 
separate section. Since the range of values may be different in each section, you 
can, if necessary, use different scaling on for each chart so that the values on the 
chart are better displayed. 

To do this:

1. Right-click on one of the charts in the Master/Detail report.

2. Choose Format Chart from the menu.

3. Click the General tab.

4. Check the Adjust Scale to Value Range option.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Adjusting scaling in a master/detail report

This report shows revenue per service line for each country. The range of values 
is quite different for France and the US and with Adjust Scale to Value Range 
turned on, the range of values displayed on the Y-axis is different for the two 
charts.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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Helping Users to Read your Chart

There are a number of items you can add to your charts to make them easier for 
your audience to read and interpret, for example you can add a chart title or a 
legend. These are described in the following section.

Chart title
A chart title is a cell in which text is displayed. You can edit and format the text, 
as well as move the title and format the cell.

Adding a chart title

1. Right-click anywhere inside the chart.

2.  Choose Insert Title from the pop-up menu.

3. Double-click the chart title.
The default title is highlighted

4. Type in the name and press the return key.

Positioning the chart title

• Click inside the chart title and drag it with your mouse to the required 
position.

Title

Gridlines

Legend
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Formatting the chart title

1. Right-click inside the chart title.

2. Choose Format Title from the pop-up menu. 
The Title Format dialog box appears. It has four tabs: Number, Alignment, 
Font and Pattern.

3. Make the required settings and click OK.

Resizing the chart title

If the text in the chart title does not fit in the title cell, you can resize it. 

1. Select the title.
A hatched border with handles appear around it.

2. Use the handles to re-size the cell.

Note: If you drag the title cell’s border beyond a chart boundary, BUSINESSOBJECTS 
automatically enlarges the chart accordingly.

Deleting the chart title
• Right-click on the chart title and choose Delete from the popup menu.

Chart Legend
The chart legend explains what the data in the chart represents. It is a rectangular 
box, containing the names of the variables (the legend text) and their 
corresponding color, shade and border (the legend key): 

Displaying a chart legend

• Click the Legend button on the Report toolbar.

or

1. Right-click on the chart.

2. Choose Insert Legend from the pop-up menu.

Legend key Legend text
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Format and moving the legend

You can format the legend by changing its border, color and shade. You can also 
move the legend to a different place in the chart. To do so:

1. Select the border of the legend.

2. Choose Legend from the Format menu.
The Legend Format dialog box appears:

3. In the Placement tab, click a radio button to reposition the legend in the chart.

4. In the Pattern tab, select the border style and color, and the pattern and color.

5. Change the alignment and font of the legend text in the Alignment and Font 
tabs.

6. Click OK or Apply.
The legend appears in its new position, with its new formats.

Tip: You can also move the chart legend by clicking it and dragging it.
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Formatting the legend key

You can change the border, shade and color of the legend key. The formats that 
you apply are immediately visible in the chart’s data series. For example, if you 
change the color of a square in the legend from yellow to red, the corresponding 
data in the chart is also changed to red.

1. Right-click the legend key.

2. Choose Legend Key from the pop-up menu.

The Legend Key Format dialog box appears. It contains the Pattern tab only.

Formatting the legend text

You can format the legend text by changing its font attributes (e.g., font, font 
size), and by realigning it. The formats that you apply only appear in the legend 
text, not in the text of the chart’s axis labels. 

1. Right-click the legend text and choose Format Legend Text from the menu. 
The Legend Text Format dialog box appears. It an Alignment and a Font tab.

2. Make the required settings and click Apply or OK. 
The new formats appear in the legend text.

Resizing the legend

1. Select the Legend.
A hatched border with handles appear around it.

2. Use the handles to re-size the legend box.

Deleting the legend

• Right-click on the legend and choose Delete from the pop-up menu.

Data labels
Data labels appear next to a chart’s data series, for example next to each slice of a 
pie chart. They indicate the exact values or percentages of the data series. In the 
pie chart illustrated below, the data labels show revenue share per resort:
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Displaying data labels

1. Right-click the data series (e.g., a slice of a pie chart).

2. Choose Insert Data Labels from the pop-up menu.
The Data Labels dialog box appears:

3. Select the data label type you want and click Apply or OK.

Formatting data labels
You can apply specific number and text formats to data labels, as well as realign 
them. You can also change data labels, or remove them.

1. Right-click on the data label.

2. Choose Format Data Labels from the pop-up menu. 

The Data Labels Format dialog box appears. It contains three tabs: Number, 
Alignment, and Font. 

Changing or removing data labels

1. Right-click on the data label.

2. Choose Insert Data Labels from the pop-up menu. 
The Insert Data Labels dialog box appears. 

3. To remove the data labels, click “None”. 

4. Otherwise, click the type of data label that you want to display and Click 
Apply or OK.

a. Displays the exact value, e.g. $10,235.

b. Displays the percentage of each data series.

c. Displays the “name” of the data series, e.g. Revenue.

d. Displays the “name” and the percentage of each data series.

a

b

c

d
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Gridlines
Gridlines help you to see a chart’s values more easily. They begin at the chart’s 
axes and extend across its wall(s).

Note: You cannot display axes and gridlines in pie charts.

Displaying gridlines

1. Right-click anywhere in the chart.

2. Choose Display Axes/Gridlines from the pop-up menu.
The Axes and Gridlines dialog box appears.

Category (X) axis 
gridlines

Series (Z) axis 
gridlines

Primary (Y) axis 
gridlines
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3. Set the required options and click Apply or OK.

Formatting gridlines
You can format gridlines by changing their color and line style.

1. Right-click on the axis or gridline.

2. Choose Format Axis Label from the menu.

3. In the Axis Label Format dialog box that appears, click the Pattern tab. 

For information on how to use this tab, refer to page 437.

You can only format one axis and its associated gridlines at a time. For example, 
if you click an X-axis gridline, the formats you select in the Axis Label Format 
dialog box are applied to the X-axis and its gridlines only.

d
e

f
g

a. These options are checked by default. Click a check box to hide an axis.

b. Only available if you have created a group and associated a secondary axis to it.

c. This option is checked by default in 3-D matrix charts (illustrated on page 432). Click 
the check box to hide the Z-axis.

d. Displays gridlines that extend vertically from the X-axis.

e. Displays gridlines that extend horizontally from the Y-axis.

f. Refer to (b), above.

g. Only available in 3-D matrix charts, this option displays gridlines that extend 
horizontally from the Z-axis, across the chart’s floor.

a

b
c
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Using Different Chart Types on one Chart
A useful feature of BUSINESSOBJECTS charts is that you can display data in more 
than one way on the same chart. For example, you can display some data in a line 
and other data in columns in the same chart as shown below. This allows you to 
make a distinctive visual comparison between data.

Using groups on charts
In order to use different chart types, BUSINESSOBJECTS uses the notion of groups. 
You add the variables you want to display on the chart to the different groups 
and then assign different chart types to different groups. To do this:

1. Right-click on the chart and choose Format Chart from the menu.
The Chart Format dialog box opens.



 Using Different Chart Types on one Chart

  BusinessObjects User’s Guide   449

2. Click on the Series tab.
By default, a chart has only one group.

3. Click the Add button to add a new group.
A new group is added.

4. Right-click on the Groups and Data Series box and choose Variables from the 
menu.

5. Click or create the variable you want to add, then click Insert.
The new variable appears in the group folder. To view the variables now in 
the group, click the + sign.

Tip: If the variable you want to use in the group is already displayed in the Series 
tab, you can drag it to the new group. 

6. Select the new group and choose a chart type and subtype.

7. Click OK to close the dialog box and see the result on your chart.

Choosing the type of chart
When you choose a chart type for a group certain charts have subtypes from 
which you can choose. Also bear in mind the types of charts you want to combine 
as some combinations give better results than others. The table below gives you 
some recommendations.
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The Group Type offers only one possibility if you selected a scatter chart or a pie 
chart. If you selected an area, column or line chart, 2-D or 3-D, you can now 
choose between a standard chart, a stacked chart or a 100% stacked chart.

The following table shows the chart combinations that give the best results.  

Using a secondary Y-axis
If you have two measures on a chart you can use a secondary Y-axis. This allows 
you to display different values on each of the axes and different scales which can 
make your chart more readable.

The primary axis is displayed on the left, the secondary axis on the right. 

You can display all the groups in a chart on the primary axis or all on the 
secondary axis. However, you will often obtain the best result by placing one 
group on the primary axis and one group on the secondary axis.

Chart Type Available Subtypes

Area/line/
column

Standard, stacked chart or 100% stacked area, line 
or column chart respectively

Scatter Standard scatter

Pie Standard pie

Group 1 chart type Group 2 chart type

Column Line

Column Area

3-D Column 3-D Line

3-D Column 3-D Area

Scatter Scatter

Pie Not possible
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Comparing revenue and quantity sold in a chart

In this chart, a clear and effective visual comparison is made by showing the 
difference in a column chart between projected and actual revenue and then 
using a line chart to compare quantity sold.

To create this type of chart:

The original chart is set up using the Insert Chart wizard. The chart has four 
variables: Quarter, Projected Sales Revenue, Sales revenue and Quantity sold. 
You choose a simple column style from the wizard.

Each measure is represented by a different colored column. However, in reality, 
revenue is calculated in dollars and quantity sold in number of units. The values 
displayed by default on the Y-axis represent dollars so you cannot even see the 
Quantity sold column on the chart.

This chart can be improved in two ways:

• by using a different chart type for quantity sold and for revenue 
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• by displaying data on two axes, one axis with values in dollars and the other 
with number of units. 

To do this:

1. Right-click on the chart and choose Format Chart from the menu.

2. Click on the Series tab of the Chart Format dialog box.

3. In the Groups and Data Series section, open the Group 1 list.
You see that, by default, all the measures have been placed in the same group 
and are on the same axis. 

4. Drag the Quantity sold variable from Primary Y-axis to the Secondary Y-axis.
A new group is created on the Secondary Y-axis.
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5. Select Group 2 and choose Line from the Group Type list.
Notice that the icon next to the Group 2 list is a line chart icon.

6. Click OK to close the dialog box and see the result.

The Primary Y-axis 
displays the values 
in dollars for 
projected and 
actual revenue 
shown in the 
column chart

The Secondary Y-axis 
displays the values for 
Quantity sold shown in 
the line chart
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You now have Revenue and Quantity sold displayed on different types of chart. 
You see more clearly the difference between actual and projected revenue and the 
accompanying progression in quantity of units sold.You can further enhance 
your chart by setting an overlap for the two columns and by formatting the 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Primary-Y axis labels to display the dollar symbol.
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Deleting Charts

To select a chart

1. If part of the chart is selected, click a blank space outside it. 

2. Hold down your Alt key and click once inside the chart. 
A hatched gray border appears around the chart:

To select two or more charts

1. Click a blank space in the report.

2. Drag the mouse until you have covered part of each chart you want to select.

3. Release the mouse button.
A hatched gray border appears around each selected chart.

Hatched gray border that 
appears when the block is 
selected.
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Displaying a Calculation on Data in Charts

In the report illustrated below, the share of revenue per resort in FY95 is shown 
in a pie chart. The calculation on the data in the chart, total revenue for the year, 
is shown in a cell above the chart:

You can display a calculation on data in a chart in the following way:

1. Insert a cell in the section where you want the calculation to appear.

2. Type an “equal to” sign (=). 

3. If you are using a variable to make the calculation, type:
• a “less than” sign (<)
• the name of the variable
• a “greater than” sign (>).  

For example, to display the Revenue variable in the cell, type =<Revenue>.

4. If you are using a formula to make the calculation, type it after the = sign.

5. Press the Enter key to view the result of the calculation.

Tip: You can also drag a calculation from a table or a crosstab and drop it in the 
section where the chart appears.

The calculation on the 
chart data appears here.



 Part V
Analyzing Data
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Analyzing Data in BusinessObjects

With BUSINESSOBJECTS, you analyze data by looking at it on different levels of 
detail and from different viewpoints. Through your analysis, you gain new 
information and thereby answer questions.

You need go no further than the BUSINESSOBJECTS interface to address all your 
multidimensional analysis needs:

• BUSINESSOBJECTS on-report analysis allows you to work directly on your data 
in your report using drag and drop and or with simple mouse clicks.

• EXPLORER, an optional component in BUSINESSOBJECTS, enables you to carry 
out multidimensional analysis in Drill mode.

• BUSINESSMINER, another optional component, allows you to analyze data 
using data mining technology.

• OLAP servers are databases that store summarized data, ready for business 
analysis

• BUSINESSOBJECTS Slice and Dice mode allows you to organize data for analysis 
in the slice and dice panel.

On-report Analysis

Part III of this User’s Guide describes how BUSINESSOBJECTS on-report analysis 
allows you to analyze your data directly on your report using easy mouse clicks 
and drag and drop or with a simple mouse click.

You can drag and drop data on your report to get a different viewpoint for your 
analysis. You can add data from the Report Manager to create tables and sections, 
you can replace, swap and re-organize data on the report. BUSINESSOBJECTS 
redoes the calculations in your report immediately so that you can see at once 
how different combinations of factors affect your performance.

Dynamic on-report grouping allows you to create groups for comparative 
analysis and you can quickly insert common business calculations or easily create 
your own formulas and variables for analysis.

You can sort, filter and rank your data using a simple mouse click to focus your 
analysis on a slice of data.
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BusinessObjects Drill Mode

BUSINESSOBJECTS drill mode allows you to analyze data from different angles and 
on different levels of detail. Typically, you start off by looking at the high level 
data and when you spot an unusually low or high value, or an unexpected value, 
you can analyze it by displaying related data on a more detailed level. This allows 
you to see how different factors of your business, seasonal, geographical, product 
line affect your revenue.

You can analyze data in Drill mode if you have the EXPLORER module.

BusinessMiner

Using BUSINESSOBJECTS, you can view different aspects of your data to see how 
different factors affect your business.

BUSINESSMINER enables you to discover the hidden patterns and relationships in 
your data. Using powerful statistical methods, it can quickly and automatically 
find patterns in customer behavior, for example. This can help you identify the 
characteristics of customers likely to default on payments or help you improve 
customer retention by targeting services according to the customer profiles you 
have identified.

BUSINESSMINER is an optional product. Once you install BUSINESSMINER, you can 
open it directly from BUSINESSOBJECTS and continue working on the data you 
have in your BUSINESSOBJECTS report.

For more information on BUSINESSMINER, refer to the BusinessMiner User’s Guide

OLAP Servers

If you work with an OLAP server, you can view and select the data you want 
when creating a report. OLAP servers are databases that store summarized data, 
ready for business analysis.

For more information on OLAP servers, refer to the OLAP Access Pack 
documentation for the server at your site.
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Slice and Dice Mode

Chapter 21 "Using Slice and Dice Mode" on page 499 describes how you can use 
the slice and dice panel to add, delete and swap data round, to analyze your data 
from a different viewpoint.
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Overview

This chapter describes how to use BUSINESSOBJECTS drill mode.

What is drill mode?
Drill mode is a BUSINESSOBJECTS analysis mode that allows you to break down 
data and view it from different angles and on different levels of detail to discover 
what is the driving factor behind a good or bad result.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Why is revenue better in this resort than in the others?

You see that revenue is much higher in the Hawaiian Club resort than in the 
others. To find the reason for this, you need to look at all the factors that affect 
revenue.

If you displayed all the factors that could be useful for analysis in a table or chart, 
it could be difficult to read. Drill mode allows you to include data for analysis 
behind the scenes of your report and display only the top level data. You can then 
go down one level at a time and display more detailed information. This allows 
you to see how different aspects of your business affect your revenue step by step.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
This behind-the-scenes data is set up by the person who creates the report.
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How does drill mode work?
When you make a query on a BUSINESSOBJECTS universe, the objects you can 
include are grouped in folders and organized in a specific order.

The person who creates the BUSINESSOBJECTS Universe classes objects and 
organizes them in a hierarchy, with the most general object in the class at the top 
and the most detailed at the bottom.

Objects are grouped in this way to make it easy for you to find what you are 
looking for. They are classified inside the groups so that if you want to make a 
high level report you know you need to include objects at the top of the list in 
your query and if you want a more detailed report than you choose objects from 
further down the list.

Hierarchies
Objects are also organized in this way for drilling. When you analyze data in drill 
mode, you use hierarchies. The Universe classes are the default hierarchies you 
use for drilling but the Universe designer can also set up custom hierarchies. You 
can also create and edit hierarchies in your reports.

Drill hierarchies only contain dimension objects. In drill mode, you drill down on 
dimensions, for example from Year to Quarter to Month. At each level, measures, 
such as Revenue or Profit Margin, are recalculated.

Sales Class

The objects grouped in the Sales class are all 
connected to sales. They are arranged in 
hierarchical order with Sales Person, the highest 
level object, at the top and then down through 
Year to Invoice Date, the finest level of detail.

Measure objects are 
stored in a separate 
folder.
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The classic themes on which a designer or advanced user creates hierarchies are 
geography, time and product. In the demo universe, Island Resorts Marketing, 
there are four hierarchies:

• Resort (Country, Resort, Service Line, Service).

• Sales (Year, Quarter, Month, Week, Invoice Date).

• Customer (Country of Origin, Region, City, Customer).

• Reservations (Reservation Year, Reservation Quarter, Reservation Month, 
Reservation Week, Reservation Date).

When you set up a report for drilling, you include high level objects to display in 
your table or chart but include more detailed objects in your scope of analysis. 
BUSINESSOBJECTS retrieves these objects from the database and stores them 
behind the scenes in your report so that they are there when you need them.

Before you can analyze data in drill mode, you have to set up this behind-the-
scenes the data.

For information on how to set up data for analysis in drill mode see “Defining 
scope of analysis” on page 67.
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Using Drill Mode

Before you can analyze data in drill mode, your report must contain data which 
has been set up for analysis.

Switching to drill mode
You open drill mode from a BUSINESSOBJECTS report. To do this:

1. Select the table, crosstab or chart that you want to analyze in drill mode.
You can only analyze one block at a time.

2. Click the Drill button on the Standard toolbar or choose Drill from the 
Analysis menu.

If no part of any table, chart or crosstab was selected before you clicked the drill 
button, the cursor becomes a magnifying glass with a question mark next to it.

If this happens click inside the table, chart or crosstab you want to analyze.

When you go into drill mode, by default:

• A new report is created which contains a copy of the selected table, crosstab 
or chart. The report tab displays the drill icon to show you are in drill mode. 
The original report remains intact.

• A sum is added on measure objects.

• If you are working on a master/detail report the Drill toolbar is displayed.

Note: You can change these default options. See page 497 for more details.

You are now ready to drill on the data in the report.

Drill

This cursor appears if you do not select a block before switching to drill mode.
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Drilling down
When you drill down, you display the next level of detail in a hierarchy.

To drill down

1. Rest the cursor over the data.
The cursor changes to a magnifying glass with a plus sign in it. The plus sign 
indicates that you can drill down on this value.
A tooltip shows you the next dimension in the hierarchy:

2. Double-click the value.
The data for the next dimension appears in the table and the selected value is 
appears in the Drill toolbar.

Continuing to drill down
Each time you drill down the value drilled on is moved to the Drill toolbar and 
the data in the table is filtered according to the values displayed in the Drill 
toolbar.

The tooltip over Resort shows Service Line, 
which is the next dimension in the hierarchy. 
This means that by double-clicking a Resort 
value, you will display values for Service Line.

The selected value, Hawaiian Club 
now appears in the Drill toolbar

The table now displays the revenue for Service Line 
services for Hawaiian Club only.

Here the table now displays the 
revenue for all services in the 
Food & Drinks category for 
Hawaiian Club only.
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You can drill down as long as there are objects in the hierarchy. When you reach 
the last level in a hierarchy, the normal cursor is displayed. This indicates you are 
at the bottom of a hierarchy. If tooltips are turned on, a tooltip displays the 
message Right-click to explore.

Displaying different values in the Drill toolbar
The block is filtered to only show data for the values currently displayed in the 
Drill toolbar. You can change the values in the toolbar to look at data for a 
different value.

1. Click the down arrow.

2. Choose a value from the drop-down list.
 The data for the chosen value is displayed in the table.

Tip: You can also click in the box and type in the first letter of the next value you 
want to display (making sure you type a capital letter if necessary). When you 
press Enter, the value is displayed and the table or chart is updated.

The revenue column is updated to 
show Revenue for French Riviera.
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Drilling up
Drilling up is the opposite of drilling down. When you drill up, you go back up 
through the hierarchy to display data on less detailed levels.

To drill up from one dimension to the next

1. Place the cursor over a value.

2. Right-click on the value you want to drill up on and choose Drill Up from the 
pop-up menu.
The data for the next level up is displayed.
If you have drilled down to the bottom of a hierarchy the magnifying glass 
cursor is no longer displayed. If tooltips are turned on a tooltip displays the 
message Right-click to explore.

Undoing drill actions
You can undo up to ten drill actions which can be useful if you lose track of your 
analysis. To do this:

• Choose Undo from the Edit menu.

Drilling by
When you drill down and up you move through the levels of the same hierarchy. 
However, if you cannot find the answer to a question by analyzing data in its 
current hierarchy, you can move to another hierarchy to analyze other data that 
belongs to a different hierarchy.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Move from analyzing Resort to Sales

Your report displays data for Resort, which belongs to the Resort hierarchy. The 
report also contains Year, which belongs to the Sales hierarchy, but the data for 
Year is not currently displayed. If you drill across from Resort to Year, you can 
then drill down on the next dimension in the Sales hierarchy. You can also drill 
across to other hierarchies, or back to the hierarchy you were originally working 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
in. Drilling across opens up new paths that you can follow when analyzing data.

Before you can drill across, your report must contain dimensions from more than 
one hierarchy. If this is not the case, you can:

• Retrieve data for dimensions from more than one hierarchy by expanding 
your scope of analysis, or

• Create new hierarchies inside the report.
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See later in this chapter for information on how to do this.

To drill down to another hierarchy

1. Right-click a value and choose Drill By from the menu.
The list of dimensions that you can drill to appears on a sub-menu:

2. Choose a dimension from the list.

In this example, you selected Food & Drink from 
the Service Line column of the table. The first 
dimension in the list, Service, is the next dimension 
down in the current hierarchy, the Resort 
hierarchy.

The next three dimensions belong to the Sales 
hierarchy.

The next dimension belongs to the Customer 
hierarchy.

More opens up a list of all the available dimensions.
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Drill By - More

The list in the Drill By sub-menu displays five dimensions only by default. To 
display the full list of dimensions:

1. Right-click a value and choose Drill By then More from the menu.
The Drill By - All Available dialog box opens.

2. Choose a dimension from the list and click OK.
The dimensions displayed in gray are already used in the current analysis.

Note: You can change the setting in the Drill By menu to display more items. See 
“Setting Options for Working in Drill Mode” on page 497 for more information.
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Drilling on Charts

You can also drill on chart blocks in the same way you drill on tables and 
crosstabs.

1. Place the cursor over a part of the chart.
A tooltip appears to indicate the next dimension down in the hierarchy and 
the cursor turns to a magnifying glass.

2. Double-click.
The chart is updated and the value you drilled on is displayed in the Drill 
toolbar.
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Drilling on Multiple Hierarchies

If your block contains more than one hierarchy, you can simultaneously drill 
down from one dimension to the next in all the hierarchies in the block. To do 
this, you have to drill down on a measure object.

In the table illustrated below, Resort belongs to the Resort hierarchy and Year to 
the Sales hierarchy. If you rest the cursor over the Resort column, you see that the 
next level down is Service. If you rest the cursor over the Year column, you see 
that the next level down is Quarter. You could drill down on one hierarchy and 
then the other or you could drill down on both at the same time by drilling on the 
Revenue column.

To do this:

1. Rest the cursor over the Revenue column. 
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A tooltip shows you can drill down on both Service and Quarter.

2. Double-click on the Revenue column in the cell that displays revenue for 
Hawaiian Club in FY94.
This is the highest value in the column.
Resort and Year are moved to the Drill toolbar. The values in the Drill toolbar 
are Hawaiian Club and FY94. Service Line and Quarter appear in the table and 
the revenue column is updated.

To drill up on multiple hierarchies
To drill up on all dimensions: 

• Right-click on a measure object value and choose Drill Up from the pop-up 
menu.

The tooltip shows you can 
drill down on two 
hierarchies, Service Line and 
Quarter.
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Getting a Different View of your Data

As you work, you can change the data to analyze by inserting, removing or 
replacing dimensions and measures in the block.

You can only replace data with data that is of the same type. You can replace 
measures with measures and dimensions with dimensions.

Note: If the Insert and Replace commands are not available when you click on 
data, this means there is no compatible variable with which to replace the 
selection.

To... Right-click..... From the 
menu 
choose......

Then choose....

Insert a 
variable

• in a table, on the cell 
below or to the right of 
where you want to insert 
the variable

• in a chart, on the data 
series (or its data label, 
or its legend key) next to 
which you are going to 
insert the variable

Insert the variable you 
want to insert

Replace a 
variable

on the data you want to 
replace

Replace the variable you 
want to use from 
the list

Delete a 
variable

the data you want to delete Delete
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Changing the data in tables as you drill
As you work on tables or crosstabs in drill mode, you can move data around from 
the Report Manager to the Drill toolbar or to and from your table or crosstab. You 
can add, replace remove data as required to get a different viewpoint for your 
analysis.

• You can move variables from the Report Manager window to the Drill toolbar 
or to a table or crosstab in the report.

• You can move variables from the Drill toolbar to a table or crosstab in the 
report.

Note: You cannot drag and drop variables onto charts.

The following tables summarize how you can move data around between the 
Report Manager, Drill toolbar and tables and crosstabs. 

Report Manager to Drill toolbar

You can drag a variable from the list in the Report Manager and drop it in the 
Drill toolbar.

To.. Click..... Drag...... Drop when....

Insert a 
variable

the icon of the 
variable you 
want to move

the variable to 
where you want 
to insert it

the Drill toolbar 
shows the Insert 
highlighting
the status bar 
displays Drop to 
insert
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Data tab or Drill toolbar to table or crosstab

You can also drag a variable from the Drill toolbar or Report Manager to the table 
or crosstab you are working on. 

Using the Drill toolbar
You use the Drill toolbar to filter the data displayed in the block you are 
analyzing. 

If you hold your cursor over one of the boxes a tooltip appears showing you:

• Which hierarchy the chosen value belongs to.

• The name of the dimension.

• A list of the top three values available for that dimension.

Replace a 
variable

the icon of one of 
the variables

the variable over 
the variable you 
want to replace

the Drill toolbar 
shows the Replace 
highlighting
the status bar 
displays Drop to 
replace contents

To... Click..... Drag.... Drop when......

Insert a 
variable

the icon of the 
variable you 
want to insert

the variable to 
where you want to 
insert it

the table or Drill toolbar 
is shows the Insert 
highlighting
the status bar displays 
Drop to insert

Replace a 
variable

the icon of one 
of the 
variables

the variable over 
the variable you 
want to replace

the table or Drill toolbar 
is shows the Replace 
highlighting
the status bar displays 
Drop to replace contents

To.. Click..... Drag...... Drop when....
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Three dots after the list of values indicates that more values are available than 
those shown in the tooltip list. You can display a value from the list by typing in 
the first letter on the keyboard.

Removing an object from the Drill toolbar 

1. Click the arrow next to the object name. 

2. Choose (Remove) from the list. 
The cell disappears from the drill toolbar, and the data for the variable is no 
longer displayed.

Moving an object from the Drill toolbar to the block

1. Click the arrow next to the object name. 

2. Choose (Move to block) from the list. 
The cell disappears from the Drill toolbar and a column of data is added to the 
table.

Re-organizing the Drill Toolbar
You can re-organize the order in which variables are displayed in the Drill 
toolbar.

To.. Click..... Drag...... Drop when....

Move a 
variable

the icon of the 
variable you 
want to move

the variable to 
where you want 
to insert it

the Drill toolbar 
shows the Insert 
highlighting
the status bar 
displays Drop to 
insert
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Tip: You can drag the drill toolbar from its docked position under the other 
toolbars and place it where it is convenient for you in your workspace.

Swap two 
variables

the icon of one of 
the variables

the variable over 
the variable you 
want to swap it 
with

the mouse cursor 
becomes a swap 
icon
the status bar 
displays Drop to 
swap

To.. Click..... Drag...... Drop when....

Replace highlighting

Insert highlighting
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Analyzing Measures in Drill Mode

Measures display numeric data that is the result of calculations. For example, 
Profit Margin is a measure that is the result of Revenue - Cost.

A report can contain two different types of measure objects:

• those created by the Universe designer and which are retrieved by a query (or 
measures retrieved by other data providers)

• measures created locally in the report

You can analyze measures in drill mode only if you have created them locally, 
based on data in the document that you are working on.

Note: For information on creating measure objects locally, see Chapter 
14 "Formulas, Local Variables & Functions" on page 313.

In drill mode, you can expand a measure in order to view its component parts in 
the report and analyze numeric data. 

Collapsing a measure is the opposite of expanding it. Instead of viewing the 
measure's component parts, you display its aggregated values once more. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Analyzing profit margin

The data for Customer, Service and Margin are displayed in a report. Margin is a 
local variable with the following syntax: Product Price - Product Cost.

When you expand Margin, the data for Product Price and Product Cost appear in 
the report. When you collapse the expanded measure, only the data for Margin is 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
shown. 

To expand a measure
To expand a measure while working in drill mode:

1. Right-click the cell or chart element that displays the measure you want to 
expand.

2. Choose Expand from the menu.
The measure's component parts are displayed in the block. 
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To collapse a measure
To collapse a measure while working in drill mode:

1. Right-click the cell or chart element that displays the measure you want to 
collapse.

2. Choose Collapse from the menu. 
The data for the measure's component parts disappears. 

Note: If the Expand and Collapse commands are not available when you click on 
a measure, it means the variable was not created locally in the report and 
therefore cannot be analyzed.
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Making Copies of Reports While You Work

To keep track of the different stages of your analysis you can make copies of your 
work as you go along. Each copy you make of the report appears in a new tab 
inside the document.

To make a copy of a report:

• Click the Take Snapshot button on the Report toolbar.

A copy of the report appears in a new tab inside your document. The name that 
appears in the tab is Report Name(n+1). For example, if the report you copied is 
named Sales, the new report is named Sales (1).

Note: The filters displayed in the Drill toolbar when the snapshot was taken are 
turned into global report filters.

Take Snapshot
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Extending Analysis
You may realize that a dimension you need for your analysis is not available in 
your report. As you drill, you can bring in data that was not originally included 
in the analysis either by extending the scope of analysis in the Scope of Analysis 
window or by editing your query to bring in more data from the database.

Expanding scope of analysis
You can bring in more data by editing the Scope of analysis. To do this:

1. Right-click on the block you are analyzing.

2. Choose Scope of Analysis from the pop-up menu.
The Scope of Analysis dialog box appears.

3. Choose the dimensions to include in your scope of analysis and click OK.
The dimensions are now displayed in the list in the Report Manager window.

Note: BUSINESSOBJECTS shows you which values are currently displayed in the 
Drill toolbar by placing a filter icon next to them.

To include all the dimensions 
from a hierarchy, click the 
hierarchy's check box.

Check the dimension 
box to just include the 
individual dimensions you 
need.

Click on a filter box to limit 
the data retrieved.
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Drilling through to the database to bring in new data
If the lowest level of detail you need is not currently available in the report, you 
can drill through to the database directly from drill mode and get the data you 
need. You do not have to edit the query in the Query Panel.

Here’s how to do it:

1. Right-click on the column or row where you want the new data to be 
displayed.

2. Choose Drill Through from the menu.
The Drill Through dialog box is displayed.

3. Choose a dimension and click OK.
The dimension is retrieved from the database and displayed in the block you 
are analyzing.

Note: You can only choose one dimension at a time.

The dimensions that are currently 
available in the report are grayed out.

All those that belong to drill hierarchies 
but are not currently available in the 
report are displayed in black.
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Bringing in new data using filters
You can use the filters applied in drill mode as query conditions when you bring 
in new data from the database. The example below illustrates how this works.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Focus analysis on one high-profit resort using drill filters as query conditions

You are interested in analyzing the excellent revenue results in the US. You have 
drilled down on country and see that the resort Hawaiian Club has generated the 
best revenue. You now want to concentrate on this one resort and find out some 
information on the country of origin of the customers for that resort, data that is 
not currently available in your report.

To do this you first need to turn the drill filters option on:

1. From the Tools menu choose Options.
The Options dialog box opens up.

2. Click the Drill tab.

3. Check the Apply Drill Filters box in the Drill Through section.

You can now retrieve the new data from the database. Your drill mode report 
currently looks like this:

You drilled down on Country and the table displays revenue for US resorts only.

1. Right-click on Hawaiian Club in the Resort column and choose Drill Through 
from the menu.
The Drill Through dialog box opens.



Chapter 20 Analyzing Data in Drill Mode

488   BusinessObjects User’s Guide

The dimensions already available in the report are grayed out. The Country 
dimension has a filter to display data only for the US and the Resort 
dimension a filter to display data only for Hawaiian Club. These filters will be 
used as query conditions and only data concerning the US resort Hawaiian 
Club will be retrieved from the database.

2. Choose Country of Origin from the Customer hierarchy and click OK.
The data is retrieved from the database and Country of Origin is displayed in 
the table. Resort is moved to the Drill toolbar.

Notice that France is no longer available in the Country list and Hawaiian Club 
is the only name in the resort list. The table now only displays data for Hawaiian 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Club.
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Drilling Using Custom Hierarchies

You may find that the default order in which dimension objects are arranged in 
hierarchies is not optimal for your analysis needs, or that you need to drill on a 
hierarchy that has objects from different classes.

You can edit a hierarchy by changing the order of the dimensions it contains, by 
adding dimensions to it, and removing dimensions from it. You can also rename 
a hierarchy, and even delete it.

You can also create your own hierarchies using dimensions available in the report 
or by using user objects. There are two types of custom hierarchies:

• Pre-defined custom hierarchies that are set up by the universe designer and 
which can be re-used in other documents.

• Hierarchies you create yourself and which are only saved in the document 
you created them in.

Editing hierarchies
The changes you make to a hierarchy that was created by a universe designer 
affect your work in drill mode only. For example, if you delete a hierarchy, you 
can no longer use it in drill mode. However, the hierarchy remains unchanged in 
the universe so you can still use the hierarchy to define scope of analysis when 
building a query on the universe. The universe designer is the only person who 
can edit or delete hierarchies at the universe level.
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To edit a hierarchy for drill mode

1. Click the Hierarchies command on the Analysis menu.
The Hierarchy Editor opens.

2. In the Available Hierarchies box, click the + sign to view the contents of the 
hierarchy folder.

3. In the Available Dimensions box, click the + sign to the left of the folder to 
view the list of dimensions.

4. Make the required changes and click OK to close the Hierarchy Editor.

To add a dimension to an existing hierarchy

• Click the dimension you want to add to the hierarchy, then click Add.

The dimension you clicked appears in the hierarchy's folder in the Available 
Hierarchies box.

If the Hierarchy Editor does not list the dimension that you want to add to your 
hierarchy, you may have to expand your scope of analysis. See “Expanding scope 
of analysis” on page 485.

Note: You cannot combine dimensions from different data providers in a single 
hierarchy.



 Drilling Using Custom Hierarchies

  BusinessObjects User’s Guide   491

To change the order of the dimensions in a hierarchy

1. Click the dimension you want to move up or down in its hierarchy.

2. Click Move Up or Move Down to change the dimension's position in the 
hierarchy.

To rename a hierarchy

1. Click the hierarchy you want to rename.

2. Click a second time on the hierarchy's name, then type the new name. 

To remove a dimension from a hierarchy

• Click the dimension you want to delete, then click Remove.

To delete a hierarchy

• Click the hierarchy you want to delete, then click Remove.

Creating hierarchies
You can create your own custom hierarchies from any dimensions available in 
the report. The dimensions you include in a hierarchy can be local variables, 
derived variables, or dimensions returned by data providers. 

Note: You can also use a date-type user object as the basis for a time hierarchy. 
For information on user objects see “Creating User Objects” on page 80.

To create a custom hierarchy

1. Click the Hierarchies command on the Analysis menu.
The Hierarchy Editor opens. 

2. In the Hierarchy Editor, click New.

3. Type the name of the new hierarchy, then click outside the name box.

4. In the Available Dimensions box, click the first dimension for the new 
hierarchy, then click Add.
The dimension you clicked appears in the new hierarchy's folder in the 
Available Hierarchies box.

5. Add the other dimensions you want to include and then click OK.
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If the Hierarchy Editor does not list the dimensions that you want to include in 
the hierarchy, you may have to expand your scope of analysis. See “Expanding 
scope of analysis” on page 485.

Note: You cannot combine dimensions from different data providers in a single 
hierarchy.
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Qualifying Data For Hierarchies

BUSINESSOBJECTS qualifies data as dimensions, measures or details.

Hierarchies only contain dimensions so if you want to include an object in a 
hierarchy for analysis in drill mode, you must qualify it as a dimension. 

In preparation for drill mode, you may need to change the qualification of user 
objects, variables or formulas that you have created in your report. For example, 
you want to include a variable in a hierarchy, but cannot because the variable is 
qualified as a detail. In this case, you must qualify the variable as a dimension 
before you can include it in the hierarchy.

You can change the qualification of data returned by stored procedures, free-
hand SQL scripts, and personal data files. You can also change the qualification 
of user objects, local variables and formulas.

Note: You cannot change the qualification of data returned by a query on a 
universe.

Re-qualifying local variables and formulas

1. Select one of the following report elements which displays the formula or local 
variable you want to qualify:
• A cell in a table or a crosstab.
• In a chart, the data series, a data label or the legend. 
• A free-form cell.

2. Click the Variables command on the Data menu.
The Variables dialog box opens.

3. Select the local variable or formula from the list.
Local variables are stored in the Variables folder and formulas are stored in 
the Formulas folder.
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4. Click Edit.

5. In the Definition tab of the Variable Editor, click an option button to change 
the qualification, then click OK.

6. Click Close in the Variables dialog box.

Re-qualifying variables

1. Click the View Data command on the Data menu.
The Data Manager dialog box opens.

2. In the Data Providers box of the Data Manager, click the icon that represents 
the column of data whose qualification you want to change.

3. Click the Definition tab.
The name, type, qualification and values for the column are displayed. 

4. In the Qualification box, click an option button to change the column's 
qualification.

5. Click OK.
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Re-qualifying user objects

1. Click the Universes command on the Tools menu.
The Universes dialog box opens.

2. Select the universe that contains the user object, then click User Objects.

3. Click Edit.

4. In the Qualification box of the Definition tab, click an option button to change 
the qualification, then click OK.

5. Click OK in the User Objects dialog box.
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Printing from Drill Mode

You can print out a table, crosstab or chart from drill mode to have a printed 
record of the results of your analysis. Before printing you can insert the contents 
of the Drill toolbar as a title to your report to keep track of the filters applied. 

Inserting Drill toolbar contents as a title

1. From the Insert menu, choose Special Field/Drill Filters.
The cursor turns into the insert cell cursor.

2. Holding down the left mouse button, draw a box on your drill mode report 
page in the position where you would like to display the title.

3. Release the mouse button.
A cell is inserted that contains a list of the values currently displayed in the 
Drill toolbar.

You can edit the size and formatting of the cell just as you would edit any cell in 
a report.

Printing a report from drill mode

1. Make sure the report you want to print is active.

2. From the File menu, choose Print.

Note: For more information on setting up reports for printing, see the InfoView 
User’s Guide.

The dimensions displayed in the drill 
toolbar are inserted as a a title. This 
table shows the revenue results for 
the US resort Hawaiian Club for 
1994.
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Setting Options for Working in Drill Mode

There are a number of options you can set to manage how you work in drill 
mode. You can:

• Control the number of items that appear on the popup sub-menus.

• View the number of values for each dimension that appears on the popup 
menu.

• Systematically create a new report when you switch to drill mode, or be 
prompted to choose whether or not to create a new report.

• Control the cursor and the tooltip that appear in drill mode.

• Automatically display the totals or percentages of numeric data (measures).

• Choose to display a message before closing drill mode.

• Set drill filters as query conditions when you drill through to retrieve more 
data from the database.

To set options for drill mode:

1. From the Tools menu, choose Options.
The Options dialog box opens.

2. Click the Drill tab:

3. Set the required options and click OK.
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Working in Slice-and-Dice Mode

Slice-and-dice mode enables you to switch the position of data in a report. You 
can, for example, move data from columns to rows. The result would be a 
crosstab, where numeric data such as revenue appears at the intersection of rows 
and columns. 

You can also use slice-and-dice mode to:

• Work with master/detail reports

• Display and remove data

• Rename, reset and delete blocks

• Turn tables and crosstabs into charts, and vice versa

• Apply, edit and delete breaks, filters, sorts, rankings and calculations.

Slice-and-dice mode is enabled by the Slice and Dice Panel, a pop-up window 
that provides a graphical representation of the report you are working on. You 
carry out tasks by dragging and dropping icons that represent the data you can 
use.

To display the Slice and Dice Panel, select the Slice and Dice command on the 
Analysis menu, or click Slice and Dice on the Standard toolbar. A detailed 
illustration of the Slice and Dice Panel is provided on page 501.Slice and Dice
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The Slice and Dice Panel

c

g

h

a
b f

d

e
i

a. Show or hide the different boxes of the Slice and Dice Panel.

b. Apply breaks, filters, sorts, rankings and calculations.

c. Lists the variables that you can display in the report.

d. Let you view all variables, dimensions only, measures only, or all variables by data 
provider.

e. Provides information on the tasks you perform.

f. Let you accept or to cancel the operations you have performed. Click Apply to accept, 
Reset to accept and recalculate the report, and Undo to cancel. 
Note that clicking the Reset button removes all formatting you have applied throughout 
the report. See also (i.)

g. Shows the master(s) in master/detail reports.

h. Shows the variables in the active table, chart or crosstab.

i. Shows the name and type (table, chart or crosstab) of each block in the report.  
You can rename, transform, reset or delete a block by clicking its tab with the right mouse 
button, then clicking a command on the pop-up menu that appears.
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Working with Master/Detail Reports in Slice-and-Dice Mode
Master/detail reports display data in sections. Each section contains a “master” 
piece of data, for example a resort, or a year. The rest of the data in the section 
relates to the master.

The following illustration shows a master/detail report, and its corresponding 
representation in the Slice and Dice Panel:

A master/detail report, and its representation in the Slice and Dice Panel

The Block Structure box 
shows the data that 
appears in the table.

The Section box shows 
the master, which in this 
report is Quarter.

The Available Variables box 
presents the variables and 
formulas you can display in 
the report.
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The Slice and Dice Panel makes it easy to work with master/detail reports. You 
can:

• Build a master/detail report.

• Re-organize a master/detail report by replacing the master or by building a 
master/master detail report.

• Undo a master/detail report by removing the master.

• Deactivate sections of master/detail reports.

The following sections describe how to perform these tasks.

To structure an existing report as a master/detail report
 To structure an existing report as a master/detail report in slice-and-dice mode, 
you drop the icon of the master in the Section box. You can:

• Use data that is already displayed in the report. 

To do this, drag an icon from the Block Structure box, drop it in the Section 
box, then click Apply.

• Use data that is not yet displayed in the report. 

To do this, drag an icon from the Available Variables box, drop it in the 
Section box, then click Apply.

You can perform this task in drill mode. To do so, switch to drill mode and 
select the data you want to use as master. Click your right-mouse button and 
from the pop-up menu that appears, select the Set as Master command.
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Reorganizing a master/detail report
You can re-organize a master/detail report by:

• Using a different master. For example, if the master is Year, you can replace it 
with Resort.

• Building a master/master/detail report. This structure enables you to view 
data on two levels of detail. The illustration below shows one section of a 
master/master/detail report. For FY93, the report displays revenue for each 
resort per quarter:

One section of a master/master/detail report
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To use a different master

You can replace the master with data that is already displayed in the report, or 
with data that is not yet displayed. Here is the procedure:

1. Open a master/detail report.

2. Select the icon of the master in the Section box, then press the Delete key.
The icon disappears from the Section box.

3. To use data that is already displayed in the report, drag an icon from the Block 
Structure box, and drop it in the Section box.

4. To use data that is not yet displayed, drag an icon from the Available 
Variables box, and drop it in the Section box.

5. Click Apply to display the report with its new master.

You can swap the master with data that is displayed in the report. To do so, 
hold down your Shift key, then drag the master until it is located above the 
icon with which you want to swap it, in the Block Structure box. Release your 
mouse button, then click Apply.
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To build a master/master detail report

A master/master detail report contains two masters, as its name suggests. This 
means that in the Slice and Dice Panel, there must be two icons in the Section box.

You are most likely to build a master/master/detail report from an existing 
master/detail report. Here is the procedure:

1. Open a master/detail report, then open the Slice and Dice Panel.

2. Drag an icon to the Section box.
You can drag an icon from the Available Variables box, or from the Block 
Structure box.

3. Drop the icon until it is located just below the existing master, then release 
your mouse button.

4. Click Apply to display the master/master detail report.
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To undo a master/detail report
Undoing a master/detail report means removing the master. In the Slice and Dice 
Panel, this means that you remove the master from the Section box. You can:

• Place the master in a block in the report. In this case, the data that was 
displayed as master is still displayed in the report.

To do this, drag the master from the Section box to the Block Structure box.

• Remove the master from the report.

To do this, select the master in the Section box, then press the Delete key.

Now, click Apply.
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Deactivating sections of master/detail reports
Deactivating sections of a master/detail report enables you to recalculate the 
report without removing data from it. This feature is particularly useful in 
reports which contain multiple blocks, as the following example describes.

The section of the report illustrated below displays revenue and number of guests 
per quarter for FY93. Revenue per quarter is shown in the chart on the left, while 
the table on the right shows number of guests per quarter:
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You want to obtain the number of guests per quarter for all resorts, rather than 
the number of guests per resort, as shown in this illustration:

You obtain this result by deactivating the Resort section for the table. The Slice 
and Dice Panel enables you to perform this task with simple mouse clicks. 
BUSINESSOBJECTS dynamically recalculates the number of guests for all resorts, 
while the data in the charts remains unchanged.
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To deactivate a section of a master/detail report

1. Open a master/detail report, then open the Slice and Dice Panel.

2. Click the tab of the block (table, chart or crosstab) that you want to recalculate.

3. In the Section box, with your right-mouse button click the master of the 
section that you want to deactivate. 
A pop-up menu appears.

4. Click Deactivate this section: 

5. Click Apply. 
The block appears in the section above the section that you deactivated.



 Working in Slice-and-Dice Mode

  BusinessObjects User’s Guide   511

To reactivate a section of a master/detail report

Once you have deactivated a section of a master/detail report, you can reactivate 
it in the following way:

1. Open the master/detail report, then open the Slice and Dice Panel.

2. Click the tab of the block (table, chart or crosstab) that you want to recalculate.

3. In the Section box, with your right-mouse button click the master that you 
now want to activate

4. On the pop-up menu that appears, click Activate this section.

5. Click Apply.

To deactivate or activate two or more sections at the same time

In master/master/detail reports, which by definition contain two or more 
sections, you can deactivate two or more sections at the same time:

1. Open the master/detail report, then open the Slice and Dice Panel.

2. Click the tab of the block (table, chart or crosstab) that you want to recalculate.

3. In the Section box, with your right-mouse button click the master of the 
uppermost section that you want to deactivate. 

4. On the pop-up menu, click Deactivate this section and all sections below it.

5. Click Apply. 
The report is recalculated.

To reactivate the sections:

6. Click the master of the lowest section with your right-mouse button (Quarter, 
in the example above).

7. Click Activate this section and all sections above it, then click Apply.

You can also perform this task by selecting and dragging the block back to its 
original section. To do this, hold down your Alt key and click inside the block. 
Position the cursor on the block’s border. When the cursor changes to a cross, 
as shown in the margin, click the border. Hold down your mouse and drag the 
block to its original section. When you release the mouse button, 
BUSINESSOBJECTS dynamically recalculates the data in the block.
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Positioning Data Horizontally in Slice-and-Dice Mode
All reports display data horizontally. In tables and crosstabs, data appears in 
columns, and in charts, data is plotted on the X-axis that runs from left to right.

In the Slice and Dice Panel, the data that appears horizontally in a table, crosstab 
or chart is shown in the Block Structure box. It is represented by the icons that 
appear in a horizontal line, as illustrated here:

You can use the Slice and Dice Panel to move variables horizontally, using drag-
and-drop. You can also swap two variables.

To drag a variable horizontally to a new position

To swap two variables horizontally

Select an icon, hold down your mouse button and drag the icon horizontally, left 
or right, to its new position. As you move the mouse, the cursor changes, as 
shown in the margin. Release your mouse button to drop the icon at its new 
position. Click Apply to display the data in its new position in the report.

To swap two variables horizontally, hold down the Shift key and select one of the 
icons you want to swap. The cursor changes to show that you are carrying out a 
“swap” operation, as shown in the margin. Drag the icon horizontally until it is 
above the other icon you want to swap, then release your mouse button. Click 
Apply to display the swapped data in the report.
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Working with Crosstabs and 3-D Matrix Charts
Working with crosstabs and 3-D matrix charts is made simple by the Slice and 
Dice Panel. The structure of a crosstab or 3-D matrix chart is clearly shown in the 
Block Structure box:

b

c

a. The icon here represents the data that appears in columns in crosstabs, or on 
the X-axis of charts.

b. The symbol for a crosstab in the Slice and Dice Panel. There is a different symbol 
for charts.

c. The icon here represents the data that appears in rows in a crosstab or on the 
Z-axis in 3-D matrix charts.

d. The icon here represents the numeric data that appears at the intersection of 
rows and columns in crosstabs (i.e., in the body), and data that is plotted on the 
Y-axis of 3-D matrix charts.

da
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The following illustrations show the crosstab and the 3-D chart. The following 
illustrations show the crosstab and the 3-D matrix chart that correspond to the 
representation in the Block Structure box, above. 

The crosstab

The 3-D matrix chart

In slice-and-dice mode you can perform the following tasks with crosstabs and 3-
D matrix charts:

• Build a crosstab or 3-D matrix chart from a table or 2-D chart, respectively.

• Reduce a crosstab or 3-D matrix chart to a table or 2-D chart, respectively.

• Reposition data that appears in rows or on the Z-axis.

• Move data between rows and columns (in crosstabs), and between the Z-axis 
to the X-axis (in 3-D matrix charts.)

• Turn crosstabs into 3-D matrix charts and vice versa.

The following sections describe how to perform these tasks, with the exception of 
turning crosstabs into 3-D matrix charts and vice versa. This task is described in 
“Transforming Blocks in Slice-and-Dice Mode” on page 519.
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To build a crosstab or a 3-D matrix chart from a table or 2-D chart
You can:

• Use data that is already displayed in the report. To do this, you take an icon 
from the Block Structure box or the Section box.

• Use data that is not yet displayed. In this case, you take an icon from the 
Available Variables box.

Here is the procedure:

1. Click inside a table or 2-D chart, then open the Slice and Dice Panel.

2. Select the icon of the data that you want to use to build the crosstab or matrix 
chart.

3. Drag the icon until it is positioned above the icon that is furthest to the right 
in the Block Structure box, then release your mouse button.
The icon appears above and to the right of the other icons in the Block 
Structure box, as illustrated on page 513.

4. Click Apply to make the crosstab or matrix chart appear.

To reduce a crosstab or 3-D matrix chart to a table or 2-D chart
When you reduce a crosstab or a 3-D matrix chart into a table or 2-D chart, you 
take data out of the crosstab or matrix chart. You can:

• Remove data from the report.

• Display the data in the 2-D chart or table. 

Here is the procedure:

1. Click inside a crosstab or 3-D matrix chart, then open the Slice and Dice Panel.

2. Select the icon of the variable whose data appears in rows (if you are working 
with a crosstab), or on the Z-axis (if you are working with a chart.) This icon 
is located in the upper right-hand corner of the Block Structure box.

3. If you want to remove the data from the report, press the Delete key.
If you want to display the data in the table or 2-D chart, drag it down and to 
the left, until it is at the same level as the other icons. Then, release your mouse 
button.

4. Click Apply to make the table or 2-D chart appear.
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To reposition data vertically
You can place more than one variable in rows in crosstabs and on the Z-axis of 3-
D matrix charts. You can reposition these variables, as illustrated here:

To move a variable up or down

To swap two variables vertically

In this example, the data 
for Quarter and Year 
would appear in rows in a 
crosstab, or on the Z-axis 
of a 3-D matrix chart. You 
can move Year up, or 
Quarter, down.

Select an icon, hold down your mouse button and drag the icon vertically, up or 
down, to its new position. As you move the mouse, the cursor changes, as shown 
in the margin. Release your mouse button to drop the icon at its new position, 
then click Apply.

To swap two variables vertically, hold down the Shift key and select one of the 
icons you want to swap. The cursor changes to show that you are carrying out a 
“swap” operation, as shown in the margin. Drag the icon vertically until it is above
the other icon you want to swap, then release your mouse button. Click Apply.
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To move data between columns and rows in crosstabs
Crosstabs display data in columns and in rows. This means you can change 
crosstabs by swapping data between columns and rows. You can do this in the 
Slice and Dice Panel, by moving icons from and to the upper right-hand corner of 
the Block Structure box:

To move data from rows to columns

To swap two variables between columns and rows

To move data between the X- and Z-axis in 3-D matrix charts
This task is equivalent to moving data between columns and rows in crosstabs. 
Follow the procedures described in the preceding paragraphs. For “column” read 
“X-axis” and for “row” read “Z-axis”.

In this example, the data for Quarter 
and Year appears in rows in the 
crosstab. You can move either variable 
to a column in the crosstab, by dragging 
Quarter or Year next to Resort.

Select an icon in the upper right-hand corner of the Block Structure box, hold 
down your mouse button and drag it to the bottom left-hand corner of the box. 
As you move the mouse, the cursor changes, as shown in the margin. Release 
your mouse button and click Apply.

Hold down the Shift key and select one of the icons you want to swap. Drag the 
icon until it is above the other icon you want to swap. The cursor changes to show 
that you are carrying out a “swap” operation, as shown in the margin. Release 
your mouse button and click Apply.
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Displaying and Removing Data in Slice-and-Dice Mode
The Slice and Dice Panel shows the data that is displayed in a report. It also shows 
any unused data that you can display. More precisely:

• The icons that you can see in the Section box, and in the Block Structure box, 
show the data that is already displayed in the report.

• The icons in the Available Variables box show all the data you can use, 
whether or not it is already displayed.

Using the drag-and-drop technique, you can display unused data in the report, 
and you can remove data that is already displayed. Once removed, the data 
remains available for later use.

To display data in the report

1. In the Available Variables box, drag an icon to the Section box to display it as 
a master, or double-click it to display it in the block.

2. Click Apply to display the data in the report.

To remove data from the report

1. Select an icon in the Section box or the Block Structure box.

2. Drag the icon to the Available Variables box, and release the mouse button.
Alternatively, press the Delete key.

3. Click Apply to remove the data from the report.
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Deleting, Renaming and Resetting Blocks in Slice-and-Dice Mode
You can delete, rename and reset blocks in slice-and-dice mode. To do so:

1. Click the tab of the block you want to work on. To select multiple blocks, hold 
down the Ctrl key then click each one.

2. Click your right-mouse button.
A pop-up menu appears.

3. Click the command that corresponds to the task you want to perform.
• If you select the Rename command, you must type the new name in the 

dialog box that appears, then click OK.
• The Rename command is not available for multiple tabs.

4. Click Apply.

Tip: You can reset one or more blocks using the procedure described above. To 
reset the whole report, click the Reset button on the Slice and Dice Panel toolbar. 
Resetting a block or a report removes any formatting you have applied.

Transforming Blocks in Slice-and-Dice Mode
In slice-and-dice mode, you can turn tables and crosstabs into charts, and vice 
versa. To do so:

1. Open the Slice and Dice Panel, then click the tab of the block you want to 
transform.

2. Click your right-mouse button, then select a command: 

3. Click Apply.

Command Action

Turn to Chart Turns the selected table or crosstab to a chart.

Turn to Table Turns the selected chart to a table.

Turn to Crosstab Turns the selected matrix chart to a crosstab. 
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Applying Further Modifications in Slice-and-Dice Mode
You can use the Slice and Dice Panel to apply the following features on data that 
is displayed in a report:

• Sorts, which control the order in which the data appears.

• Ranking, which enable you to view top and bottom values of selected data.

• Calculations.

• Breaks, which break up blocks of data.

• Filters, which enable you to view only the data that you need.

There is a button for each feature in the Slice and Dice Panel toolbar:

None of the above are specific to slice-and-dice mode, as they are all core features 
of the User module. However, the Slice and Dice Panel’s graphical interface 
provides a user-friendly way to apply them. Moreover, it is useful to be able to 
perform slice-and-dice operations, then apply one or more of the features to the 
report. For example, if you build a master/detail report that displays revenue by 
resort, you can quickly calculate the total revenue per resort.

In the sections that follow, you learn how to use the Slice and Dice Panel to apply 
sorts, ranking, calculations, breaks and filters on report data. References to more 
information on the features are provided in their respective sections.

a b c d

a. Sorts

b. Ranking

c. Calculations

d. Breaks

e. Filters

e
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Using sorts to control data order

You can also:

• Invert the sort, i.e., from ascending order to descending order, or vice versa. 
To do this, double-click its icon.

• Remove the sort. To do this, select its icon then press the Delete key.

Using ranking to view only top and bottom values of data

Double-click the ranking icon. The Select Top/Bottom Variable Name dialog box 
appears, where you define the ranking you wish to apply. Click OK, then, in the 
Slice and Dice Panel, click Apply. The report appears with the ranking you 
applied.

You can also:

• Redefine the ranking by double-clicking its icon in the Slice and Dice Panel, 
then modify its attributes in the Select Top/Bottom Variable Name dialog box.

• Remove the ranking. To do this, select its icon then press the Delete key.

Making calculations on data

To select the calculation you want to make, double-click the calculation icon. The 
Calculation on dialog box appears.

To apply a sort on data in the report, select an icon in the Section box or the 
Block Structure box, then click Apply Sort. A sort icon appears next to or 
below the icon you selected. Click Apply to display the data in order in the 
report.

Apply Sort

For further information on sorts and how to apply them on report data, refer 
to “Ordering Data” on page 266.

To apply ranking on data in the report, select an icon in the Section box or the 
Block Structure box. Then, click Apply Ranking. A ranking icon appears next 
to or below the icon you selected.Apply Ranking

For further information on ranking and how to apply them, refer to “Using 
Ranking to View the Top and Bottom Values” on page 273.

To make a calculation on data in the report, select an icon in the Section box or 
the Block Structure box, then click Insert Calculation. A calculation icon 
appears next to or below the icon you selected.Insert Calculation
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Select the function(s) you wish to apply, then click OK. Click Apply to make the 
calculation(s) appear in the report.

Applying breaks
You can apply a break on data that is displayed in tables or crosstabs. You cannot 
apply a break on a master, or on data that is displayed in a chart.

You can also:

• Redefine a break by double-clicking its icon. In the dialog box that appears, 
you can select different attributes for the break. 

• Remove a break. To do this, select its icon, then press the Delete key.

Using filters to view only the data you need

Double-click the filter icon. The Filter On dialog box appears, where you define 
the filter you wish to apply. Click OK, then, in the Slice and Dice Panel, click 
Apply. The report appears with the filter you applied.

You can also:

• Redefine the filter by double-clicking its icon in the Slice and Dice Panel, then 
modify its attributes in the Filter on dialog box.

• Remove the filter. To do this, select its icon then press the Delete key.

For information on how to apply calculations without using slice-and-dice 
mode, refer to Chapter 13 "Breaking Up Tables and Displaying Calculations" 
on page 285.

To apply a break, select an icon in the Block Structure box, then click Apply 
Break. A break icon appears next to or below the icon you selected. click 
Apply. The report appears with the break you applied.Apply Break

For further information on breaks and how to apply them, refer to Chapter 
13 "Breaking Up Tables and Displaying Calculations" on page 285.

To apply a filter on data in the report, select an icon in the Section box or the 
Block Structure box. Then, click Apply Filter. A filter icon appears next to or 
below the icon you selected.Apply Filter

For further information on filters and how to apply them, refer to “Limiting 
the Data Displayed” on page 258.
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Overview

This chapter describes how to format sections in a report and how to format the 
cells, rows and columns that make up tables and crosstabs.

Formatting Sections

You can format the sections in a report by applying shading to the background.

What are sections?
There are two types of section in a BUSINESSOBJECTS report.

Main Section

If you have not created any sections, the main section is the only section in the 
report and when you apply shading, the whole report (except margins) will be 
shaded in the same color.

Sections in a Master/Detail report

If you have set up a report with sections, you can apply a different type of 
shading to each section in the report. This can allow you to easily distinguish 
between the different sections.

The sections you have created are contained in the main section and a main 
section header is displayed at the beginning of the report and a main section 
footer at the end of the report.

You can hide the main section header or the main section footer or both of them 
if you wish.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Example Using shading to distinguish between sections

In the illustration below, the report contains two sections: the main section and a 
Resort section. The Resort section has three values, Bahamas Beach, French 
Riviera and Hawaiian Club. The main section is shaded blue and the Resort 
section yellow which allows you to clearly see where the sections begin and end. 
As you can see from the illustration, the Resort section is contained within the 
main section.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

main section 
header

main section footer

Resort section
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Formatting sections

1. Right-click in the section you want to format.

2. Chose Format Section from the menu.

3. Click on the Shading tab:

4. Make the settings as required and click OK.

To hide the main section header of footer

1. Right-click in the main section header or footer area.

2. Choose Format section from the menu.

Click here to select a 
color you want to the 
foreground.

Click here to select the 
color you want to apply 
to the background.

Choose the pattern 
or shade from the list.

If you choose Clear, 
you apply the 
Background color 
only.

If you choose Solid, 
you apply the 
Foreground color 
only.

The other settings mix 
the two colors.

Click None if you do 
not want to apply 
shading to the 
section.

This box displays a 
preview of the shading 
that will be applied to 
the section.
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3. Click on the General tab.

4. Check the Hide Section Footer or Hide Section Header check box.
A section header or footer that is hidden is shown in italics in the Report 
Manager Map list.

Note: For more information on hiding and displaying report components, see 
“Hiding and Displaying Report Components” on page 569.

To display the section footer or header again

1. Click the Map tab on the Report Manager.
If Report Manager is not open, choose Report Manager from the View menu.
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2. Click the Structure option button.

3. Right-click on main Section in the list in the Map window and choose Format 
Section from the menu.
The Section Format dialog box opens.

4. Click on the General tab.

5. Uncheck the Hide Section Header or Hide Section footer check box and click 
OK.

Structure option button

The Main Section Header 
is shown in italics in the list 
to show that it is currently 
hidden in the report 
window



 Formatting Tables

  Business Objects Guide   531

Formatting Tables

Tables and crosstabs are made up of headers and footers, columns and rows, and 
cells. All these elements together make up the block. The cell is the most basic 
element of a table or crosstab. Rows and columns are made up of groups of cells. 
When you format tables and crosstabs, you can work on the formatting cell by cell 
or on the block formatting.

Formatting blocks
You can format a block by applying shading and borders. The following 
procedure shows how to do this for a table. The procedure is the same for a 
crosstab or a chart block:

1. Right-click on the table and choose Format Table from the menu.
The Table Format dialog box opens.

2. Click the Border tab:

3. Choose a line style from the Style section.

4. To change the border color, click the box next to Custom, then select a color 
from the color palette that opens. Click OK to close the palette.
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5. Set which sides of the block you want to format. You can:
• Click one or more borders in the Borders box, or
• Click Box to put a border on all four sides of the table.

6. Click Apply.

7. Click on the Shading tab and make the required settings.
The options available on the Shading tab are described on page 528.
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8. Click OK to close the dialog box.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Example Applying shading and borders to tables

In the examples below, the table has been shaded yellow. In the first table, all four 
sides have a double-line border. In the second table, a thick border has been 
applied to the top and bottom sides only.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Example Correctly formatting crosstab corners

When you apply shading to a section and then insert a crosstab, the corner cells 
of the crosstab are sometimes incorrectly shaded or formatted as shown in the 
example below. In this example, you want the top left-hand corner be shaded as 
the section shading. 

There are two things you have to check. You have to make sure that the cell 
shading and the crosstab shading are set to transparent.

To do this:

1. Right-click on the top left-hand cell and choose Format Cell from the menu.
The Cell Format dialog box opens.
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2. Click on the Shading tab.

3. On the Shading tab, click the None option button in the Fill section.

This means the cell is now transparent and the section shading can show through. 
If this has not solved the problem, repeat the procedure above but this time, 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
choose Format Crosstab from the menu.
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Resizing Columns, Rows and Cells
You can resize cells, rows and columns. 

Resizing using the mouse
To change the width:

1. Click the right border of the selection.

2. Holding down the left mouse button, drag the border until the selection 
reaches the width you want. 

To change the height of the selection:

1. Click the top border of the selection

2. Holding down the left mouse button, drag the border until the selection 
reaches the width height you want.

Resizing using a menu command

1. Select the cells, columns or rows you want to resize.

2. Select the Cell Height and Width command from the Format menu.
The Cell Height and Width dialog box appears:

3. Set the required width on the Width tab.

4. Click the Height tab and set the required height.

5. Click OK. 
The dialog box closes and the selection is resized, according to the settings you 
entered.

Click AutoFit to 
adjust the width of 
the selected cells 
automatically to 
the width of their 
contents. 

Type an exact value, or use the arrows to 
increase or decrease the width that is shown.
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Showing Headers and Footers
You can choose whether you want to display headers or footers or not on a table 
and specify how rows and columns are managed. For crosstabs, the header rows 
are always displayed but you can choose to display or hide the footer row and 
columns and also choose to display additional information in the header.

To set these options:

1. Right-click on the table or crosstab.

2. Choose Format Table (or Crosstab) from the menu.

3. Click on the General tab.
The options you can set are described below.
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Tables

Displaying tables in a multi-column layout
You can set up a multi-column or multi-row page layout to fit more information 
on a page. The example below shows how this works:

In this example, you have a long two column table. By setting the page to display 
a three column layout, you use the page space more efficiently. You can also set 
how much space you want to have between each set of columns or rows.

You can only see the results of this setting in page layout view.

Displays a header and 
footer on the table

Orientation sets the 
type of table 
displayed.

Down displays the data 
in columns with the 
header in the top row.

Across displays the 
data in rows with the 
header down the left-
hand side.Displays a table in 

multiple columns or rows.

The options available 
here depend on what 
table orientation is set.
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Displaying duplicate rows in a table
The Avoid Duplicate Rows Aggregation option allows you to display all rows of 
a report instead of aggregating to avoid displaying rows with the same set of 
dimensions.

This is demonstrated in the example below:

The first table shows the revenue per resort per quarter. Since each resort per 
quarter is unique, there is no difference whether duplicate row aggregation is 
used or not.

In the second table, the Resort column has been removed. The revenue column 
now shows a sum of all resorts for each quarter. Since there are only four 
quarters, there are only four rows in the table.

The third table shows the effect of using the Avoid Duplicate Rows Aggregation 
option on the second table. Here the original number of rows is retained, even 
though the table shows duplicate rows based on the dimension shown (Quarter). 



 Formatting Tables

  Business Objects Guide   539

Crosstabs

Showing additional header information
When you display data in a crosstab, the headers show the values of the variables 
placed in the header row and column. If you check the option Show Variable 
Header, you can display the name of the variable as well as the values and also 
show what the figures in the body cells refer to. This gives additional information 
to help interpret the data in the crosstab.

Here is an example of how this works:

Displays or hides a 
footer on the down 
edge of the crosstab

Displays or hides a 
footer on the across 
edge of the crosstab

The same crosstab 
with the Show Variable 
Header option on

Here the values only 
are shown in the 
headers and the 
figures only in the 
body cells
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Formatting Cells

This section describes how to format cells. The illustration below shows what you 
can do to format cells and their contents:

Before you can format cells, you must first select them.

Selecting the body without the header
The body is made up of the cells where data is displayed in a table or a crosstab. 
The body does not include the title cells that appear at the top of columns and to 
the left of rows. 

By selecting the body, you can format all the cells it contains at the same time, for 
example by applying border styles or backgrounds.

To select the body in a table

1. Place the cursor on the table’s left-hand border, but not at the top of the table 
where the title cells appear.

2. When the cursor turns into a black arrow pointing towards the table, click 
once. 
A hatched gray border appears around the table, and the body is highlighted 
to show that it is selected:

A table, with the body selected

Apply color and shading to cell 
backgrounds.

Change the color and line 
style of cell borders.

Apply color and font 
attributes to text.

Apply formats to numbers 
and dates.

Align cell contents: text to the 
left and numbers to the right.



 Formatting Cells

  Business Objects Guide   541

To select the body in a crosstab

1. Click once inside the crosstab’s body.

2. If the body contains two or more variables, hold down your Shift key and click 
each one.
A hatched gray border appears around the crosstab, and the body is 
highlighted to show that it is selected:

A crosstab, with the body selected

Using the formatting toolbar
The quickest and easiest way to apply common formats is to use the toolbar 
buttons.

To display the Formatting and Borders toolbars:

1. From the View menu, choose Toolbars.
The Toolbars dialog box opens.

2. Check the Formatting and Border toolbar check boxes, then click OK.

The toolbars are displayed. The buttons you can use to format cells are illustrated 
in the sections that follow.

Repeating cell formats
When you have spent time formatting a cell, you can quickly apply the same 
formats to other cells. To do this:

1. Select the cells you want to format.

2. From the Edit menu, choose Repeat Format.

Tip: You can also use the keyboard shortcut Ctrl+Shift+Y
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Copying cell formats
You can copy and paste the formatting only of a cell. To do this:

1. Select the cell from which you want to copy the formatting.

2. Click Copy button on the Standard toolbar.

3. Select the cell to which you want to paste the formatting.

4. Choose the Paste Format Only button on the Standard toolbar.
The formatting is copied but the contents remain unchanged.

Tip: You can also use the keyboard shortcut Ctrl+Shift+V to paste the formatting 
only.

Paste Format
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Formatting text
You can format text in cells in the following ways:

• Change the font and font size.

• Apply color.

• Apply bold, italics and underline.

You can apply some of these text formatting features using buttons on the 
Formatting toolbar:

1. Select the cell(s), row(s) or column(s) that contain the text you want to format.

2.  Use the toolbar buttons to apply the required formatting.

a b c 

a. Font

b. Font size

c. Bold

d. Italics

e. Underline

f. Text color

d e f
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You can also use the Cell Format dialog box to format text. Here is the procedure:

1. Select the cell(s), row(s) or column(s) that contain the text that you want to 
format.

2. Choose the Cell command from the Format menu, or the Format Cell 
command from the pop-up menu that appears when you click your right-
mouse button.
The Cell Format dialog box appears.

3. Click the Font tab to display the text formatting features:

4. Choose the text formats you want, then click Apply or OK.
The formats are applied to the selection.

Click here to open the 
color palette.
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Formatting numbers and dates

This section describes how to apply formats supplied by BUSINESSOBJECTS to 
numbers and dates, and how to create your own formats.

Using the toolbar buttons

The formatting toolbar has several buttons you can use to quickly apply certain 
formats to numbers. You can use these buttons to format numbers in cells or on 
charts.

1. Make sure the Formatting toolbar is open.

2. Select the number you want to format and click the required button.

Note: The default currency, million and percent styles are taken from the regional 
settings properties in the Windows Control Panel.

To format numbers and dates

1. Select the cell(s), row(s) or column(s) that contain the numbers or dates that 
you want to format.

2. Select the Cell command from the Format menu or the Format Cell command 
from the pop-up menu that appears when you click your right-mouse button.
The Cell Format dialog box appears.

a. Formats the number with the default currency style

b. Formats the number with the default percent style

c. Formats the number with the default million style

d. Adds a decimal place

e. Removes a decimal placea b c d e 
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3. Click the Number tab:

4. Click a category in the Category list to display its corresponding formats:
• All All formats.
• Custom Formats that you have created yourself.
• Number Formats for decimal values.
• Currency Formats for currency values.
• Date/Time Date and time formats.
• Scientific Formats to display values to the nth power.
• Percentage Percentage formats.
• Condition Mr., Mrs., Miss.
• Boolean True, False.
• Image Bitmap/TIFF

5. Click a format in the Format list.
An example of the effect the format has on numbers is shown below the 
Positive field. Examples also appear below the other fields (Negative, Equal to 
Zero and Undefined) if the format has been defined for negative numbers, 
zero and empty cells, respectively.

6. Click Apply or OK.
The new formats are applied to the selection.
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Creating your own number and date formats
You can create your own number and date formats, based on standard formats. 
To illustrate the procedure that you must follow to create your own format, the 
steps described in this section are based on an example.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Example Creating a number format with three decimal places

The format can be applied to positive and negative values, as well as to zero 
values and empty cells.

1. In the Number tab of the Cell Format dialog box, click the Number category 
from the Category list.
The corresponding number formats appear in the Format list.

2. Click the number format with two decimal points (0.00).
The effect that this format has on positive values appears below the Positive 
field.

3. Click inside the Positive field, then add a zero in third decimal place.
You have now created a format that will display positive values with three 
decimal places. If you do not wish to enter formats in the remaining fields 
(Negative, Equal to Zero and Undefined), go to step 6

4. Click inside the Negative field, then enter the format (0.000).
Negative values will now be displayed with three decimal points.

5. Enter 0.000 in the Equal to Zero and Undefined fields.
These fields correspond to null values (zero) and empty cells, respectively. In 
cells that contain null values, “0.000” will be displayed. The format is also 
applied to empty cells.



 Chapter 22  Formatting Tables, Cells and Sections

548   Business Objects Guide

6. Click Add.
The new format appears in the Format list, under the Number category and 
the Custom category.

7. Click Apply or OK.
 The new number format is available for use.

You can apply a color to number formats that you create. For example, if you 
want negative values to appear in red, type [Red] after the number format in the 
Negative field.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

To delete number and date formats that you have created
You can delete number and date formats that you or other users have created.

1. In the Number tab of the Cell Format dialog box, click the Category where you 
created the format you want to delete. 

2. Select the format(s) that you wish to delete. 

3. Click Remove, then click OK.

An example of the 
format appears 
below each field.

The four properties for 
the new format appear 
in the Format list.



 Formatting Cells

  Business Objects Guide   549

Using hyperlinks in BusinessObjects reports
You can easily add hyperlinks such as email addresses and web site addresses to 
your reports. BUSINESSOBJECTS automatically recognizes certain keywords or 
symbols included in the address, adds any extra syntax behind the scenes and 
formats the address as a hyperlink. Hyperlinks you add to a BUSINESSOBJECTS 
report are retained when you save the report in PDF or in HTML format.

BUSINESSOBJECTS automatically recognizes the keywords, syntax and symbols in 
the table below and turns them into hyperlinks:

How are hyperlinks formatted?
If you have Microsoft Internet Explorer installed, hyperlinks in BUSINESSOBJECTS 
reports are formatted according to the settings you have made in Internet 
Explorer. If Internet Explorer is not installed on your computer, unused 
hyperlinks are formatted in blue and underlined.

Keyword or syntax Automatically recognized and formatted as....

HTTP or www HyperText Transfer Protocol

MAILTO or @ Electronic Mail

FILE Host-specific Files

<a href specified in the HTML code

FTP File Transfer Protocol

NEWS Usenet news

TELNET Telnet Protocol for Interactive Sessions

GOPHER Gopher and Gopher+ Protocols

WAIS Wide Area Information Servers Protocol

PROSPERO Prospero Directory Service

NNTP Usenet news using NNTP access
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Adding a hyperlink
You can type an address directly into a cell or retrieve it through a query if your 
universe Designer has included hyperlinks in a universe.

1. Select the cell where you want the hyperlink to appear. 

2. Type in the address using one of the supported keywords or symbols in the 
table above and press return.
BUSINESSOBJECTS automatically detects the hyperlink and formats 
accordingly.

Tip: Selecting and resizing cells containing hyperlinks can be a little tricky because 
every time you click on the cell, the hyperlink is activated. Make the cell 
containing the hyperlink longer than the actual text inside it so that you can select 
the cell after the address without activating the hyperlink.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Example Adding a link to a web site in a report

Complementary information on the data in your report is available on a company 
web site. Including a link to this site from your report allows your report readers 
to go directly to the source of further information. To add a web site address to 
your report:

1. Insert a new free-standing cell in your report.
It’s a good idea to make the cell fairly large to allow some space in the cell after 
the address. This allows you to easily select the cell without activating the 
hyperlink.

2. Select the cell and type in the address: www.businessobjects.com.

3. Press return.
BUSINESSOBJECTS automatically recognizes the key string www as part of a 
web address and formats the string in blue underline. If you move your 
mouse over the address, the cursor changes to the hand icon to show it is a 
hyperlink.

4. Click on the link.
If you have Internet access, the BUSINESSOBJECTS web site will open in your 
Internet browser.
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BUSINESSOBJECTS also recognizes <a href syntax which allows you to define 
exactly what will be visible in the hyperlink and to define relative paths to files.

In the example syntax below, the hyperlink will take you directly to the Tips & 
Tricks page on the Business Objects web site but you only see “BusinessObjects 
Tips & Tricks” displayed in your report:

<a href="http://www.businessobjects.com/services/infocenter//tips/start/
starthome.htm">BusinessObjects Tips & Tricks</a>

If you hold your mouse cursor over the address, a tooltip appears displaying the 
web address syntax:

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Editing a hyperlink
You can edit a cell containing a hyperlink either directly in the cell or using the 
Formula Bar.

Using the Formula Bar:

1. Make sure the Formula Bar is open.

2. Select the cell containing the hyperlink you want to edit.
The full hyperlink syntax is displayed in the Formula Bar window.

3. Make the required changes in the Formula Bar window and press the return 
key.
The hyperlink is updated.

Editing directly in the cell:

1. Double-click on the cell containing the hyperlink you want to edit.
The hyperlink becomes editable.

2. Make the required changes and click out of the cell or press the enter key.
The hyperlink is updated.
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Aligning cell contents
Aligning contents means positioning the data in a cell relative to the borders of 
the cell. For example, you can align data against the left border of its cell.

You can use buttons on the Formatting toolbar to align cell contents:

1. Select the cell(s), row(s) or column(s) whose contents you want to align.

2. Click one of the alignment buttons. 

You can also use the alignment features in the Cell Format dialog box. To do so:

1. Select the cell(s), row(s) or column(s) whose contents you want to align.

2. Right-click the cell, row or column and choose Format from the pop-up menu.
The Cell Format dialog box appears.

3. Click the Alignment tab to display the alignment features:

4. Select the features that you wish to apply to the selection, then click OK.

a b c 

a. Left align

b. Center

c. Right align

d. Justify

d 

This option aligns text to 
the right and numbers 
to the left.

Click this option to 
display long contents 
on multiple lines.

To modify the vertical 
alignment of cell 
contents, click a button in 
the Vertical box.
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Certain types of table or crosstab typically used in financial reports have a 
characteristic layout as shown in the illustration below.

Indenting cell content
You can set a space between the left cell border and the text or numbers in the cell 
to give the appearance of an indented list in your table.

1. On the Alignment tab, click Left to align the cell contents on the left of the cell.

2. Set a value in the Indents box.
A value of 1 is equal to one space. You cannot enter negative values.

You can also use the buttons on the Formatting toolbar:

1. Click inside the cell.

2. Click the Left Align button on the Formatting toolbar.

3. Use the buttons to increase and decrease the amount of indent.

Fill and character settings
You can fill in the space between the end of the text in a cell and the cell border 
with a selected character.

1. On the Alignment tab, check the Fill checkbox in the Settings section.

2. Type in the character you want to use.

Merging cell contents
When you have inserted a break on a row or column, you have several columns 
or rows displaying the same value. You can remove these duplicate values, 
merge the empty cells and center the value over the rows or columns it describes.

Indented cell contents.

Fill character at the end 
of the text.

Align left/Align right



 Chapter 22  Formatting Tables, Cells and Sections

554   Business Objects Guide

To do this:

1. Click in the column or row where you have inserted a break.

2. Click the Center Values Across Break button on the Formatting toolbar.

Note: For information on inserting and managing breaks see Chapter 
13 "Breaking Up Tables and Displaying Calculations" on page 285.

Wrapping cell contents
When you have a long label in a header row or column, you can display the text 
on more than one line.

In the example below, the Number of guests label is much longer than any of the 
figures displayed under it and this column is taking up unnecessary space in the 
table. By wrapping the cell contents and then resizing the column, you can get 
round this problem. 

To do this:

1. Right-click on the Number of guests cell and choose Format Cell from the 
menu.
The Cell Format dialog box opens.

2. Click the Alignment tab.

3. In the Settings section, check the Wrap Text check box.

Tip: If you have column labels on two or more lines, choose Bottom in the Vertical 
section of the Alignment tab to align all labels along the last line of the text.  
To automatically align rows of wrapped text, choose Row by row autofit. The size 
of the highest cell in the row is taken as default. Note: If you manually adjust the 
size of the row this feature is overwritten.

Center Values 
Across Break
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Formatting cell borders
You can format cell borders by applying line styles and colors. The buttons on the 
Borders toolbar make it easy to format cell borders:

To display the Borders toolbar:

• Right-click on any other toolbar and choose Borders from the menu. 

or

• If the Formatting toolbar is already displayed, click the arrow next to the 
Borders button.

To format borders

1. Select the cell(s), row(s) or column(s) whose borders you want to format.

2. Choose a line style and a color to apply. 

3. Click the border buttons to add the required borders to the cell.

You can also use the Cell Format dialog box to apply lines and colors to cell 
borders. To do so:

1. Select the cell(s), row(s) or column(s) that you want to format.

2. Select the Cell command from the Format menu, or the Format Cell command 
from the pop-up menu that appears when you click your right-mouse button.
The Cell Format dialog box appears.

a. Enables you to select the line style to apply.

b. Applies the style to the upper border.

c. Applies the style to the lower border.

d. Applies the style to the left border.

e. Applies the style to the right border.

f. Applies the style to the inner borders.

g. Applies the style to the outer borders.

h. Removes the style from all borders.

i. Selects the color to apply.

a fb c d g h ie

Borders Toolbar



 Chapter 22  Formatting Tables, Cells and Sections

556   Business Objects Guide

3. Click the Border tab to display the border formatting features:

4. Choose a line style from the Style section.

5. To change the border color, click the box next to Custom, then select a color 
from the color palette that opens. Click OK to close the palette.

6. Select the border(s) you want to format. You can select them individually, or, 
to select the outer borders, click Box.

7. Click Apply or OK.
The border line styles and color are applied to the borders you selected.

 

Select the line style.

Click to open the color 
palette.

Clear the style 
from all borders.

Apply the style to 
outer borders.

Select the 
borders you 
want to format.
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Formatting cell backgrounds
You can format the background of cells in the following ways:

• Change the color.

• Apply a pattern.

• Combine a color and a pattern.

To format cell backgrounds:

1. Select the cell(s), row(s) or column(s) that you want to format.

2. Choose Cell from the Format menu or

• Right-click the cell, row or column and choose Format Cell from the menu

The Cell Format dialog box appears.

3. Click the Shading tab:

4. Make the required settings, then click Apply or OK. 
The shading and color attributes are applied.

Click here to select a 
color you want to the 
foreground.

Click here to select the 
color you want to apply 
to the background.

Choose the pattern or 
shade from the list.

If you choose Clear, 
you apply the 
Background color 
only.

If you choose Solid, 
you apply the 
Foreground color only.

The other settings mix 
the two colors.

Click None if you do 
not want to apply 
shading to the cell.
This makes the cell 
transparent.

This box displays a 
preview of the shading 
that will be applied to 
the section.
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Overview

This section describes how to lay out the different report components on a page 
to obtain a clear, professional look to your reports. It deals with how to:

• Position blocks (tables, crosstabs and charts) and cells relative to one another.

• Align blocks with one another.

• Set conditions to hide and display blocks so that you can have different page 
layouts on different pages.

• Use page backgrounds.
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Positioning Report Components

This section describes how to position and align the different components that 
make up your report.

Relative positioning
Relative positioning means positioning a selected block in relation to markers 
such as page margins or other blocks. If these markers change in size or position 
the block is re-positioned accordingly. The example below demonstrates why 
relative positioning is important.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Why is relative positioning important?

You have a table and a chart positioned on a report page. The table is five lines 
long. You refresh your report to update it with new data and your table is now 10 
lines long. If you do not set the position of the chart in relation to the actual 
position of the table, the new table will overlap the chart as shown in the first 
illustration below.

If you set the position of the chart in relation to the actual position of the table, 
when the table expands, the chart is positioned accordingly so that it is always 
under the table with the space that has been set.

Using relative positioning is particularly important if you are setting conditions 
to determine whether a table or chart, for example, is displayed or not. If you do 
not position components in relation to one another you could end up with 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
overlapping components or with big gaps between them.
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To position a block in relation to another report component

1. Right-click on the block or cell and choose Format (block) form the menu.
The Format dialog box opens.

2. Click the Appearance tab:

3. In the Horizontal Position Relative To box, choose the marker you want to use to 
position the block or cell horizontally. 

4. Enter a number (positive or negative) in the Left field to set how much space 
you want to have between the marker and the selected block.

5. In the Vertical Position Relative To box, choose the marker you want to use to 
position the block or cell vertically.
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6. Enter a value (positive or negative) in the Top field to set how much space you 
want to have between the marker and the selected block. 
The Sample box demonstrates the way the components are positioned.

7. Click Apply or OK to display the cells or blocks in their new position.

Note: When a report contains only the main section, the Upper section is the top 
margin of the page. When a report contains sections, the Upper Section is the top 
of the section in which a block is currently positioned.

Aligning blocks and cells
You can align report components with one other in the following ways using the 
Alignment toolbar:

1. Make sure the alignment toolbar is displayed.

2. Select the first component. 
For example, if you want to align a cell with a table, you must first select the 
table.

3. Hold down the Ctrl key and select the component you want to align with the 
first.

4. Click the option you want to use, then click OK.
The report components you selected are aligned.

The space between the marker 
and the selected block is always 
calculated from the upper left 
corner of the block. Horizontal position 

Vertical position

a. Aligns the left edges

b. Centers horizontally

c. Aligns the right edges

d. Aligns the top edges

e. Centers vertically

f. Aligns the bottom edges

g. Snap to Grid - Forces components to 
stick to gridlines

a b c d e f g 
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Displaying delimiters
When you are working on your page layout and aligning components, it may be 
useful to turn on the delimiters. Delimiters are non-printing dotted lines. There 
are three types of delimiters that you can turn on and off:

To turn cell and section delimiters on:

• From the View menu, choose Cell Delimiters or Section Delimiters.

To turn margin delimiters on:

1. From the View menu, choose Page Layout.

2. If the margins are not displayed, choose Page Margins from the View menu.

Manually positioning components using the grid
You can manually drag report components and place them as required on the 
report page. To help place components accurately you can turn on a page grid.

 To display the grid:

• From the View menu, choose Grid.

You can use the grid to automatically align the selection as you drag it. To do this: 

• Click the Snap to Grid button on the Alignment toolbar

When you drop a component in a new location, it will automatically be aligned 
with the nearest line on the grid.

cell delimiters shows the outline of a cell

margin delimiters shows the size of page margins; you can only turn 
margin delimiters on if you are in Page Layout view

section delimiters shows where a section begins and ends

cell delimiters 

section delimiters 

Snap to Grid
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To position a component:

1. Select the block(s) or cell(s) you want to position.

2. Then:
• Hold the cursor over the hatched border of the block. When the cursor 

changes to the Move arrow, hold down your mouse and drag.
• Click inside the cell, hold down your mouse and drag.

3. Drag the block or cell to the new position and release the mouse button.

Note: In master/detail reports, you can drag a block between sections. When you 
do this, the data in the block is re-calculated. You can also move blocks between 
sections using the Report Manager.

Move arrow
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Using Report Manager to Structure Report Layout

You can use the Map tab of the Report Manager to work on the structure, layout 
and formatting of your report. In particular, the Map tab in structure view allows 
you to manage reports which contain hidden cells, sections and blocks.

To display Report Manager in structure view

1. If the Report Manager is not already open, click the Report Manager button on 
the Standard toolbar.

2. Click the Map tab.

3. Click the Structure option button.

The Map tab displays a list of all the components in the currently selected report 
arranged in the order they appear in the report. The Report name is at the top, 
followed by the Main Section Header and then the Sections with the cells, charts, 
crosstabs and tables in each section.

Each report component is represented by an icon. When you click on an icon in 
the Report Manager window, the corresponding component is displayed in the 
report window.

Report Manager

Structure 
option button
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Organizing the report in Report Manager
You can use the Report Manager to organize the tables, cells and charts in your 
report. 

Copying report components

You can copy and paste a component from one section of your report to another. 
When you paste a component in a new location, the original formatting is 
retained. For example, if you copy a pie chart from one part of your report to 
another in the Map window, the chart will retain all the colors, legends, title and 
other formatting. To do this:

1. Right-click on the icon of the component you want to copy.

2. Choose Copy from the menu.

3. Right-click again and choose Paste from the menu.

This is a quick and easy way of copying a component and then working on it in 
the report window.

Moving report components

You can also drag a component from a position in the list and drop it in the new 
position. To do this:

1. Click on the icon of the component you want to move.

2. Click on the icon again and, holding down your mouse button, drag the icon 
to the new position in the list.
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3. Release your mouse button.
The icon is displayed in the new position in the list and the component is 
displayed in the new position in the report window.

Formatting components in Report Manager
You can also work on the formatting of the components in your report from the 
Report Manager Map tab. You can format tables, crosstabs, charts, cells and 
sections as well as work on the format of filters, sorts and breaks. To do this:

• Right-click on the component icon in the Map list and choose the relevant 
option from the menu.

Naming components in Report Manager
You name tables, crosstabs, cells and charts. These names appear in the Report 
Manager Map list in structure mode. Naming components makes it easier for you 
and others to find your way to the different parts of the report. With one click, 
you can go directly to the part of the report you are interested in. More 
importantly, however, naming components is a good idea if you are hiding report 
components on certain pages. To do this:

1. Make sure you are in structure view in the Report Manager Map tab.

2. Click once on a component name and then click again.
The name is highlighted

3. Type in your new name.

4. Press Enter or click out of the name.

Tip: You can also name components in the FormatBlock dialog boxes either on the 
General tab or on the Appearance tab.
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Hiding and Displaying Report Components

BUSINESSOBJECTS allows you to create and format report components (tables, 
crosstabs, charts, cells and sections) and then choose which components you 
want to display on a given page or in a given set of circumstances. This is 
sometimes called conditional formatting.

Conditional formatting allows you to easily set up reports which display 
different information and different formatting on different pages. For example, 
you can create a different page layout for your odd and even pages or use a 
different table format for customer payment records depending on whether the 
customer is up-to-date or not on payments.

You can hide and display report components in two ways:

• either by simply checking a box to temporarily hide a report component 

• or by setting up a condition to determine when the report component is 
hidden or displayed.

This section describes how to hide and display report components using both 
methods and gives a number of illustrated examples. 

Showing and hiding report components
You can temporarily hide a report component from the report page. This may be 
useful, for example, if you want to hide a cell containing a comment before you 
print out a report. To hide a report component:

1. Right-click on the report component.

2. Choose Format (Cell, Section, Table, Crosstab, Chart, depending on the type 
of report component) from the menu.
The Format dialog appears.

3. The next step depends on the type of component you want to hide:
• if you selected a section, click the General tab
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• if you selected a table, crosstab, cell or chart, click the Appearance tab

4. Check the Hide box and click OK.
The component is removed from the report page and the component name is 
displayed in italics in the Map list.

Check this box to 
hide the selected 
component

The comment cell is in italics to 
show that it is currently hidden.
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To display the report component

Since the report component is no longer displayed on the report page, you use the 
list in the Report Manager Map tab to display the component again. To do this:

1. Right-click on the component name in the Report Manager window.

2. Choose Format (Cell, Section, Table, Crosstab, Chart, depending on the type 
of report component) from the menu.

3. Click the Appearance or General tab.

4. Uncheck the Hide box and click OK.

Setting a condition to hide a component
You can also use the BUSINESSOBJECTS Formula Editor to set a condition to 
determine when a report component is hidden or displayed. To do this:

1. Right-click on the report component.

2. Choose Format (Cell, Section, Table, Crosstab, Chart, depending on the type 
of report component) from the menu.
The Format dialog appears.

3. The next step depends on the type of component you want to hide:
• if you selected a section, click the General tab
• if you selected a table, crosstab, cell or chart, click the Appearance tab.

4. Check the Hide box.

5. You can then:
• Either click the Edit Formula button to open the Formula Editor to write 

your formula.
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• Or type in your formula directly in the formula box.

6. Click OK to apply the condition.
The components which satisfy the condition set will be hidden.
A hidden component is removed from the report page and the component 
name is displayed in italics in the Map list in the Report Manager window.

Note: For details on the syntax to use for writing formulas see Chapter 
14 "Formulas, Local Variables & Functions" on page 313.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Displaying different table formats for European and US currencies

You produce a weekly report of the sales revenue generated per product line per 
city in the eFashion retail group. The report has a section for each city and you 
have created a variable, Currency Region, by grouping your cities into Europe 
and US. You want to produce a report displaying sales revenue in US dollars and 
in euros for your three European cities, and sales revenue in US dollars only for 
your US cities.

Type the condition 
here

Click here to open 
the Formula Editor
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To do this, you create two different table formats as shown below: 

• One table, named Dollars, has sales revenue in US dollars only. You set a 
condition to hide this table for all cities in Europe. The syntax is:

=<Currency region>InList("Europe")

European cities US cities

The condition tells 
BUSINESSOBJECTS to hide 
this table if the city 
belongs to the group 
Europe.

Make sure you set the 
table position in relation 
to the left edge of the 
report.
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• The other table, named Euros, displays sales revenue in US dollars and in 
euros. You set a condition to hide this table for all US cities. The syntax is:

=<Currency region>InList("US").

When you set up two table formats with conditions specifying when each one is 
to be hidden, it’s important to position both tables in relation to the left edge of 
the report page. When one table is hidden, the other will be re-positioned 
accordingly. For more details on relative positioning, see “Relative positioning” 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
on page 561.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Setting up a different page layout for odd and even pages

In this example, you are setting up a report that will printed and bound and you 
want to create a different layout for the odd and even pages. You want:

• odd page numbers to appear in the top right-hand corner of the page and 
display the document name in the page footer

• even page numbers to appear in the top left-hand corner of the page.

Here’s how to do it:

Layout for odd numbered pages

You’re going to place the page numbers in the page header area and the 
document title in the page footer area.

1. Make sure you are in page layout view and that page 1 of your document is 
displayed on screen.

Both tables are shown 
in italics in the Report 
Map list because both 
are hidden in certain 
sections of the report.



 Hiding and Displaying Report Components

  BusinessObjects User’s Guide   575

2. Add a special field containing the page number in the right-hand side of the 
page header area.

3. Right-click on the page number cell and choose Format Cell from the menu.
The Format Cell dialog box is displayed.

4. Click the Appearance tab.

5. Check the Hide Cell checkbox and type the following formula in the Hide Cell 
text box.

=Even(Page())

You can use this formula to hide all components that you do not want to be 
shown on even pages in your report.

6. Click OK to close the Cell Format dialog box.

7. Following the same procedure, add the document title to the page footer and 
set a condition to hide it on even-numbered pages.

Type a name for the cell 
here. The name helps 
you to identify the cell in 
the Report Map list
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Layout for even numbered pages

To set up the even numbered pages:

1. Add a special field containing the page number in the left-hand side of the 
page header area.

2. Right-click on the page number cell and choose Format Cell from the menu.
The Format Cell dialog box is displayed.

3. Click the Appearance tab

4. Check the Hide Cell checkbox and type the following formula in the Hide Cell 
text box.

=Odd(Page())

You can use this formula to hide all components that you do not want to be 
shown on odd pages in your report.

5. Click OK to close the Cell Format dialog box.
This cell will be hidden on all odd-numbered pages.

If you page through your document, you will see that the odd page numbers 
appear at the top right-hand side of the odd pages only and the even page 
numbers appear at the top left-hand side of the page. The document title appears 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
on the odd pages only.
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Hiding an empty section in a report
When you create or refresh a master/detail report, you may have empty sections, 
as shown in the example below:

This may happen for two reasons:

• the section master cell is empty because you have data in the data provider 
that has not been organized into one of the section values. BUSINESSOBJECTS 
designates sections with no value in the master cell as #EMPTY.

• you have a section that contains no data because there is no data currently 
available for that section.

You can set a condition to hide these empty sections in a report. You can hide the 
master cell only, the section only or both master cell and section.

To do this:

1. Click on the Report Manager Map tab and choose Navigation view.

2. In the Report Manager list, right-click on the empty master cell or the empty 
section and choose Format Section from the menu.
The Section Format dialog box opens.

3. Click the General tab.

4. Check the Hide Section Header check box and type the following formula in 
the formula box:

=IsNull(<variable>)

where <variable> is the variable for which you have no data. 
To hide the empty year master cell in the example above, the formula is:

=IsNull(<Year>)

5. Click OK.
The empty cell or section is hidden on the report page and displayed in italics 
in the Report Manager list in the Map tab.

The year section 
contains an empty 
master cell.

There is no data for 
revenue in Australia 
and the US for the 
unidentified year.



Chapter 23 Formatting Page Layout

578   BusinessObjects User’s Guide

Working with Page Backgrounds

You can enhance the look of a report by inserting a page background. A page 
background is simply a picture displayed behind the report data and other 
pictures.

To insert a page background
You can insert an existing picture as a page background, or call a graphics 
application to create a new picture:

1. Click the Page Layout button on the report toolbar.

2. Click the tab of the report in which you want to insert the page background.

3. From the Format menu, choose Page and then Background from the sub-
menu.
The Page Background dialog box appears:

4. Click New.
The Insert Object dialog box appears.

5. Click Create from File.

6. Type in the path of the file you want to insert in the File text box or click 
Browse to locate the file.

7. Check the Link checkbox if you want to link the file.
If you leave this box unchecked the image is embedded in the report.

8. Click OK to close the close the Insert Object dialog box.

9. Click a Display option in the Page Background dialog box, then click OK.
• Center displays the background in the center of the page.
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• Tile displays the background as multiple tiles.

Tip: You can also copy a picture to the clipboard, then click Paste in the Page 
Background dialog box.

To edit the current page background
You can edit a page background in the graphics application in which it was 
originally created.

1. Make sure you are in Page Layout view. If not, choose Page Layout from the 
View menu.

2. From the Format menu, choose Page and then Background from the sub-
menu.
The Page Background dialog box appears.

3. Click Edit.
The current page background appears in its native graphics application, i.e., 
the application in which it was created.

4. Make the required changes to the page background, then quit the graphics 
application.

5. In the Page Background dialog box, change the Display option if you wish:
• Center displays the background in the center of the page.
• Tile displays the background as multiple tiles.

6. Click OK.
The edited page background appears in the report.

To remove the current page background.

• Click Remove on the Page Background dialog box, then click OK.

The Page Background dialog box closes, and the page background no longer 
appears in the report.
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Overview

This chapter describes how to set up your report layout. It deals with how to set 
margins, headers and footers and how you can control exactly what appears on 
each page of the report and how to set up and manage multi-page reports.

It also deals with how to handle tables which extend over several pages using 
running headers and footers for calculations over page breaks.

Finally, it deals with how you can enhance your report by adding document and 
tracking information such as author, page numbers, date and time and how you 
can prepare a report for viewing.
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Multi-page Reports

When your report contains several pages, there are a number of options in 
BUSINESSOBJECTS to manage the page layout over multiple pages so that your 
report reads fluently and coherently and you obtain good printed copy.

Setting what is to appear on each page
You can control how sections, tables and crosstabs, cells and charts appear on 
each page of a report. For example, in a report divided into sections, you may 
want to start a new page at the beginning of each new section. Or, you may wish 
to display a specific chart on every page of your report.

To display a block on every page of a report

1. Right-click on the block.

2. Choose FormatBlock from the menu.

To display one section or block per page

1. Right-click on the block or in the section.

2. Choose FormatBlock or Format Section from the menu.

For a.. Click this tab..... And check this box...

cell Alignment Repeat on Every Page

table Page Layout Repeat Block on Every Page

crosstab Page Layout Repeat Block on Every Page

chart General Repeat on New Page

For a.. Click this tab..... And check this box...

section Alignment Start on a New Page

table Page Layout Start on a New Page

crosstab Page Layout Start on a New Page

chart General Start on a New Page
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Managing page breaks
When tables and charts extend over more than one page you need to make sure 
that they are split coherently and that the elements that help your readers to 
understand the tables and charts correctly, such as title headers on tables, are 
added to every new page. You may also want to include page sub-totals and 
previous page recaps for calculations to make it easier for your readers to follow 
tables of data over several pages.

The page break options are set on the format dialog boxes. To open the format 
dialog for a table, crosstab or chart:

1. Right-click on the block.

2. Choose FormatBlock from the menu.
The Format dialog box that opens depends on the type of block selected. 

3. For crosstabs and tables, choose the Page Layout tab.
See page 585 for an illustration of the Page Layout tab. 
For charts, choose the General tab.

ca

b

a. Places the selected chart on a new page.

b. Repeats the selected chart on every page of the report.

c. Where possible, starts a new page for charts that would 
otherwise be split by a page break.
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The page layout tab below shows the page break options you can set for crosstabs. The 
options for tables are exactly the same. The only difference is that you can manage page 
breaks along the across edge as well as the down edge for crosstabs. 

a. Where possible, starts a new page for blocks that would otherwise be split by a page break.

b. When a table/crosstab goes over more than one page, the title header is repeated at the 
top of the table/crosstab on every new page.

c. Before a table/crosstab goes over onto a new page, a footer is displayed at the bottom of 
the table.

d. When a table/crosstab goes over more than one page, a page break header is displayed 
at the top of the table/crosstab on the new page. You can insert a formula in this header 
to allow you to display a recap amount from the previous page, for example.

e. Before a table/crosstab goes over onto a new page, a page break footer is displayed. You 
can insert a formula in this footer to allow you to display a running total for example.

f. Page break options for the across edge of a crosstab.

c

d
e

a

b f
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Running headers and footers in tables
When a table extends over more than one page you may want to recap on certain 
calculated amounts to make the table easier to follow. You do this by inserting 
conditional headers and footers in your table and then inserting the text and the 
formula for the information you want to display into these header and footer 
cells. These headers and footers are only displayed if there is a page break in your 
table. The example below shows how this works for a multi-page bank statement.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example How can I display page totals and recap amounts in a multi-page report?

The example below shows a two-page bank statement. To help the bank’s client 
follow this two-page statement, the account status after the list of credits and 
debits is displayed at the bottom of the first page. This sum is then repeated at the 
top of the second page before the list of debits and credits continues. These two 
sums are only displayed if a page break occurs.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Page break footer. This 
line is only displayed 
before a page break in 
the table.

Table footer. Displayed 
at the end of the table.

Page break header. This 
line is only displayed 
after a page break in 
the table.

Page break occurs 
here.
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To set up a report with running headers and footers
First, you have to turn the option on. To do this:

1. Right-click on the table.

2. Choose Format Table from the menu.
The Format Table dialog box opens. 

3. Choose the Page Layout tab.

4. Check Page break header after page break and Page break footer before page break.

5. Click OK to close the dialog box.

Next, type in the formula:

1. Click the page layout button on the Report toolbar.
You can only see page break headers and footers when you are in page layout 
mode and when the table goes over to the next page.

2. Click the structure button on the Report toolbar, click the header/footer cell 
and type in the formula.

3. Press the enter key.
The result of the formula is displayed in the cell.

4. Click in an adjacent cell and type in a text to describe what the amount 
represents.

To add columns and rows to a running header or footer
By default, a page break header or footer has one column or row but you can add 
as many columns or rows as you need for the information you want to display. 
The size of the table is adjusted so that all the page break header and footer 
columns and rows fit onto the page.

1. Make sure you are in page layout view.

2. Select the page break header or footer in the table.

3. Use the Structure toolbar to insert the required columns and rows.

4. Insert the required formulas in the page break header and footer.

Page Layout
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Running header and footer examples
Here are some examples of formulas used in page break headers and footers 
where the measure object to calculate is <Revenue>.

Note: For information on writing formulas, see Chapter 14 "Formulas, Local 
Variables & Functions" on page 313. You can also use Input, Output and Reset 
contexts as well as the keyword arguments ForEach and ForAll in the page break 
header and footer cells. For information on using this extended syntax see 
Chapter 15 "Calculation Contexts and Extended Syntax" on page 341.

Formatting page break headers and footers
You can change the font, number, color and other attributes for the text and 
numbers displayed in the page break header and footer cells. See “Formatting 
Cells” on page 540 for information on how to do this.

To calculate and display... Type the following formula...

A subtotal for the current 
page

=Sum(<Revenue>)

A running total, that is the 
sum of all the data displayed 
in the table up to and 
including the current page

=RunningSum(<Revenue>)

A recap amount from the 
previous page, that is the 
sum of all the data in the 
table up to and including the 
previous page

=RunningSum(<Revenue>)-Sum(<Revenue>)

The percentage of data 
displayed in the current page 
against all data displayed in 
the table

=Sum(<Revenue>)In CurrentPage/
Sum(<Revenue>)In Block
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Page Setup

This section describes how to set up report page margins and how to use and 
format page headers and page footers.

Setting margins
When setting margins, remember that the minimum margins you can set are 
determined by the printer you are using. You may be tempted to reduce the 
margins as much as possible to fit everything on the printed page. Bear in mind, 
however, that reports are often bound or stored in binders and you need to allow 
an adequate margin for this

1. From the File menu, choose Page Setup.

2. The Page Setup dialog box opens.

3. Click the Margins button to open the Margins dialog box.

4. Type in sizes for the Left, Right, Top and Bottom margins.

Using headers and footers
The Header and Footer areas of the page are usually reserved to display 
information that you want to repeat on every page of your document. 
Information such as page numbers, author name and creation date are typically 
placed in header and footer sections.
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Inserting a cell in a page header or footer
If you want to display information (text, pictures, variables) in a header or footer, 
you must first insert a cell. Here is how to do it:

1. Make sure you are in Page Layout view. If you are not, click the Page Layout 
button on the Report toolbar.
You can only see the header and footer sections in Page Layout View

2. Click inside the header or footer, then choose Cell from the Insert menu.
The cursor changes to the Insert Cell cursor.

3. Click where you want your cell to appear and, holding down your mouse 
button, draw a cell.

When you release the mouse button, a cell appears in the area you have 
drawn. When a new cell is inserted it has a flashing cursor inside it so that you 
can immediately type in text.

4. Type your text or formula in the cell and press Enter.
You can now format the cell as you wish.

Applying shading to a header or footer
You can apply different color shades and patterns to a header or footer. Here is 
how to do it:

1. Ensure that the Page Layout command on the View menu is switched on.

2. Click inside the header or footer, then select the Page Header or Page Footer 
command on the Format menu.
The Page Header Format dialog box or the Page Footer dialog box appears. 
Each dialog box contains the Shading tab only.

3. Select the fill, foreground color and background color you want, then click OK 
or Apply.

Page Layout
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Resizing headers, footers and margins
You can reduce or increase the height of headers and footers, and the width of 
margins, simply by dragging the mouse:

1. Ensure that the Page Layout command on the View menu is switched on.

2. Position the pointer over the element you want to resize.

3. When the pointer changes to the resize cursor, press and hold down the left 
mouse button.

4. Drag the mouse until the header, footer or margin reaches the size you 
require, then release the mouse button.

Resize cursor
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Using Page Numbers, Times and Dates

BUSINESSOBJECTS has pre-defined page number, date and time functions that you 
can insert in your reports directly from the Insert menu. These functions are 
automatically updated.

Inserting numbers, time and date
To insert a page number or a date at the top of the page (in the page header) or at 
the bottom of the page (in the page footer):

1. From the View menu, choose Page Layout.
The page number commands are only available when you are in Page Layout 
view.
The margins are displayed on your report. If the margin lines are not 
displayed, choose Page Margins from the View menu.

2. From the Insert menu, choose Special Field then Page Numbers or Date and 
Time and then an option from the submenu.

The mouse cursor turns to the Insert Cell cursor

Page Numbers

Page # Displays the word Page followed by the current page number

Page # of # Displays the current page number and then the total number 
of pages in the report

Date and Time

Current Displays the current date and time (automatically updated 
each time a report is opened)

Save Date Displays the date on which the report was last saved 
(automatically updated)

Print Date Displays the date on which the report was last printed 
(automatically updated)

Last Refresh 
Date

Displays the date on which the data in the report was last 
refreshed with the most up-to-date data from the database 
(automatically updated)

Insert Cell cursor
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3. Click once in the area of the report where you want your page numbers to 
appear.
A cell displaying the page number is inserted.

Formatting the cell
When you insert a cell it has the default formatting. To change the formatting, 
you use the same procedure you use for formatting any other type of cell.

1. Right-click on the page number.

2. Choose Format Cell from the menu.
The Cell Format dialog box opens.

3. Change the formatting as required and then click OK to close the dialog box.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example How do I know when the data in my report was last updated?

In many companies, it is essential to know the exact date or time at which the data 
in the report was updated. In BUSINESSOBJECTS, you can display the last refresh 
date in a special field which is automatically updated every time you refresh your 
report and see at a glance when the data was last updated.

To do this:

1. Add a caption cell at the top of your report and type “Last refreshed” in it, for 
example.

2. From the Insert menu, choose Special Field, then Date or Time, then Last 
Refresh Date.
The cursor changes to the Insert Cell cursor.

3. Click once next to the Last Refreshed caption.

The date on which the report was last updated is inserted in the report. This 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
date is updated each time you refresh the report.
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Changing how the date and time is displayed
When you choose the insert date and time option from the menu, the date is 
inserted by default. To re-format the cell to display the time or to format the date 
display differently:

1. Right-click the cell and choose Format Cell from the pop-up menu. 

2. Click the Numbers tab on the Cell Format dialog box

3. Choose Date and Time in the Category list.
The display options are shown in the Formats box.

4. Click on a format in the Formats box.
An example of how the date or time will appear is shown in the Properties 
box.

Tip: If you get a cell which displays ####, it means that the text is to long to be fully 
displayed in the cell size. To fix the problem, click on the cell and re-size it until 
the text is correctly displayed.

Inserting the date and the time
If you want to insert both the date and time, insert two cells using the Insert/
Special Field/Date and Time command and re-format one to display the time.
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Inserting Document Information

For tracking purposes it may be useful to display information about the query 
you used to retrieve the data displayed in the report, the filters you have placed 
on the report and the drill filters you have used in drill mode. You can do this 
automatically using the Insert Special Field option. The following options are 
available:

Choose Insert Special Field... To display....

Query prompt Inserts the option you chose from the prompt 
dialog box when you ran the query. If you 
only chose to retrieve the sales figures for 
Northern Europe in FY95 for example, 
Northern Europe FY95 is inserted in the cell.

Global Filters Inserts the name of the filters you have 
applied to the whole report. These are the 
filters placed in the Global folder in the Filters 
dialog box.

Drill Filters Inserts the name of the filters currently 
displayed in the drill toolbar.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Example Inserting a query prompt in a report

In this example, when you ran a query you were prompted to choose which data 
you wanted to retrieve from the database. You had to choose the name of the sales 
representative and the year you wanted the data for. You now want to insert this 
information into your report to keep track of the data you have retrieved. Here’s 
how to do it:

1. From the Insert menu, choose Special Field and then Query Prompt.
The List of Prompts box opens if there is more than one choice.

2. Choose the prompt Which Salesrep? and click OK.
The insert cell cursor is displayed.

3. Click once where you want the query prompt to be displayed.
The name of the sales representative is displayed in a new cell.

4. Repeat Step 1 to Step 3 to insert the year you chose when you ran the query.
You now have the name of the sales representative, Galager, and the year, 
FY96, displayed in your report.

This information is updated if you run the query again and choose a different 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
sales representative or year.

Insert Cell cursor
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Using Outline View

When you have a report in sections with a lot of information in each section, a 
convenient way of presenting the report is to use outline view. Outline view folds 
up the sections in the report to display only the high level information that you’ve 
included at the top of each section. People viewing your reports can then open up 
the sections they are interested in to get more details.

To turn on outline view:

• From the View menu, choose Outline.

A bar with arrows is displayed at the left side of the report window.

The number of buttons displayed at the bottom of the outline bar depends on the 
number of sections you have in the report. In the report illustrated below, there 
is a main section and a City section.

If you click the S button, the main section is folded to display only the title and 
logo. If you click the 1 button, all section 1 City sections are folded to display only 
the section title, the name of the city and the section totals.

Click here to fold or unfold all sections.
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To view a report in outline view:

1. Click on the Report Manager Map tab.
This gives you a list of the sections in the report.

2. Click on the section you want to view in the Report Manager Map list.
The high level information for this section is displayed in the Report window.

3. Click on the arrow next to the section name in the Outline bar.
The selected section opens up and you can view the details for that section.
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Overview

This chapter describes how to set up templates and how to customize the 
standard report styles used to create standard reports.

Using templates saves you time if you regularly use the same structure and 
formatting for your reports. You make the settings once and then re-use them in 
all your reports.

Customizing standard report styles allows you to change the default shading, 
fonts, and other formatting that BUSINESSOBJECTS uses by default each time you 
create a standard report or insert a new table, cell, break or other component in 
an existing report.

Who should read this chapter
Most of the information in this chapter concerns those users in your company 
who are designing templates and styles. If you are not designing templates and 
styles, all you need to know is how to:

• apply a template to your report

• use a template when you create a new document

• apply standard report styles to a report
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What Are Templates And Standard Report Styles?

When you create a new document in BUSINESSOBJECTS, you choose the type of 
report layout your data will be displayed in. You can either generate a standard 
report or choose from a set of templates.

What is a standard report?
When you install BUSINESSOBJECTS and create your first standard report, your 
data is displayed in a table with a report title and has the default application 
formatting as illustrated below:

The table header is dark blue, the body cells are pale yellow with text and 
numbers in Arial size 10 font and black borders. The table footer has a white 
background and free-standing cells have a black border.

Whenever you insert a new table, crosstab or free-standing cell in a report, this 
default formatting is used.

Choose the report 
layout here.

Table header

Table footer

Table body

Free-standing cell



 What Are Templates And Standard Report Styles?

  BusinessObjects User’s Guide   603

But what if your company always uses a green header row and different type of 
borders? Or you want to use a different font? Or you want to have a particular 
format every time you insert a break in a table or crosstab. Using the Standard 
Report Styles editor, you can customize and save these attributes so that every 
time you create a new standard report, or insert a new component in a report, you 
will have your own colors, fonts, number styles and so on.

The settings that define the styles used to create a standard report are contained 
in a file called default.ret. This file is stored in the BUSINESSOBJECTS template 
folder.

Since the settings used to create a standard report are contained in one file, you 
can customize these settings once and then distribute this file to all users in the 
company. Every time a user creates a standard report, the corporate formatting 
will be used.

Note: A standard report does not contain information on page setup such as 
margin sizes and page orientation. If you want to include this information when 
you create a new report, use a template. See “Making sure a template contains the 
correct standard styles” on page 613 for more information.

What is a template?
A standard report does not contain information on page setup or include custom 
elements such as graphics. A BUSINESSOBJECTS template allows you to do this. A 
template is a special kind of BUSINESSOBJECTS document that contains pre-defined 
styles and structure that you use as a foundation to create reports. 
BUSINESSOBJECTS comes with several templates for you to use and you can also 
create your own.

Your own templates enable you to apply the same customized styles and 
structure to your reports. For example, if you always display your company's 
logo in the header of your reports, you can place the logo in the header of a 
template, then use the template when creating or formatting reports.

Templates contain a report structure and styles. You can either use a template 
when you create a report or you can apply a template to an existing report. 

Structure
The structure of a report defines how the data is presented. Your data can be 
presented in a crosstab, a column chart, or it can have a master/detail structure 
for example. When you use a template, the data is displayed in the structure 
defined in the template using the formatting defined in the template.
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Styles
The styles contained in a template define the report page background and the 
style of the headers and footers.

Setting a default report layout
You can set default options for the layout you want to use when you create new 
reports with the New Report wizard. This allows you to always use the same 
template or to always create a standard report.

To do this:

1. From the Tools, choose Options.
The Options dialog box opens.

2. Click the New Document tab.

3. Set the required option in the Report Layout section.

Tip: If you have set a default universe and template, you can create documents 
without using the New Report Wizard. When you click the New button or choose 
New from the File menu, the Query Panel appears. The Classes and Objects list 

Always creates a standard report.

Always uses the template you 
select in this list box to create a 
new report.

Prompts you to choose whether you 
want to use the standard report 
layout or select a specific template.

Displays a screen that allows 
you to select a template.
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presents the classes and objects of the default universe. When you build the 
query, the data appears in the layout provided by the default template you set. 
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Customizing Standard Report Styles

You customize standard report styles in the Standard Report Styles dialog box. 
You can open the Standard Report Styles dialog box with or without a 
BUSINESSOBJECTS document open.

To open the Standard Report Styles dialog box:

• From the Tools menu, choose Standard Report Styles.

The Standard Report Styles dialog box opens:

The Standard Report Styles dialog box has two parts:

• Report Components

The Report Components box on the left-hand side of the dialog box displays a list 
of the components that make up a report. This includes tables, crosstabs and cells 
as well as section and page components and breaks. Each component in the list is 
given a name and is identified by an icon.

• Settings tabs

When you click on an icon in the list the tabs on the right-hand side of the dialog 
box display the formatting options that can be set for the selected component. 
These are the same tabs used on the format dialog boxes.

Some icons in the list have a plus sign next to them. Click on the plus sign to 
expand the list.
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What you can change depends on the type of report component.

The following buttons are available on the Standard Report Styles dialog box:

Note: You cannot set chart attributes in the Standard Report Styles dialog box.

Editing settings
To edit settings in the Standard Report Styles window:

1. Select the item you want to modify in the Report Component list.
The tabs display the formatting options available for the selected item.

2. Make the required settings on the tabs.

3. Click OK to save the changes and close the dialog box.

Editing settings and applying to an open report
If you have a document open and want to apply the changes you have made in 
the Standard Report Styles window immediately to the active report:

• When you have made the required changes in the Standard Styles dialog box, 
click the Apply button and then the OK button. 

Click... To...

Add Add a break or section level.

Delete Remove a break or section level from the list.

OK Save the changes you have made and close the dialog box. The 
changes are saved in the default.ret file.

Cancel Close the dialog box without saving any changes you have made.

Apply Apply the changes you have made to the active report. This button 
is not displayed if you do not have a document open.

Help Open the on-line Help for a quick explanation of the dialog box 
options.
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Tables
You can edit the default formatting and page layout options for tables.

Crosstabs
You can edit the default formatting and page layout options for crosstabs.

To edit general settings for tables, select the table icon 
in the list. General settings include whether to 
display headers and footers, table orientation and 
how page breaks are handled.

To edit the settings for the different elements that 
make up a table, click on the plus sign next to the 
table icon.

You can set different formatting for header, body and 
footer columns and rows.

Select the crosstab icon to edit general settings for 
crosstabs. General settings include whether to display 
headers and footers and how page breaks are handled.

To edit the settings for the different elements that make 
up a crosstab, click on the plus sign next to the crosstab 
icon.

You can set styles for headers and footers, for the body 
cells of the crosstab and for the four corners of a 
crosstab.
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Breaks
You can edit the settings for breaks you insert in tables and crosstabs. You can 
define up to nine different break levels with different attributes set for each level.

Adding and deleting break levels
When you add a new break level, BUSINESSOBJECTS inserts the new level below 
the level selected when you click the Add button. The newly inserted break level 
has the same style settings as the break level under which it is inserted.

To add a break level:

1. Select the Break level under which you want to add a break.

2. Click the Add button.
A new break level is added to the list.

To delete a break level:

1. Select the break level you want to delete in the list.

2. Click the Delete button.

Click on the Breaks icon to edit settings that will apply 
to all breaks in the report.

Click on the Level n icon to edit settings that will apply 
to all level n breaks in the report.

Open the Level n folder and click on Down or Across to 
edit settings that apply only to the selected item.
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Sections
You can set different attributes for up to nine different sections in a report.

You can set attributes for the cells that are displayed at the top of each section and 
that contain the master value and for the background shading of the section.

Adding and deleting sections
When you add a new section level, BUSINESSOBJECTS inserts the new level below 
the level selected when you click the Add button. The newly inserted section level 
has the same style settings as the section level under which it is inserted.

To add a section:

1. Select the Section level under which you want to add a section.

2. Click the Add button.
A new section is added to the list.

To delete a section:

1. Select the section you want to delete in the list.

2. Click the Delete button.

Click on the Section icon to edit settings that apply to all 
the section levels in your report.

To edit settings for a particular section, click on the Level 
n icon and make the required changes.

To edit the settings for the different elements that make 
up a section, click on the plus sign next to the Level n icon 
to open up the section list.

Click on Master Cell to edit settings for the master cell.

Click on Section Area to edit the background shading for 
the selected section.
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Pages
You can edit the background shading for the report page. You can either set the 
same shading for the whole page or set the shading for the page header, page 
body and page footer separately.

Free-standing cells
Click on the cell icon to edit settings for free-standing cells.

Select the Page icon to set the same shading for all three 
page elements.

To edit the settings for the different elements that make 
up a page, click on the plus sign next to the page icon.

You can set different shading for the page header, the 
main section (the page body) and the page footer.
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Applying standard report styles
You can create a new standard report using your custom standard report style 
settings or you can apply your custom styles to existing reports.

You can apply your custom standard report styles to the whole report or to a 
selected item.

Applying standard report styles to the report
• From the Format menu, choose Report and then Apply Standard Style.

Applying standard report styles to a selected component
You may want to only apply a standard report style to a selected table, crosstab 
or cell, for example. When you apply a standard report style to a selected 
component, only the formatting attributes are applied. The pagination and break 
settings are ignored so that your report layout is not disorganized.

1. Make sure the Report Manager window is open.

2. Click on the Map tab.

3. Click the Structure option button.
A list of all the components in the report is displayed.

4. Right-click on the component you want to apply the standard report style to.

5. Choose Apply Standard Style from the menu.

Tip: For a section or cell, you can right-click on the component you want to apply 
the standard report style to and choose Apply Standard Style from the menu. 
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Making sure everyone uses the same standard report styles
Any changes you make to the standard report style settings are saved in the 
default.ret file. This allows you to customize the standard report styles once using 
your corporate formatting and then distribute the default.ret file to all users in a 
company via the repository. To do this:

1. Edit and save the standard report styles on your computer.

2. Make sure all users in the company are using the same default.ret file.
There are several ways of doing this:
• send the default.ret file to all users and have them copy it into their 

BUSINESSOBJECTS template folder
• change the template folder location to point to the folder containing the 

customized default.ret file; you can also do this during installation
• use a master/ shared installation

A word about the default.ret file
If BUSINESSOBJECTS cannot find the default.ret file, it will re-create one using the 
default application settings and the standard report created may not reflect any 
changes you have made.

Make sure the default.ret is in the Template folder in the BUSINESSOBJECTS folder. 
If you have changed the default location of your templates in your 
BUSINESSOBJECTS options, make sure the default.ret file is in this folder.

Making sure a template contains the correct standard styles
To make sure that the standard styles you want to use are saved in a template, 
apply these styles to a report before saving it as a template:

1.  Make all your required formatting settings in the Standard Report Styles 
window and save.

2. Create a Standard report using these settings or apply the new standard styles 
to an existing report.

3. Set up the report page layout, margins, and add any other elements you want 
to include in the template.
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4. Save this report as a template in the folder where your BUSINESSOBJECTS 
templates are saved.
You can now use this template to create new reports.

Note: The standard report styles saved with this template are the ones set at the 
time of creating the template. This means that if, at a later date, you change 
settings in the Standard Report Styles window, the styles saved in the template 
will not be the same.
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Using Templates 

You can use a template in the following situations:

• When creating a report. 

The New Report Wizard includes a dialog box that enables you to view and 
select the template you want to use. The styles and structure of the template 
are applied to the new report. 

• When formatting an existing report. 

When you apply a template you can choose to apply the template styles only, 
or to apply the styles and the structure.

If you choose to apply the styles and the structure, you can also manually replace 
certain variables in the template with certain variables from the report.

Note: Universe Designers can apply formats (Alignment, Font, Border, Shading) 
to objects when creating universes. These formats are used even if you use a 
template with different formats. If you are designing templates, we recommend 
you talk to the person designing universes in the company to make sure you are 
using the same formats.

Creating a template
Set up the report you want to use as a template with all the required formatting, 
margin settings etc.

1. Make sure the report that you want to use as a template is active.

2. Choose Save As from the File menu.
The Save Document As dialog box appears.

3. Click the Save as type box, then click BusinessObjects Templates (*.ret).

4. Select the folder in which you want to save the template.
If you want the template to be available in the New Report Wizard, you must 
save it in the Template folder in the BUSINESSOBJECTS folder.

5. Type the name of the template in the File Name box, then click OK.
Templates are saved as .ret files.
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Changing the default template folder
To set a default folder other than Template in which to save your templates

1. From the Tools menu choose Options. 

2. Click on the File Location tab.

3. Click User Templates.

4. Click the Browse button to select the folder you want to use.
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Applying a Template
You can quickly format an existing report by applying a template.

1. Display the report you want to format.

2. From the Format menu, choose Report then Apply Template.
The Apply a Template dialog box appears:

3. Select a template from the Available Templates list.

Note: If the template you want to use is located in a folder other than the one set 
in the File Locations tab on the Options dialog box, click Browse. A dialog box 
appears, and enables you to select the folder where the template is located.

4. The next step depends on what you want to do:

If you want to... Click... Then...

Apply the template styles and 
structure to the report

OK. BUSINESSOBJECTS 
applies the template to 
the report.

Choose what to apply from the 
template to the report

Options. The Template Options 
dialog box opens.
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5. In the Template Options dialog box, click Apply Only the Style if you want to 
apply the page background and header/footer contained in the template. 
Only the options in the Page Options section are now available:

6. If you do not want to apply the background or header/footer, deselect Apply 
Template Background and Apply Template Header and Footer, respectively. 

7. Click Apply Structure and Style if you want to apply the template's style and its 
structure (blocks, sections) to the report.
This option:
• Activates the options in the Structure box.
• Enables you to replace variables in the template with variables from the 

report. For information on how to do this, refer to “Replacing variables in 
a template with variables from a report” on page 619.

8. Click OK, then click Apply or OK in the Apply a Template dialog box.

Note: You cannot apply templates created using BUSINESSOBJECTS 4.1 to reports 
created using BUSINESSOBJECTS 5.x and vice versa.
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Replacing variables in a template with variables from a report
When you apply a template, by default BUSINESSOBJECTS chooses how to place the 
variables in the report into the template structure.

You can also choose manually how you want to map variables in the report to 
variables in the template structure. To do so:

1. From an open a report, choose Apply Template from the Format menu.
The Apply a Template dialog box appears.

2. Click the Options
The Template Options dialog box appears.

3. Click Apply Structure and Style.
The options in the Structure box are now active. 

4. Uncheck Replace Variables Automatically, then click Define.
The Replace Variables dialog box appears.

5. In the Report Variables box, click the report variable you want to map to the 
template variable.

6. In the Template Variables box, click the template variable to be replaced by the 
report variable, then click Replace.
The variable from the report appears in the Template Variables box:

Here, the user has 
replaced Customer with 
Region.
Region will appear in the 
report where Customer 
appears in the template.
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7. Repeat step 6 to replace other variables, then click OK.
To undo a replacement, click the variable in the Template Variables box, then 
click Remove.

8. In the Template Options dialog box, click OK.
You return to the Apply a Template dialog box.

9. Click Apply or OK.
BUSINESSOBJECTS applies the template to the report.
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Overview

BUSINESSOBJECTS is open to working with data from and in other applications. 
This means that you can bring in data and pictures from other Windows 
applications, and display these in BUSINESSOBJECTS reports. You can also transfer 
data from BUSINESSOBJECTS reports to other applications, such as Microsoft Excel.

BUSINESSOBJECTS supports Microsoft Object Linking and Embedding version 2 
(OLE 2). This feature creates objects from files that come from other applications 
that also support OLE 2. An OLE 2 object can be a word processing file, a 
spreadsheet, a picture, and so on. 

You can embed an OLE 2 object in a BUSINESSOBJECTS report, which means that the 
object physically resides in the report. You can also link OLE 2 objects, which 
means that the data or picture remains in its native application and is displayed 
in BUSINESSOBJECTS thanks to a dynamic link. Finally, you can link or embed 
BUSINESSOBJECTS reports in other applications that support OLE 2.

BUSINESSOBJECTS also supports the Microsoft Dynamic Data Exchange (DDE) 
feature. This feature enables you to use data from BUSINESSOBJECTS reports in 
other applications. DDE ensures that the data in the remote application is 
dynamically updated when the data in the host application, i.e., 
BUSINESSOBJECTS, changes.

Note: You can also exchange data from BUSINESSOBJECTS with other applications 
by exporting data to different file formats. For example, you can export the results 
of a query to dBASE or Microsoft Excel format. To find out about exporting data 
to different file formats see Chapter 8 "Exporting Data From BusinessObjects" on 
page 175.
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Using Data and Pictures from Other Applications

You can use data and pictures from other applications in BUSINESSOBJECTS. The 
data and pictures you can use are objects that you or other users created in remote 
applications. For example, a Microsoft Word document is an object that you can 
insert in a BUSINESSOBJECTS report.

Inserting Data and Pictures from Other Applications
Object Linking and Embedding (OLE 2), developed by Microsoft Corporation, 
enables you to share data and pictures between Windows applications. 
BUSINESSOBJECTS supports OLE 2, which means that you can insert OLE 2 objects 
inside BUSINESSOBJECTS reports, and use BUSINESSOBJECTS reports as OLE 2 
objects in other applications.

When you link or embed an object in a BUSINESSOBJECTS report, you display an 
object from a remote application. The differences between linking and 
embedding are as follows:

• When you create a link, the object does not physically reside in the 
BUSINESSOBJECTS report. It is represented there, but, thanks to the link, it 
remains in its native application. The link between the object’s native 
application and BUSINESSOBJECTS updates the object’s representation in the 
BUSINESSOBJECTS report. For example, if you insert a picture with a link, then 
modify the picture in its native application, you also modify the picture in 
BUSINESSOBJECTS.

• When you embed an object, it physically resides in BUSINESSOBJECTS. 

You insert objects in reports by using the Object command on the Insert menu. 
When you select this command, the Insert Object dialog box appears. This dialog 
box enables you to:

• Select the file that corresponds to the object that you want to insert.

• Start a remote application, for example Microsoft Word, in which you can 
create an object to insert.

The following sections describe these ways of inserting objects.

To insert an object in a report, you must first select a cell. If you do not select a 
cell, BUSINESSOBJECTS prompts you to insert a cell in the active section and 
displays the object in the cell.



Chapter 26 Including Graphics and Other Data Objects

624   BusinessObjects User’s Guide

To create a new object to insert

1. Click the cell where you want the object to appear, then select the Object 
command from the Insert menu.

2. In the Insert Object dialog box that appears, click the Create New option 
button. 

3. Click the type of object you want to create from the Object type list, as shown:

4. Click OK.
Depending on the type of object you want to create, one of two things now 
occurs:
• If the application you use to create the object supports OLE 2, the 

application now appears in the cell you selected. The application’s name 
replaces BUSINESSOBJECTS in the title bar, and the application’s menus 
appear.

• If the application does not support OLE 2, it opens on top of the 
BUSINESSOBJECTS window. 

5. Create the object in the remote application.

6. To return to BUSINESSOBJECTS:
• If the remote application supports OLE 2, you simply have to click outside 

it.
• If the application does not support OLE 2, select the Exit command.
The object appears in the cell you selected.

Click Display Icon to 
display the object as an 
icon in the report. You 
open the object by 
double-clicking its icon.

Information on the object 
type you select appears 
here.
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To insert an existing object

1. Select the cell where you want the object to appear, then select the Object 
command from the Insert menu.

2. In the Insert Object dialog box that appears, click the Create from File option 
button.

3. To locate the file (object) you want to insert, type a path in the File text box, or 
click Browse to select the file.

4. Click Link if you want to link the object. If you do not click Link, you embed 
the object in the report.

5. Click OK to close the dialog box.
The object appears in the cell you selected.

Notes: If you do not select a cell before selecting the Object command on the Insert 
menu, BUSINESSOBJECTS invites you to create a new cell in which the object will 
appear.

You should avoid saving reports that contain OLE 2 objects as PDF documents as 
you may encounter problems viewing the OLE 2 objects.

If you encounter problems viewing OLE 2 objects in reports that have been 
shared, this may be because they have been shared via Enterprise Server products 
installed on UNIX. You should contact your WEBINTELLIGENCE or BROADCAST 
AGENT administrator.
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To insert a logo or other image in a report and save the report as a PDF document 
or share it via Enterprise Server products installed on UNIX, you should save the 
image as a bitmap (.bmp). You can do this in Microsoft Paint or a similar 
application.

Editing Inserted OLE 2 Objects
Once you have inserted an object in a BUSINESSOBJECTS report, you can edit the 
object. You can:

• Edit the object itself by calling the application in which it was created. You can 
then work on the object’s file, then save it. The new version of the object is 
displayed in BUSINESSOBJECTS.

• Edit the link between BUSINESSOBJECTS and the object’s source file. This is the 
case for objects that you insert with a link, rather than objects that you embed.

You must edit the link if, for example, the object’s file is moved to a different 
location. If you do not, the link is lost and the object is no longer displayed in 
the report.

 These two ways of editing objects are described in the following section.

Editing an inserted object
OLE 2 enables you to edit an object “in place”. This means that you can edit the 
object without leaving BUSINESSOBJECTS. This feature is only available if the 
application in which the object was created supports OLE 2.

If in-place editing is not available, you can open the object in its native 
application. You can then edit the object, save its file, and return to 
BUSINESSOBJECTS, where the edited object is displayed.

To edit an object in place

When you edit an object in place, the commands and toolbars you need to edit the 
object appear in BUSINESSOBJECTS. The application name in the title bar changes 
from BUSINESSOBJECTS to the name of the remote application.

To edit an object in place, you can:

• Double-click the object in the report.

• Click the object, then select the Object>Edit command from the Edit menu or 
the Edit Object command from the popup menu.

A hatched border appears around the object. When you have finished editing the 
object, click anywhere outside the object’s borders to return to the 
BUSINESSOBJECTS interface, and save the active document.
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To edit an object in its native application

If the object’s application does not support in-place editing, you must open the 
application when you want to edit the object. To do so:

• Double-click the object.

• Click the object, then select the Object>Open command from the Edit menu, 
or the Open Object command from the popup menu.

The object appears in its native application. To return to BUSINESSOBJECTS when 
you have finished editing the object, save the file and exit the application. The 
edited object appears in the report.
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Using Pictures in Reports

You can display pictures in BUSINESSOBJECTS reports. You can display a picture 
in a cell, or use a picture as a page background on every page of the report.

The pictures that you use can be static files, or they can be objects enabled by OLE 
2 (Object Linking and Embedding).

Inserting a Picture in a Cell
This section describes how to insert static pictures in report cells. Examples of 
inserting static pictures in cells include using a logo in a title cell at the top of a 
report, or a picture of a product that features in a report.

To insert a static picture in a cell:

1. If you want to insert the picture in a new cell, click in a blank part of the report. 
Select the Picture command on the Insert menu, then click in a blank part of 
the report once again. Hold down your mouse button, then drag the mouse to 
draw the cell in which the picture will appear. 
If you want to insert the picture in an existing cell, click inside it, then select 
the Picture command on the Insert menu.
The Open dialog box appears.

2. Select the picture’s file, then click Open.
The picture appears in the cell.

You can also insert a picture by double-clicking inside a cell and typing the 
picture’s path and file name (e.g., c:\pictures\picture.bmp). Then, click 
inside the cell and select the Cell command on the Format menu. In the 
Number tab of the Cell Format dialog box, select the Image category and 
Bitmap or TIFF format. When you click OK or Apply, the picture appears in 
the cell.
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Overview

This appendix explains how to run BUSINESSOBJECTS by using the Run command 
on Windows. You can use the Run command as an alternative way of double-
clicking the BUSINESSOBJECTS icon. You can also specify command line options 
such as your user name, password and other options.

Using the Run Command

The following procedure describes how to launch BUSINESSOBJECTS by using the 
Run command. The options you can include in the Run command are listed and 
explained in “Run Command Options” below.

1. Click the Start button, then click the Run command. 
The Run dialog box appears.

2. In the Open text box, enter the path to the BUSINESSOBJECTS executable file 
(Busobj.exe). By default, this file is located in the BusinessObjects folder. You 
can click Browse to specify the path, rather than type it.

3. Click OK. 
The User Identification dialog box appears.

4. Enter the user name and password that your BUSINESSOBJECTS supervisor 
provided, then click OK. 
The BUSINESSOBJECTS application is now launched.
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Run Command Options
You can use Run command options to log in to BUSINESSOBJECTS with your user 
name and password. The table below describes the options that you can use.

Tip: In the file you declare after the -vars option, you can also specify the variables 
such as DBUSER, DBPASSWORD and DBDSN. (The names of such variables 
depend on the database at your site). These variables can be used to define a 
restriction on an object, for example. For further information on these variables, 
refer to “BUSINESSOBJECTS Variables” in the Database Guide included in your 
BUSINESSOBJECTS package.

Option Description

-user [user 
name]

The user name assigned to you by your supervisor. User 
names that include spaces must be written in double quotes, 
e.g., “user name”.

-pass 
[password]

The password assigned to you by your supervisor. This 
option is mandatory if you enter the -user option. Passwords 
that include spaces must be written in double quotes, e.g., 
“my password”.

-online or  
-offline

By default, the last connection mode of the specified user, or 
“online” the first time you launch BUSINESSOBJECTS. 
Offline mode disconnects you from the repository and 
therefore disables remote connections during your work 
session.

repname.rep The name of the document that you wish to work with on 
launching BUSINESSOBJECTS. You must include the path to 
this file, for example: 
c:\BusinessObjects\userdocs\sales.rep

-keyfile [keyfile 
name]

If you are working with multiple repositories, specifies the 
repository you want to work with.

-nologo Runs BUSINESSOBJECTS without showing the logo screen.

-vars myfile.txt Name of a text file in which variables are specified. You can 
specify BOUSER and BOPASS, which manage your access to 
BUSINESSOBJECTS. You can also declare your own variables in 
the file. For more information on these variables, refer to 
“Specifying BOUSER, BOPASS and Other Variables” below.
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Specifying BOUSER, BOPASS and Other Variables
You can use the BOUSER and BOPASS variables to manage your access to 
BUSINESSOBJECTS. You can specify the values of these variables in the Run 
command, or in a file that you call from the Run command. Other variables can 
be declared in this file.

BOUSER and BOPASS
When the BUSINESSOBJECTS supervisor creates users, he or she assigns each one a 
user name and password. The user’s name and password are stored on the 
repository. When you log in to BUSINESSOBJECTS in online mode, which is the 
default working mode, BUSINESSOBJECTS connects to the repository and reads 
your security information. Your user name and password are then written to 
either the objects.lsi file or the objects.ssi file, located in either the ShData folder 
or the LocData folder.

Once you have launched BUSINESSOBJECTS in online mode, you can use the 
BOUSER and BOPASS variables in the Run command. You can:

• Declare the value of the variables after -user and -pass. 
For example, if your supervisor assigned you the user name JOHN and the 
password SMITH, you can write the following command:

c:\BusinessObjects\Busobj.exe -user JOHN -pass SMITH

• Declare the variables and their values in a text file in the BusinessObjects 
folder. Then, in the Run command, you specify the file name after the -vars 
option. 
For example, if your supervisor assigned you the user name JOHN and the 
password SMITH, you create a .txt file (myfile.txt) in which you specify: 
BOUSER=JOHN 
BOPASS=SMITH 
You can now use the following Run command:

c:\BusinessObjects\Busobj.exe -vars myfile.txt

Note: User names and passwords that contain spaces must be written in double 
quotes, e.g., “user name”. You must use upper-case characters when specifying 
the variables that manage security, as in the example above.
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Other variables you can specify in a file
In the .txt file that you declare after the -vars option, you can specify other 
variables that you work with in BUSINESSOBJECTS. For example, if you have 
created a variable that displays a prompt when a query is run, you can specify 
this variable’s value in the .txt file. The syntax is as follows: 
VARIABLENAME=VALUE

Specifying prompt values in a file
When you open a report from the command line and specify the value of a 
prompt, BUSINESSOBJECTS  treats the prompt as a global variable. If you then close 
the report, re-open it from the user interface and refresh it, the Values button on 
the prompt dialog box is grayed out. This is because BUSINESSOBJECTS still treats 
the prompt as a global variable, but is no longer able to locate its value(s) because 
the report was not opened from the command line.

To enable the Values button again, rename the prompt. BUSINESSOBJECTS now 
treats the prompt as a local variable and is able to associate a list of values with it.
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Overview

You can customize BUSINESSOBJECTS 5.x using the Microsoft Visual Basic for 
Applications programming language. BUSINESSOBJECTS 5.x has a Visual Basic 
Editor that you can use to develop macros, add-ins and VBA data providers. The 
Visual Basic Editor is the standard Microsoft VBA editor that you may already be 
familiar with if you use Microsoft Office products. 

This chapter describes how to use macros and add-ins in BUSINESSOBJECTS. For 
information on building VBA data providers, see “Using Visual Basic for 
Applications Procedures” on page 142.

What is a macro?
A macro is a series of commands and functions that are stored in a Visual Basic 
for Applications module and can be run whenever you need to perform the task. 
If you perform a task repeatedly, you can automate the task with a macro.You 
create macros using the Visual Basic Editor.

What is an add-in?
Add-ins are programs that add optional commands and features to 
BUSINESSOBJECTS. Add-ins are usually created by those responsible in your 
company for adding customized features to BUSINESSOBJECTS. All you probably 
need to do is install and uninstall add-ins that are sent to you.

Before you can use an add-in, you must install it on your computer and then load 
it in BUSINESSOBJECTS. Add-ins (*.rea files) are installed by default in the 
UserDocs folder in the BUSINESSOBJECTS folder. Loading an add-in makes the 
feature available in BUSINESSOBJECTS and adds any associated commands to the 
appropriate menus.

Unloading an add-in removes its features and commands from BUSINESSOBJECTS, 
but the add-in program remains on your computer so you can easily load it again.

You can use your own Visual Basic for Applications programs as custom add-ins. 
For information about making a Visual Basic for Applications program an add-
in, see the BUSINESSOBJECTS SDK Reference Guide.
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Using Macros

Macros are created and stored inside BUSINESSOBJECTS documents (.rep files) or 
BUSINESSOBJECTS add-ins (.rea files). You can run macros either from the Macros 
dialog box or from the Visual Basic toolbar if macros have been assigned to the 
macro buttons.

Running a macro

1. From the Tools menu, choose Macro and then Macros or click the Macros 
button on the Visual Basic toolbar.
The Macros dialog box opens.

2. From the Macros in: list box, choose the documents where the macros are 
stored. You can display the macros available in the active document, all 
macros in all open documents, macros in a selected open document or macros 
in add-ins.

The macros stored in the selected document(s) are displayed in the Macro 
Name list.

3. Select the name of the macro you want to use and click Run. 
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Using the Visual Basic toolbar
To open the Visual Basic toolbar:

• Right-click on any other open toolbar and choose Visual Basic from the menu.

Associating a macro to a toolbar button

1. From the Tools menu, choose Options.
The Options dialog box opens.

2. Click the Macro tab.

3. Click check box 1 to activate the first button on the Visual Basic toolbar.

a b c 

a. Opens the macros dialog box

b. Opens the Visual Basic Editor

c. Buttons 1-5 run the macros that have been assigned 
to them
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4. Click the button to the right of the Macro Name box.
The Macros dialog box opens.

5. Click on the macro you want to use from the list and click the Select button.
The name the macro is displayed in the Macro Name box.

6. In the Tooltip box, type the tooltip that you want to use for the macro.
The tooltip appears when you rest the cursor over the button on the Visual 
Basic toolbar.
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Using Add-Ins

BUSINESSOBJECTS add-ins are Visual Basic for Applications programs that add 
optional commands and features to BUSINESSOBJECTS. You can distribute add-ins 
you have created to other users and retrieve and use add-ins that others have 
created.

Installing an add-in

1. From the Tools menu, choose Add-Ins.
The Add-Ins dialog box opens.

2. Click the Browse button to locate and open the add-ins on your computer.
The Add-Ins Available box displays the list of available add-ins. There are two 
types of add-ins that you may see in this dialog box: those that are available 
and those that have been installed. You cannot use an add-in until it has been 
installed.

3. Click the check box next to the name of the add-in and click OK.
The add-in is installed and can now be used.

Note: When a user installs an add-in, it is only installed for that user. If that user 
logs on under a different name, the add-in will not be available.

The check mark shows 
that this add-in has been 
installed

No check mark shows that 
this add-in is on the 
computer but not 
installed



 Using Add-Ins

  BusinessObjects User’s Guide   643

Using an add-in
You can run an installed add-in from the Macros dialog box, or you can associate 
it with a button on the Visual Basic toolbar.

Uninstalling an add-in

1. Click the check box next to the add-in name in the Add-Ins dialog box to 
remove the check mark

2. Click OK.
The add-in features and commands are removed from BUSINESSOBJECTS, but 
the add-in program remains on your computer so you can easily load it again 
if you want to use it.

Exchanging add-ins with other users
You can send and retrieve add-ins (.rea files) in the same way you can send and 
retrieve BUSINESSOBJECTS documents.
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Using the Visual Basic Editor

You can open the Visual Basic Editor directly from BUSINESSOBJECTS to create 
macros and programs to use in BUSINESSOBJECTS. This development environment 
has its own set of online Help files.

Running Visual Basic Editor
To open the Visual Basic Editor:

• Click the Visual Basic Editor button on the Visual Basic toolbar.

The Visual Basic development environment opens up. 

Programming in Visual Basic requires knowledge of the programming 
environment and this is covered in the BUSINESSOBJECTS SDK Reference Guide.

Visual Basic Editor
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#######  390
#ALERTER  390
#COMPUTATION  343, 376–379

cumulative aggregations  377–
379
examples  378, 380
in break footer  378, 380
non-aggregate formulas  380
solution for reset contexts  379

#DICT.ERROR  391
#DIV/0  392
#EMPTY  577
#ERROR  393
#IERR  395–397

in complex aggregate formulas  
396
in formulas combining 
measures and dimensions  395
in formulas using WHERE  397

#MULTIVALUE  382–390
aggregations  382–384
applying a sort  401
examples  383, 385, 387
in break headers and footers  
385
in sections  387

#OVERFLOW  398
#SYNTAX  398, 399
#UNKNOWN  399
& operator  336
.bqy file extension  219
.html file extension  216
.pdf file extension  217
.rea file extension  638
.rep file extension  215
.rtf file extension  216
.txt file extension  216
@prompt  133, 134
@variable  134
2000

year  180, 193
2-D charts

building 3-D charts from  515
formatting line charts  429

using Z-axis  414
3-D charts

building from 2-D charts  515
formatting the 3-D view  433
formatting walls and floor  432
moving data between X-, Z-
axis  517
using Z-axis  415, 432

3-D matrix charts
working with in slice-and-dice 
mode  513–517

3-D view
formatting  433

A
accelerator keys  190
across edge

of crosstab  225, 539
sorts  271

Across tab
breaks  290

adding
breaks  289
columns to tables, crosstabs  
239
filters  261
rows to crosstabs  239
sorts  272

add-ins  638
installing  642
running  643
uninstalling  643

Adjust Scale to Value Range
option  439

ADO  142
aggregate

functions  332
aggregation, defined  369
alerters  279

#ALERTER  390
and custom sorts  269
copying  283
creating  279

deleting  284
hiding and displaying  283
switching on and off  282

aligning
axis labels  437
blocks  563
cell contents  552
cells  563

analyzing data
BUSINESSMINER  460
defining scope of analysis  67
dimension objects  67
drilling across  471
drilling down  469–476
drilling through to database  
486
drilling up  471
hierarchies  67
in drill mode  465
in slice-and-dice mode  500–
522
preparing for drill mode  468
Slice and Dice Panel, 
illustrated  501
switching to drill mode  468
switching to slice-and-dice 
mode  500

and
operator on query panel  107, 
108

Apply Standard Style
command  612

applying
predefined conditions  70
ranking  274
simple query conditions  72
sorts in reports  267
sorts on query objects  73
standard report styles  612
value-based breaks  295

area charts
formatting  429

argument
VBA  144
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ascending sorts
on data  266
on query objects  73

AutoFormats, for charts  412
automation

object, VBA  142
autoscale

setting on 3-D charts  433
average

rolling, calculating  335
Avoid Duplicate Rows Aggregation

table option  538
axes

formatting  435–437
formatting numbers on  436
hiding  446

axis labels
applying line styles  437
applying text formats  437
applying tick marks  437
changing orientation  437
defining scale  437
formatting  435–437
illustrated  435

B
back wall

on 3-D chart, formatting  432
background

color, setting  425
shading, making transparent  
425

between
operator on query panel  96

blank reports
creating  198

block
chart, formatting  423
chart, resizing  425

blocks
aligning  563
deleting  519
formatting  526
formatting borders  531
moving  565
moving between sections  565
positioning  561
renaming  519
resetting  519
setting conditions to hide  571

body  540

and input contexts  347
defined  371
dimensions in  348
in crosstabs  225
selecting crosstab body  541
selecting table body  540

BOPASS  634
borders

applying to chart walls  432
borders toolbar  555
formatting cell borders  555
formatting chart borders  423
formatting crosstab borders  
531
formatting section borders  531
formatting table borders  531

both
operator on query panel  96

BOUSER  634
breaks  297

#COMPUTATION in footer  
378, 380
#MULTIVALUE in header or 
footer  385
adding  289
and Rank() function  361
applying in slice-and-dice 
mode  522
applying on different variable  
290
applying on more than one 
variable  290
Breaks dialog box, illustrated  
290
center across break  553
changing break level  290
custom  295
defined  288
editing  289, 290
folding  292
inserting  290
managing over multiple pages  
297
on Across tab  290
on Down tab  290
opening Breaks dialog box  289
page  584
removing  289, 290
setting standard report style  
609

showing headers and footers  
290
value-based breaks  290, 295

BUSINESSMINER  460
BusinessObjects

and zero administration  32
demo database, universe, 
reports  30
installing via CD  38
installing via Internet browser  
38
starting from InfoView  185
what does it do  26
what’s new  31
zero admin  32

BUSINESSOBJECTS

demo database, universe, 
reports  57

BusinessObjects 3.1
upgrading  31

BusinessObjects 4.1
upgrading  31
viewing documents  31, 192

BusinessObjects documentation  
xvi–xxi

BusinessMiner Tutorial  xviii
documentation service on the 
web  xvi
Error Message Guide  xx
guides in PDF  xix
multimedia presentations  xvii
obtaining more information  
xxi
online help  xxi
Quick Tour  xvii, xviii

BusinessQuery
documents, saving in 
BusinessObjects  219
saving documents in 
BusinessQuery format  218

C
calculations

applying in slice-and-dice 
mode  521
count  298
count all  298
deleting from tables, crosstabs  
300
dragging-and-dropping  304
on query panel  98
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rolling average  335
toolbar  300
using functions in  332
using in query conditions  100
using on charts  456
variance  298
writing formulas  316

categories
assigning to documents  206
creating  206
defined  202
using to find documents  203

CD
installing BusinessObjects 
from  38

cells
adding hyperlinks to  549
aligning  563
aligning contents  552
combining data in  336
copying formatting only  542
editing free-standing  244
formatting  557
formatting backgrounds  557
formatting borders  555
free-standing  242
hiding  569
indenting content  553
inserting  239, 242
inserting pictures  628
master  246
merging  553
moving  565
positioning  561
repeat on every page  583
resizing  535
selecting  238
setting conditions to hide  571
setting standard report styles  
611
start on new page  583
wrapping contents  554

character
functions  332

chart legend key
formatting  444

charts
adjust scale to value range  439
autoformatting  410
avoiding page breaks in  423
axis labels  435

changing data labels  445
creating  409
creating from tables  410
data series  429
deleting  455
displaying a legend  442
displaying data labels  445
displaying gridlines  446
displaying tables, crosstabs as  
519
displaying tick marks  437
displaying title  441
drilling on  474
floor  432
formatting  421
formatting 3-D view  433
formatting axes  435–437
formatting axis labels  435–437
formatting axis styles  437
formatting chart block  423
formatting data labels  445
hiding  569
hiding axes  446
inserting data labels  444
making calculations  456
matrix  413
plot area  423
positioning  561
removing data labels  445
reorganizing data on axes  413
repeat on every page  423
repeat on new page  583
resizing  425
selecting chart elements  422
selecting to resize  425
setting chart type  449
switching between chart types  
412
tick marks  435
turning to tables, crosstabs  
411, 519
types, illustrated  407
using groups  448
using Insert Chart Wizard  409
using preset formats  412
walls  429
what elements make a chart  
421
X-axis  435
XY scatter  429
Y-axis  435

Z-axis  432
classes

defined  27, 56
introduction  58
opening in Query Panel  64
sub-classes  64

clearing
master cells in master/detail 
reports  254

client/server
connection  186

collapsing
measures  483

colors
applying to cell backgrounds  
557
applying to cell borders  555
applying to charts  429

column charts
displaying negative values  
430
formatting columns  429
setting column overlap  430
setting gap between columns  
430

columns
adding to tables, crosstabs  239
hiding  278
inserting  239, 242
naming  239
resizing  240, 535
selecting  238
selecting in tables and 
crosstabs  237
table and crosstab, copying  
229
table and crosstab, deleting  
231
table and crosstab, swapping  
227

combined
queries  79, 111
queries, maximum number of  
114
queries, restrictions on  114

command
run line options  633

complex
filters  263
query conditions  93, 95
query conditions, editing  100
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COMPUTE
statement  123, 130

Concatenation()
function  336

conditional
formatting  569

conditions
multiple  79
using to hide report 
components  571

conditions on queries  70–73
applying calculations  101
applying predefined 
conditions  70
applying simple conditions  72
applying with a subquery  104
complex  93, 95
complex, deleting  100
complex, editing  100
complex, tips  98
defined  70
deleting  73, 110
predefined  93
selecting different values for 
simple conditions  72
simple  93
using a subquery  103
using groups of  107
using lists of values  72

connection
client/server  186
creating for free-hand SQL  131
to databases  41
web  186

contexts
defined  371
different contexts in a report  
348
input  346, 352
output  346, 352
reset  377

context-sensitive
menus  190

conversion rates
viewing for euros  308

converting
to and from euros  306

Copy All command (Edit menu)  
177
copying

alerters  283

and pasting data from 
BUSINESSOBJECTS  176
and pasting data to an Office 
application  176
cell formatting  229
tables and crosstabs  240

count
calculation  298

count all
calculation  298

creating
alerters  279
blank reports  198
personal categories  206
queries  60–75
reports  198

crosstabs
across edge  225
across edge display  539
adding cells, columns, rows to  
239
and rank function  363
and reset contexts  357
body, illustrated  225
building from tables  515
building using drag and drop  
232
copying  240
deleting  240
deleting calculations from  300
dialog box for pivoting data  
278
displaying charts as  411, 519
down edge  225
down edge display  539
editing  236
formatting corners  533
hiding  569
illustrated  225
insert wizard  234
inserting  232
moving data between columns, 
rows  517
positioning  561
repeat on every page  583
selecting  237
setting standard report style  
608
showing additional header 
information  539

showing headers and footers  
536
start on new page  583
turning to charts  519
working with in slice-and-dice 
mode  513–517

cumulative aggregations  377–379
defined  369, 377
example of #COMPUTATION  
378
example with reset context  
355
solution for #COMPUTATION  
379

currency
default format and regional 
settings  193
editing conversion rates  309
euro  305
formatting numbers as  306
ISO labels  308
style  545

Current
date and time command  592

CurrentPage
keyword  365

custom
breaks  295
hierarchies  489
sorts  266

customizing
block background shading  
425
breaks on data  295
sorts in reports  266
SQL scripts  133
standard report styles  606

D
DAO  142
data

accessing using VBA  142
adding to tables  230
combining in cells  336
DDE  see dynamic data 
exchange
dragging and dropping  233
from different sources in 
different blocks  152
from different sources in same 
block  154
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hiding  278
highlighting  279
incompatible types  338
limiting amount retrieved  107
linking from different sources  
152
making calculations in reports  
298
moving from axis to axis on 
charts  416
pivoting on charts  413
qualifying for drill mode  493
removing from chart display  
417

data labels
changing  445
deleting  445
displaying on chart  445
formatting  444, 445
on chart, illustrated  444

data provider
functions  332

data providers
building queries  60–75
cancelling  52
deleting  171
deleting link  163
editing  51
examples of names  167
explained  27
free-hand SQL  128
free-hand SQL, defined  39, 42
getting statistics on  170
linked and compatibility rules  
155
linking  158, 161
linking data from different 
sources  152
linking dimensions  159
new  51
OLAP server, defined  40, 42
personal data files, defined  
39, 42
purging  171
queries, defined  39, 42
renaming  167
stored procedures  123
stored procedures, defined  
39, 42
types of  38
updating  209

VBA  142
VBA procedures, defined  40
why rename  167

data series
defined  429
formatting on charts  429

data sources
accessing  151
and data providers  151
combining  152
linking  152
supported  151
synchronizing  152

Data tab
Report Manager  194

database
connections  41
drilling through to  486
multidimensional  38
relational  38

dates
applying formats to cell 
contents  545
combining with text in cells  
338
custom formats  547
deleting formats  548
FormatDate() function  338
formatting  545, 548
functions  332
inserting in reports  592

days
sorting  268
sorting chronologically  266

dBASE  139
files, accessing data from  141

DBDSN  633
DBPASSWORD  633
DBUSER  633
DDE  180
DDE  see dynamic data exchange
decimal

scale on charts  438
default

file extension for documents  
215
file locations  207
scope of analysis  68
universe, setting  48

default.ret
file, about  603

file, distributing  613
file, location  613

Define As Variable
command  324, 350

defining input and output contexts  
353
defining reset contexts  356
defining sort priority in queries  74
deleting

alerters  284
blocks  519
calculations from tables, 
crosstabs  300
categories  207
charts  455
complex query conditions  100
data from charts  417
data providers  171
link between data providers  
163
master/detail cells and 
sections  252
number and date formats  548
query conditions  73
query condtions  110
reports  199
subquery  106
table and crosstab columns  
231
table and crosstab rows  231
tables and crosstabs  240
variables and formulas  331

delimiters
and personal data files  140
displaying  564
displaying margin  564
displaying section  564
in lists of values  89
section  251

demo database, universe, reports  
30, 57
demo kit

eFashion  30
depth

setting on 3-D charts  433
descending sorts

on data  266
on query objects  73

Designer
BusinessObjects  27, 56

detail objects  59



Index

650   BusinessObjects User’s Guide

Developer Suite  xvi
different from

operator on query panel  95
operator, tips for using  99

different from pattern
operator on query panel  96

dimension objects  59, 67
dimensions  344

defined  369
hiding  400
linking data providers  159

display
across edge  539
down edge  539
setting workspace size  191

displaying
alerters  283
chart title  441
data in reports using slice-and-
dice mode  518
data labels on charts  445
gridlines on charts  446
page numbers in reports  592
Report Manager  194
reports inside documents  199
section header and footer  529
toolbars  189, 247

document
functions  332

documentation see BusinessObjects 
documentation
documents  185

.rea file extension  638

.rep file extension  215

.rtf file extension  216

.txt file extension  216
demonstration samples  30
refreshing  209
saving  215
saving as BusinessQuery files  
218
saving as PDF files  217
saving as text files  216
saving for all users  215
saving in html format  216
saving in rich text format  216

documents, defined  369
down edge

of crosstab  225, 539
sorts  271

Down tab

breaks  290
DpVBAInterface  142
drag-and-drop

moving blocks  565
moving cells  565
moving cells, columns, rows  
233

drill
filters, inserting as title  496
toolbar  470, 479

drill by
command  471

Drill Filters  595
drill mode

bringing in new data  485, 486
custom hierarchies  489
drill button  468
drill by  472
drill through  486
drilling across  471
drilling down  469–476
drilling on multiple hierarchies  
475
drilling up  471
explained  465
inserting and replacing data  
477
preparing for  468
printing from  496
qualifying data for  493
setting options for  497
setting up hierarchies for  121
snapshot  484
switching to  468
undoing actions  471
using drill filters as query 
conditions  487
working on charts  474

drill through
command  486
turning on use filters option  
487

drop lines
showing on line charts  431

duplicate
rows, showing  538

dynamic
filters  263
groups, creating for analysis  
325

Dynamic Data Exchange see DDE

E
editing  328

blocks  236
breaks  289, 290
data providers  51
euro conversion information  
309
filters  260
free-standing cells  244
hierarchies  489
OLE 2 objects  626
page backgrounds  579
ranking  276
SQL scripts  130

eFashion  59
demo kit  30
demo materials  30

elevation
setting on 3-D charts  433

eliminating duplicate rows returned 
by query  74
email

addresses, adding links from 
reports  549
data, accessing using VBA  144

equal to
operator on query panel  95

error
in euro conversion  306
in formula syntax  320
messages, see also Error 
Message Guide

Error Message Guide  xx
euro

conversion errors  306
conversion rates  308
converting from  307
converting to  306
displaying currency symbol  
305
editing conversion information  
309
triangulation  309

even
pages, setting up layout  574

Even()
function  574

examples
#COMPUTATION  378, 380
#IERR  396
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#MULTIVALUE  383, 385, 387
aggregate formula with 
extended syntax  349
aggregation with input and 
output contexts defined  353
aggregation with input context 
defined  352
aggregation with output 
context  351
calculating minimum revenue 
per city for each region  352
calculating number of cities per 
region  351
calculating total revenue  345
calculation contexts  347
cumulative aggregation with 
reset contexts  355
extended syntax  349
ForAll  359
ForEach  359
keywords  367
Report (keyword)  365
running total revenue per 
country  355
semantically dynamic 
calculations  344

except
operator on query panel  96
operator, tips for using  99

exceptions in data
highlighting using alerters  279

expanding
measures  482

exporting data  176
external formats  176
options  179
using copy and paste  176

extended syntax
defined  369
input and output contexts  353
input, output and reset 
contexts  358
reset contexts  356
using  349
viewing  400

F
file

default locations  207
file extensions

.bqy  219

.pdf  217

.rea  638

.rep  215

.ret  603

.rtf  216

.txt  216
html  216

file locations
default.ret file  613
templates  616

filtering
document lists  203

filters  368
adding  261
and keywords  368
and master cells  337
applying in slice-and-dice 
mode  522
block-specific  258
complex  263
displaying values in special 
field  262
dynamic  263
global  258, 484
ignoring  264
illustrated  258
inserting  259
managing  260
managing filters and ranking  
277
NoFilter() function  264, 368
removing  262
selecting different values for  
260

floor
formatting on 3-D chart  432
on 3-D chart, formatting  432

folding
breaks  292
sections  597

fonts
Windows  191

footer
applying shading to  590
break  290
inserting a cell in  590
page  589
page break  586
resizing  591
running in tables  586

showing in tables and 
crosstabs  536
table  224

ForAll operator
and Rank() function  361
defined  372
example  359

ForEach operator
and Rank() function  361
defined  372
example  359

foreground
color, setting  425

FormatDate()
function  338

FormatNumber()
function  338

formats
currency  306

formatting
alerters  279
axis labels  435–437
blocks  526
cell backgrounds  557
cells and their contents  557
cells borders  555
chart axes  435–437
chart floor  432
chart legend  442
chart legend key  444
chart plot area  427
chart walls  429
charts  421
conditional  569, 571
copying and pasting  542
copying cell  542
copying column and row  229
crosstab borders  531
crosstab corners  533
data labels  445
data series  429
data series in 2-D line charts  
429
data series in scatter charts  429
data series on 3-D charts  429
data series on area charts  429
data series on column charts  
429
data series on pie charts  429
footers  589
headers  589
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numbers  545
numbers and dates  545, 548
repeating cell formats  541
section borders  531
sections  526
table borders  531
text  543
toolbar  541

Formula Bar
using  317

Formula Editor  401
using  318
using functions  332

formulas
adding to reports  330
defined  316, 370
deleting  331
editing  330
editing in cells  401
guidelines on syntax  320
in page break headers and 
footers  588
in running headers and footers  
588
using in conditions  316
viewing all in document  401
viewing in Structure view  401

free-hand SQL  128
customizing  133
defined  39, 42
free/constrained  133, 135
lists of values  133
mono/multi  133, 135
naming data providers  167
prompts  133
syntax for prompts and lists of 
values  133

free-standing cells
hiding  569
inserting  242
setting standard report style  
611

FTP  549
Function Help  334
functions

aggregate  332
character  332
Concatenation()  336
data provider  332
date  332
document  332

Even()  574
FormatDate()  338
FormatNumber()  338
getting help on  334
IsNull()  577
logical  332
miscellaneous  332
NoFilter()  264
numeric  332
Odd()  574
Previous()  335
Rank()  333, 361
using  332
using in Formula Editor  332
Where  339

G
gap

setting on column charts  430
width, setting on 3-D charts  
434

global
filters  258, 484
filters, in special field  262

Global Filters  595
GOPHER  549
greater than

operator on query panel  95
greater than or equal to

operator on query panel  95
grid  243, 564
gridlines

displaying  446
formatting  447
illustrated  441
on charts, defined  446

grouping
values, to create variables  325

groups
on charts  448
on charts, illustrated example  
451

H
header

additional information in 
crosstabs  539
applying shading to  590
break  290
inserting a cell in  590

page  589
page break  586
resizing  591
running in tables  586
showing in tables and 
crosstabs  536
table  224

help
messages in status bar  190
on functions  334

help see BusinessObjects 
documentation
hiding

alerters  283
cells  569
chart axes  446
charts  569
crosstabs  569
data  278
data in charts  417
data labels on charts  445
dimensions  400
empty sections  577
gridlines  446
report components  569
section header and footer  529
sections  569
tables  569
toolbars  189

hierarchies  67
building from personal data 
files  140
building in stored procedures  
126
creating custom  489
drilling on multiple  475
explained  466
setting up for drill mode  121
viewing  468

high low lines
showing on line charts  431

highlighting
data  279

html
saving documents in  216

HTTP  549
hyperlinks

adding to reports  549
editing  551
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I
in list operator

defined  96
maximum number of values  
99
tips for using  99

in operator, defined  372
incompatible data type  338
incompatible variables  155
indenting

cell content  553
InfoView

starting BusinessObjects from  
185
User’s Guide  29

input contexts  346, 352
body  347
defined  371
defining  353
example of formula  353
syntax  353

inserting
breaks  290
calculations on data in charts  
456
cells  239, 242
columns  239, 242
crosstabs  232
data in tables  230
drill filters  595
filters  259
free-standing cells  242
global filters  595
page backgrounds  578
page numbers  592
pictures in cells  628
query prompt  595
rows  239, 242
special field  592
tables  226
time and date  592
tracking information  592

installing
add-ins  642

installing BusinessObjects
via an Internet browser  38

Internet
browser, installing 
BusinessObjects from  38

interrupting

data providers  52
intersect

operator, on query panel  113
inverting

sorts on query objects  73
is not null

operator on query panel  96
is null

operator on query panel  96
IsNull()

function  577
using to hide empty sections  
577

ISO
currency labels  308

K
keyboard

shortcuts  190
keywords

Block  365
Body  365
Body, example  367
CurrentPage  365
defined  372
filters  368
Report  365
Report, example  365

L
labels

changing on charts  445
Last Refresh Date command  592
layout

multi-column or multi-row  
537
odd and even pages  574
page  585
report  566

legend
displaying on chart  442
formatting  442
formatting key  444

less than
operator on query panel  96

less than or equal to
operator on query panel  96

limitations
on combined queries  114

on using stored procedures  
123
on using user objects  81

limiting number of rows returned 
by query  74
line charts

showing drop lines  431
showing high low lines  431
showing multiple lines  414
showing up-down bars  431

line styles
applying to cell borders  555
applying to chart axes  437

linking data providers  158, 161
in existing report  161
when inserting new block  159
why?  158

lists of values  79
assigning personal data to  88
customizing  87
defined  86
purging  91
refreshing  91
setting up in free-hand SQL  
133
syntax for free-hand SQL  133
using in simple query 
conditions  72
viewing  91

local contexts
and output contexts  347
defined  371
dimensions in  348

local variables
changing qualification  330
creating  322
creating by grouping  325
deleting  331
editing  328, 330
using  321

logarithmic
scale on charts  438

logical
functions  332

M
macros

assigning to toolbar buttons  
640
defined  638
running  639
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MAILTO  549
main

section  526
managing  289

breaks  289
filters  260
ranking  277
sorts in reports  270

Map tab
Report Manager  194, 567

margins
aligning blocks and cells with  
563
resizing  591
setting  589

master
cells  246

master/detail reports
building master/master/detail 
reports  249, 506
clearing master cell  254
deactivating sections  508–511
illustrated  246
moving blocks between 
sections  565
placing master in table or 
crosstab  252
re-organizing  504
scaling on charts  439
structuring existing reports as  
247, 503
undoing  252
undoing master/detail reports  
507
working with in slice-and-dice 
mode  502–511

matches pattern
operator on query panel  96

matrix charts  413
measure

objects  59
objects, analyzing in drill mode  
482
objects, collapsing  483
objects, defined  344, 370
objects, expanding  482

menus
context-sensitive  190
right-click  190

merging
cells  553

messages
in status bar  190

microcube, defined  370
Microsoft Excel 97

accessing data from  139, 141
Microsoft OLAP Server  40
Microsoft Outlook  144
million

style  545
minus

operator, on query panel  114
miscellaneous

functions  332
mode

offline  186
months

sorting  268
sorting chronologically  266

moving
blocks  565
cells, columns, rows using 
drag-and-drop  233
cells, using drag-and-drop  565

moving average see rolling average
multi-page

reports  583
multiple

conditions  79
hierarchies, drilling on  475
queries  79
sorts  270

N
names

combining first and last  336
naming

cells  568
charts  568
columns and rows  239
crosstabs  568
data providers  167
tables  568
VBA procedures  167

navigating
in reports  196

negative values
displaying on column charts  
430

New Data Provider command  51
new report wizard  45

setting default options  48

NEWS  549
NNTP  549
NoFilter()

function  264, 368
not between

operator on query panel  96
not in list

operator on query panel  96
operator, tips for using  99

numbers
applying formats to cell 
contents  545
checking regional settings  193
combining with text in cells  
338
custom formats  547
deleting formats  548
FormatNumber() function  338
formatting  545, 548
formatting on chart axes  436
inserting page  592

numeric
functions  332

O
object  27
object linking and embedding  623–
625

creating new objects to insert  
624
editing objects  626
inserting existing objects  625

objects
applying sorts on  73
changing order in query  64
defined  56
detail objects  59
dimension objects  59
including in query  64
measures  59
qualification  59
removing from query  64
viewing in Query Panel  64

odd
pages, setting up layout  574

Odd()
function  574

offline mode
using  186

OLAP
Microsoft OLAP Server  40
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OLAP server
defined  40, 42

OLE 2 see object linking and 
embedding
online help  xxi
opening

classes in Query Panel  64
documents  201
several documents together  
201

operators  372
&  336
using in Formula Editor  319

options
for drill mode  497
for running queries  74
setting file locations  207

or
operator on query panel  107, 
108

ORDER BY
statement  130

orientation
table  537
table, changing  227
text, setting for axis labels  437

outline view  597
OUTPUT

statement  123
output contexts  346, 352

and local contexts  347
defined  371
defining  353
example of formula  353
syntax  353

overlap
setting on column charts  430

P
page

layout options  585
layout, viewing  191
margins see margins
numbers, inserting  592
setup  589
totals and subtotals, displaying  
586

Page # command  592
Page # of # command  592
page backgrounds  578

editing  579

inserting  578
pasting  579
removing  579
setting standard report style  
611

page break
footer  586
footer before page break  587
header  586
header after page break  587

page breaks
and charts  423
managing  584

page layout
different for odd and even 
pages  574

parse
SQL scripts  131

passwords
for launching BusinessObjects  
185

paste
page backgrounds  579

paste format
button  542

patterns
applying to chart walls  432

PDF
online guides  xix
saving BusinessObjects 
documents as  217

percent style  545
personal categories

creating  206
personal connection

selecting  132
personal data files

accessing data from  137
building hierarchies from  140
defined  39, 42
naming  167

personal document
list, viewing in BusinessObjects  
202
list, viewing in InfoView  202
retrieving  202
saving on server  205
send to  205

pictures
Bitmap format (Cell Format 
dialog box)  628

editing page backgrounds  579
inserting in cells  628
page backgrounds  578
pasting page backgrounds  579
removing page backgrounds  
579
using in reports  579, 628

pie charts
formatting  429

pivoting data
dialog box for tables, crosstabs  
278
hiding data  417
horizontally, in slice-and-dice 
mode  512
on charts  413
vertically, in slice-and-dice 
mode  516

PL/SQL  128
plot area

formatting  427
illustrated  427
resizing  426

positioning
blocks  561
cells  561
charts  561
crosstabs  561
report components  561
tables  561

predefined query conditions  93
applying  70
defined  70
in demo universe  71
removing  71

preparing for drill mode  468
Previous() function  335
primary

Y-axis  450
PRINT

statement  123
printing

from drill mode  496
printing see InfoView User’s Guide
priority

sorts  271
procedures

stored, data providers  123
VBA, using to access data  142
Visual Basic for Applications  
142
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prompts
and refreshing documents  212
in SQL scripts  133
inserting information in a 
report  596
syntax for free-hand SQL  133

PROSPERO  549
purging

data providers  171
lists of values  91

Q
qualification

of data for drill mode  493
of objects, defined  59
variables, changing  330

queries
applying conditions  70–73
applying predefined 
conditions  70
applying simple conditions  72
applying sorts  73
building  60–75
changing order of objects  64
combined  111
combined, restrictions on  114
defined  39, 42
defining scope of analysis  67
deleting conditions  73
editing from drill mode  486
including objects  64
introduction  56
inverting sorts  73
names  167
new  51
removing objects  64
removing predefined 
conditions  71
removing sorts  73
renaming  167
running  74
running a query on a different 
universe  76
Save and Exit  66
saving without running  66
selecting different values for 
simple conditions  72
setting options  74
setting up a subquery  98
using lists of values  72
viewing the SQL  116

query options
eliminating duplicate rows  74
limiting number of rows 
returned  74
Query Options dialog box  75
running a query without 
retrieving data  74

Query Panel
illustrated  61
View button  61
viewing objects in  64

Query Prompt  595
Quick Tour  xvii, xviii

R
Rank()

function  333
function, using context 
operators  361

ranking  273–277
altering values for  276
applying  274
applying in slice-and-dice 
mode  521
managing  277
removing  276

rates
conversion, editing  309
in euro conversion  308

RDBMS
exporting data to an RDBMS  
179

recap amounts
displaying  586

redo
an action  200

refreshing
documents  209
documents with prompts  212
lists of values  91
setting automatic options  212

regional settings
checking and changing  193

relative
positioning  561

removing
breaks  289, 290
data in slice-and-dice mode  
518
data labels  445
filters  262

page backgrounds  579
predefined conditions  71
ranking  276
sorts  272
sorts on query objects  73

renaming
blocks  519
categories  207
data providers  167
reports  199
VBA procedures  167
why rename data providers  
167

re-organizing
master/detail reports  504

re-organizing master/detail reports
using different master  505

repeat
cell formats  541
chart on every page  423

Repeat Block on Every Page
command  583

Repeat on Every Page
command  583

Repeat on New Page
command  583

Report Manager
hiding and displaying  194
in drill mode  478
inserting tables from  226
using to structure reports  566

reports
contexts  348
creating  75, 198
creating blank reports  198
defined  370
deleting  199
demo reports  30, 57
displaying inside document  
199
displaying page numbers  592
hiding components  569
inserting crosstabs  232
layout, setting default  604
master/detail  246
master/master/detail  249
multi-page  583
opening  201
page backgrounds  578
refreshing  209
renaming  199
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saving  215
standard, defined  602
structuring as master/detail  
247
updating  209
using pictures in  579, 628
viewing in Structure view  401
working on structure of  566

repository  29
reset contexts

defined  371
example  355
example of #COMPUTATION  
378
explained  377
how to define  356
in crosstabs  357
solution for #COMPUTATION  
379
syntax  356
syntax with input and output 
contexts  358

resetting blocks  519
resizing

blocks  425
cells  535
charts  425
columns  535
columns and rows  240
footers  591
header  591
margins  591
plot area  426
rows  535

restrictions
on combined queries  114
on using stored procedures  
123
on using user objects  81

retrieving
personal document  202

revenue
and quantity sold, comparing 
on chart  451

rich text format
saving documents in  216

rolling average
calculating  335

rotating
tables  227

rotation

setting on 3-D charts  433
rows

adding to tables, crosstabs  239
hiding  278
inserting  239, 242
naming  239
resizing  240, 535
selecting  238
selecting in tables and 
crosstabs  237, 238
table and crosstab, deleting  
231
table and crosstab, swapping  
227, 229

run line
command options  633

running
headers and footers  586

S
SAP  40
Save and Exit in Query Panel  66
Save Date command  592
saving documents

and reports  215
as BusinessQuery files  218, 
219
as html files  216
as PDF files  217
as text files  216
in html format  216
in PDF format  217
in Personal Documents  205
in rich text format  216
Save for all users option  215
WebIntelligence documents  
219

saving query definitions  66
scale

adjust scale to value range  439
adjusting in master/detail 
reports  439
decimal  438
defining on a chart  438
logarithmic  438

scatter charts
formatting data series  429

scope of analysis
custom  68
default  68
defining in query  67

dialog box  68
editing in drill mode  485
hierarchies  67

scripts
SQL, editing  130

secondary
Y-axis  450

sections
and #MULTIVALUE  387
and Rank() function  361
creating in reports  246
deactivating  508–511
displaying delimiters  251, 564
folding in outline view  597
formatting  526
formatting borders  531
hiding  569
hiding and displaying  529
hiding when empty  577
main  526
moving blocks between 
sections  565
setting standard report styles  
610
start on new page  583

security domain
choosing  186
connecting to  186

SELECT statements  116
selecting

cells  238
chart blocks to resize  425
chart elements  422
columns  238
columns in tables and crosstabs  
237
different values for filters  260
different values for ranking  
276
different values for simple 
query conditions  72
rows  238
rows and columns  238
rows in tables and crosstabs  
237
tables,crosstabs  237
two or more blocks  237, 455

semantically dynamic calculations  
344
sending to

personal documents  205
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set as master
in master/detail reports  247

shading
applying to cell backgrounds  
557
background, creating custom 
colors  425
headers and footers  590
setting background color  425
setting foreground color  425

shared
connection, selecting  132

sharing
user objects  81

shortcuts
keyboard  190

Show Variable Header
crosstab option  539

side wall
on 3-D chart, formatting  432

simple query conditions  93
applying  72
selecting different values for  
72
using lists of values  72

Slice and Dice Panel
Reset button  519

slice-and-dice mode
Apply button  501
applying breaks  522
applying calculations  521
applying filters  522
applying ranking  521
applying sorts  521
building master/master/detail 
reports  506
building/reducing 3-D matrix 
charts, crosstabs  515
deactivating sections of 
master/detail reports  508–
511
displaying data in reports  518
moving data between columns, 
rows  517
moving data between X-, Z-
axis in 3-D charts  517
positioning data horizontally  
512
positioning data vertically  516
removing data from reports  
518

Reset button  501
Slice and Dice button  500
Slice and Dice Panel, 
illustrated  501
swapping variables 
horizontally  512
working in  500–522
working with 3-D charts  517
working with 3-D matrix 
charts  513
working with crosstabs  513–
517
working with master/detail 
reports  502–511

Snap to Grid command  243, 564
snapshot

making in drill mode  484
sorting

days  268
months  268

sorts in reports  266–267
across edge sorts  271
adding  272
and alerters  269
applying  267
applying in slice-and-dice 
mode  521
checking regional settings  269
custom  266
customizing  266
down edge sorts  271
managing  270
managing sorts and ranking  
277
multiple  270
ordering multiple  271
removing  272
sorts toolbar  266

sorts on query objects
applying  73
ascending\descending order  
73
defining priority  74
inverting  73
removing  73
transparent sorts  74

sorts, and #MULTIVALUE  401
special field

date and time  592
drill filters  496, 595
global filters  262, 595

page numbers  592
query prompt  595

SQL  79
parsing for errors  131
scripts, customizing  133
scripts, editing  130
scripts, using prompts  133
viewing in query panel  116

standard report
definition  602

standard report styles
and templates  613
applying  612
customizing  606

Start on a New Page
command  583

statistics on data providers  170
STATUS

statement  123
status bar

meassages  190
stored procedures  123

building hierarchies  126
changing parameters  127
defined  39, 42
naming  167
restrictions on  123

structure
view  191, 401
view in Report Manager  566

style
currency  545
million  545
percent  545

styles
standard report  606
template  604

subclasses  58, 64
subquery  103

deleting  106
subroutine

VBA  143
subtotals

page, displaying  586
supervisor

BusinessObjects  30
synchronizing

calculations  102
data sources  152

syntax
errors, in formulas  401
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guidelines for formulas  320

T
tables

adding cells, columns to  239
adding data  230
building crosstabs from  515
building using drag and drop  
226
copying  240
creating  226
deleting  240
deleting calculations from  300
dialog box for pivoting data  
278
displaying charts as  411, 519
editing  236
headers and footers  224
hiding  569
insert wizard  234
multi-column or row layout  
537
orientation  537
positioning  561
reorganizing data in  227
repeat block on every page  
583
rotating  227
selecting  237
setting standard report style  
608
showing duplicate rows  538
showing headers and footers  
536
start on new page  583
turning to charts  519
types, defined and illustrated  
224

TELNET  549
templates

#DICT.ERROR  391
and standard report styles  613
and universe formats  615
applying  617
changing the default folder  
616
defined  603
replacing variables  618
setting default  604
setting up  615
structure  603

style  604
style and structure  618
upgrading  31, 618

text
applying text formats to axis 
labels  437
formatting  543

tick marks
displaying on chart axes  437
illustrated  435

time
inserting  592

tips  xvi
on dragging and dropping 
data  233
on using complex query 
conditions  98

tips and tricks  365, 368, 395, 399, 
400–401
title

displaying on chart  441
toolbars

alignment  563
borders toolbar, illustrated  
555
displaying  247
drill  470, 479
formatting  541
formatting, illustrated  543
hiding and displaying  189
sorts  266
structure  587
Visual Basic  639

totals
page, displaying  586

tracking
global filters  262
inserting document 
information  592, 595

Transact SQL  128
transparent

shading,setting  425
sorts on query objects  74

trends
highlighting using alerters  279

triangulation
in euro conversion  309

troubleshooting
see also Error Message Guide

turn to chart
command  410

TXT file display
and BusinessObjects version  
180
double quotes  180

U
undo

action in drill mode  471
an action  200

undoing master/detail reports  252, 
507

clearing master cell  254
placing master in block  507
placing master in table or 
crosstab  252
removing master  507

ungrouping
grouped variables  328

union
operator, on query panel  113

universes
classes  56
demo universe  30, 57
hierarchies  67
introduction  56
name in query name  167
objects  56
running a query on a different 
universe  76
setting a default  48, 604
subclasses  64

updates  xvi
updating

data  209
documents  209
vewing BusinessObjects 4.1 
documents  31, 192

up-down bars
showing on line charts  431

upgrading
and templates  31, 618
from BusinessObjects 3.1  31
from BusinessObjects 4.1  31

user identification  185
when logging on  185

user objects  79
creating  82
creating a time hierarchy for  
85
deleting  84
editing  84
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restrictions  81
sharing  81
writing the formula for  83

V
value-based breaks  290, 295
values

grouping  325
negative, displaying on 
column charts  430

variable
header, show in crosstabs  539

Variable Editor
using  322

variables  144
adding to reports  330
creating  322
creating by grouping  325
defined  370
hiding in charts  417
incompatibility  155
local  328
local, adding to drill 
hierarchies  329
local, changing qualification  
330
local, deleting  328
local, editing  330
moving from axis to axis on 
charts  416
organizing on charts  413
renaming  327
using  321

variance
calculating  298

VBA  142
add-ins  638
data providers  142
macros  638
procedures, naming  167
subroutine  143

viewing
BusinessObjects 4.1 documents  
31, 192
extended syntax  400
lists of values  91
report in outline view  597
report page layout  191, 592
report structure  191, 566
reports in Structure view  401
SQL, in query panel  116

Visual Basic  638
Editor  644
for Applications  142, 638
toolbar  639

W
WAIS  549
wall

back, formatting on 3-D chart  
432
side, formatting on 3-D chart  
432

web
connection  186, 209

web page for documentation  xvi
WebIntelligence documents

saving  219
website

adding links to from reports  
549

what’s new
in BusinessObjects  31

Where
function  339

wildcard characters
in query conditions  98

Windows
fonts  191
regional settings  193

wizard
calculation, on query panel  
100
insert chart  409
insert crosstab  234
insert table  234
new report  45

workspace
BUSINESSOBJECTS  188
illustration  188
organizing  191

X
X-axis

hiding  447
illustrated  435
organizing data on  413

XY scatter
charts  429

Y
Y-axis
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